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Online Manual - MAXQDA 2022
This guide provides a detailed overview of the features of MAXQDA. If you are just
starting to work with MAXQDA, we recommend starting with the chapter "Getting
Started Guide".

Popular topics:
Importing Data
●
●
●
●

Import and Group your Data
Supported Data Types
Import Transcripts
Import PDF Documents

More

Codes
●
●
●
●

The “Code System”
Create a New Code
Edit the “Code System”
Create Code Sets

More

Coding
●
●
●
●

How to code
Display Coded Segments in the “Document Browser“
Color Coding
Open Coding

More

Transcription
●
●
●

Transcribe Audio/Video
Simplify your Transcription Work
Link Transcript to Recording with Timestamps
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●

Insert Timestamps into a Transcript

More

Making the Switch from MAXQDA 2020 to MAXQDA 2022

Important notes on switching from MAXQDA 2020 to MAXQDA 2022 - and on
working in teams using a mix of both versions.
Go to FAQ
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Switching from older versions to MAXQDA
2022
To see all the new features of MAXQDA 2022, visit the "New Features" website.
MAXQDA 2022 includes features not available in previous MAXQDA versions and
several improvements have been made to the data structure of project files. As a
result, MAXQDA 2022 uses a new file format with the extension .mx22.
You can open projects from previous MAXQDA versions in MAXQDA 2022, they will
be converted automatically.

How to open projects from older versions in MAXQDA 2022
Start MAXQDA 2022 and select Open Project in the start window.

Opening an existing project from the start window

Navigate to the location on your computer where the project file that you want to
open is saved. Select the project and click Open.
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Select and open a project file that was created with an older version of MAXQDA

MAXQDA 2022 will read the data from the old project file and save it into a new
MAXQDA 2022 project file (.mx22). A message box is displayed as soon as the
conversion is successfully finished.

Successful conversion message

The new MAXQDA 2022 project file (.mx22) is saved in the same folder as the old
project. Your old project file remains untouched.
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The new MAXQDA 2022 file is saved in the same folder as the source file

What to consider when working in a team with Windows and Mac?
If you are working with several people with the same data and you are using Windows
and Mac, projects from MAXQDA 2018 and older should not be converted on
different computers. It is best to have one team member convert the projects and then
distribute the converted projects to all other members.
The background: because of the improved text processing since version 2020, the
length of text documents may differ depending on whether they were converted on
Windows or macOS (the content of the texts remains the same, of course). If you
convert the same projects on different operating systems in a team, difficulties may
arise when using functions such as Intercoder or Teamwork Export and Import.

What happens when converting projects from MAXQDA 2020?
The emoticodes will be replaced by new symbols. Since MAXQDA 2022 does not
contain all the symbols from previous MAXQDA versions (but lots of new ones), some
emoticodes may be converted to standard codes. To make these codes recognizable,
they will be prefixed with the name “emoticode”.

What happens when converting projects from MAXQDA 2018?
In addition to the previously described changes for projects from MAXQDA 2020, the
following happens:
In MAXQDA 2022 the Focus Group Speaker codes and the Paraphrased Segments
codes are moved to the bottom of the “Code System” window. Both code types are
counted separately since version 2020 and their frequencies are no longer included in
the total number of regular codes. Therefore, the total number of codes displayed at
the top of the Code System may be smaller than before. Scroll down the Code System
to see Focus Group Speakers and Paraphrased Segments codes.
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Change the file type to MAXQDA 2020 Project

A few elements of MAXQDA 2022 will be changed, because MAXQDA
2020 does not have the functionality to handle new or changed features:
"Coded segments in PDF documents of type "Text" are converted to
type "Image".
emoticodes in the "Code System" window are converted to standard
codes. Their code names start with "Emoticode" followed by their
symbol's name.
Memo titles are shortened to 63 characters.
Code and document summaries in code and document memos are
deleted.
●

●

●
●

Switching from older versions to MAXQDA
2022

9

Getting Started Guide: Go for it!
Introduction
Welcome to the MAXQDA Getting Started Guide! As no one likes to read long
introductions and manuals, we tried to make this one as short as possible to help you
get started as quickly as possible. The guide will enable you to start your analysis and
make your own experiences with MAXQDA. We will focus on the actual usage of the
program, and not on the presentation of different analysis and research methods. If
you want to find out more about those, we have provided a list of useful publi-cations
in the chapter “Further literature”. As you may know, there is an endless number of
different qualitative methods. But most of them can be conducted with the help of
MAXQDA as they all follow the same basic structure as pictured in this illustration.
The vast majority of qualitative analysis methods work with categories. These can
either be created from within the data or based on prior knowledge of the data,
existing theories, or recent research results. Categories are often also named codes or
keywords, but whatever the name, they all have the function to organize and
systematize the data, often even working as analytical codes. Analytical codes are the
result of an analytical process that exceeds simply determining a topic, and this is what
we refer to as Codes in this guide. Coding data can take a long time, but don’t worry:
there are many different ways to make use of QDA (qualitative data analysis) software.
It’s not always necessary to code your data in order to analyze it with MAXQDA; you
can also use it simply for organizing your da-ta, or searching for words and word
combinations.
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The MAXQDA Interface
Starting MAXQDA
When opening MAXQDA, you will see a window on the top left that lets you type in a
user name or a user abbreviation (which can be more practical in your later work).
To create your first MAXQDA project, click New Project, name your project and save it
to a place of your choice. The best location for a MAXQDA project is inside a local
folder on your computer, not on a network drive or on a USB flash drive. You should
also avoid folders that are synchronized by a cloud service like iCloud, Dropbox or
Google Drive. These services may compete for access to the project database while it is
open in MAXQDA.
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MAXQDA 2022 project files have the file ending MX22. You can also recognize these
files in Windows Explorer or Mac Finder by the description “MAXQDA 2022 Project”.
MAXQDA uses Projects, like Excel uses workbooks (.xlsx), and Word uses text
documents (.docx). Nearly everything you import to or create with MAXQDA (like your
Codes and Memos) will be saved in Projects.
The right side of the start screen provides you with several links, for example the
option to open up the MAXQDA online manual, watch MAXQDA video tutorials or
send feedback to the MAXQDA team.

The user interface
Once you successfully created and saved your first MAXQDA project, the following
screen will appear – with all of the main windows still mostly empty.
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The division into four windows makes working with MAXQDA very easy: as you can
see, the first window (1) in the upper left corner contains the Document System, the
window below (2) contains the Code System, the window in the upper right corner (3)
is the Document Browser, and the fourth window (4) is called Retrieved Segments.
(Don’t worry, if you only see three windows. The fourth window is hidden when you
start MAXQDA for the first time, because you don't need it at the beginning of your
analysis.)
These four windows make up MAXQDA’s basic structure. You can rearrange them by
swapping the windows’ sides, or by displaying the windows in three instead of two
columns. You can change those settings in the main menu with the four symbols on
the “Home” tab.

These tabs (some programs may call them “ribbons”) are located at the top of the
MAXQDA window and offer access to many of MAXQDA’s features. On the “Home”
tab you can open or close individual windows and arrange the screen according to the
work you intend to do. On top of that, you can “undock” individual windows from
the four-window structure and drag them to a different position or even a second
computer screen. To open and close the windows, you can click on the button for the
respective window(s), or simply close a window by clicking the “x” symbol in its upper
right corner.
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Now, let’s return to the four main windows! All the files you wish to work with will be
imported into the Document System window. In case you use codes and subcodes,
you can manage them in the Code System window. You can view and edit your data
in the Document Browser. The Retrieved Segments window is where the results of
your retrievals will be displayed later on.

A few notes on data storage and saving
MAXQDA administers everything you import, comment, or define in one single file,
the Project file. So, once you create it: one project = one file. As we learned earlier,
those files end in MX22 (older versions’ projects end in MX20 or MX18). MAXQDA
Exchange files are special types of files used to make data exchanges between
different program versions.
In order to ensure that your project is always safe, please read the following box:
MAXQDA automatically saves everything that is imported or created by the user (that’s
why there is no save button). However, you should still make sure to create daily backups via the option Save Project as, which you can find in the “Home” tab and save
them on a secondary storage device.
To sum up, the Project file contains all the data material you need to work on your
research project, bachelor thesis or master thesis. But there’s an exception to every
rule: if you use a lot of audio or video files, the Project file may become too large, even
after importing only a few video files. The standard setting therefore automatically
embeds pictures and PDF documents only up to a certain file size (5 MB), whilst audio
and video files are saved separately. Of course, you can change these settings. But
when your Project file becomes too large, it may be difficult to exchange it with
others.

Important keywords
Here are some of the most important keywords you should know for your work with
MAXQDA:
Projects are the system files, or “work units” in MAXQDA. They contain all imported
data, like texts, PDFs, pictures, tables as well as the codes, memos, comments you
created.
Documents are those units that you want to analyze. They can be interviews, focus
group protocols, video or audio recordings, articles from scientific journals and many
more.
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Codes are your most important analysis tool. They can be assigned to anything you
consider worth marking, be it text segments, sections in a photo or parts of a video.
The Code system or Code tree describes the entirety of all codes and subcodes which
can be ordered hierarchically.
Coding is the act of assigning a code to a marked segment of your material.
Coded segments are those material segments that have been assigned a code.
Memos basically serve as your records. You can note your ideas, assumptions, and
questions for your next analysis steps, or formulate first hypotheses regarding possible
connections in the data.
Comments are shorter than memos. You can use them to assign comments like
“contradictory”, or “important part!” to coded segments.
Overviews are tabular presentations omnipresent in MAXQDA. There are overviews of
coded segments, memos, variables, links and so on. All MAXQDA overviews follow the
same principle and allow easy access to individual elements so that you don’t lose
track of your data.

Import and Explore your Data
Importing data
Before we learn about the different ways to import your data let’s have a closer look
at the Document System window.

When you right-click the word Documents or the symbol next to it, a large context
menu will open.
You can see a part of it here:
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Alternatively, you can go via the “Import” tab menu and click on the appropriate
symbol for your data, e.g. Transcripts, or – even easier – drag and drop the files from
Windows Explorer or macOS Finder into the Document System window. On the
“Import” tab you will see additional options to import special types of data, including
importing documents from spreadsheets, focus group transcripts or creating a text
directly in MAXQDA.
In the way that your computer lets you create folders to organize your files,
MAXQDA’s New document group function lets you create document groups to
organize your documents. Right-click a document group and choose Import
Document(s) to import them, or drag and drop your documents from one group to the
other.

Exploring data
Analyzing qualitative data does not really work without you knowing the data. So
MAXQDA makes it easy for you to look through your files: simply double-click on a
document in the Document System window, and it will be opened in the Document
Browser, looking roughly like the interview transcript in the following example:

Paragraph numbers make it easier to discuss certain segments in a team (“Have a look
at the comment in paragraph 4!”) as well as coding whole paragraphs at once. You
can also use the paragraph numbers to quote your data sources. If you need a finer
numbering of your data, you can change the display to line numbering at any time by
right-clicking in the text and selecting “Convert to Line Numbered Text”.
In the example above you can see three colored vertical stripes, as well as a yellow
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sticky note symbol next to the text. The latter shows that a memo has been attached
to that paragraph. The vertical stripes are the so-called coding stripes symbolizing
which code the text was assigned to (in this case the long codes “..Interests”,
“..Career” and “..Parents”). To view long code names, simply enlarge the coding
column by dragging the line next to the coding stripes to the right.
What is a memo? Memos serve to create notes and records to attach them to texts,
text segments, document groups, images, audio or video files, and even codes – just
like you would do with “real” sticky notes.
When you open a text in the Document Browser for the first time, that sector will still
be empty as you have not coded nor created a memo yet. Just try to create one now:
double-click somewhere in the memo sector and a memo dialog window will
automatically open. As we will talk about memos in more detail later, this is all you
need to know for now.
The standard setting for the codes is to be displayed left of the data. If you prefer
them on the right, however, you can just place the whole sector there by clicking the
sector head and dragging it to the other side. There is no functional difference.
In the very top of the Document Browser, a toolbar shows you the most important
features.

If you import and open a PDF document in the Document Browser, you can use a few
additional settings. You will see that you are provided with icons, which enable you,
for example, to zoom in or out or to jump to the next page of the PDF file.

At some point of your research, you may wish to print a text including the paragraph
numbers (or save this display to PDF with a PDF printer). To do so, chose the symbol
Print document or use the keyboard shortcut Ctrl+P (on Windows) or cmd+P (on
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macOS). The print dialog will give you a variety of choices for the design of your print:

Search your data
The exploration phase of your research may call for the necessity to search your
documents for certain words. In MAXQDA, word search can be done locally in each of
the four main windows, that means in one window at a time. You will find a
magnifying glass symbol in each window to enter the search word upon click.
MAXQDA will display the term’s frequency, and you will be able to navigate from each
hit to the next to view its context by using the arrow keys.
A more powerful tool than the local search is the Text Search (to be found in the
“Analysis” tab or via the magnifying glass symbol in the Standard toolbar). The Text
Search enables you to search several documents at a time; it is not restricted to
opened documents.
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As soon as the window opens you can enter as many search items as you like at once.
Use the return key to end your entry or add a new search string. Each search item is
placed in a new line. The standard setting follows the “OR” logic, i.e. as soon as one
of the search items is found, it will be listed as a hit. Clicking an item will show you the
relevant paragraph in the Document Browser window.

Color-coding and memos
Sometimes you may want to mark something in a text or note comments, hypotheses
and further ideas, before you have even started thinking about categories and the
general direction of your analysis. Just like you may then highlight passages in a book
or stick a sticky note to a page, you can use the Highlight coding function in MAXQDA
to mark texts with five colored, virtual pens (red, blue, green, yellow, and purple). You
can find the color-coding icons at the top of the Document Browser window.

You can select any text part with your mouse and then click one of the symbols to
highlight it with the color of your choice. The difference to highlighting in “real life” is
that it is much easier to find those passages again in MAXQDA than to skim through a
book. How to retrieve coded segments created with Highlight coding, will be
described further down in Data analysis. As we learned, color-coding is a useful tool to
mark important things even before the explicit coding process. Another useful tool is
the Memos function. With the help of In-document-memos you can attach memos to
any place in any document. Select any part of a document, right-click on the
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highlighted selection and use the context menu to create a new memo for you to fill
with your thoughts and ideas:

Similar to color-coding, it is simple to retrieve Memos. You can find all types of memos
and a special memo search feature on the “Memos" menu tab. The search results are
displayed in MAXQDA’s Memo Manager, where you can easily manage, edit and filter
all your memos, e.g. by only displaying memos you have written in a certain time
period.

Code your Data
Coding data segments
As we learned earlier, the central work technique among most analysis methods is
Coding the data. But what does this mean? Coding describes the process of selecting
part of the data material, for example a paragraph or one part of an image, with the
mouse (just like in Word or other programs) and assigning a code to it. This is
principally the same as tagging contents, but coding in empirical social research
includes much more than that.
So, what is a code then? Your first associations may be of secret services and their
coding and decoding machines, or of codes as strictly regulated mappings as in Morse
codes. Both associations are misleading! In the context of qualitative research, a code
is more of a label used to name phenomena in a text or an image. In technical terms, a
code is a character string that can consist of up to 63 characters in MAXQDA, be it
several words or more cryptical strings like “CR128”. In social research, codes can
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possess different meanings and take on different functions in the research process:
there are factual codes, thematic codes, theoretical codes and many more (see Rädiker
& Kuckartz 2019, Richards 2014). From simply looking at the code itself, its role in the
research process is not always clear: it could be of minor importance or play a key role.
Only its context or framing will shed light on that.
So, how can codes be created? Simply click the green plus symbol in the Code System
window that appears when you hold your mouse over the first line. Using the plus
symbol, you can later add new codes to each level of your code system.

A dialog window to define your new code opens:

How can I assign a code to a certain document section? First, you select a section with
your mouse (if you want to mark the whole paragraph, just click the paragraph
number). Then you either drag and drop the marked section onto a code, or the other
way around, i.e. you drag the code on the selected section. Once you did that for the
first time, you will see that the number next to that code in the Code System, showing
how many times a code has been used, changed from “0“ to “1“. If you look at the
Document System you will see that the number of coded segments in a document is
displayed next to each document as well.
MAXQDA offers you other coding possibilities; you can access them via right-clicking a
selected section in the document or via the icons in the toolbar Code, which is located
at the top of the Document Browser window. The toolbar looks like this:
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The code that you used last is always displayed on the very left. If you click the red
coding symbol on the right, it will assign this code to a selected text section. Each of
the following icons refers to a different coding function; you can for example click the
Undo code symbol and then choose one or several codes from a drop-down list.
The context menu in the Document Browser contains even more coding options,
which you can see when you right-click into a marked text section:

Analyze your Data
Activating documents
Maybe you saw the option Only in activated documents earlier in the dialog window
for the Text Search and asked yourself what that means. Activation is one of
MAXQDA’s key concepts: it means that you can select documents (and/or codes) for
your analysis and then work only with the selected items. How does the activation
work? This is very simple: in every document’s or document group’s context menu you
will see the option Activate right at the top. More experienced MAXQDA users will
simply click the document or folder symbol to activate a document or a document
group.

You can immediately see if a document or group is activated. Both name and symbol
will be red, and a red arrow appears in front of them. symbols in the Document
System window change to indicate if a document is activated or not. The grey circle
turns into a red arrow to show that a document is currently activated. Further below,
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MAXQDA’s so-called Status bar displays the total number of documents currently
activated. Should you wish to limit your search to certain texts, activate them first and
then chose the option Only in activated documents in the dialog Text Search.

How can I reset the activation? Simply go to the Document System window and click
the icon Reset activations on the toolbar. Alternatively, you can click on the document
or document group symbol again.

Retrieving all segments coded with one code
Coding isn’t everything and your analysis is certainly more than just coding. At one
point you will want to stop coding and start looking at the results of that process. The
easiest way is to retrieve all segments assigned to one specific code. If you, for
example, do a research based on interviews, you may ask: “What was said about a
certain topic and who said what?” The magic word to get exactly those answers is
Retrieval. In MAXQDA such a Coding Query works – similar to the Lexical search – via
activations.
Activate all documents that you want to include in the Coding Query, as well as those
codes assigned to the segments you are interested in. Activation of codes works just
like the activation of documents (right-click the code and choose the option Activate
or click on the symbol in front of the code namesubcode name). All coded segments
found will appear in MAXQDA’s fourth main window, the Retrieved Segments
window. Below every segment you will see the segment’s source information. In the
example below the segment can be found in paragraph 6 of document “Riley“.

The source info does not only tell you which document a certain segment is from, it
also lets you go directly to that document: click on the document name, and the
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document will be loaded to the Document Browser window with the coded segment
right at hand, so that you can easily view it in its context.

Using visualizations
Visualizing results is one of MAXQDA’s strengths which is why we want to include this
chapter in a Getting Started Guide. There are several ways to visualize data in
MAXQDA, starting with the possibility to assign individual colors to codes and
documents. This does not only help you with the visual organization of your data, but
colors can also be given certain meanings. MAXQDA is the first QDA software to allow
the use of emojis as a code symbol. This may be particularly useful to overcome
language barriers, for example when working in international projects.
The visualization tools also allow you to show data connections in a comprehensible
way. The most used visual tool is the Code Matrix Browser, which you can open via
the “Visual Tools” tab.

So, what does the Code Matrix Browser show?

The columns list the different documents; in this case each document is one
respondent in an interview study on life satisfaction. For example, the respondents
were asked about issues they encounter on a daily basis. You can see here that all of
them mention emotions, but that only two of the respondents mention money-related
issues.

Conduct Mixed Methods Analyses
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Defining document variables
One of the most important MAXQDA features is its support of Mixed Methods
approaches. For every document in the Document System a whole set of attributes
(that is, variables as used by statistics programs) can be managed. You can, for
example, record personal data or background information for interviews as variables or
variable values, and use them for your Mixed Methods analysis. The option List of
Document Variables in the “Variables” tab will open the following dialog window:

On opening, you will see that several variables have already been defined. These are
the so-called system variables whose values are automatically set by MAXQDA and
cannot be changed. The option New variable lets you define further variables. The
most common variable types are Text (like “teacher” or “student” for the variable
“occupation”) and Integer (like whole numbers for the variable “number of children”).
You can define new variables anytime.

Entering variable values
To enter values for the Document Variables, use the toolbar in the List of Document
Variables and switch to the Data Editor.
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The document variables table can be exported to Excel or SPSS format, which means
that you can continue working on them with statistics programs like SPSS or Stata and
conduct a statistical analysis.

Transforming code frequencies into variables
The frequency of segments assigned to a certain code can be transformed into a
variable, which will receive the code’s name. Right-click on the preferred code and
choose Transform into a Document Variable in the context menu. In the following
example, the code “Significantly Positive” has been transformed into a variable:

Using document variables in your analysis
Quantitative and qualitative data can be connected in a variety of ways. The easiest
way is to choose the document variables as selection criteria when you run a Coding
Query. This will enable you to compare sociodemographic characteristics like “What
did New Yorkers over 50 say about XY?” or “How did the suggestions by singles
compare to those of married couples?”. The relevant selection can be made with the
function Activate by document variables in the “Mixed Methods” tab.
First, choose a variable from the list on the left (in this case: Relationship status), press
the arrow and then choose the variable value on the right (in this case: single). As soon
as you click Activate, all documents with matching variable values will be activated in
the Document System, in this example all interviews with male respondents.
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01 - The Workspace
How to Start the Program
When you open MAXQDA, the following start dialog will appear in which you can:
●
●
●
●
●

choose a user name,
start a new project,
open existing projects,
open example projects, and
view your license information.

The window area to the right displays all the latest MAXQDA news.

MAXQDA Start Dialog

Entering your username
Enter your name in the "User" field and your signature will be added to everything
you do in MAXQDA, be it importing documents, coding segments or creating memos.
This becomes particularly useful when working in teams, as it’s easier to see who has
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done what.

Starting a new project
Before you can analyze your data with MAXQDA, you need to create a new MAXQDA
project into which you can import your data. Click on New, enter a project name and
choose a location to save your project. (Please see the note on file saving locations
below.) As soon as MAXQDA has created a new project you can start to import your
data.

Opening existing projects
MAXQDA lists the recently opened projects in the lower window area, which you can
open with a double-click. If you want to open a project that doesn’t appear in this list,
click on Open and choose a file from the dialog window that appears.

Important note about saving MAXQDA projects: As MAXQDA is a database program,
all changes are always saved directly in the project file. For this reason, it is very
important that the computer's connection to the project file is not interrupted,
otherwise there may be problems with the project file.
To avoid data loss, we recommend that you do not open the project file from the
following locations:
●
●
●
●

USB drives
network drives
external hard disks
folders synchronized with cloud services (Dropbox, Google Drive, iCloud, etc.).

We strongly recommend to copy your project to a local hard drive (e.g. to the desktop)
and open it from there. Of course you can save your MAXQDA projects on USB drives,
network drives etc., but you should not open the file directly from there.

Opening example projects
Click on the Examples button to list the featured example projects, with which you can
thoroughly explore all MAXQDA’s functions. Just click on a project in the list to open
it.
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Changes to projects are saved automatically
MAXQDA does not include a save function which you must click when you finish
working on a project.
MAXQDA operates as a database program, which means that all changes you make to
a project, including the import of texts or later coding of data, are automatically saved.
Exceptions are edits to texts, memos and MAXMaps. These are saved automatically
every few minutes, as well as automatically when you close the window and the
project.

Opening projects from earlier versions (MAXQDA 2020 or older)
To open a project that was created in an earlier version of MAXQDA, follow these
steps:
1. Start MAXQDA and select Open in the start window.
2. In the dialog window that appears select file type of the old project.
MAXQDA 2022 for Windows can open the following project file types:
●
●
●
●
●
●
●
●
●

●

MAXQDA 20 (extension: MX20)
MAXQDA 18 (extension: MX18)
MAXQDA 12 (extension: MX12)
MAXQDA 11 for Windows (MX5)
MAXQDA 10 (MX4)
MAXQDA 2007 (MX3)
MAXQDA 2 (MX2)
MAXQDA (M2K)
MAXQDA Exchange files (MEX), that were created with MAXQDA for Mac versions
11.2.2 or newer
MAXQDA Exchange files (MEX), that were created with MAXQDA for Windows.

MAXQDA 2022 for macOS can open the following project file types:
●
●
●
●
●

●

MAXQDA 20 (extension: MX20)
MAXQDA 18 (extension: MX18)
MAXQDA 12 (extension: MX12)
MAXQDA 11 for macOS (MX11)
MAXQDA Exchange Files (MEX), that were created with MAXQDA for macOS version
11.2.2 or newer.
MAXQDA Exchange Files (MEX), that were created with MAXQDA for Windows
version 11.1.0 or newer.
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Please note: MAXQDA 2022 will create a copy of the project in the new MX22 format
in the folder where the project is located. Please note that the conversion process may
take several minutes to complete. The progress of the conversion process will be
displayed on your screen at all times.

Opening MAXQDA 2022 projects in MAXQDA 20
To open a MAXQDA 2022 project in the previous version MAXQDA 2020, you can
save it from MAXQDA 2022 in the previous format:
1. Open the project in MAXQDA 20202 (If you do not have a license for MAXQDA
2022, you can also use the free MAXQDA Reader.)
2. Select Start > Save project as from the menu bar.
3. Set the file type to "MAXQDA 2020 Projects", select a file name and location, and
then click Save.

Change the file type to MAXQDA 2020 Project

Select the appropriate file format in the file dialog box
MAXQDA then saves a copy of the opened project in 2020 format. When converting
to the old format, the following adjustments are made to the project file:
●
●

●
●

Text codes in PDF documents are converted to image codes.
emoticodes in the “Code System” window are converted to standard codes. Their
code names start with “Emoticode” followed by their symbol’s name.
Memo titles are shortened to 63 characters.
Code and document summaries in code and document memos are deleted.
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Project File Backups
Project file backups
It is strongly recommended that you regularly create project backups and save them
on external hard drives or flash drives, in order to minimize losses in case of computer
problems. Backup files shouldn’t be stored in the same location as your computer.
MAXQDA 2022 project files have the extension MX22 - if the file extensions are
hidden in your computer system, you can recognize the files by the MAXQDA icon and
the file type "MAXQDA 2022 Project File".
You can transfer your MAXQDA project files to an external storage drive using
Windows Explorer or Mac Finder. Alternatively, open the file in MAXQDA and choose
Home > Save Project As in the top menu. Then specify a location and file name and
click OK.

Automatic backups
MAXQDA allows you to backup projects automatically. If you open a project that has
not been backed up by MAXQDA for more than a day, MAXQDA will save a copy in a
selected folder. MAXQDA automatically provides the backup file with a date and time
stamp.
Both the time interval after which a project should be automatically saved and the
directory for backup copies can be specified in the MAXQDA preferences. Open these
preference by clicking on the gear symbol in the upper right corner of the MAXQDA
window . There, you can also disable the function entirely.
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Define the settings for the automatic backup of projects

Warning: The automatic backup represents a good safety net, but does not replace
the regular backup of your important project files on the Internet or on an external
data carrier, such as a hard disk!

The Main Menu
After opening or creating a new project, you will see the MAXQDA interface:
●

●

●
●

At the very top of the screen, you will see the project document name including the
location where it is saved.
Underneath the file name, you will see the main menu with several tabs that offer
quick access to MAXQDA functions.
MAXQDA’s four main windows occupy the main part of the screen.
A status bar is found at the bottom of the screen.
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The MAXQDA interface

Menu overview
Along the top edge of the MAXQDA interface, you will see the Main Menu, which
features several tabs.

The Main Menu

As soon as you hold the mouse pointer on one of the main functions, a brief
description will appear for most functions.

Home tab
In this tab you can choose to create a new project, open an existing project, or
complete other project management functions like printing, exporting, and importing.
The tab also features functions for managing externally saved project files.
The four main windows can also be hidden or revealed or changed in their
arrangement. For teamwork, there are functions for user management and for
merging two projects. You can also open the logbook from this menu.
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Import tab
In this tab, you can import your data into your new MAXQDA project. You can also
transform text documents into tables, spreadsheets or focus group documents.

The Import Tab

Codes tab
In this tab you will find the functions relating to codes. Some of these can be opened
in the context menus within the “Code System” window.
These options allow you to create new codes, create code frequency analyses and
manage your code favorites, shortcuts, and code alias table.
Further functions let you export and import a code system, for example in the general
exchange format "REFI-QDA Codebook".

The Codes Tab

Memos tab
This tab provides access to important functions for working with your memos, in
which you can record your own thoughts, hypotheses, notes and ideas about the data.
On the tab you can create new free memos as well as open the Memo Manager for
individual memo types or, for example, list and edit all your memos in documents. You
can also search within your memos on this tab.

The Memos Tab
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Variables tab
This tab lets you check and edit document, code and focus group variables as well as
check, add and edit the values of individual variables in the data editor. Additionally,
you can import and export variables.
It also allows you to create frequency tables and charts for these variables.

The Variables Tab

Analysis tab
This tab features MAXQDA’s extensive analysis functions. In addition to simple and
advanced lexical search functions, it includes retrieval functions for coded segments
(called a “Coding Query”) and a function for both qualitative and quantitative group
comparisons.
The Analysis tab also offers access to the intercoder agreement functions and working
with summaries. You can create summaries of encoded segments and present them in
summary tables. These summaries are an additional level of analysis over and above
the data.
The Analysis tab gives you access to text paraphrasing functions and the categorization
of survey data and the analysis and coding of twitter data.
Code configurations let you analyze the co-occurrence of codes, code frequencies look
at how often codes are used, and code coverage looks at the scope of coded
segments.

The Analysis Tab

Mixed Methods tab
This tab includes various functions for the combination of qualitative and quantitative
data using documents and variables.
The activation via variables allows you to select documents or document groups, based
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on their assigned variable values, for further analysis. The Quote Matrix and Crosstabs
functions are different visualizations that show connections between coded segments
and selected variables or variable categories.
The Typology Table is similar and shows percentages and mean values and standard
deviations for qualitatively-designed typologies. The Similarity Analysis for Documents
makes it possible to compare documents with regard to their coded segments and
variable values. You can use the Quantitizing function to store the code frequencies of
the activated codes as document variables.
Additionally, you have access to a wide range of further joint displays that incorporate
qualitative and quantitative data into a visual representation, such as the Side-by-Side
Display or the "Statistics for QUAL groups" obtained using qualitative data analysis.

The Mixed Methods Tab

Visual Tools tab
This tab allows you to choose between many different visualization options:
"MAXMaps", the tool for qualitative modeling, can be found here as well as the
"Code Matrix Browser", the "Code Relations Browser" and the "Document
Comparison Chart".
The "Document Portrait" and "Codeline" tools always refer to a single text, i.e. they
can only be selected if a suitable document is opened in the "Document Browser"
window. The "Word Cloud" displays the most common words of the currently opened
text, PDF or table and can be adjusted using stop lists.

The Visual Tools Tab

Reports tab
This tab lets you create various table overviews for important analysis data, such as the
Overview of Coded Segments with all your coded segments and the Overview of
Memos with all your project memos.
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Additionally, you can print the data in your project via this menu or export it for
further processing. With the Smart Publisher you create ready-made reports of the
coded segments while the code book contains the category definitions from your code
memos. You can also export tables of your summaries as well as look at a project
information page that provides a roundup of your project.

The Reports Tab

Stats tab (optional)
This menu is only available if you are running a license for “MAXQDA Analytics Pro”.
Stats is a module, which offers frequently used descriptives and inferential statistic
functions, like frequency tables, crosstabs, one-way analysis of variance, correlation
and creating scales.

The Stats tab

MAXDictio tab (optional)
This tab is only available if you are running a license for “MAXQDA Plus” or
“MAXQDA Analytics Pro”. MAXDictio is a module, which offers many functions for
word frequencies, word combinations, and other tools for text exploration as well as
quantitative content analysis based on a dictionary.

The MAXDictio Tab

TeamCloud tab (optional)
This tab is only available if you are running not any of these license types:
●

Demo license
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●
●
●

Student license
Teaching/Course license
MAXQDA Reader license

The TeamCloud Tab (Team Lead View)

Please note: For Mac, all the functions can be found in identical order in the menu at
the top of the screen.

Further functions in the main menu
There are several icons to the right of the menu that provide access to other MAXQDA
functions.

Undo options
Undo – undoes your last action, such as deleting a code or document.
Redo – redoes an “undone“ action.
When using the undo function in MAXQDA, please note the following:
●

●

●

●

●

Turning on Edit mode for a text or spreadsheet document disables MAXQDA's global
undo function. While Edit mode is on, no actions can be undone in MAXQDA. Only
the local undo function in the "Document Browser" is active, which means you can
undo text edits using the formatting bar or context menu. Once you switch off Edit
mode all changes within the document are saved and can no longer be undone.
The same applies to transcription mode, as MAXQDA's Edit mode is automatically
turned on for this.
The "Merge Projects" and "Import Teamwork" actions cannot be undone. Since
these functions can have complex effects on the project structure, a backup copy of
the project is automatically created in the designated folder before the function is
started. Actions taken before using these functions cannot be undone.
Text changes within a memo are also saved when the memo is closed. The undo
function returns the memo to the state before it was opened.
The undo function of MAXQDA has no effect on MAXMaps - there is a local undo
function, which applies to the opened map.
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Reducing or expanding the main menu
Reduce Menu /
Expand Menu – click on this icon and you can reduce the main
menu so that more space is available to work in MAXQDA’s four main windows.
When the menu is reduced, click the tab heading to access a function on the tab.
Another click on the symbol will expand the menu again.

Opening preferences
Preferences – here you can open the MAXQDA preferences menu.

Feedback to the MAXQDA Team
Send Feedback to the MAXQDA Team – opens a window where you can send a
message, including screenshots, to the MAXQDA team.

Help menu
Help – the question mark opens a comprehensive help menu that provides access
to MAXQDA’s online help and tutorials as well as information about your license.

The Four Main Windows
MAXQDA's four main windows occupy the main part of the main interface:
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The four main MAXQDA windows

The four windows have the following functions:
●

●

●

●

The “Document System” provides an overview of all the texts, PDF files, tables,
pictures and media files of your project. You also have the option of organizing these
documents in document groups, which act as folders.
The “Code System” displays all the codes, subcodes and code memos along with the
number of associated coded segments.
The “Document Browser” displays one of the documents from the “Document
System”, where it can then be worked on. You can highlight, edit, code, create links,
or attach memos in this window. Geo-Links are also displayed in the “Document
Browser”.
The “Retrieved Segments” window is a results window. Here you can display a
selection of coded segments (Retrieval).

Small toolbars in the MAXQDA windows
Each window has a toolbar, which gives you quick access to frequently-used functions.
By hovering over each symbol, you can see what each symbol does. Symbols that are
found in more than one toolbar always have the same function, such as:
prints out the content of the window
exports the content of the window
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allows for search in associated window
undocks the window
maximizes the window to the largest possible size
closes the window:

Small toolbar within a window

Hiding or displaying the main windows
All four windows can be individually displayed or hidden so that you can control the
arrangement of windows on your screen and optimize your work space.
Click on one of the the four window symbols in the Home tab to hide or show one of
the main windows.

Symbols for hiding or showing the four main windows

You can close the windows by clicking on the appropriate icon
in the upper-right
hand corner of each window. Next to the close icon, you also have the option of
clicking to maximize the window to its largest possible size.
Note: At least one window must be open, which means it‘s not possible to switch off
all four windows at the same time.

Optimizing the interface
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Adjusting the window size
The size of each window in comparison to the others can be adjusted as you wish by
clicking with the left mouse button on a border and dragging it in the appropriate
direction.

Window height and width can be adjusted by clicking and dragging borders with the mouse

The two-column and three-column layouts
You can change the arrangement of the four main windows at any time from a threecolumn view for wide screens to a two-column view better suited for narrow screens.
On the Home tab, there are four icons that you can use to customize the window
layout:

Adjusting the windows in the “Home” tab

Top left: The three column layout for wide screens. The “Document Browser” is found
in the middle and “Retrieved Segments” in the third column on the far right.
Top right: Alternative three-column layout with the “Document System” and the
“Code System” on the right side.
Bottom left: The two-column layout with the “Document System” and the “Code
System” on the left side.
Bottom right: Alternative two-column layout with the “Document System” and the
“Code System” on the left side.
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Small screens
When coding a document, it is sometimes helpful to close the “Document System”
and “Retrieved Segments” window, so the “Code System” and “Document Browser”
are larger. The “Document Browser” can then be made even bigger by dragging the
border in the direction of the “Code System”.

Optimal window setup when coding on small screens

The same is recommended for retrieving coded segments, the "Coding Query"
function. The "Document Browser" window is often not required and can be hidden.
Sometimes you want to see both the coded passage and its context. The easiest way
to do this is to open the "Retrieved Segments" and "Document Browser" windows
next to each other. If you then click on the source indication in front of the segment,
the surrounding context will be displayed the adjacent window.
There are several tasks for which specific window arrangements can be useful: for
example, in the case of selective searches for coded segments based on variable
values, it may be useful to display the "Document System" in the left window, to see
which documents are currently selected, and the "Retrieved Segments" in the right
window, so as to immediately check the results.

Maximize window
The four main windows can not only be hidden and displayed independently, they can
also be maximized to full screen mode by clicking on the corresponding symbol in the
upper right corner of the window. This is very useful, for example, if you want to
reorganize the category system and have the entire screen available for it.
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Context Menus and Toolbar in the
"Document System"
In addition to the various menus accessible from the menu, MAXQDA can be
controlled using the toolbars and context menus in their respective windows. The
functions that relate to the handling of documents are available in the “Document
System” window.

Toolbar
The toolbar at the top of the “Document System” window offers quick access to the
following frequently-used functions:
Reset activations – resets current activations
Activate by ... – enables the activation of documents depending on their variable
values and colors as well as random activation
Display only activated documents - reduces the display of documents to currently
activated ones
Import document(s) – allows you to insert text, PDF files, spreadsheets, images and
media files into the project
New text document - creates a new text document and opens it directly for editing
in edit mode
New document group – creates a new document group directly above the top
document group in your list
Display search toolbar – allows you to search for a specific document name
Settings - opens a dialog with locally relevant options (see below)
Undock window
Maximize window
Hide window
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Local settings
After clicking on the gear symbol in the "Document System", the following options
dialog box will appear with locally relevant settings:

Settings for the Document System

Open documents in tabs - If this option is enabled, each opened document is displayed
in a new tab in the "Document Browser". The previously opened document remains
open in a tab.
Display favorit variables in th tooltip - Select which document variables should be
displayed at the mouse pointer when you hold the mouse over a document name.
Import comments from Word or PDF documents as memos - Already existing
comments on the PDF document are imported as in-document memos at the same
position in the document.
Automatically code hihglightd text while importing Word or PDF documents - Color
highlighting that already exists in a PDF document is adopted as regular coding during
import into MAXQDA.
Ignore images and objects when importing text documents - graphics, especially
photos, take up a lot of space in a text, and there are research situations where only
the plain text is of interest, not the potentially annoying graphics. Therefore, by
selecting this option you can ensure MAXQDA does not import graphics and other
objects and cleans up the text.
Insert new documents at the end of the list - By default, new documents are inserted
at the top of the tree or at the top of a document group. Select this option to insert
documents at the bottom of the hierarchy level instead.
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Documents and document groups
In order to better organize your documents, it is possible to create document groups.
In MAXQDA, it is, however, not absolutely necessary that each document is put in a
document group. Documents can simply be left in the root folder of the “Document
System” window.
Documents can also be temporarily grouped together from various document groups
for certain aspects of your analysis. In MAXQDA, these groupings are called
"document sets."
Example: In an interview-based study on kindergartens in which teachers,
administrators, and parents are interviewed it makes sense to make three folders,
named “Administrators,” “Teachers,” and “Parents.”
In the “Document System,” it is possible to differentiate between four levels, each
level offering a different context menu:
●
●
●
●

the project level
the document group(s) 1st level
the document group(s) 2nd level
the document level

Four levels in the “Document System” window

The top level
The top level in the “Document System” hierarchy is the project level. After creating a
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new project, the “Document System” is empty except for the “Documents” entry.
When you right-click on the icon, the following context menu will open:

Context menu for the upper level in the Document System

The menu contains the following functions:
Activate All Documents – activates all documents in the entire project.
Deactivate All Documents – deactivates all documents in the entire project.
Activate Documents by Variables – allows you to create logical conditions based on the
existing document variable values for selecting and activating documents.
More... > Activate by Color – this function enables you to activate documents by their
assigned color.
More... > Activate by Random – this function enables you to activate documents at
random.
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More... > Activate Focus Group Participants by Variables – with this function the focus
group participants can be activated via their variable values for the analysis. (The entry
is visible only if the project contains focus group transcripts.)
Invert Activation – activates all documents that are not currently activated and
deactivates all those documents that are currently activated. This is especially helpful
when doing logical activations; you can then very quickly compile segments from
documents with contrasting document variables.

Memo – creates a project memo, i.e. a memo that refers to the entire project. If a
memo already exists, it is opened.

New Document Group – creates a new document group.
Collapse All – collapses all document groups for a better overview. Thus, the individual
documents of the document groups will not be visible.
Sort Document Groups (Ascending) – sorts all document groups in ascending
alphabetical order.
Sort Document Groups (Descending) – sorts all document groups in descending
alphabetical order.

Import Documents – you can import one or more files. These are assigned to the top
level ( the "root" folder).
New Text Document – inserts a new text document at the top of your "Document
System" and opens it directly for editing.
Move Activated Documents Here – moves all activated documents to the top level of
the “Document System” window. This function is only visible if at least one document
is actually activated.

Coded Segments – lists all coded segments in the entire project in table form in the
Overview of Coded Segments.
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Variables – displays the Data Editor for Document Variables for all documents in the
project.
Codes – lists all codes in the entire project in table form in the Overview of Codes.
Memos – lists all memos in the entire project in table form in the Overview of Memos.
Summaries – lists all summaries in the entire project in table form in the Overview of
Summaries.
Links – lists all links in the entire project in table form in the Overview of Links.
Focus Group Speaker - opens the Overview of Focus Group Participants" with all focus
group participants contained in the project and their variable values. (This entry is only
visible if the project contains focus group transcripts.)

Teamwork > Export Teamwork: Export Data to Exchange File – exports the coded
segments, memos, summaries, paraphrases and variables of your project.
Teamwork > Import Teamwork: Import Data from Exchange File – imports the coded
segments, memos, summaries, paraphrases and variables of an external project.

Word Cloud – creates a word cloud with the most frequent words that appear in the
documents within your project.
Code Cloud – creates a code cloud with the most frequent codes that appear in the
documents within your project.

MAXDictio: Quantiative Content Analysis – creates a count of the dictionary categories
in all your text, PDF, and table documents. (This function is only available for
"MAXQDA Plus" or "MAXQDA Analytics Pro".)

The middle level: document groups
A project can contain as many different document groups as you wish to create. A
context menu is also available at the document group(s) level, which offers functions
that only affect that specific chosen document group.
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Context menu for the middle (document group) level in the Document System

The following options are available in the context menu of a document group:
Activate All Documents – activates all documents in the document group.
Deactivate All Documents – deactivates all documents in the document group.

Memo – creates a memo that refers to the selected document group. If a memo
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already exists, it is opened.
Add Document to Document Set – adds the documents to an existing or new
document set.

Delete – deletes the selected document group, including all documents, coded
segments, memos, summaries and variables that are associated with it.
Rename – lets you give a new name to the document group.

Import Document(s) – one or more new documents can be imported. These are
assigned to the selected document group.
New Text Document – inserts a new text document at the top of your "Document
System" and opens it directly for editing.
Export documents - exports all documents of the clicked document group.
Sort documents > ... - sorts the documents within this document group according to
various criteria.
Move Activated Documents Here – moves all activated documents to this document
group, thus resorting the “Document System” accordingly. This function is only
displayed if at least one document is actually activated.

Coded Segments - Opens the Overview of Coded Segments with the codings of all
documents of the selected document group.
Variables - Opens the Data Editor for Document Variables with the variable values of
all documents of the selected document group.
Codes - Opens the Overview of Codes with the codes assigned in at least one
document of the selected document group.
Memos - Opens the Overview of Memos with the memos of all documents of the
selected document group.
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Summaries - Opens the Overview of Summaries with the summaries of all documents
of the selected document group.
Paraphrases - Opens the Overview of Paraphrases with the paraphrases of all
documents of the selected document group.
Links - Opens the Overview of Links with the links of all documents of the selected
document group (internal links, external links, geolinks, web links).
Focus Group Participants - Opens the Overview of Focus Group Participants with the
focus group participants contained in the selected document group and their variable
values. (The entry is only visible if the document group contains focus group
transcripts.)

Word Cloud – creates a word cloud with the most frequent words that appear in the
documents within this document group.
Code Cloud – creates a code cloud with the most frequent codes that appear in the
documents within this document group.

Single-Case Model > Single-Case Model (Coded
Segments)/(Summaries)/(Paraphrases)/(Code Hierarchy) - Creates a new single-case
model in MAXMaps with the selected document group at the center.
Teamwork > Export Teamwork: Export Data to Exchange File – exports the coded
segments, memos, summaries, paraphrases and variables of all documents this
document group.
Teamwork > Import Teamwork: Import Data from Exchange File – imports the coded
segments, memos, summaries, paraphrases and variables from another project into
this document group.

MAXDictio: Quantiative Content Analysis – creates a count of the dictionary categories
in all your text, PDF, and table documents in the document group. (This function is
only available for "MAXQDA Plus" or "MAXQDA Analytics Pro".)
Please note: Document sets are handled similarly to document groups. They are a
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temporary grouping of documents, but only contain links to the documents instead of
the documents themselves. The context menu that appears when you right-click on a
document set is similar to the document group context menu, but it does not contain
the options to import documents.

The lower level: the document
A context menu is also available at the individual document level and contains a variety
of functions connected to the chosen document.
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Context menu for the lowest (document) level

The menu contains the following functions:
Activate/Deactivate – activates the document; if the document is already activated, the
option will be to deactivate it.
Open Document – opens the document in the “Document Browser”. The document
which is currently opened in the “Document Browser” is indicated in the “Document
System” with a special symbol (document with a pen).
Open Document in a New Tab – opens the document in a new tab in the “Document
Browser”. The document which is currently displayed is indicated in the “Document
System” with a special symbol (document with a pen).
Open Document in Second Document Browser – opens the document in an undocked
“Document Browser”. The document which has last been focused is indicated in the
“Document System” with a special symbol (document with a pen).”
Delete Document – The document and all its associated data (memos, coded
segments, variable values) are deleted.
Rename Document – The name of the document can be edited.
Export Document – The selected document is exported and saved to a location of your
choice.

Memo – creates a memo for the document.
Add Document to Document Set – adds the document to an existing or new
document set.

Assign Audio / Video File – Opens a dialog window where you can select an audio or
video file to assign to the text. (The entry is visible only if you click a text document
that has not yet been assigned a media file.)
Transcribe Audio / Video File – Activates transcription mode for an audio or video files.
(The entry is only visible if an audio or video file is assigned to the selected document.)
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Coded Segments - Opens the Overview of Coded Segments with the coded segments
in the selected document.
Variables - Opens the Data Editor for Document Variables with the variable values of
the selected document.
Codes - Opens the tabular Overview of Codes with the codes assigned in the selected
document.
Memos - Opens the Overview of Memos with the memos of the selected document.
Summaries - Opens the Overview of Summaries with the summaries of the selected
document.
Paraphrases - Opens the Overview of Paraphrases with the paraphrases of the selected
document.
Links - Opens the Overview of Links with the links of the selected document
(documentation links and external links, geo-links and web links).
Focus Group Participant - Opens the Overview of Focus Group Participants with the
participants of the selected focus group and their variable values. (The entry is only
visible if a focus group transcript has been selected.)

Document Portrait – opens a visualization of the document that uses the code colors
of the coded segments in the document to create a picture of the document. The size
of the coded segment acts as the weighting factor, meaning that the longer the coded
segment, the more space that color takes up in the visualization.
Codeline – opens a visualization of the coded segments of the document. A matrix is
created with the codes on the y-axis and the paragraph numbers on the x-axis. It is
then possible to see which codes were used in each paragraph of the document.
Word Cloud – creates a visualization of the most frequently-used words in the
document (only for text, pdf and table documents).
Code Cloud – creates a code cloud with the most frequent codes that appear in the
document.
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Single-Case Model > Single-Case Model (Coded
Segments)/(Summaries)/(Paraphrases)/(Code Hierarchy) - Creates a new single case
model in MAXMaps with the selected document at the center.

(Color Selection) - A color can be assigned to the document.

Teamwork > Teamwork Export: Export Data to Exchange File - Exports the encoded
segments, memos, summaries, paraphrases and variables of the selected document.
Teamwork > Teamwork Import: Import data from Exchange File - Imports the coded
segments, memos, summaries, paraphrases and variables of another project into the
selected document.

Teamwork > Export Teamwork – allows for the export of all coded segments, memos,
summaries, and variables for the document. The exported file can be imported in a
project on a different computer. This function enables you to work in a team and
divide the work on a single document among team members.
Teamwork > Import Teamwork – allows for the import of coded segments, memos,
summaries, and variables for the document of an earlier exported file.
MAXDictio: Quantitative Content Analysis – creates a count of the dictionary
categories in the selected document. (This function is only available for "MAXQDA
Plus" or "MAXQDA Analytics Pro".)
Properties – opens a window with all the properties of the document, which can then
be edited (e.g. whether or not the document should be opened in read-only mode).
You can also link a media file to the corresponding document (e.g. an audio file with
the corresponding transcribed interview) to either code the transcript or the media file
itself.
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Context Menus and Toolbar in the
"Document Browser"
Toolbar
The “Document Browser” is MAXQDA's main work window: This is where you can
code texts and images, write memos, link text and/or images together, add external
links and more. The majority of the functions you will carry out in the “Document
Browser” are available in the context menu, which you can access by simply rightclicking in the window. The most commonly-used functions are also available in the
toolbar at the top of the “Document Browser.” It contains the following functions:
Show sidebar - displays the sidebar to the right of the document. Memos,
comments and paraphrases can be displayed in the sidebar.
Print document – allows you to print the document displayed in the window,
optionally along with memo symbols and coding stripes.
Export displayed document – saves the open document in a location of your
choice.
Display search toolbar - allows you to search within the open document.
Settings - opens a dialog with locally relevant options (see below)
Undock window
Maximize window
Hide window

Local settings
When you click on the gear symbol in the "Document Browser" window, the
following options dialog box will appear with local settings:
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Settings for the “Document Browser“ window

Copy text segments with source information to clipboard - When this option is
enabled, the indication of origin (document group, document name and document
position) is appended to all text segments that you copy to the clipboard.
Display coding stripes on the right - By default, the coding stripes are displayed to the
left of the document. Select this option to place the encoding strips to the right of the
document.
Reset coding stripe filters when opening a project - When this option is enabled,
coding strip filters are reset upon opening a project.
Maximum number of codes in 'Quicklist' - The setting determines how many codes
were last used in the encoding bar above the document.
Spellcheck language - Here you can set the language for MAXQDA’s spellcheck
function from the dropdown menu.

Context menu
If you highlight a segment of text or select a section of a picture opened in the
“Document Browser,” a context menu will appear with a large selection of various
functions, if you right click on the selected segment.
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Context menu in the Document Browser

Most of the available functions are self-explanatory, but they will still be explained
quickly in the following section.
Note: For PDF and image documents some functions such as cut and paste are not
available because these file formats do not permit modification. Some functions are
also unavailable for table documents.
Code with New Code - codes the highlighted text or section of an image with a new
code.
Code In-Vivo - codes the highlighted text with a new code created and named with
the highlighted text.
Code with “xyz” - codes highlighted text or section of a picture with the most recently
used code.
Code with Activated Codes - codes highlighted text or section of a picture with all
activated codes in the “Code System.”
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Insert Memo for Selection - creates a memo for the highlighted segment.

Explore in Word Explorer - opens the Word Explorer that gives you an overview of the
use of terms throughout your project.
Search for Highlighted Text - opens the text search with which you can search for the
selected text in all or part of the project.
List Assigned Codes - displays the codes assigned anywhere in the selected segment.
Insert as New Document – adds the selected text or image excerpt as a new document
at the top of the "Document System".

Convert to Line Numbered Text/Convert to Paragraph Numbered Text - Switches
between the numbering of each line and the numbering of each paragraph in text
documents. The numbers are used for quotations from the data.

Insert Internal Link (Anchor/Target) - sets an anchor for a link, which is a connection
between two sections in your data or memos.
Insert External Link - opens a file dialog to allow you to choose a file to be linked to
the highlighted section of the text or image.
Insert Web Link - allows the insertion of a link to a website.
Insert Geolink - allows to insert a geolink; a file dialog will appear to open and import
a KML file, which links to a geographic location.
Remove link - deletes a link from the selected segment.

Cut - cuts the highlighted text from the document to the clipboard.
Copy - copies the highlighted text to the clipboard.
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Paste - pastes the content of the clipboard (only works when in Edit Mode)
Paste without formatting - Same functionality as e.g. in Word: The text from the
clipboard is pasted and the formatting of the existing text is assigned. (This entry is
only visible when Edit Mode is switched on.)

Undo Text Changes - undoes the most recent change to the text (only works when in
Edit mode).
Undo All Text Changes - undoes all changes to the text that have been done since Edit
mode was turned on (only works when in Edit Mode).

Display Geolink Column – displays the geolink column next to the memo and code
visualization column on the margin of the “Document Browser.” All geolinks are
visualized with a symbol in this column.
Display Timestamp column - By default, the timestamps for connecting to an
audio/video file are displayed to the left of a transcript. Here you can hide this column.
Sidebar > Show Sidebar – displays the sidbar column next to the document which can
display memos, comments, or paraphrases.

Context Menus and Toolbar in the "Code
System"
Toolbar
The toolbar at the top of the “Code System” window offers quick access to the most
commonly-used functions in this window. These functions are:
Reset activations – resets current code activations.
Display codes from activated documents only - reduces the code system to codes
assigned in at least one of the activated documents.
New code – adds new code into the code system.
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Display search toolbar – allows you to search for a specific code.

Settings - opens a dialog box with local settings options (see below)
Undock window
Maximize window
Hide window

Local Settings
Click on the gear symbol in the "Code System" and the following options dialog will
appear with local settings options:

Settings for the “Code System” window

Display frequency of - here you define what the numbers behind the codes should
indicate. The setting does not refer to the entries "Paraphrased segments" and "Focus
group speaker" in the code system. Is reset to the setting Coded segments of all
documents when changing projects.
Sum up frequencies of subcodes - if you collapse a code, the frequencies of the code
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and all its subcodes will be added if this option is selected.
Click a code to apply a code to a selected segment - if this option is enabled, you can
click on a code to apply it to a selected segment instead of having to use drag-anddrop.
Table view - Switches from tree view to tabular view of all entries in the code system.
Will be turned off when changing projects.
Display only emoticodes - if this option is enabled, only emoticodes are displayed in
the code system and all other entries are hidden. Will be switched off when changing
projects.
Display 'Paraphrased Segments' at the top - by default the entry 'Paraphrased
Segments' is displayed below the codes. Enable this option to fix the entry at the top
of the code system.
Insert merging history in code memos - by default, a merging history is added to the
codes memo.
Display 'Focus Group Speaker' at the top - by default, the 'Focus Group Speaker' entry
is displayed below the codes. Enable this option to fix the entry at the top of the code
system.
Insert new subcodes below - by default, new subcodes are inserted directly below the
clicked upper code. Activate the option to add new subcodes below the existing
subcodes.
"Coding with new code", "Coding in vivo", "Open coding".
Insert new codes at the top - new codes added by the listed coding functions are
inserted at the top of the code system.
Insert new codes at current position - Newly added codes are inserted at the current
position, i.e. the blue mark, as subcodes.
No duplicate code names on same level - this option prevents codes with the same
name from being generated at the same hierarchy level.

The top level in the “Code System”
When you create a new project, the “Code System” is empty except for the “Code
System” icon and label. This represents the root directory or folder, the upper level of
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the “Code System” hierarchy. If you right-click on the symbol or the label next to it,
you will see a context menu. Since most selectable functions only apply to a nonempty Code System, some codes have already been inserted into the following
illustration.

Context menu for the upper level of the “Code System”

This menu offers access to the following functions:
Activate All– activates all codes in the entire “Code System”.
Deactivate All– deactivates all codes in the entire “Code System” (except focus group
participant codes).
More … > Activate Codes by Variables – allows activation based on code variable
values.
More … > Activate Codes by Color – allows activation based on code colors.
More … > Invert Activation – activates all currently deactivated codes and deactivates
all currently activated codes in the entire “Code System.”
More … > Load Activation – code activation status will be imported from a file
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previously created in MAXQDA.
More … > Save Activation – the current activation status of the code system is stored
in a file that can be called up at a later time in order to establish this specific activation
status.

New Code – creates a new top level code in the code system.
Code Favorites – opens window with your code favorites.
Code Alias Table – Displays a table with all codes that can be assigned an alias with
up to 255 characters for each code.

Sort – sorts all subcodes of the current code by alphabetical order or by code
frequency.
Collapse All Subcodes – for a better overview all subcodes are reduced so that only the
codes at the top level are visible.
Expand All Subcodes – all subcodes are expanded to give a quick view of all codes in
the Code System.
Move Activated Codes Here – moves all activated codes to the top level of the “Code
System” window. Subcodes of activated codes will keep their position as subcodes as
long as they are not activated. This function is only visible if at least one code is
actually activated.

Coded Segments – lists all coded segments in the entire project in table form in the
Overview of Coded Segments.
Variables – the complete data matrix for code variables is displayed.
Linked Memos – lists all memos that are linked to any code in the “Code System.”

The lower level: individual codes and subcodes
There is also a context menu for the single code/subcode level, which offers functions
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that affect the code you right-clicked on.

Context menu on the code/subcode level

The following functions are shown in the context menu:
Activate Incl. Subcodes / Deactivate Incl. subcodes – the code including all its subcodes
are activated or if it is activated, it is deactivated together with the subcodes.
Activate/Deactivate – only the code itself, without its subcodes, is activated.

New Code – creates a new subcode for the selected code.
Delete Code (and Subcodes) – the selected code is deleted. In the alternative view of
the “Code System” as Table, several codes can be deleted simultaneously. When a
code is deleted, every association to coded segments will be deleted. Subcodes will
also be deleted. The removal of codes from a code system can be visualized as the
cutting of branches from a tree: when a branch (code) is cut, all attached subcodes
and subcodes of subcodes are also cut off.
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Rename Code – allows you to create a new name for the code.

(Color Selection) – allows to set a color for the code.

Memo – creates a memo for the clicked code. If a memo already exists, it is opened.

Add Code to … > Code Favorites – the selected code is included in the "Code
Favorites" window, which enables a fast coding process for a few selected codes.
Add Code to … > Code set – the selected code is included in a new or existing code
set..

Subcodes > Sort – sorts all subcodes of the current code by alphabetical order or by
code frequency.
Subcodes > Copy/Paste – copies all subcodes so that they can be pasted into another
code.

Move Activated Codes Here – inserts all activated codes as subcodes of the chosen
code. Subcodes of activated codes will keep their position as subcodes as long as they
are not activated. This function is only visible if at least one code is actually activated.
Duplicate Code with Coded Segments - Creates a copy of the code below the clicked
code, including the associated encoded segments.
Copy Coded Segments – copies all coded segments for the selected code, so that they
can be copied into a different code. After choosing this option, right-click on the code
that you would like to paste these coded segments into and select Paste Coded
Segments (from Code 'xyz')
Move Coded Segments – cuts the coded segments from the current code, so you can
insert them in a different code. After selecting this option, right-click on the code
where you want to move the coded segments to and select Paste Coded Segments
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(from Code 'xyz').

Coded Segments – opens the Overview of Coded Segments with all coded segments
coded with the current code, offering an overview of the text and image segments
assigned with the code.
Documents – opens the Overview of Documents with all of the selected documents in
which the code was used.
Variables – opens the Data Editor with all code variables of the code and its subcodes.
Summaries – lists all summaries in the entire project in table form in the Overview of
Summaries.

Linked Memos – lists all memos that are linked to any code in the “Code System.”

Intersections – All codes that overlap with this code are displayed in a pop-up list, with
the most common overlapping codes topping the list. Clicking on an entry in the list
displays the corresponding segments that contain overlaps in the "Retrieved
Segments" window.
Crosstab – opens the mixed methods "Crosstabs" function, which can be used to
compare the code frequencies for groups of documents.
Code Model – opens MAXMaps and creates a map with the chosen Code Model.

Transform into a Document Variable – creates a numerical document variable with the
name of the current code in the variable list. The number of times the code appears in
each document is entered as the variable value for each document.
Transform into a Categorical Document Variable – creates a new string variable whose
value for each document is the subcode that appears most often in that document
(only works for codes that have subcodes).
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Subcode Statistics – opens a "statistics for subcodes" dialog window for creating a
frequency table or a chart of the subcode frequencies of the selected code.

Properties – opens the properties menu, where a color, alias name, and keyboard
shortcut can be assigned or changed for a code.

Context Menus and Toolbar in the
"Retrieved Segments" Window
Toolbar
The following commonly-used functions are available in the toolbar at the top of the
“Retrieved Segments” window:
Display origin - displays the document from which the segment originates for each
segment, supplemented by the position within the document.
Display favorite variables - shows the variables belonging to the document and
their values that are marked as favorites in the list of document variables for each
document or coded segment, depending on the sort order.
Display comments of coded segments - displays the column with comments on the
coded segments.
Overview of retrieved segments – shows overview of all retrieved segments in
table form. Overview will be displayed in a new window.
Smart Coding Tool – opens the displayed retrieved segments in the Smart Coding
Tool, where the assignments of codes can be customized.
Code Relations Browser – opens the Code Relations Browser for the displayed
retrieved segments, which visualizes overlapping codes.
Word cloud – creates a word cloud of the words most often used in the displayed
retrieved segments.
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Code retrieved segments – all coded segments that are currently in the
“Retrieved Segments” can be coded additionally with an existing code.
Code retrieved segments with a new code – all coded segments that are currently
in the “Retrieved Segments” can be coded additionally with a new code.
Print retrieved segments – prints segments along with indications of their origins.
Open as Word document - creates a text document in Word DOCX format and
opens the document with the program associated with that format.
Open as Excel table – opens the retrieved segments in an Excel document.
Open as HTML table – opens the retrieved segments in your standard browser.
Export retrieved segments – the segments can be exported in text format RTF
(text format), or as tables in XLS or HTML format. Memos attached to coded
segments, other codes assigned to the segment, as well as tooltip variables, can be
included in the exported material.
Display search toolbar – allowing for searches within the retrieved segments.
Settings - opens a dialog with locally settings options (see below).
Undock window
Maximize window
Hide window

Local Settings
When you click on the gear symbol in the "Retrieved Segments" window, the
following menu will appear with local settings:
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Settings for the “Retrieved Segments” window

Ordered by Document System – the segments in the “Retrieved Segments” window
will be sorted in order of the “Document System.”
Ordered by Code System – the segments in the “Retrieved Segments” window will be
sorted in order of the “Code System.”
Ordered by Weight Score (ascending/descending) – sorts retrieved segments according
to the weight assigned to them.

Include Subcodes – automatically includes all subcodes in the retrieval for each code
activated in the “Code System.”
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Use Weight Filter – displays only those retrieved segments that are within a certain
weight range.
Edit Weight Filter – opens a window where you can change the range of weight scores
included in the “Retrieved Segments” window.
Dislpay weight - displays the weight of the coded segments in the code name. The
weight is only displayed when the origin information is displayed.

List View - This is the default view for the "List of Coded Segments".
Classic View - Switches to the view of previous versions of MAXQDA.
Table View - Switches to a tabular list of coded segments.

The Status Bar
At the bottom of the MAXQDA screen, you will see a status bar that includes
information about various aspects of your current workspace (e.g. the number of
activated documents and codes, the number of retrieved segments, the current
retrieval option, etc.)

Status bar at the bottom of the MAXQDA screen

Activated Documents – number of currently activated documents
Activated Codes – number of currently activated codes
Coded Segments – number of coded segments, which are displayed in the
“Retrieved Segments” window
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Default Weight – displays the current standard weight, with which each new
coded segment is provided. The icon is interactive! Click the icon to customize the
standard weight.
Use Weight Filter – displays the current status of the weight filter for the retrieval:
If there is no checkmark displayed on the icon, the weight filter is switched off and all
segments will appear in the “Retrieved Segments” window, regardless of their weight.
If a checkmark appears on the icon, the weight filter is active and only the segments
which satisfy the conditions of the filter will appear. The icon is interactive! Click the
icon to turn the weight filter on and off.
Include Subcodes – displays the current status of the retrieval: If there is a
checkmark on the icon, the subcodes are included in the retrieval; if no checkmark is
displayed, the subcodes are not included. The icon is interactive! Click the icon in
order to determine whether subcodes will be included or not.
Sort Sequence – shows the sequence of the coded segments in the “Retrieved
Segments” window, which can be sorted by Document System, Code System, or
weight. The icon is interactive! Click the icon to toggle between the various sorting
options.
Coding Query – displays the selected mode of retrieval, such as “Simple Coding
Query” or “Overlapping.” The icon is interactive! Click the icon to call up the Complex
Coding Query.

Managing Table Overviews
MAXQDA lets you open several table overviews that list project data such as coded
segments, memos or variables. In the Reports tab you can find many of these, the
contents of which always refer to the whole project:

Overview in the 'Reports' tab

Overviews in MAXQDA can be customized as in Excel or other similar spreadsheet
programs. For the following example, we’ll use the table view of the document
variables in MAXQDA:
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Table view of an example project’s document variables

The heading of each column has the name of each variable, although the standard
MAXQDA system fields are written in a different font color:
●

●
●
●
●
●

Document group – the name of the Document group in which the document is
found
Document name – the name of the document
Creation date – the date on which the document was imported
Number of coded segments – the number of coded segments in the document
Number of memos – the number of memos in the document
Author – the user that was logged in when the document was imported

Adjusting column width and position
The width of each column can be changed by clicking and dragging the border
between the columns. Double-clicking on the column header border to the right of
the column resizes the column to its optimal size, so that the contents of each row can
be fully seen.
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Adjust column width and position

It is also very easy to change the order of the columns. You just need to click on a
column header and drag it to the place you wish to have it.
By right-clicking on a column header, the context menu appears for that particular
column. This includes various options, including the option to hide the column or
search within the column. The Select field option opens a window where you can
select which of the columns should be viewed in the standard view.

Sorting tables
Tip: Tables can be sorted very easily. Just click on the column header of the column
that you want to sort the rows by.

Sorting tables

Tables can be sorted alphabetically or in reverse alphabetical order. Clicking once on
the column header sorts it alphabetically; clicking a second time sorts it in reverse. A
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small triangle appears inside the column header of the column that is currently being
used to sort the table and whether it is sorted alphabetically or in reverse alphabetical
order.
Please note: Tables in MAXQDA contain both editable (blue) and un-editable (black)
columns. The system variables, for example, cannot be edited. You would therefore
need to change the document name in the “Document System” and change the
document group of a document by dragging it to a different document group in the
“Document System.”
In the editable cells of the table, you can enter or change a value by double-clicking on
the cell and then typing the value.

Selecting rows in a table
The table contents can also be selected and copied into the Windows clipboard. The
selection of one or multiple rows, or a section of the table, is done as follows: A single
cell can be selected by simply clicking on it, and additional cells can be added to the
selection by holding the Ctrl key (Windows) or Command key (Mac) and a section of
the table can be selected by clicking the first and last rows to be included while
holding down the Shift key. In MAXQDA, the selected sections of a table are
highlighted in green.
You can also search for certain values within each column of tables in MAXQDA. You
only need to right-click on the column in which you want to search and select Search.
In string fields, the search will start with the initial character. If you wish to search for a
certain word or phrase that does not have to appear at the beginning of the value,
you can use the asterisk (*) at the beginning of your search.

Context menus for tables
All overviews in MAXQDA have context menus that can be called up by using the right
mouse button. The number of options that appear in the context menu depends on
the overview. It is usually possible to delete a selection (e.g. a coded segment or
memo). In the Overview of Coded Segments, you also have the option to change the
weight score of each segment. The most options are available in the document
variables table.
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Context menu in the document variables table

Table overviews with a detailed display
The Overview of Coded Segments differs from, for example, from the Overview of
Variables in that it is divided into two parts. The lower section is used just as in other
tables. The upper section serves as a detailed view. Here, the coded segment, or text
or image segment itself that is selected in the bottom section appears. The same
applies to the “Overview of Memos”: Here the detailed view of the memo will appear.
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Detailed view of the “Overview of Coded Segments”

The toolbar in table overviews
There are many situations in MAXQDA where table overviews are used to display
information, and they are similar in how they can be worked with, which is similar to
the handling of tables in Excel. All table overviews have a toolbar offering quick access
to frequently-used functions.
The overviews include various icons in the toolbar depending on their function and
purpose. The following icons are found in nearly all of these toolbars:
Only activated documents – Displays only the rows in which activated documents
appear. The icon can only be clicked when at least one document is activated.
Only activated codes – Displays only the rows in which activated codes appear. The
icon can only be clicked when at least one code is activated.
Switch on Filter – Turns the filter for the columns on and off. The icon can only be
clicked when a filter has been set for at least one column. Set the filter by rightclicking on the column header.
Reset all filters – Deletes the defined filter for all columns of the table.
Search – Turns the search toolbar for the table on and off.
Excel table – shows the current table in an Excel document. This does not happen
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within MAXQDA, but can be printed out or saved as a separate file.
HTML table – shows the current table in an HTML document. This can also be
saved or printed out, but is no longer connected to your MAXQDA project.
Export – saves the content of the table in diverse formats including Excel (XLS/X) or
Website (HTML) and opens the file. Unlike the two functions above, you can choose
the file name and location. This exported file is also no longer connected to your
project file.

Searching in table overviews
To search through a table, click the icon
in the header of the overview. Another toolbar will then appear where you can enter a
search term.

Searching in a table overview

Highlight rows with hits – Highlights the rows in which the search term appears.
Choose search columns – Allows you to select the columns in which to search.
Find & replace – Allows you to enter a term to replace hits. Only hits that the user
has permission to change will be replaced. In the Data Editor for Document Variables
shown above, the values of the user variables with blue headers can be adjusted, for
example, but not the document names or the number of coded segments.
Tip:If you want to restrict the search to a single column, right-click the column header
and select the option Search. MAXQDA automatically selects only the clicked column
for the search.
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Filtering table overviews
Table overviews can easily be filtered. For example, in the Data Editor you can display
only the rows with documents containing more than 20 codes or whose names begin
with “B”:
●

Right-click on the heading of the column you wish to filter, and select the Set Filter
option. (If a filter is already set for the column, this option is called Edit Filter.)

Set filter by column

●

Set the desired filter options in the window that appears.

Filter window

In all four input fields, you can define criteria to filter. The following criteria are
available:
●

Contains
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●
●
●
●

Doesn’t contain
Starts with
Greater than or Lesser than (applies to both numbers and the alphabet)
Earlier than and Later than (available only in columns containing a date)

OR/AND: Here you can select the manner in which the four input fields are combined.
With OR, the rows in which at least one of the criteria applies are listed. With AND,
the rows in which all of the criteria apply are listed.
Case sensitive – When this option is selected, you can differentiate based on whether
the text in the text column appears in upper or lowercase. In this case, if “interview”
in lowercase appears in the filtered column, “Interview” beginning with an uppercase
letter would not be taken into account.
After clicking OK, MAXQDA filters the table overview according to the defined criteria.
At the top right MAXQDA indicates how many of the originally existing rows are
currently displayed.

Filtered table overview

If you set a filter for multiple columns, they are combined with the AND function.
You can switch a filter for a table overview on or off at any time using the Switch on
Filter
icon, to toggle the view between all rows and filtered rows.
If you wish to delete all defined filters in an overview, click on the Reset all filters
icon.

01 - The Workspace

83

Please note: Each time an overview is reopened, filters in table overviews will
automatically be set to “off”. The filter settings are saved individually for each
overview in the project, so if you have defined a filter and reopen the project at a later
time, you can turn on the filter by simply clicking the Filter
icon.

General Preferences
Click on the gear symbol in the upper right-hand side of the MAXQDA window to
open a window in which you can adjust several MAXQDA settings.

Open preferences

The following settings can be changed:

“General” settings
Folder for externally stored files
Here you can set the location for all of your externally-linked files to be stored. These
include audio and video files, for example, that are too big to be included in the
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project file. Image and PDF files might also be stored here, depending on their size and
your settings (see below).
Default weight
Every code assignment receives a weight. The default weight score for newly-coded
segments is 0, but can be changed here.
Autosave documents in Edit Mode and memos
Here you can specify the amount of time after which the project is saved automatically
during editing of documents and memos.
Confirm deletion of objects
If you deactivate this option, MAXQDA no longer asks for confirmation when deleting
code assignments, codes, documents, memos etc., but deletes this data directly. You
can then only restore them using the Undo function.

”User interface” settings
Interface theme
Here you can switch between the the light and dark interface color scheme.
Interface language
Here you can set the language of the menus, dialogs, and windows of MAXQDA.
Spellcheck language
Here you can set the language for MAXQDA's spellcheck function. MAXQDA offers
spell checking in English (UK), English (US), German, Italian, and Spanish.
Large font
Select to see the program interface labels (menus, title bars, etc.) in a larger font size.
To adjust the size of the text in the “Document Browser” use the zoom icons in the
window toolbar.
Reset user settings
Check this box to reset your user settings. MAXQDA will need to restart.
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”PDF and image documents” settings
Do not embed if larger than [MB]
This value determines the size at which an imported PDF or image file will be saved not
in the MAXQDA project file, but instead in the folder for externally stored files, with
only a reference to the document created in the project. The default size is 5 MB. If
necessary, you can adjust this value to be higher or lower.

”Automatic project backups” settings
Back up projects automatically
If the option is activated, MAXQDA checks each time a project is opened, when it was
last saved by MAXQDA and creates a backup of the project upon request.
Time interval [days]
Sets the number of days after which MAXQDA will start the next backup of the
project.
Folder for backup files
Here you can specify the folder in which you would like MAXQDA to save backup
copies of your project.
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02 - Importing Data
Supported Data Types
The following table provides an overview of what data types you can import into
MAXQDA:
Data

Format

Examples and Notes

Texts, transcripts,
Transcripts with time
stamps and
associated media
files,
Focus group
transcripts.

Word (DOC/X)
OpenOffice (ODT)
Rich Text (RTF)
Text (TXT)

Interview transcripts, field notes,
observation logs.
Time stamps allow the
synchronization of transcript and
sound.
Speakers in group discussions are
automatically coded

Documents

PDF

Academic journals, literature, news
articles

Tables

Excel (XLS/X)

Spreadsheet with survey result

Images

PNG, TIF, JPG, GIF, SVG, Photo diaries, advertisement images
BMP

Audio files

MP3, WAV etc.

Recorded interviews (these can be
transcribed and synchronized with
the transcript)

Video files

MP4, AVI, MPG, MOV
etc.

Recordings of group interactions,
YouTube videos
Data can be transcribed and
synchronized with the transcript.
Video and audio can be coded
directly.

Surveys,
questionnaires

Excel (XLX/S)
SPSS (SAV)
Direct import from
SurveyMonkey

Exported data matrices from the
open-source software LimeSurvey

Pre-structured texts
and tables

Same as for texts and
tables

Exports from the online data
collection tool kernwert.de can be
coded automatically during the
import

Websites

Downloads from the
Company presentations, news
MAXQDA Web Collector articles
(free extension for
Chrome browser)
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Tweets

Direct import of Tweets

Social media analysis of trending
topics

YouTube comments

Direct import from
YouTube

Social media analysis of trending
topics

Video file subtitles

SRT

Film analysis

Bibliographic Data

RIS, TXT

For literature reviews

Please note: In Windows, ODT documents can only be imported in MAXQDA if
Microsoft Office (2003 or later) is installed on your computer. Otherwise, the
documents can be saved in DOCX format and then be imported into MAXQDA.
All text and table documents imported into MAXQDA can be edited in the “Document
Browser”. This means you have the option of fixing typos, deleting or adding text, etc.
This is also possible once you have done some coding and/or creation of memos. This
means you don’t have to have a completed document to start your coding. PDFs,
images, and audio/video files cannot be edited in MAXQDA.
You can also create new texts or spreadsheets in an opened project at any time, into
which you can paste content from the clipboard.

Analyzing texts in any language (Unicode supported)
The fact that MAXQDA supports Unicode makes it possible not only to import and
analyze documents in any script, from Japanese to Cyrillic to Arabic, but also to create
codes and variables in these languages. The support for Unicode text is available in
every MAXQDA function.
Unicode is an international standard with the goal of standardizing all known
languages and characters. This makes it possible to work with various languages in the
same document. One sentence can be in English, the next in Mandarin, and the next
in Arabic. In MAXQDA, even codes and variable names can be created with “foreign”
characters, and searches and in-vivo coding are possible with any language.

Import and Group your Data
Importing data via the ”Import” menu tab
The Import tab provides numerous functions for importing different data types. When
you create a new project, the tab is automatically opened so that you can start
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importing data directly:

Importing data via the ”Import” tab

How to import standard data such as texts, PDF documents, tables, images, or audio /
video files:
1. Go to the Import tab and click on the appropriate icon for your data type, e.g.
Transcripts to import interview transcripts and Texts, PDFs, Tables to import Word
files, PDF documents or Excel files.
2. A dialog window will appear, in which you can select the files to be imported. Press
Ctrl (Windows) or ⌘ key (macOS) to select multiple files at the same time.
After making your selection, the files are inserted into the open MAXQDA project and
displayed in the ”Document System” window. The following image shows that several
texts (”Arne”, ”Amadi”, ”Chris”, etc.) have been added.

Display of documents in your ”Document System” window after import

By default, all inserted texts, PDF documents, tables and images are saved in the
project file. This means that you can modify or delete the source file with no effect on
the file in the project. Conversely, you can make changes to a file in MAXQDA, e.g.
improving typing errors, without changing the source file. Exceptions are audio and
video files, they are not stored in the project because of their size but in a special
folder for external files. The same applies to PDF documents and images that exceed
an adjustable file size. For more information, see "External Files".
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When inserted, MAXQDA takes the filename as a document name, it can be modified
later, avoiding duplication. Depending on the type of document, the documents are
given different symbols.
Please note: Using the other icons on the tab, special data types, such as focus group
transcripts, survey data, or data from Twitter can be imported. The specifics of these
imports are described in detail in their own sections.

Ordering the documents in document groups
Once you’ve imported your documents, you’re ready to start your analysis. Most
people don’t start with the analysis immediately, though, and prefer to organize the
documents in folders, as they might do on their computer’s hard drive. In MAXQDA,
these folders are called ”document groups”. They work just like folders do on your
computer – you can name them and drag documents into them.

Display of documents in your ”Document System” after import

There are two ways to create a new document group:
●
●

Click the New Document Group icon
in the ”Document System” toolbar.
Right-click on the root folder in the ”Document System” and select New Document
Group from the context menu.

MAXQDA then creates a new document group at the current position and
automatically assigns a name and number. To give the document group a meaningful
name, click on it with the right mouse button and select Rename. Alternatively, click
the name once with the mouse button to select the line, and then click the name
again.
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Suitable names for document groups are, for example, the data types (individual
interviews, group discussions, document analyses, etc.) or differentiation criteria
resulting from the sampling (first survey wave, second survey wave, ecclesiastical
organizations, public-law organizations, etc.).
Please note: You can create document groups on up to two levels. This means that
each document group at the top level can contain subgroups. These subgroups cannot
contain any further subgroups.
You can change the order of the document groups at any time using drag-and-drop.
Please note: You will often be working with documents or document groups whose
names consist of numbers or whose names contain numbers, e.g. Interview 1,
Interview 2, Interview 3. In the case of more than ten documents or document groups,
it is recommended to use double-digit numbers for their description, so that the
documents are sorted according to the order of numbers, e.g. Interview01,
Interview02, ..., Interview48. In the case of more than 100 documents or document
groups, corresponding three-digit designations should be used, e.g. Interview001,
Interview002 etc.

Moving and sorting documents

Moving individual documents
You can arrange the order of the documents in the ”Document System”. Just click
and drag the document to the desired position.

Moving multiple documents
You can select multiple separate documents by holding down the Alt key (Windows)
or ⌥ key (macOS) and then move this selection while holding down the mouse
button. To select a range of documents, first click on one document and then click on
a second document while holding down the Shift key ⇧. This then selects all the
documents between these clicked documents.

Moving multiple documents by activating them
To move multiple documents at once, first activate these documents by, for example,
clicking on their document symbol before their docuemnt name (the names will then
turn their color to red). Now click on a document group with the right mouse button
and select Move Activated Documents Here.
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Move all activated documents to a document group at once

Sorting documents
To sort the documents in a document group, choose Sort Documents from the context
menu of the document group and then the required sorting order in the drop-down
menu. Sort criteria include Document Name, Last Action, and Text Length (only text,
table, and PDF documents are taken into account).
To sort document groups by their names, right-click on the root folder of the
”Document System” window, and choose Sort in Ascending Order to sort them from
A - Z or Sort in Descending Order for the reverse order.

More import options
You can import documents not only from Import tab but also using several other
ways:
●
●
●

●

Click the Import Documents
icon on the toolbar of the ”Document System”.
Or use the keyboard shortcut Ctrl+D (Windows) or ⌘+D (macOS).
Or click on the root folder in the ”Document System” with the right mouse button
and select Import Documents.
Or right-click the document group to which the document is to be assigned. From
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the context menu, choose Import Documents.

Import documents via the context menu in the document group

As described above, a dialog window opens in which you can select which file to
import.
Please note: The imported documents are imported into the selected document group,
i.e. marked in blue. If no document group or root folder is selected in the ”Document
System”, MAXQDA inserts the new documents at the top of the document "tree".

Importing documents via drag and drop
Files can be imported via drag and drop: Select one or several documents in the
Windows Explorer or Mac Finder and simply drag the documents into the ”Document
System” with the mouse. Then drop the documents in the desired position.
Tip: To import the documents of a whole folder into MAXQDA, drag the folder from
the Windows Explorer or Mac Finder to the ”Document System”. MAXQDA then
creates a new document group with the same name of the file folder at the top of the
document “tree” and imports all documents that MAXQDA can import. If the folder
contains subfolders, these are also created as separate document groups.

Document sets
MAXQDA makes it possible for you to create and save a temporary grouping of
documents. While each document can only be in one document group, it can be in as
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many document sets as you wish, because document sets are only made up of
shortcuts to the documents. In other words, a document set can be deleted without it
having any effect on the document. If that same document were deleted from a
document group, however, it would be deleted from the project along with all of its
memos, coded segments, links, etc.
Document sets are very convenient in case you want to analyze a certain selection of
documents. Forming a document set is also an easy way to save the result of a
complex variable activation process.
Document sets may be used like document groups; you can activate all the documents
in a document set at the same time and request all the overview table options for
working with document groups (codes, memos, variables, links, etc.).

How to create a document set
1. Left-click on the symbols of all documents to be included in the set (the activated
documents are displayed in red). You can actiavte all documents in a document
group at once by clicking on the folder icon.
2. Right-click on the word Sets at the bottom of the “Document System” window.
3. Select New Set form Activated Documents.
MAXQDA then creates a new set with the name “Set 1” and adds all activated
documents to this set. You can click on the name with the right mouse button and
choose another that is more appropriate. Document sets may be used like document
groups; you can activate all the documents in a document set at the same time and
use all the options for working with document groups (Codes, Memos, Variables,
Links, etc.).

Modifying document sets at a later stage
Individual documents can be deleted from a document set: Right-click on a document
in a set and select Remove Document from Set. Or drag and drop documents to move
them from one set to another.
Tip: You can drag documents into a set at any time with the mouse. Drop the
documents into the desired set and MAXQDA will insert them directly at the top of the
set.

Create New Text or Table Documents
MAXQDA lets you not only import and export texts and tables, but also create them,
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for example for ethnographic descriptions of researched items.

Create new text documents
There are several ways to create a new text document:
●
●
●
●

●

Click the New Text Document
icon in the toolbar of the "Document System", or
go to the Import tab and click the Create Document icon, or
press the key combination Ctrl+T (Windows) or ⌘+T (macOS), or
right-click on the root folder of your documents in the "Document System" and
select New Text Document to insert a text at the top of the document list, or
click on a document group with the right mouse button and select New Text
Document to create a text at the top of the selected document group.

Creating a new document via the context menu of a document group

MAXQDA will automatically assign the document a name in the form of “Document
nn,” where nn is a consecutive number. Of course, you can always change the name
later. After creating a new document, it is automatically opened in the “Document
Browser” and put in Edit Mode, so you can start to type or paste text from another
program into it.
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Create new tables
To create a new table, go to the Import tab and click on the text (not the icon) Create
Document. Then click New Table Document in the menu that appears. You can freely
select the number of rows and columns.

Select the number of columns and rows when you create a new table

Please note: No new columns or rows can be added later.

Convert text document into a table
You can convert a text document automatically into a table document, for example, to
paraphrase the text in an additional column:
1. Open a text document by double-clicking on it in the “Document System“.
2. Then go to the Import tab and click on Convert Text to Table Document.
3. A dialog box will appear, in which you can specify the number of columns.

Choose the number of columns

Please note: The original text will be preserved in the “Document System“ window,
the new table will be inserted as a copy.
A new table document appears in the “Document System“, which you can recognize
by the symbol
and which will bear the same name as the source document. Each
paragraph of the source text appears in a separate line of the new table. If you have
selected more than one column for the table, the text appears only in the first column.
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The original text will appear only in the first column

As this picture shows, this conversion function makes it easy to paraphrase and
summarize texts in MAXQDA. When you activate Edit mode, you can paraphrase the
texts in the empty columns of the newly created table.

External Files
In general, all documents will be imported into the MAXQDA project file, meaning the
original file remains in place. You can modify or delete the original file without
affecting the imported document in MAXQDA. This concept holds a great advantage
over other QDA software, in which the primary files are constantly at risk of being
modified “from the outside.”
With MAXQDA you can connect audio or video files to their transcriptions and import
PDF and image files, which means that the “one project = one file” concept is not
always optimal. If you were working with many audio/video, image, or PDF files, for
example, your project file would quickly become very large, which would slow down
processes in MAXQDA and make it almost impossible to move the file.
For this reason, MAXQDA does not save audio and video files in the project file and
also PDF and image files lager than 5 Megabytes (default setting) are not imported.
Instead, they are saved in an external folder. You won’t notice any difference in the
way you work with the documents in MAXQDA; the icons in the “Document Browser”
look just like they would if the documents were saved in the project file.
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The threshold for the file size can be set in the overall MAXQDA preferences.
Preferences can be opened by clicking on the gear wheel on the upper right corner of
the MAXQDA main menu.

Open settings

Edit settings for saved files

You can also set the location where external files are to be saved. If you do not change
it, the default location for all external files will be as follows:
●
●
●

for portable license installations: [MAXQDA 2022 Files]MAXQDA_Externals
for Windows normal license installations: [My documents]MAXQDA_Externals
for Mac normal license installations: [My documents]/MAXQDA_Externals

Please note: All your external documents will be saved in one global external folder. If
you wish to save externals in a project-specific folder, you should create a folder for
the designated project. However, it can be useful to work with a global external folder
from which external files can be accessed by multiple MAXQDA project files. For this
reason, when you delete a document, the associated media file will not be deleted
without confirmation, as the file could still be linked to other documents.
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What actually happens when a PDF or image file larger than the set
maximum size is imported into a MAXQDA project?
●
●

●

●

You are informed that the file is saved externally and is not embedded in the project.
The document is added to the list in the “Document System” just as it would be if it
were a smaller file.
The document is visualized with the PDF or image icon as is the case with smaller
files.
The file is copied into the set folder for external files. The original document remains
in its original location.

What happens to a media file (audio/video) when it is linked to a text
document in the “Document System”?
●

●

●

The location of the original audio or video file is saved in the properties menu of the
document.
The original media file is never saved as part of MAXQDA project file, even if it is
smaller than the maximum file size.
The media file is copied into the folder for external files. The original file remains in
its original location.

Which file is actually used – the original or the copy?
MAXQDA always looks for the original first – it looks for the file based on the path
that is saved in the properties menu of the document. If the original is not found, the
copy of the file in the external files folder is used. This file is then loaded. And if the
file is also not available here, MAXQDA looks in the folder where the currently opened
project file is stored. Therefore, the original file can be moved or deleted without it
affecting the proper functioning of MAXQDA.

Be careful when using the same file name for different files!
It is possible to import several documents with the same name into the “Document
System” (e.g. three files named “Document 1”). This is only a problem if the file is
larger than the set maximum and must be saved in the external files folder. When the
most recently imported file is saved, it automatically replaces the older file with the
same name.
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What happens when you change the location of the external files folder
in the global MAXQDA settings?
In this case, MAXQDA will ask you if you would like to move the documents from the
previous location to the new external files folder. The documents are only moved once
you confirm this. Since this action changes the global setting for all projects, all files
are moved from the former external files folder to the new.
Can you import an externally saved document into the project file at a later time?
Yes, you can. To do this, right-click a document in the “Document System” and select
Properties. Then click on the button Embed document.

Can you store a document outside the project file at a later stage, that is, save it in the
folder for external files?
Yes, you can do this, too. To do this, right-click a document in the "Document
System" and select Properties. Then click Store documents externally.
To store several documents outside the project file, go to Home > External Files > Store
Documents in Folder for External Files. A dialog box will appear listing all documents
stored in the MAXQDA project file. Here you select all the documents that you want to
store externally.

Function for storing files externally
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How do you transfer external files from one computer to another?
To share the project with team members and colleagues, including the external files,
follow these steps:
1. Send the MAXQDA (MX22) project file to the target computer.
2. Bundle all external files by clicking on External Files > Bundle External Data Files in
the Home tab. MAXQDA then compresses all external files associated with the
current project into a Zip archive, which is named after your project (e.g.
“Projectname.mx22.zip”) and saved in the same place as your project file.
3. Send this newly created Zip file, too.
Procedure on the receiving end:
1. Open the MX22 project file.
2. Click External Files > Unpack Bundled Data Files in the Home tab and select the Zip
archive in the file dialog box that appears. MAXQDA then unpacks the archive and
moves the linked files to your external files folder. If you saved the Zip archive in the
same folder as the project file, MAXQDA automatically accesses the archive and
unzips the files on request.

Text Documents
Importing texts
You can import texts into a MAXQDA project in various ways:
●

●
●

with the mouse, drag and drop text files from the Windows Explorer or macOS
Finder directly into the “Document System” window,
click the Import Documents icon
in the "Document System", or
click the Texts, PDFs, Tables icon in the Import tab.

Importing data via the “Import” tab

Please note: In Windows, ODT documents can only be imported in MAXQDA if
Microsoft Office (2003 or later) is installed on your computer. Otherwise, the
documents can be saved in DOCX format and then be imported into MAXQDA.
For general information on importing files and organizing them, see Import and Group
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your Data.

Preparing text documents before import
If you want to import text documents into MAXQDA, you should briefly think about
how to prepare them for the import. If you want to analyze certain sections of text as
a single unit, for example, it makes sense to put them together in the same paragraph.
MAXQDA enters a new paragraph number after each hard return. This makes it easier
to then automatically code these paragraphs in MAXQDA.
Here are the things to remember when importing a text document:
●
●
●
●
●

●
●

All formatting aspects – like bold, italics, etc. – are carried over to MAXQDA.
All fonts and text sizes are carried over.
Most of the paragraph formatting (e.g. right-justified, line height) is also carried over.
The text can contain tables, pictures, graphics, etc.
If objects like graphics are imported or not can be determined in the local
preferences of the "Document System", which you can open by clicking on the gear
symbol at the top right of the window.
Contents of header and footer are ignored.
Footnotes are added at the end of the text, they are converted to endnotes.

Color highlighting and comments
Color highlighting that already exists in a text document is adopted as regular coding
during import into MAXQDA. A parent code with the name "Word/PDF highlighting"
is created at the top level in the code system. For each color, a subcode with the colors
name in English is created and assigned to the corresponding text passage.
Please note: When importing the color highlighting, slight color deviations from the
original are possible, as MAXQDA selects the one that fits best from a list of stored
colors.
Already existing comments on the text document are imported as in-document memos
at the same position in the document and can be displayed in the "Document
Browser". Several related comments (threads) are combined into one memo.
The option to code highlighted text and import comments as in-document memos
during import can be turned on/off in the settings of the "Document System". To
open the settings, click on the gear wheel in the toolbar.
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In-text tables
MAXQDA can import tables included in text documents, and you can code parts or
whole cells of these tables in MAXQDA. The only limitation here is that the size of the
table and the column widths can no longer be changed once it has been imported.
Please note: We recommend that you use tables in text documents only sparingly. This
not only increases your analysis options (e.g. automatic coding at paragraph level), but
also increases the performance of the display. In particular, we advise against
importing interviews in a table structure in which each response is contained in a
separate row.

Links to websites embedded in texts
Documents imported into MAXQDA can also have links to websites (hyperlinks) in
them. Clicking on the link in MAXQDA brings up the webpage or HTML file in the
default browser.
Hyperlinks are always made up of two parts: the visualization (whether it be a button,
picture, or text) and the URL, which is the information about the location of the file,
which may be a WWW address. By hovering over the link, you can see the
location/URL in the tooltip that appears. Usually, this is not otherwise visible.

Hyperlink in a text

Please note: When you enter an Internet address in a text in MAXQDA, it will
automatically transform into a clickable hyperlink when you close Edit Mode.
You can find more notes and advice in Links in MAXQDA.
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PDF Documents
Importing PDF documents
You can import PDF documents into a MAXQDA project in various ways:
●

●
●

with the mouse, drag and drop PDF files from the Windows Explorer or macOS
Finder directly into the “Document System” window,
click the Import Documents icon
in the “Document System”, or
click on the Texts, PDFs, Tables icon on the Import menu tab.

Importing data via the “Import” tab

For general information on importing files and organizing them, see Import and Group
your Data.

Color highlighting and comments
Color highlighting that already exists in a PDF document is adopted as regular coding
during import into MAXQDA. A parent code with the name "Word/PDF highlighting"
is created at the top level in the code system. For each color, a subcode with the colors
name in English is created and assigned to the corresponding text passage.
Note: When importing the color highlighting, slight color deviations from the original
are possible, as MAXQDA selects the one that fits best from a list of stored colors.
Already existing comments on the PDF document are imported as in-document memos
at the same position in the document and can be displayed in the "Document
Browser". Several related comments or threads are combined into one memo.
The option to code highlighted text and import comments as in-document memos
during import can be turned on/off in the settings of the “Document System”. To
open the settings, click on the gear wheel in the toolbar.

Navigating through the “Document Browser”
As soon as a PDF document is displayed in the Document Browser, several clickable
icons will appear in the toolbar. You can flip forward and backward, adjust the zoom
and use the bookmarks for navigation (many PDF files have several bookmarks, e.g.
one per chapter).
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Navigation toolbar

Tip: MAXQDA does not support editable PDF form fields. To display content from PDF
forms, save your PDF document via a PDF printer as a new PDF file that contains the
contents of the form fields as pure text.

Working with PDF documents
There are some special considerations when working with PDF documents, as the PDF
format was not conceived for text editing but rather as a layout format for printing,
and hence are much bigger files than simple text documents.

Saving PDF files outside the MAXQDA project file
By default, all PDF files smaller than 5 MB will be saved in the project file upon
insertion. PDF files larger than 5 MB are not saved in the MAXQDA project itself, but
rather in the folder for externally saved files, and only a reference to the externally
saved data is created. You can customize the maximum file size as well as the location
for externally saved files in MAXQDA’s preferences, which you can access via the gear
symbol in the top right corner of MAXQDA's main window.
For detailed information, see External Files.
Tip: If you are working with many large PDF files (e.g., with a total size of more than
50 MB), it makes sense to store them externally so that the MAXQDA file remains
small and can be easily backed up. For optimal performance, it is recommended that
externally saved files are located on the local hard disk. The use of a network drive can
also work if the connection is very fast.

Coding text and image segments
Text and image segments in PDF documents can be coded with the mouse. Select and
create a frame around the desired segments to subsequently code them. MAXQDA
does not distinguish between text and image codings in regard to code frequency;
however, in the Coding Query when searching for overlap, the query will search
independently for text and image segments. Overlap between text segments and
image segments will be ignored. The “Near” function for image segments always
returns a result of 0, both in the Complex Coding Query and the Code Relations
Browser.
If a text is in the format of a scanned PDF file, Optical Character Recognition (OCR), a
text recognition process, must carried out with a suitable program before the import
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into MAXQDA. This process makes it possible to mark and code the text in MAXQDA
later, otherwise it would only be possible to mark images.

No paragraphs in PDF files
PDF documents, unlike text documents, have no paragraph structure per se. MAXQDA
functions that rely on the paragraph structure can therefore not be used in PDF
documents. These functions include, among others, automatic coding with the
parameters “Paragraph” as well as the “Near” function for segments in the Complex
Coding Query and Code Matrix Browser.

Extract text from a PDF document and save as text document
After a PDF document has been imported into a MAXQDA project, you can extract the
text from the PDF document. Images and formatting are ignored, only the plain text is
inserted as a new text document in the “Document System”.
Click on a PDF document in the “Document System” and select the function Insert
PDF Text as New Document. The new text appears directly below the clicked
document.

Insert PDF text as a new document

Tip: With many PDF texts, the conversion makes it possible to search within
paragraphs when conducting a lexical search.

Image Documents
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Importing images
You can import images into MAXQDA in various ways:
●

●

●

With the mouse, drag and drop files from the Windows Explorer or macOS Finder
directly into the “Document System” window.
Click on the Import document(s) icon
in the "Document System", or on the
Images icon on the Import tab. A file dialog appears in which you can select the files
to be imported.
If you have copied a picture and want to paste it directly from the clipboard, click the
dropdown arrow to the right of the Images icon and select Import Image from
Clipboard. Alternatively, you can insert the image from the clipboard directly into the
“Document System” using the shortcut Ctrl+V (Windows) or ⌘+V (macOS).

Importing data via the “Import” tab

For general information on importing files and organizing them, see Import and Group
your Data.

Working with images
When working with images, there are a few aspects to consider that are described in
this section.

Saving image documents outside MAXQDA projects
Normally all image documents of less than 5 MB are saved directly in the MAXQDA
project. Image documents larger than 5 MB are not saved directly in the project, but
rather in the folder for external files, and only a reference referring to the externally
saved file is generated. You can customize the maximum file size as well as the
location for externally saved files via the MAXQDA preferences, which you can access
by clicking on the gear symbol in the top right of your window.
Tip: If you are working with many large image files (e.g., with a total size of more than
50 MB), it makes sense to store them externally so that the MAXQDA file remains
small and can be easily backed up. For optimal performance, it is recommended that
externally saved files are located on the local hard disk. The use of a network drive can
also work if the connection is very fast.
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Coding image segments
In image documents, borders can be drawn around the selected area with the mouse
which can be subsequently coded like text segments, meaning they can be dragged
and dropped into a code. With the Complex Coding Query and Code Relations
Browser, the “Near” function for image segments always returns a result of 0.

Rotating and zooming into images
As soon as an image document is displayed in the “Document Browser“, several icons
for viewing the image will appear in the toolbar. You can zoom in or out of the image
as well as rotate it clockwise (images imported from digital cameras and mobile
phones should automatically be correctly rotated by MAXQDA, provided the correct
information has been saved in the image).

Audio and Video
You can import audio and video files into MAXQDA in various ways:
●

●
●

with the mouse, drag and drop text files from the Windows Explorer or macOS
Finder directly into the “Document System” window,
click the Import Documents icon
in the "Documents System", or
click on the Audios or Videos icon on the Import tab.

Importing data via the “Import” tab

There are some special considerations regarding audio and video files.
MAXQDA supports the following formats as standard:
Audio Windows: MP3, WAV, WMA, AAC, M4A
Mac: MP3, WAV, AAC, CAF, M4A
Video MP4, MOV, MPG, M4V, 3GP, 3GGP
Windows: additionally AVI and WMV
For video, a MP4 file with the video codec H.264 / AVC is recommended.
Audio and video files are generally not imported directly into a MAXQDA project.
Instead, they are stored in the MAXQDA folder for external files and linked to a text
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document in which you can, if necessary, save a transcript.
When importing an audio or video file, MAXQDA creates a new text document with
the name of the media file and links the newly added document to the media file. The
media file itself is copied in the MAXQDA externals folder. If a file with the same name
already exists in the externals folder, MAXQDA asks if the existing file should be
overwritten. You can adjust the location of the folder for external files in the global
MAXQDA settings. The settings are called up via the gear wheel at the upper right
edge of the main window.
For detailed information, see External Files.
In the "Document System", you will recognize text documents with the associated
media file by their document symbols: a musical note
for audio files and a video
camera
for video files.

Audio and video files in the “Document System“

Assigning an existing transcript to an audio or video file during import
During the import of an audio or video file, MAXQDA asks you whether there already
is a transcript that you want to assign to the media file. If you select Yes a dialog
window pops up where you can select the transcript file.
If the selected transcript does not contain timestamps, MAXQDA will ask you whether
you want them to be generated automatically:

Options for automatically generated timestamps
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MAXQDA will automatically place timestamps in the transcript at the selected
intervals, making it easier to listen to the original sound of a selected text passage.
Please note: The automatic assignment of time stamps to the text is linear to the
length of the audio or video file. This means that a click on a time stamp does not
always play back precisely the clicked text but positions the audio or video file
approximately near the text passage.

Assigning audio/video files to a text document
You can also assign a media file to an existing text document. To do this, right-click on
the document in the "Documents System" and select Link Audio/Video File.
To change the assignment of an audio or video file, right-click on the document in the
“Document System” and select Properties. In the dialog that appears, an alternative
file can be selected by clicking on the three dots in the "Media file” line

Assigning a different audio/video file to a text document in the Properties dialog box

Play and edit audio and video files
Audio and video files can be played and edited in MAXQDA's "Multimedia Browser".
For detailed information, see Analyzing Videos.

Table Documents
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Importing table documents
You can import Excel documents into MAXQDA in various ways:
●

●
●

with the mouse, drag and drop text files from the Windows Explorer or macOS
Finder directly into the “Document System” window,
click the Import Documents icon
in the "Documents System", or
click on the Texts, PDFs, Tables icon in the Import tab.

Importing data via the “Import” tab

For general information on importing files and organizing them, see Import and Group
your Data.
What happens when an Excel spreadsheet document is imported into a MAXQDA
project?
●
●
●
●
●
●

The first worksheet in the Excel workbook will be imported.
Hidden columns and filtered rows in Excel will also be imported.
The columns are numbered according to their order.
The entries in the first row of the table are used as headings.
The row order will remain the same when imported.
The font will be standardized.

Imported table document in the “Document Browser“

Please note: Excel spreadsheets that use Object Linking and Embedding (OLE) to
integrate embedded objects such as Word documents, PowerPoint slides, etc., can
have a significant impact on performance, so we advise against using them. Instead,
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external links are much better suited for linking tables with objects outside the
MAXQDA project.

The table view in the “Document Browser”
For table documents, a standardized font is used and it is not possible to modify the
text format. You can enlarge or reduce the display font by using the zoom icons in the
“Document Browser”. The height of the rows will be automatically set to the height of
the largest cell.
Please note: When importing, the columns are numbered according to their order in
the Excel document. The number is at the beginning of each column heading and
cannot be changed post-import.
During the import, the first row of the imported Excel worksheet is copied as the
column header. You can adjust this heading by right-clicking on a column and
selecting Edit:

Modify column header

When you import a table, each column will be assigned a type automatically:
●
●
●

Text
Numeric
Date/Time

To change a column type, open the drop-down menu “Type.”
Please note: It is not possible to modify the column type if the column contains coded
segments.
The column widths and column positions can be modified using drag & drop. Like
overview tables, table documents in MAXQDA can be sorted by clicking the column
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header. The original order can always be restored by right-clicking on the column
header and selecting Reset Sorting. Alternatively, you can click on the empty column
header just above the row number.

Modify table view

You can access the following options by right-clicking on the column header:

Context menu of a column header

Hide Column – hides the column.
Edit – allows the modification of column name and column type.
Select Columns – opens a window in which the columns to be displayed can be
selected.
Reset Sorting – restores original order after import.

Notes on table rows
The row numbers are fixed when the table is imported into MAXQDA and cannot be
modified.
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Please note: For performance reasons, we advise using table documents with a
maximum of 1,000 rows. Longer tables should therefore be divided into smaller units
if possible.

Editing table documents
The contents of individual cells can be modified. In order to do so, click on the Edit
mode on/off
button in the top right corner of the “Document Browser”.
Tip: To insert a paragraph within a cell, hold down the Alt key (Windows) / option key
⌥ (macOS) and press Return.

Coding table documents
Any text segment of any cell can be coded. First, double-click on the cell in order to
select the contents. The cell will then be outlined in yellow, and you can mark a text
segment. All of the usual MAXQDA coding options, including color-coding and coding
with emoticons, are now available. It is not possible to code across multiple cells.

Coded text in a cell

Please note: When you hide a column, the corresponding coding stripe in the
“Document Browser” will also be hidden.

Notes on Coding Query function in table documents
The retrieval options for coded segments in table documents are identical to those for
text documents. For example, overlap will be handled in the same way as it is with
normal text. The retrieval functions also include hidden columns and are based on the
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current configuration of the table. Retrieval functions for a single row correspond to
those for a single paragraph.
The Near function in the Code Relations Browser and Complex Coding Query applies
to columns in table documents. This means that only the vertical proximity of two
codes, and not the horizontal or diagonal proximity, will be taken into account, and
that coded segments in different columns will never be found, when using the Near
function.
Click on the source data in the “Retrieved Segments” to indicate the coded text in the
“Document Browser” and display the corresponding column.

Memos in table documents
As with all documents in MAXQDA, you can assign memos to table documents. You
can assign a memo to a table document like this:
●

●
●

Right-click a selected text section in a cell and select Insert Memo for Selection to
compose a memo for the text section.
Right-click on a cell and select New Memo.
Double-click in the memo column to the left of the table to create a memo to the
first character of the first cell at the click position height.

Adding memos to a table document

When you click on a memo symbol, MAXQDA will indicate to which text or cell this
memo is assigned.
Please note: When a column is hidden, the memos assigned to the cells in this column
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will also be hidden.

Table documents and the Visual Tools
In principle, hidden columns in table documents will be taken into account when using
Visual Tools.
Code Matrix Browser functions as with any other type of document, as only the
number of coded segments for a particular code will be analyzed.
Code Relations Browser functions as with overlapping in normal text. Overlap can only
occur within a particular cell. The “Near” function will search only for coded segments
in the same column.
Codeline Each row represents a paragraph in the Codeline – the column structure is
ignored in this case. Hidden columns will be taken into account. Paragraphs will be
sorted in their original order.
Document Comparison Chart As with the Codeline, each row in the table represents a
paragraph – the column structure is ignored. Hidden columns will be taken into
account. Paragraphs will be sorted in their original order.
Document Portrait This tool operates differently than with regular documents.
Columns will be more or less ignored; cells will be processed from left to right, then
top to bottom. A one-dimensional structure is then created, which is displayed as
usual in the Document Portrait.

Exporting table documents
Table documents cannot be printed directly from MAXQDA; they can, however, be
exported in Excel format. Click the Export displayed document
button in the
"Document Browser" or select Reports > Export > Displayed Document from the main
menu. Alternatively, you can right-click on the document in the “Document System”
and select Export Document.

Transcripts
Transcribing recordings is easy with MAXQDA, because MAXQDA provides all the
standard transcription functions, such as automatic speaker exchange, autocompletes
with defined shortcuts and timestamps for synchronizing transcriptions with audio or
video files. All the functions for transcribing in MAXQDA are described here.
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MAXQDA also lets you import transcripts that were created automatically or with
specialized transcription software, including f4/5 transkript, Inqscribe, or Transcriber
Pro. This is usually the case when a professional service provider has transcribed your
recordings.
The transcripts created with such software usually contain timestamps corresponding
to certain audio or video files. MAXQDA automatically includes these timestamps.
Most transcription programs create their transcripts in standard text formats which can
be imported directly into MAXQDA without conversion.
When creating or ordering transcripts, it’s a good idea to insert a timestamp at the
end of paragraphs least as well as at easily misunderstood points within a paragraph.
Timestamps let you open and play the original sound file with just one click.
A transcript with timestamps then looks like this:
I: So, Robert. Could you please describe your current living situation for me?
#00:00:10.5#
B: Sure. Uhm, at the moment I am living with my parents. In my old room in the
basement. I did have a room in the dorms at college, but I am taking a semester off
and wasn't sure where I'd end up going. I am looking for an internship at the coast,
so I'll probably find a place with a roommate there soon. #00:00:30.1#

Example transcript with timestamps at the end of paragraphs

Importing transcripts without timestamps
If your transcripts do not contain timestamps, you can import them via Import >
Transcripts > Transcripts without Timestamps. Alternatively, you can simply drag the
transcript from Windows Explorer or Mac Finder to the "Document System".

Importing transcripts with timestamps
Importing transcripts combined with their corresponding audio or video files:
1. Ensure that you have the appropriate audio or video recordings for all transcripts
that you want to import. For example, you can save the transcripts and the media
files in the same folder using same names for a transcript and the corresponding
media file.
2. In MAXQDA, go to the Import tab and select the function Transcripts.
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Start import of transcripts

3. In the drop-down menu, select the entry of the transcription software that was
used to create the transcript. Select Transcript with Timestamps if you do not know
the software used.
4. A dialog window will appear in which you can select a transcript for the import. If
you press Ctrl (Windows) or ⌘ (macOS), you can also select several transcripts.
5. Click Open and MAXQDA will search the file for timestamps and ask for the
associated media files. Select them in the dialog window that opens, and click
Open. If you don’t want to link any media files to the transcript, click Cancel.
MAXQDA will ask if you want to import the transcript without a media file and if
you want to keep the timestamps in the text.

Importing transcripts from AmberScript
AmberScript is an online transcription app with automatic speech recognition. To
import a transcript from AmberScript:
1. Edit the transcript online.
2. Export the transcript in DOCX format. Make sure to activate the options to include
timestamps and speakers.
3. In MAXQDA go to the Import tab and choose Transcripts > From Amberscript

Importing transcripts from f4x Spracherkennung
f4x Spracherkennung is an online transcription app with automatic speech recognition.
To import a transcript from f4x Spracherkennung:
1. Edit the transcript online.
2. Export the transcript in RTF format.
3. In MAXQDA go to the Import tab and choose Transcripts > From f4/f5 transkript

Importing transcripts from HappyScribe
HappyScribe is an online transcription app with automatic speech recognition. To
import a transcript from HappyScribe:
1. Edit the transcript online.
2. Export the transcript in DOCX format or in "MAXQDA(.txt)" format. Make sure to
activate the options to include timestamps and speakers.
3. In MAXQDA go to the Import tab and choose Transcripts > From HappyScribe
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Importing transcripts from Otter.ai
Otter.ai is an online transcription app with automatic speech recognition. To import a
transcript from Otter.ai:
1. Edit the transcript online.
2. Export the transcript in DOCX format.
3. In MAXQDA go to the Import tab and choose Transcripts > From Otter.ai

Importing transcripts from SimonSays
SimonSays is an online transcription app with automatic speech recognition. To import
a transcript from SimonSays:
1. Edit the transcript online.
2. Export the transcript with the "MAXQDA" option or in DOCX format.
3. In MAXQDA go to the Import tab and choose Transcripts > From SimonSays

Importing transcripts from Sonix
Sonix is an online transcription app with automatic speech recognition. To import a
transcript from Sonix:
1. Edit the transcript online.
2. Export the transcript in DOCX format.
3. In MAXQDA go to the Import tab and choose Transcripts > From Sonix

Importing transcripts from Temi
Temi is an online transcription app with automatic speech recognition from Rev.com.
To import a transcript from Temi:
1. Edit the transcript online
2. Export the transcript in DOCX format.
3. In MAXQDA go to the Import tab and choose Transcripts > From Temi

Importing transcripts from Trint
Trint is an online transcription app with automatic speech recognition. To import a
transcript from Trint:
1. Edit the transcript online
2. Export the transcript in DOCX format.
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3. In MAXQDA go to the Import tab and choose Transcripts > From Trint

Importing transcripts from Voicedocs
Voicedocs is an online transcription app with automatic speech recognition. To import
a transcript from Voicedocs:
1. Edit the transcript online
2. Export the transcript in DOCX format.
3. In MAXQDA go to the Import tab and choose Transcripts > From Voicedocs

What happens when you import a transcript?
●
●

●

MAXQDA creates a new text document with the transcript.
The associated audio or video file is copied into the folder for external files and
assigned to the transcript.
Text documents with the associated media file can be recognized by their special
symbols in the "Document System": a musical note
for audio files and a
video camera
for video files.

MAXQDA converts the timestamps in the transcript to internal MAXQDA timestamps
and removes them from the text for better readability. The chronology of the
timestamps is checked in the text: tmestamps that refer to an earlier time than those
previous to them are removed.
Tip: If you do not assign an audio or video file during import, you can do this later by
right-clicking on the document name and selecting the Link Audio/Video File option.
After importing the transcript and audio or video file, you can immediately see in
MAXQDA’s “Document Browser” that timestamps are displayed in the column left to
the text. Clicking in the area of the timestamps plays the media file at the
corresponding position.
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Timestamp display in MAXQDA

Texts that already contain timestamps when imported can, if necessary, be subdivided
more precisely with further timestamps. For more information, see the Transcription
section.

Supported timestamp formats
MAXQDA automatically recognizes the following timestamp formats in a transcript:
Software

Timestamp format

easytranscript, f4 & f5transcript

#hh:mm:ss-x#

HyperTRANSCRIBE

[hh:mm:ss.xxx]

Inqscribe Transcriva

[hh:mm:ss.xx]

Transana

(h:mm:ss.xx)

Transcribe

[hh:mm:ss]

Rev, HappyScribe

[hh:mm:ss]

Transcriber Pro

hh:mm:ss

General

hh:mm:ss.x
hh:mm:ss.xx
[h:mm:ss]

If you are using a transcription software that works with none of these timestamp
formats, you may be able to customize the timestamps by search and replace digits in
Word or another text processing programto fit one of the formats that can be
imported.
Please note: If you import any text document that contains timestamps in one of the
formats listed above, MAXQDA will automatically detect the timestamps and ask you
for the associated media file.

Focus Group Transcripts
MAXQDA offers a variety of functions for the analysis of focus groups and group
interviews. To use these analytical tools, it is necessary to import transcripts with
multiple speakers using the focus group import function. If you are transcribing a
focus group interview in MAXQDA or if you have already imported a transcript, you
can also convert the text into a focus group transcript later. When importing a focus
group transcript or converting a text into a focus group transcript, all speech
contributions are coded with the respective speaker name, which makes it easy to
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differentiate between individual speakers in the analysis.
To import a focus group transcript to MAXQDA, select Focus Group Transcripts in the
Import tab and choose your transcript format from the drop-down menu. Linking the
focus group transcript to an audio or video file and working with time stamps works
just like importing a regular transcript.

Import focus group transcripts

During import, MAXQDA automatically generates one code in the code system for
each participant in the focus group and automatically codes all of a participant’s
contributions with their code for later analysis and differentiation. To ensure that this
automatic import process runs smoothly, MAXQDA places the following requirements
on the structure of the transcript:
●

●

●

●

●

Each contribution begins in a new paragraph. At the beginning of each contribution
the name of the participant appears, followed by a colon. Using bold type or special
fonts for the names will not affect the import process, however upper and lowercase
will be taken into account. Names like “Lisa B.” or “Gábor” with spaces and special
characters are not a problem when importing. The subsequent text will be coded
with the names of the speakers, up to the point where the next speaker is indicated.
MAXQDA will tolerate a space that is accidentally set before a name or in front of a
colon and treats the associated names to be identical.
The names of the speakers that appear before the colon can be a maximum of 63
characters in length.
Sections of text at the beginning of the transcript (in which no colon occurs within
63 characters) will not be coded. This provides the opportunity for you to include a
title and general information about the focus group for easy recognition.
Timestamps originating from the transcription software F4 or F5 will be treated as
usual: MAXQDA will ask if you wish to associate the corresponding audio/video file
with the transcript. The timestamps will be integrated into the MAXQDA project and
removed from the text.

Let’s take the following interview with multiple speakers as an example:

Moderator: Hello everyone, thank you very much for your participation! This study
examines how the balance of work and leisure time affects the general feeling of
happiness. I have invited you to this interview because you all have a part-time job in
addition to your studies. I would be very interested in hearing how you are doing in
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your studies and in your job. First of all, I would like to ask you why you decided to
work while studying. Maybe we can go around the room; if you have any comments
in the meantime, feel free to chime in.
Olga: Well, I started working because I wanted to gain work experience but by now
it’s mainly because I need money.
Fatima: Yes, I didn’t really have a choice either. I have to work alongside university
because otherwise I can't afford to study. I have to support myself financially.
Andy: It’s the same for me. For financial reasons and also to not be dependent on my
parents.
Pranav: Yes, for me that’s also the case. I need money to pay rent and to make ends
meet. And at the same time, in my industry you need a certain amount of work
experience or let’s say, it’s not bad to have some work experience when you graduate.
Moderator: Was it also that professional experience… did that also play a role? You
mentioned this already, Pranav- what do the others think?
Andi: Yes, work experience- I think... in any case internships always look good on your
CV, especially in the social sciences, in political science, internships are incredibly
important in those fields, if you can manage to land some, of course.

After selecting Import > Focus group Transcripts and choosing a file, an import dialog
opens in MAXQDA. This import dialog shows all identified speakers in your transcript
and allows you to select which of the recognized speakers should be coded and with
which name.
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Import dialog

In the import dialog, you can directly assign a code color to the speakers. Furthermore,
you can combine several different spellings for the same person in one speaker. This
can, e.g., be useful if a name of one participant in the transcript contains typing errors.
In the column “Target”, select the correct name of a speaker if you identify a
misspelled name in the “Speaker” column.
Tip: When importing the transcript you should check the names of the speakers for
typographical errors. This will avoid frustration later, in the case that the same person
appears twice under different names because the name was written or spelled
differently. Since the speaker code cannot be deleted, you would have to make the
appropriate modifications in a word processing program and then import the
transcript again.
Following a successful import, MAXQDA opens the transcript immediately in the
“Document Browser”, and from the coding stripes in the margin you can see that the
speech contributions have already been coded. During the import MAXQDA creates a
new document in the “Document System” with the filename of the transcript. This
document has its own symbol, which allows you to immediately recognize that it
relates to a focus group. Below the document, the speakers of are listed individually,
with the number at the end of the line indicating the number of contributions. The
speakers are attached to their transcripts. If you move the document, the speakers will
move with it. Only the order of speakers can be adjusted with the mouse. Like other
documents, focus groups documents can be assigned to a document group or set.
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MAXQDA view after importing a focus group transcript

In the “Code System” you will see a very similar listing: At the bottom, a code with the
name of the imported data will appear, with the speakers listed as subcodes, and the
same
symbol as in the “Document System”. Speaker codes and the speakers in the
document are connected: If you change the order of the speakers or their names in
the “Code System”, their order will also change in the “Document System”, and vice
versa. This also applies when a focus group transcript is deleted: if you remove a
transcript from the “Document System”, the corresponding code and its subcodes will
be deleted from the “Code System”.
Tip: Tip: You can choose to place focus group speaker codes at the top of your code
system, in the “Code System” window settings. To open the settings, click on the gear
wheel in the “Code System” toolbar.
The fact that the speakers are available both in the "Document System" and in the
“Code System” opens up extensive possibilities for the analysis, as the speakers can be
activated as independent codes and as document subsets. More information:
Analyzing Focus Group Data.
When you import multiple transcripts, a unique code will be assigned to each focus
group along with subcodes for the respective speakers. The speaker codes are firmly
attached to their top-level code, and their order can be modified only under this toplevel code.
Tip: The automatic coding function for speakers may be useful for other types of
documents in which multiple individuals interact, for example forum discussions or
comments on YouTube videos.
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Converting an already existing text into a focus group transcript

Convert text to focus group transcript

Sometimes you realize that it would have been better to import a text as a focus group
transcript into MAXQDA after you have already imported and coded it as a normal text
document. Or you have transcribed an interview with several participants in MAXQDA
and would like to code all of the speakers and their contributions automatically. In
both cases you can use the function Convert Text to Focus Group Transcript, which is
available in the Import tab. You can either convert the currently displayed document in
the “Document Browser” or you can activate (several) documents you want to convert
and choose Convert Activated Document(s). The same dialog as for importing focus
group documents appears and MAXQDA will insert a copy of the text as a focus group
document:
●

●

●
●

The speakers contributions will be coded automatically and corresponding codes for
each speaker will be created in the “Code System” window.
MAXQDA will copy all existing coding information and memos into the newly
created document, also the variable values and the summaries.
A linked media file will be linked to the new document, too.
The links in or on the document will not be transferred.

Survey Data from Excel
Importing survey data and other structured data from Excel spreadsheets
With MAXQDA you can import structured documents from an Excel spreadsheet in
XLS/S format, during which individual table cells will be automatically coded. In
addition, variable values can be assigned automatically to the individual texts (the
cases). This is particularly useful when importing (online) surveys with standardized and
open answers.

How should the Excel table be structured?
When imported into MAXQDA, each row of the table becomes a new document,
wherein the contents of the cells form the document content and are coded with the
respective column header. The structure of the Excel table corresponds to the principle
of a data matrix of a standardized survey. This logic is illustrated in the table below:
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ID
Document
Positive Feedback
[Document
Group
[Open Question 1]
Name]
Group A

Person 1

Group A

Person 2

Group B

Person 3

Group B

Person 4

Great conference!

Negative
Age
Feedback
Pre-knowledge
[Variable
[Open
[Variable 2]
1]
Question 2]
The catering
22
high
was a bit tight

Best keynote I have
25
heard in a long time
I especially enjoyed
the pre-conference none
21
workshop
Please make
Great job - keep
workshops
31
going!
longer in the
future

medium
medium

low

Each row of the table contains a case, and the columns "Open Question 1" and
"Open Question 2" contain the respondent’s responses to the respective questions.
The "Variable" columns contains standardized information for each case in the form
of variables. Of particular importance are the first two columns "Document Group"
and "ID", which assign the individual rows of the table to documents in MAXQDA’s
“Document System”.
Please note:
1. It is not necessary to have a column for the “Document Group” as MAXQDA can
also create a new document group, into which all documents are imported, during the
import process. However, at least one column is required, which contains the
document's names.
2. MAXQDA supports one sublevel for document groups. These can be created and
addressed during import using the backslash, e.g. "Survey\New York".
3. The column headings should be short and concise, as this is much more practical for
further work and MAXQDA only imports the first 63 characters of the headings. Only
if the column headings differ in the first 63 characters, MAXQDA will be able to
handle the columns as different.

Starting the import process
To import survey data from an Excel file, go to the Import tab and select the Survey
data > Import data from Excel spreadsheet function. On the Import tab, you’ll also find
the Documents from Excel Spreadsheet function. In principle both calls lead to the
same result.
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Import survey data from Excel files

Selecting import settings
After calling up the function, the desired Excel file must be selected from the file
dialog box. This opens a window where you can enter the settings for the import.

Settings for importing documents from an Excel spreadsheet

The two top settings determine which columns contain the Document Group and the
Document Name. If the names "Document Group" and "Document Name" are used
in your table as column headings, MAXQDA will automatically pre-select them, but
this choice can be changed at any time.
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If you select [Create new document group] from the "Document Group" drop-down
menu, MAXQDA will automatically import all documents into a new document group.
MAXQDA automatically selects this option, if your table doesn’t contain a column with
the heading “Document Group”.
Tip: When importing survey data, it is recommended that you select the ID’s of the
respondents as a column for the document names. In this way, you can avoid any
ambiguity in the association of responses to cases, even during the subsequent export
of data into statistical software.
In the middle section, you can select the columns to be imported as coded text or as
variables.
If both “Code” and “Variable” are selected, MAXQDA will import the contents of this
column as both as coded text and as a variable. This may be useful, for example, you
do not wish to view the variable information of a document each time as a tooltip over
a document name or in the Data Editor for document variables, but rather view, for
example, how old a respondent is and whether he has children, directly in the text.
Please note: When the dialog box opens, MAXQDA will have marked all the columns
in the Excel table which vary a lot as coded text, since these are most likely to be
responses to open questions.
If neither “Code” nor “Variable” are selected, MAXQDA will ignore the column during
the import process.
In the lower section, further options are available:
Code empty cells: When this option is selected, MAXQDA will import and code cells
without content as empty paragraphs; these cells would otherwise not be coded.
You can also decide how MAXQDA should handle documents that were already
included in the project before the import. MAXQDA considers that a document
already exists in the project if the document name and document group are identical.
Import: When this option is selected, existing documents will be included in the
import, and therefore may appear twice in the respective document group.
Ignore for import: Select this option if documents that already exist in the project
should not be taken into account during the import.
Add text to existing documents: It is also possible to add text to existing documents.
For example, data from different points in time in a longitudinal study can be added to
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the original document. Existing variable entries in existing documents will be updated.
Empty variable values in the Excel table are ignored when importing.
Please note: For documents whose name appears repeatedly in a document group, the
text will be added to the first document of the same name.

Selecting settings for importing the variables
If you choose to import variables, a second window will open after you click OK.
Source: By selecting this option, you can again decide which variables will be
imported.
Target: If there is already a document variable with the same name in the project,
MAXQDA assigns the variable to it automatically and no other choice is available. If
there is no variable with the same name in the project, you can specify the type of
variable. Options include Boolean (true/false), date/time, decimal, integer, and text.
Preview data type: This column displays a preview of how an entry will appear in the
appropriate column in the data editor.
A final report window confirms the import of documents from the table and lists how
many texts, codes, and variables were imported, as well as how many documents may
have been ignored during the import.

Imported texts in MAXQDA
After importing the table from the example into an empty MAXQDA project, it will
appear as follows:

Imported texts in MAXQDA

When importing, MAXQDA proceeds as follows:
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●
●

●

Document groups that do not yet exist will be created.
The headings of the code columns will run from left to right and will be inserted
from top to bottom in the code system as new code names, as long as they do not
yet exist. All text segments from the code columns will be coded with the respective
column headings. The complete heading of each column is recorded in the code
memo.
If a variable does not yet exist, it will be created. Each document will be assigned the
variable value from the variable column.

In the section "Categorize Survey Data" you will find information on how to analyze
the imported survey data in MAXQDA.

Survey Data from SurveyMonkey
Which import options does MAXQDA offer for SurveyMonkey data?
With MAXQDA you can import survey data directly from SurveyMonkey into an open
MAXQDA project in order to analyze the data with all MAXQDA tools. The use of
another software such as Excel for export and import is no longer required. While
importing the data every case of the online survey becomes a MAXQDA document.
You can code the answers of the open-ended questions automatically with the
question text. Additionally, you can transform the standardized information into
document variables.
Please note: In order to use this MAXQDA tool access to your own SurveyMonkey
account is required. Not all SurveyMonkey plans allow access to the data by third-party
applications like MAXQDA. Please check the website of SurveyMonkey, if your plan
allows to export data (at present at least an EXTRA plan is necessary).
Starting the import process
To start the data import, proceed as described below:
1. Select Import > Survey Data > Import Data from Survey Monkey in the main menu.
2. You will be redirected to the login page from SurveyMonkey in your Internet
browser. Fill in your login data and click Login.
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Login page for SurveyMonkey in the Internet browser

Please note: If it is the first time you connect with SurveyMonkey a window might
appear asking for free access through your firewall. Please confirm that MAXQDA is
allowed to contact the Internet. Otherwise, the import is not possible.
Importing data
3. After a successful authorization of SurveyMonkey MAXQDA loads an overview of
your surveys and displays the dialog below. In this window you can select the survey
you want to import
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This dialog window allows you to select a survey you want to import

4. Via the selection at the bottom, you can choose whether you want to import every
case or a random sample of the cases. After doing that click Continue.
5. A new dialog window appears. Here you can choose on the top which question
shall be applied as document name. In order to guarantee a unified definition of
the documents the case-ID is selected by default. In general, it is advised to keep
this selection.
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Tweaking the settings for the import

In the center of the window, you can choose the columns to import as coded text or
as a variable. If you tick both marks MAXQDA imports the content of this column as
both, a coded text and a variable. This can be useful if you want to read the
information of the variable directly in the text (e.g. how old a person is or whether she
has kids). By doing that you can avoid receiving this information only via the tooltip or
the data editor of the document variables.
If you don’t place a tick mark on a column MAXQDA ignores this column for the
import.
The selection at the bottom allows you to set the option Code empty answers. If you
mark this option, MAXQDA imports and codes cells without content as empty
paragraphs. Otherwise, empty cells would not be coded.
After clicking OK the data will be imported:
●
●
●

A new document group labelled with the name of the survey will be created.
Every imported case in this document group will be imported into an own document.
For each question that had been ticked in the column to import as a “code” a new
code will be created in the “Code System” window
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●

The imported documents contain answers to those questions that are selected
automatically in the column “Code”. The answers are coded automatically with the
particular question code. This gives you the opportunity to get an overview of every
answer of a question just by using the Coding Query functions in MAXQDA.

Data from SurveyMonkey after the MAXQDA import

Information about the single question survey types
The question types from SurveyMonkey are imported into the MAXQDA project as
described in the following table. You can determine whether an answer will be
imported as an automatically coded answer to an open-ended question or/and as a
document variable in the dialog that is shown before starting the import (see above).
Question type
Multiple Choice
Dropdown
Star Rating
Matrix/
Rating Scale
Matrix of Dropdown Menus
Ranking
Net Promoter® Score
Slider
Single Textbox
Multiple Textboxes
Comment Box
Contact information
Date/time

Standard import in MAXQDA
1 variable
‘Other’ answer: automatically coded text
1 variable
‘Other’ answer: automatically coded text
1 variable
1 variable per item
‘Other’ answer: automatically coded text
1 variable per answer cell
‘Other’ answer: automatically coded text
1 variable per rank
1 variable
1 variable
Automatically coded text
Automatically coded text per textbox
Automatically coded text
1 variable per box
1 variable
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Twitter Data
MAXQDA’s Twitter analysis features
MAXQDA allows you to import data directly from Twitter into an open project and to
analyze it using MAXQDA’s usual functions as well as the specific analysis tool.
With a complex search, you can search for tweets on Twitter according to specific
hashtags, usernames or terms, and then import them into a MAXQDA project. The
function’s special feature is that it can code your Twitter data automatically with up to
100 author names and up to 100 hashtags during import (and, if necessary, later). This
automatic preparation can save a lot of time, which you can then use for your actual
analysis.
Researchers who analyze social media data can use MAXQDA to answer the following
questions, among others:
●

●
●

●

What did a user, user group or company post at a certain time? What were other
users reaction to its content?
Which are the most common words used in the tweets?
How many followers do the people tweeting about particular topics have and what
is the reach of individual tweets?
On which weekdays and at what times were tweets on certain topics written?

Please note: To use this function, you need your own Twitter account.

Import Twitter data
To import twitter data, go to Import > Twitter Data.

Importing Twitter data

The following dialog window will appear:
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Dialog window for importing data from Twitter

Twitter login
In order for MAXQDA to import data directly from Twitter, you must first link your
Twitter account to MAXQDA. To do so, click Connect to Twitter at the top of the
dialog window:
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Connect to Twitter

A new browser window will open where you can enter the login data of your Twitter
account. Then, click Authorize App to allow MAXQDA to receive Twitter data from
your account.

Authorize MAXQDA for Twitter

After registration, you can close the browser window and return to MAXQDA to start
importing data.
Please note: MAXQDA uses the connection to Twitter only for importing tweets. When
you close MAXQDA, the connection will be canceled, meaning you must reconnect to
Twitter each time you restart MAXQDA.

Searching for Twitter data
The original dialog window that you opened in MAXQDA will remain open, indicating
whose account is connected to MAXQDA. You can now check the box below the
login button, which was previously greyed out. Only once you have agreed to the
terms of using Twitter data neither for advertising purposes nor for personal
identification can you start your search on Twitter. Once you agree to the terms, the
search fields will become available.
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Search window for importing Twitter data

The complex search follows the same principle as the advanced search on Twitter.com.
In the top fields, you can enter words or strings that must appear or not appear in the
tweets. In the middle and lower sections, you can set define specific conditions for the
search and the accounts to be searched:
From these accounts – searches for tweets from specific users. Multiple usernames can
be entered, separated by commas.
To these Accounts – searches for tweets in which the entered username appears at the
beginning of the tweet. Multiple usernames can be entered, separated by commas.
Mentioning these Accounts – searches for tweets in which the entered user name
appears somewhere in the tweet. Multiple usernames can be entered, separated by
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commas.
Further parameters can be set in the lower section:
Language: Limits the search to the selected language (the assignment of tweets to a
language is done by Twitter itself and is not verified by MAXQDA). If you wish for
tweets in all languages to be taken into account, allow the default parameter “Any
language” to remain.
From/to: The default search period is set at seven days because this is the maximum
period allowed by Twitter’s search function. You can reduce the search period, for
example to one day, by adjusting the dates accordingly.
Include retweets: By default, this option is not selected. If you wish to include retweets
in your analysis, simply place a checkmark in the appropriate checkbox at the bottom
of the dialog window. (The inclusion and exclusion of retweets are managed by
Twitter.)
Limit import to most recent tweets: If you wish to limit import to most recent tweets,
this option allows you to set the specific number of tweets to be imported from 1 to
10,000 tweets.
Please note: All search criteria are linked with the search operator AND. This means
that only tweets that meet all of the conditions entered will be retrieved.
After clicking the Run Search button, a preview window with the first 100 search
results will appear. The number of tweets found is displayed on the lower left. When
more than 100 search hits are found, the display is updated approximately every 10
seconds.

Preview of search results
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When you click Import Data, MAXQDA will begin importing the tweets.
Please note: Each import process is limited to 10,000 tweets.
Immediately after import, a dialog window will appear with the functions for
autocoding tweets.

Twitter data in MAXQDA
During the import process MAXQDA creates a new document group in the
“Document System“, in which a table document is generated for every 1,000 tweets.

Table document with Twitter data in the “Document System“

To ensure transparency of the research process, the name of the document group
contains the import date. A memo will also be created for the document group in
which the search query is stored:

Memo of a Twitter import with the exact search query
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When you double-click on the document in the “Document System“, the Twitter data
will be displayed in the “Document Browser“:

Table document with Twitter data in the “Document Browser“

Each imported Twitter document contains several columns, each named in the top
line:
Date/Time

The time when the tweet was sent

Tweet

Text of the tweets

Hashtags

All hashtags that occur in the tweet

Type

Marks whether a tweet is a retweet or a reply

Reply

Lists the Twitter name to which tweet was replied

Author und real name

Twitter name and real name of the author

Author location

Location entered by the Twitter user himself - not
necessarily the location from which the tweet was sent
(may be empty)

Author timezone

Time zone according to user (may be empty)

Author URL

Author's website (may be empty)

Author description

Self-description of the author

Followers

Number of followers of the author (the higher the range of
a tweet)

Follows

Number of people who follow the author

Tweets

Number of tweets
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Profile verified by Twitter

Specifies whether the author's profile has been verified by
Twitter

Profile created

Specifies how long the author has been registered on
Twitter with their profile

Retweets

Number of times the tweet has been retweeted

Likes

Number of likes for the tweet

Language

Language in which the tweet was written (automatically
recognized by Twitter)

Device

Device or software from which the tweet was sent

Tweet-Coordinates

Geoposition from which the tweet was sent (often empty)

YouTube Data
What YouTube data analysis options does MAXQDA offer?
YouTube videos are often commented on by viewers, and sometimes their comments
sections even turn into forums for extensive debates, for instance in the case of videos
on political topics. These comments can be very interesting to researchers working in
diverse disciplines in the social sciences, as well as in market or opinion research.
MAXQDA allows you to import comments posted on a YouTube video into an open
MAXQDA project and have them coded automatically. Additionally, you can import
any transcripts or subtitles provided with the videos, which means you don't have to
transcribe them manually.
You can analyze the imported data using MAXQDA's wide range of tools, including
thematic coding, word frequency analysis, and visualization tools. These tools allow
you to answer questions including, but not limited to, the following:
●
●
●
●
●
●

What is the content of the comments posted on the selected videos?
Which words are used most frequently in these comments?
How have viewers rated the selected video?
Which comments are replied to most frequently and which not at all?
How do users communicate with each other?
What is said in a video or in certain scenes?

Importing YouTube data
To import YouTube data into your MAXQDA project, first open the YouTube video in
your browser (e.g., in Chrome, Firefox, or Safari) and copy the complete link from the
URL bar to the clipboard.
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Copy the complete YoutTube link

Go to Import > YouTube Data in MAXQDA.

Start import from YouTube

You will then see the following dialog box. If you have saved a link for a YouTube
video to the clipboard, MAXQDA automatically enters it in the first field and retrieves
the corresponding video information. If you already have the dialog box open, you can
paste a link from the clipboard into the field at any time and then click the button
Retrieve video information.
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Dialog box for importing YoutTube data

In the upper area of the dialog box, MAXQDA will display how many comments and
how many transcripts or subtitles assigned to the video are available to download.
Please note: YouTube does not allow you to download transcripts/subtitles for all
videos, even if subtitles are displayed on the YouTube page of the video.
In the lower area of the dialog box, select whether you want to import the comments
and transcript or just one of the two. The following options are available for importing
comments:
Import only top-level comments – If you choose this option, the replies to comments
are ignored.
Autocode comments – If you select this option, each comment is automatically coded
with a code. The code indicates how many replies were made to the comment. You
should leave this option activated to give you easy access to the texts of comments
later.
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To import the transcripts, you can select or deselect all the available languages listed in
the dialog box. The following options are also available:
Include times in transcript – If you select this option, the corresponding times in the
video times are added at the beginning of each line of the transcript. This is useful if
you don't need to match the video to the transcript (in that case the times are
displayed as MAXQDA timestamps at the beginning of each line).
Link existing video file to transcript – If you have downloaded the YouTube video, you
can link it directly to the transcript. To do this, simply tick this option and select the
video file by clicking on the three dots.
Please note: You can link video files to their transcript at any time later: MAXQDA
saves the corresponding times during import and displays them later as timestamps. To
do so, right-click on the text document of a transcript in the “Document System” and
select Link Audio/Video File.

Imported comments in MAXQDA
The following image displays an example of the view in MAXQDA after you have
imported YouTube comments:

Imported YouTube comments in MAXQDA

What happens when you import comments from YouTube?
●

Comments are compiled in table documents, 1,000 comments at a time, in the
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●

●

●

●

"Document System". These table documents are labeled with a YouTube icon.
These table documents are stored in a document group whose name contains the
video title and the import time. The corresponding document group memo contains
more information about the video, such as the publication date and the number of
likes.
A new code named "Autocode <Video Name and Import Time>" is added to the
"Code System".
This code contains the subcode "Comment at top level with...", where as many
subcodes are added to the code as there are different frequencies of replies to a
comment. All comments are coded with the code according to their number of
replies.
The second subcode is the code "Reply to comment". All replies are coded with this
code.

To later display all the comments at the top level in the "Code System" to aid your
analysis, you can do the following:
1. Activate all the documents containing the comments of one (or more) videos.
2. Activate the code "Comment at top level with..." including all subcodes.
The table document with the imported YouTube comments contains the following
columns:
●

●
●
●
●

●

●
●
●

Nr. – Consecutive numbering, where the answers to a comment are numbered
starting at 1 for easy identification:
0001 = oldest comment
0001-01 = first reply to oldest comment
0002 = second-oldest comment
0002-35 = 35th reply to second-oldest comment
Comment – The comment text
Author – Name of the comment author
Author URL – Link to the author's profile
Top level – Indicates whether the comment is a top level comment (i.e. not a reply).
The cell will either contain the word "yes" or <empty>.
Replies – Number of responses to a top-level comment. Always 0, if it is not a toplevel comment, that is, a reply.
Likes – Number of likes given to the comment
Published – Date the comment was posted
Updated – Date the comment was updated, if applicable

Please note: The YouTube comments import function is limited to the 10,000 most
recent comments per video.
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Imported YouTube transcripts
Here you can see a YouTube transcript once it has been imported into MAXQDA:

Imported YouTube transcript in MAXQDA

The transcript text is displayed in the "Document Browser". In the example, a video
file has been assigned to it such that timestamps can be seen in the column next to
the paragraphs. Clicking on a timestamp plays the video at the corresponding position.

Subtitle Data (SRT)
Videos often come accompanied by text files that contain the spoken words of a video
combined with the corresponding playback times such that the texts can be displayed
as subtitles to the video. Very often the SRT format is used for these text files, which
can be generated for YouTube videos, for example, using various software tools.
You can import these text files in SRT format into MAXQDA. Start the import as usual
via Import > Texts, PDFs, Tables or right-click on a folder in the "Document System"
and select Import Document(s). Then select an SRT file in the file dialog box.
MAXQDA imports the file and asks you for the corresponding video file.
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Imported SRT data in MAXQDA's “Document Browser“

The timestamps in the SRT file are converted into MAXQDA timestamps. Clicking on a
timestamp plays the video file at the corresponding playback position.
If you have downloaded an SRT file assigned to a YouTube video, this file may have
been created automatically. YouTube identifies parts in these files that were not easily
recognized by the automatic system in a light gray and gray font. This coloring is
adopted by MAXQDA during the import. Please note that such automatically
generated transcripts have no punctuation either, that is, the text does not contain
commas, full stops, or other punctuation.

Web Pages
With the MAXQDA Web Collector, you can save web pages, parts of web pages, or
PDF files in your browser and then import them into MAXQDA in different formats as
a PDF, image, or text. Additionally, you can directly import web pages in HTML format
as MAXQDA text documents.

Saving web pages with the MAXQDA Web Collector
The MAXQDA Web Collector is an extension for the Internet browser "Google
Chrome". It allows you to save entire web pages and import the files as PDF, image, or
text documents into MAXQDA. Among others, this tool is useful to compare websites
from various organizations, or to collect content from web pages for analysis with
MAXQDA.

Installing the MAXQDA Web Collector
In order to work with the MAXQDA Web Collector, the installation of the Internet
browser "Google Chrome" is required. As soon as "Chrome" is installed on your
computer you can start the installation of the "MAXQDA Web Collector":
1. Open "Google Chrome".
2. Search the Chrome Web Store for "MAXQDA" or use the following link:
https://chrome.google.com/webstore/detail/web-collector-formaxqda/jhnochbooihpgjbgcjlpihaefoehlakd
3. In order to add the extension to your browser click „+ Add“.
4. Click the “puzzle piece” icon in Google Chrome and click the pin icon to display
the installed Web Collector in the address bar.
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Pin Web Collector extension symbol to Google Chrome’s address bar

After a successful installation you can see a tiny MAXQDA icon on the top-right in
your browser window:

MAXQDA icon to open the MAXQDA Web Collector in „Google Chrome“

If you want to use the Web Collector, just click on the MAXQDA icon:

MAXQDA Web Collector

The Web Collector offers four modes:
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●
●

●
●

Entire web page: the layout is preserved in the best possible way.
Simplified web page: the web page will be reduced to key text and images as in
using a read mode.
Selections on web pages: only the selected part of the web page is collected.
PDF documents: all PDF files currently open in Chrome are collected.

Collecting entire web pages
If your research is based on the analysis of every visible item of the web page it is
recommended to save the entire web page in order to import it to your MAXQDA
project as true to the original as possible:
1. Open the web page you want to save in Google Chrome.
2. When the web page is fully loaded, open the Web Collector by clicking the tiny
MAXQDA icon.
3. Make sure the tab "Web Page" is open.
4. If required, change the proposed document name. This name will later be inherited
into the MAXQDA project.
5. If required, enter a text memo in the “Document Memo” box. This text will later be
connected to the imported document as a document memo.
6. Click Collect.
The MAXQDA Web Collector saves the web page in the default download folder of
your browser. The web page is saved in MWEB format, which was especially
developed for further processing in MAXQDA.
A web page saved this way can be imported into MAXQDA as a PDF or image
document.

Collecting simplified web pages
In case your analysis focuses on the text of a web page you can save it as a
"simplified" web page. The web page will be reduced to main text and images, which
can be compared to the read mode of your smartphone. This is particularly useful for
big newspapers and magazines. In order to import a “simplified” web page, proceed
as described below:
1. Open the web page you want to save in Google Chrome.
2. When the web page is fully loaded open the Web Collector by clicking the tiny
MAXQDA icon.
3. Click on the "Simplified Web Page" tab. The web page will then be reduced to its
main parts.
4. If required, adjust further options such as font type, font size, and exclusion of
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images.
5. If required, change the proposed document name. This name will later be inherited
into the MAXQDA project.
6. If required, enter a text memo in the “Document Memo” box. This text will later be
connected to the imported document as a document memo.
7. Click Collect.
The MAXQDA Web Collector saves the web page in the default download folder of
your browser. The web page is saved in MWEB format, which was especially
developed for a further processing in MAXQDA.
Please note: Some web pages cannot be simplified for technical reasons. In this case, a
message appears in the Web Collector window.

Collecting parts of a web page
In case you are only interested in a certain part of a web page you can download only
the current selection:
1. Select the segment you are interested in with your mouse.
2. Right-click the highlighted segment and choose Collect Selection for MAXQDA.
The MAXQDA Web Collector saves the selected content in the default download
folder of your browser. The selection is saved in MWEB format which was especially
developed for a further processing in MAXQDA.
Segments that have been saved this way can be imported into MAXQDA as a text or
PDF document.

Collecting PDF documents
To import PDF documents currently opened in Chrome follow these steps:
1. Open the Web Collector by clicking on the MAXQDA icon.
2. If required, change the proposed document name. This name will later be inherited
into the MAXQDA project.
3. If required, enter a text memo in the “Document Memo” box. This text will later be
connected to the imported document as a document memo.
4. Click Collect.

Importing collected web pages into MAXQDA
You can import a collected web page into your MAXQDA project by following these
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steps:
1. Open the MAXQDA project into which you want to import the saved web pages.
2. Mark a document group in the "Document System" window by clicking on it in
order to import the web page in a selected document group (if no document group
is marked, MAXQDA will import the web pages into a new group).
3. Select Import > Web Collector Data in the main menu.

Import Web Collector data from the Import tab

The following dialog window will appear:

Dialog window for the import of documents that have been saved with the Web Collector

1. If you open the dialog for the first time MAXQDA selects the standard folder for
downloads and displays it at the top of the box. Every collected web page located
in this folder will be listed in the dialog. By clicking the three dots … you can
choose any other folder to import collected web pages from the MAXQDA Web
Collector.
2. Select every web page you want to import with the mouse. Selected pages will be
highlighted green. By default, all listed web pages are selected).
Tip: Double click a row to open the downloaded file in the Internet browser. This
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allows you to check individual web pages for their content.
3. Import options are provided at the bottom of the dialog:
you can select whether web pages should be imported as PDF or image
documents
you can select whether simplified web pages or selections should be imported as
PDF or text documents.
The option Import new data only can be used to import only data that does not
yet exist in the open MAXQDA project. If checked, MAXQDA compares the
collect date, the document name, and the document type (text, PDF, image).
❍

❍

❍

In order to start the import, click Import selected files. The time for import can vary
depending on the scope and format of the selected document. A progress bar informs
you about the import progress of each document.
In case you selected PDF or image format and you want to import large files,
MAXQDA asks you whether you want to import them as externally saved files instead
of saving them in the project (see External Files for more details).
Please note: The main layout will be adopted in the import process. Deviations from
the web page’s original layout might occur, especially as far as complex web pages are
concerned.

Direct import of web pages in HTML format
1. You can also import an HTML file directly into MAXQDA. To do this, select Import >
Texts, PDFs, Tables from the main menu. In the dialog box that appears, select the
HTML file. Alternatively, you can drag and drop a HTML file into the "Document
System" window with the mouse.
2. MAXQDA imports the file as a text document and includes images if they were
embedded in the HTML file.
Please note: If you use the direct import of web pages in HTML format they are
imported as text documents (and not as web pages). The layout can change a lot
during the import, which is why using the Web Collector for this task is clearly
preferable. Direct HTML import is particularly suitable for simply structured and
designed data.

Bibliographic Data (Endnote, Zotero etc.)
How Does MAXQDA Support Working with Bibliographical Data?
MAXQDA offers you the option to import bibliographic data from reference
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management programs such as Endnote, Mendeley, Citavi, and Zotero in order to
conduct literature reviews or to review the state of research in literature. Such
programs are mainly used in the scientific field for literature work, which means that
they primarily serve the administration of literature references and the creation of
literature lists and support the creation of scientific texts. Similar to MAXQDA, the
literature management programs work with projects, which are containers containing
all collected bibliographic information. The units of the projects consist of literature
references (author, title, etc.), for which digital versions of the full texts in PDF format
are often stored as attachments.
MAXQDA is compatible with all literature management programs that are able to
export their literature databases in RIS format, which is a standard format for
bibliographic information. With the following programs it is possible to import the
assigned full texts into MAXQDA in addition to the literature references:
●
●
●
●

Endnote
Mendeley
Zotero
Citavi

When imported into MAXQDA, each literature entry becomes its own text document.
If full texts are imported, MAXQDA automatically connects the full text to the
literature entry with an internal link. The individual information in the literature entries
is automatically coded for later analysis so that, for example, all titles or abstracts can
be compiled and searched. The attachments can be automatically coded during the
import with the keywords assigned to them, and the notes for a literature entry can be
saved as a document memo with the corresponding attachment.
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Literature import in MAXQDA

Remarks on the RIS format
RIS is the short form for "Research Information System Format". RIS files are simple
text files in which all exported literature entries are listed one after the other. RIS files
contain so called " tags ", which consist of two letters and are followed by the
corresponding information. Important tags include for example:
TY – Type of reference, always marks the beginning of a new entry
ID – Unique identification number for each entry
AU – Author
TI – Title
PY – Publication date
ER – Closes entry, always located at end of entry
A detailed description of all RIS format tags can be found on Wikipedia under
http://en.wikipedia.org/wiki/RIS_(file_format). An example of RIS source data is listed
below:
TY - BOOK
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AU - McLuhan, Marshall
AU - Fiore, Quentin
TI - The medium is the message
PY - 1967
CY - New York
PB - Bantam Books
ER -

Exporting literature data from Citavi, Endnote, Mendeley, or Zotero
Before importing literature data into MAXQDA, you must export the desired data from
your literature management program in RIS format.

Export from Citavi
1. Select the literature entries you want to export.
2. Select File > Export > Export... from the main menu.
3. Choose RIS as the export filter. If this option is not displayed, click on Add export
filter.

Export options Citavi

4. Click Next
5. Click Search..., enter a name and select a directory
6. Click Next and again click Next

Export from Endnote

02 - Importing Data

157

Export options Endnote

1.
2.
3.
4.

Select the literature entries you want to export.
Select File > Export... from the main menu.
Enter a file name and select a directory.
Set the file type to "Text Only" and the output style to "RefMan (RIS) Export" as
shown in the following picture. If this output style is not available, open the
selection list and select "Select Another Style..." at the top, where you can search
for the output style.
5. Click Save

Export from Mendeley
1.
2.
3.
4.
5.

Select the literature entries you want to export.
Select File > Export... from the main menu.
Enter a file name and select a directory.
Set the file type to "RIS - Research Information Systems (*.ris)".
Click Save

Export from Zotero
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Export options Zotero

1. Right-click on a collection and choose Export Collection... Alternatively, choose File
> Export Library... from the main menu to export the entire library.
2. In the appearing dialog select "RIS" as the format.
3. If you want to export the notes and the associated files (especially the full texts),
make sure to check the corresponding boxes for Export Notes and Export Files.
4. After clicking OK, assign a file name and select a directory.
5. Click Save

Starting the Import in MAXQDA
After you have exported the desired data, select Import > Reference Manager Data >
Import from Citavi/Endnote/Mendeley/Zotero in MAXQDA. The following dialog
appears:
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Import literature from Endnote

Click Select File... to select the exported file in RIS format. This file has either the
extension RIS (Citavi/Mendeley / Zotero) or TXT (Endnote).
MAXQDA analyzes the file and shows you various options for importing it. First you
can choose if you want to import the references as well as the attachments (full texts)
or only one of them.
Tip: MAXQDA checks by author, year, title, and publication type which bibliographical
references and which attachments already exist in the project file and indicates in
brackets how much new data is added by the import. MAXQDA only imports new
entries so that no duplicates are created.
For the import of attachments, the following options are available:
Only PDF files - Select this option to ignore all other file formats such as Word
documents when importing appendices.
Autocode keywords - By setting this option, a small area with all keywords contained
in the literature reference is coded at the beginning of each attachment. This makes it
easy to select full texts based on the keywords assigned to them. Please note that the
keywords contained in a literature reference do not necessarily have to match the
keywords actually assigned in the text by the authors.
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Add notes as document memos - If this option is enabled, all notes for a literature
reference are added as document memos in the "Document System". The tag N1 of
the RIS format is evaluated for the notes.
Store attachments in folder for external files - If this option is disabled, all PDF and
image files will be copied to the MAXQDA project file. This is usually recommended if
there are only a few or small attachments. If this option is enabled, PDF and image
files will be saved in the External Files folder, so the project file itself will remain very
small. Here you can find more information about externally stored files.
If you want to import attachments from Endnote, you have to click on Select file... at
the bottom of the dialog to tell MAXQDA where the Endnote library from which you
exported the data is located in your file system. This is necessary for MAXQDA to
know where the attachments are located. The Endnote library has the file extension
ENL.
By clicking OK the import process is started.

Import bibliographic data from other programs
If you neither use Citavi, Endnote, Mendeley nor Zotero, you can still import a RIS file
with bibliographic information. Export all desired references from your program in RIS
format.
Tip: You can also export search results in RIS format from an online journal or
catalogue, for example to analyse how the thematic focus of a journal's titles has
changed over the years.
Switch to the tab Import in MAXQDA and select the entry Reference Manager Data >
Import Bibliographic Data from RIS File. A short explanation window will appear and
then a selection dialog which lists only files with the endings RIS or TXT. Select the
exported file and confirm your selection with OK.
Please note: When using this import option, no attachments (full texts) are imported.

What happens during the import?
●
●

●

A document group "REFERENCES" is created in the "Document System".
All literature entries are added to the newly created document group as individual
text documents. The entries are sorted alphabetically and marked with their own
symbols.
The document name consists of the surnames and first names of the authors as well
as the year. In the case of two authors these are linked with "&", in the case of three
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●

●

●

●

or more authors only the first author is mentioned and "et al." is added.
In the "Code System" a code "REFERENCES" with the two subcodes "RIS" and
"KEYWORDS" is generated. The code "RIS" contains all RIS tags used in the import
file as subcodes, e.g. "Type of reference" or "Abstract". The code "KEYWORDS"
contains all keywords assigned in the literature references as subcodes.
When importing, all references are automatically coded by coding each text section
with the corresponding RIS code.
Each keyword in the literature reference is coded with the corresponding keyword in
the code system.
DOI links are inserted into the text as hyperlinks, so that you can access the online
version of a publication directly if required.

If attachments are imported, the following will also happen:
●

●
●

A document group "REFERENCES > ATTACHMENTS" is created in the "Document
System".
All attachments are imported into this document group as separate documents.
The documents retain their file names and are sorted in alphabetical ascending order
of their references. The sorting of the document names is therefore not necessarily
alphabetical and the same document names may occur several times, e.g. if there are
several documents with "Table of Contents".

And if references and attachments are imported:
●

Internal links are additionally created, which link the literature reference with the
corresponding attachments, so that you can jump back and forth between literature
reference and full text with a single click. In the literature reference, the internal link
can be found in the "Link to PDF (L1)" section (the name comes from the RIS format
and also applies if it is a file format other than PDF). In the attachment, the internal
link is placed at the beginning of the document.

Adopting selected information as variables
The following variables are automatically assigned to each newly created document
when importing literature data, including attachments if imported.
●
●
●
●

●

RIS_Type (Type of reference) – Text variable
RIS_Author (First author) – Text variable
RIS_Title (Title) – Text variable
RIS_Reference-ID (Identification number of the entry in the literature database, is
only exported by a few programs, e.g. Endnote) – Integer
RIS_Year (Year of publication) – Integer
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The variables are created as system variables and cannot be changed by the user.

Analyzing literature data in MAXQDA
After the import and the automatic pre-coding, the bibliographic data and the
corresponding full texts are available in MAXQDA like normal documents. This means
that they can be searched, coded, linked and assigned memos and are available for
further analysis. Of course, the Visual Tools and all other functions such as the
graphics and statistics functions can also be used. By importing the variable values, for
example, only documents of a certain type can be selected for analyses, such as
journal articles or anthology articles, or only publications from a certain year.
Some initial ideas for the analysis:
●

●

●

Right-click on a keyword in the code system and select the function Activate
Documents Containing this Code. MAXQDA will then activate all literature entries
and attachments to which this keyword has been assigned.
Activate code "RIS > Abstract". Via the Codes menu tab, start the Smart Coding
Tool and restrict view to activated codes only to code and systematize the abstracts.
Activate the document group "REFERENCES" and activate the code "RIS > Title" to
list all titles in the "Retrieved Segments" window. Click on the Word Cloud icon to
start an analysis of the (most common) words in the title.

If you want to learn more about how to conduct literature reviews with MAXQDA,
check out our PDF guide:
Literature Review Guide
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Exporting bibliographic data in RIS format
Bibliographic data from a MAXQDA project can be exported in RIS format for import
into a reference management program, for example. The export function can be
found in the Reports tab. Click on the Export icon and select the Bibliographic Data as
RIS File entry from the menu.
After you have specified a saving directory, all documents of the project that contain
literature references (indicated with a book symbol) are exported to a RIS file with UTF8 encoding.

Structured Documents (Preprocessor)
What are structured texts?
Often you may wish to import documents that are structured and pre-coded. Examples
for this kind of document include:
●

●

●

Forms: Here you would like to code each section with its respective heading for the
field in the form.
Questionnaires filled in by the respondents in a structured text file: Here you may
wish to code the answers with their respective questions or instructions.
Asynchronous online discussions: that you have retrieved with online tools and
already tagged.

The problem is similar in each case: before the actual analysis has begun certain text
sections have already been allotted to specific form fields or similar. And you would
like to save yourself the effort of manually coding each. To solve this problem,
MAXQDA has the preprocessor that allows you to split a text file into several text
documents during its import and to code labeled text areas with one or more codes.

Import structured data with the preprocessor
The preprocessor lets you enter a large number of documents into a single file and
have them separated out into different documents when imported into MAXQDA. The
syntax rules are as follows:
#TEXT textname this is the content of the 1st text...
#TEXTtextname this is the content of the 2nd text...
#TEXT textname...
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Every document must start with the “#TEXT” and “TEXT” must be written in capital
letters.
The name that you want to give to the document should come immediately after the
“#TEXT” without a space in between. If you do not enter a name, MAXQDA will
automatically assign one when the document is imported. The first imported
document will be called “Document nn,” and the following documents will be named
in sequential order in the “Document System.”
Document names are handled by MAXQDA as follows. You can enter any kind of
string (up to 63 characters) as a document name – spaces are also allowed. If you
enter a document name with more than 63 characters, MAXQDA will truncate it
automatically. Once the document has been imported into MAXQDA, you can change
the name to include up to 64 characters.

Example
In the example project, various interviewees were asked about their level of
satisfaction with various aspects of their life. Their answers were transcribed and
entered into a Word document.
The resulting Word file appears as follows:
#TEXT 1(26,m,kk,led)
I've gained too much weight over the last several years and I don't seem to be doing
anything to get rid of it. I have high cholesterol levels, but I don't attempt to change
my eating habits. I'd like to jolt myself into becoming more physically active, so I can
lose the weight and feel more energetic. I keep saying I'm going to do something
about it, soon.
#TEXT 2(34,w,2k,ver)
Overall I am pretty happy with my mental, social and physical health. I would like to
improve my dedication to working out. I am the type of person who will work out 5
times a week for a month straight and then is slowly turns into less days a week until
it is none. I get distracted by school work, my job or just being tired.
After each #TEXT entry is the name being given to the document. For the purposes of
this project, it made sense to assign a number for each of the interviewees in addition
to some basic information about that person, including age, gender, number of kids,
and marriage status.
The Word file was then saved with the name “HealthSatisfaction” in RTF or DOC/X
format. It could then be imported by going to the Import tab and selecting Structured
Text.
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Tip: MAXQDA automatically creates a new document group in the „Document
System“ during import and inserts all texts into this document group.
All texts will appear in the “Document System” after being successfully imported. The
documents are named as previously specified followed by #TEXT as an identifying
agent. In the above example, the document name consists only of a text number and
the personal data indicated in parentheses.

Documents after being imported with the Preprocessor

Pre-coding text segments during import
The document is then imported, separating out each individual document and
assigning the given name for each in the “Document System” from the original RTF
document.
In this way, it is possible to very quickly import and separate out many different
documents formerly contained in a single file. The Preprocessor is able to do
significantly more than this simple action, however. In many cases, you will already be
able to code aspects of the document, and the Preprocessor can do that automatically
during the import. To do so, you simply need to use additional syntax words.
For each section of the document that is to be coded, you simply need to type
“#CODE” before and “#ENDCODE” after. In the case of a standardized survey or
questionnaire, you could, for example, code each answer with the question number
that it connects to. The answer to the first question, then, could be coded with the
code “Question1” as is shown below.
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#TEXTinterviewee1
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
#TEXTinterviewee 2
#CODEquestion1
answer to question 1
#ENDCODE
#CODEquestion2
answer to question 2
#ENDCODE
…
Important: It is important to remember that “CODE” is written in capital letters.

To avoid typos when entering “CODEquestion1,” it is possible to simply use a place
holder, such as “§1” for the first question, “§2” for the second, etc. You can then
later do an automatic search and replace, finding all instances of “§” and
automatically replacing it with “CODEquestion.” This can save you a lot of time in
addition to helping you avoid typos.
It is also possible to define and code with a subcode in a document prepared for the
Preprocessor. To do so, use the following syntax:
#CODE Codename\Subcodename
You are giving the complete information about the subcode, including its name and
the code it is a subcode of. The code and subcode are separated by a “\” symbol, but
no spaces. As with any codes used in a document imported with the Preprocessor,
MAXQDA will first check whether the code already exists, and if it does not, it will be
created.
Important: As soon as “#CODE” appears in the text, the new code will be used,
automatically ending the coded segment of the previous code.
Text excerpts, as well as full paragraphs, can be pre-coded with the help of the
preprocessor during import, as shown by the following example:
#TEXTtextname
Here is a text. Encoding begins here with #CODECode 1Subcode#. In the next sentence it ends with
#ENDCODE# in the middle
#CODECode 2
Here is another text. The encoding ends here #ENDCODE# in the middle of the text.…
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For a preliminary encoding of keywords from various text excerpts, the following rules
apply:
●

●

When the keywords #CODE or #ENDCODE appear alone in a row, it is not necessary
to insert # at the end. If these keywords appear within a text, or at the end of a line
of text, they must be enclosed with #.
It is not possible to “layer” encodings. When a new #CODE# command comes
before an #ENDCODE# command, the previous code is automatically closed.

Tip: To assign several codes to a text part you can combine the codes with two “&&”
characters, e.g. #CODEFirst code&&Second code&&Third code
Mark participants of a focus group
If you use the tag #SPEAKER inside a text section, MAXQDA will import the text as a
focus group transcript and will code the text after the tag with a speaker code. The
tag #ENDSPEAKER closes the speaker coding. The tag may be inserted within a
sentence, but then a # has to be added after the name of the speaker.
#TEXTFocus group 1
#SPEAKERModerator
A warmly welcome to our session …
#ENDSPEAKER
#SPEAKERParticipant 1
#CODETheme 1
I have the following opinion
#ENDCODE
#ENDSPEAKER
This function is very interesting for exporting data that have been collected online with
the tool http://www.kernwert.com.
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03 - Viewing and Editing Data
View Documents
To view and edit a document, it must be open. MAXQDA will automatically open the
most recently imported document. To open a specific document in MAXQDA, you can:
●
●

double-click on the document in the “Document System”, or
right-click on the document in the “Document System” and choose Open
Document.

The document is then opened in the “Document Browser”, and the icon next to the
name of the document in the “Document System” changes from a sheet of paper to a
sheet of paper with a pencil on it.

You can now begin to work with the document in the “Document Browser”. You can
code document or picture segments, attach memos, link segments, insert external
links, edit text, or add new text.

"Document Browser" setup
The "Document Browser" window has the following setup:
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“Document Browser“ window setup

The window title displays the name of the open project and on the right, there are
some icons for controlling the display, for printing, for exporting, and for searching.
The coding bar is located directly underneath it, with which you can code the
document. Coded segments in the document are visualized in the gray side area with
so-called “coding stripes”. In the memo column, you can attach yellow memos with
notes on the data.
For texts, as shown in the example, there is a column with paragraph numbers
immediately to the left of the text, and each paragraph that is not empty receives a
consecutive number in MAXQDA. You can use these numbers as sources for citations
from the analyzed data.

Opening and viewing two documents windows
In MAXQDA’s “Document Browser” you can only open and edit one document. But
you can still open two documents simultaneously, each in in a separate Document
Browser. This is helpful notably for conducting literature reviews: Open a publication
as a PDF in one window and code it thematically. You can simultaneously open and
code a text document in which you have made your notes on the publication in the
second window.
To open a document in its own “Document Browser”, right-click on the document in
the “Document System” and select the option Open Document in Second Document
Browser. A second browser window will open and display the selected document.
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Open document in second Document Browser

What are the rules for working with the second “Document Browser”? The following
functionalities will make your work easier:

Internal links
●

When you click on an internal link within a document, it will open in a second
document browser, while the original document or section remains displayed. This
allows you to view both linked document sections at the same time. You can find
further information on internal links here.

Coding and coding stripes
●

●

If the same document is displayed in both the document browsers, newly added
codes are displayed immediately in both browsers after they are created; the display
is thus synchronized.
The filter settings for the displayed coding stripes are saved separately for each
Document Browser. In this way, you can display, for example, only red coding stripes
in one Document Browser, and only coding stripes by a specific author in the other
document browser. Once you close the second browser, the selection of the coding
stripes is reset: that is, the next time you open the second browser, all coding stripes
will be turned on and visible (of course, only if they were created while coding the
document).

Jump from segments to the “Retrieved Segments” window and
“Overview of Coded Segments”
●

Clicking on the source data in the “Retrieved Segments” window always brings up
the selected segment in the standard “Document Browser”, not in the second
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browser window. The same is true for browsing the segments in the “Overview of
Coded Segments”.

Editing documents
●

In the second “Document Browser”, you can switch to Edit Mode at any time by
clicking the
Edit button, to make changes to the document. Please note that
only one of the two open documents can be in Edit Mode at a time.

Please note: If the same document is open in both MAXQDA “Document Browsers”, it
is not possible to edit the document.

Opening documents in tabs
MAXQDA includes the option of opening more than one document in the “Document
Browser” at once, each opened in a separate tab. This allows you to switch quickly
back and forth between documents. Once you have opened documents in tabs, you
can switch to any of them by clicking on the appropriate tab at the top of the
“Document Browser”. Documents can be opened in tabs by holding the Shift ⇧ key
and double-clicking on the document or by right-clicking on the document and
selecting Open Document in a New Tab.
Once a document has been opened in this way, tabs will appear at the top of the
“Document Browser” with the names of each of the documents open. You can switch
between the documents by clicking once on the appropriate tab. The tabs can be
closed individually.
If tabs are already open, a document opened in the normal fashion from the
“Document System” will appear in the currently selected tab in the “Document
Browser”.
Tip: To open all documents in a document group in tabs, drag the document group
into the “Document Browser” with the left mouse button, then release.
In the local preferences of the "Document System" window, you can set that
documents are opened in a new tab by default. To do this, click on the gear in the
upper right corner of the toolbar and select the option Open documents in tabs.
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Open documents in tabs by default

Spellchecking in Documents and Memos
You can check for spelling errors within editable text documents and memos.
MAXQDA offers spell checking in English (UK), English (US), German, Italian, and
Spanish.

Activate and Deactivate Spellchecking
To turn on the Spellcheck function for a text document click the Spellcheck on/off icon
in the "Document Browser" as shown in the image below. Click the icon again to
deactivate the function. To turn on the Spellcheck function in a memo click the same
icon in the "Memo Editor" toolbar or the "Memo Manager" toolbar.
The spell-checking language can be changed directly in the "Document Browser"
Preferences menu as well as in the General Preferences.

Activate/Deactivate the Spellcheck function

Correct Errors
When Spellcheck is activated, MAXQDA underlines all words that are not found in the
default dictionary for the selected language or in your custom dictionary. Right-click
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on an underlined word to view the spellcheck options. You can decide to:
●

●

●

●

Click on a suggestion in the upper part of the dialog window to replace the word
with this suggestion.
Click on a suggestion in the lower part of the dialog window to replace all
occurrences of the word in the open document or memo with this suggestion.
Click Add to Dictionary to add this word to your personal dictionary. In future
MAXQDA will then no longer recognize the word as a mistake in any project or
document.
Click Ignore to ignore the spelling of the word once.

Spellcheck options

Edit Custom Dictionary
The user-defined dictionary that contains the list of words you have added to your
personal dictionary can be edited at any time to add or remove any words from the
dictionary. The file is named "(language)_UserDictionary.txt" and can be opened and
edited with any text formatting tool.

●

●

On a Windows computer, you can find the user-defined dictionary this way: Press
the Windows key and R. Enter this: %appdata%\MAXQDA2022
On a Mac computer, you can find the user-defined dictionary here:
Users/(USERNAME)/Library/Preferences/MAXQDA2022
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Edit Text Documents and Tables
Text documents and tables can’t be modified after you open them in the ”Document
Browser”, to prevent unintentional changes to the document during your analysis.
However, you can activate the Edit Mode at any time, which allows you to adapt the
text, for example, to correct a typo or error. You also need to activate Edit Mode to
create a new text in MAXQDA.
To turn on Edit Mode:
●

●

Click on the Edit Mode icon in the ”Document Browser” toolbar as in the image
below.
Alternatively, you can also use the shortcuts Ctrl+E (Windows) or ⌘+⌥+E (macOS).

Turn Edit Mode on/off

For text documents, the usual text formatting functions such as font size and size are
available in Edit Mode. A separate formatting toolbar will appear below the coding
toolbar.

Formatting toolbar for text documents

For table documents, only the content can be customized, but not the appearance of
the text.
Note: It is not possible to edit contents of a PDF, an image, an audio file or a video file
within MAXQDA.

Saving text edits
The changes made in Edit Mode are transferred to the MAXQDA project file when the
Edit Mode is closed. The modified text is saved every 5 minutes as you go. You can set
this backup interval in the global preferences of MAXQDA, which can be opened via
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the gear symbol

on the top right of your MAXQDA window.

Set the interval for autosave in Edit Mode

Undoing text changes
You can undo changes made in Edit Mode - this works in the same way as in Word.
For example, if you delete or reinsert a text passage, you can undo all these steps. You
can do this either by right-clicking the context menu in the "Document Browser" and
selecting the Undo Text Changes option. Alternatively, you can click on the symbol in
the toolbar:
With the Undo All Text Changes option, you can undo all the changes made since you
last opened Edit Mode with one click.
Please note: Deleting a text deletes all code assignments that are completely within the
deleted text. These assignments cannot be restored by the undo function.

Line Numbers in Text Documents
By default, when importing a text into MAXQDA, all paragraphs are sequentially
numbered so that you can use them to cite the analyzed data. This is sufficient in most
cases for the accuracy of the citation. However, sometimes it is desirable to use line
numbering instead of paragraph numbering for the citation.
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Therefore, MAXQDA allows you to switch back and forth between paragraph and line
numbering: Right-click in the text and select Convert to Line Numbered Text.

Option for converting paragraph numbered text to line numbered text

In the following dialog box, the desired width of the text can be set in characters, e.g.
60 characters, 80 characters, etc.

Set max. line length

The result is a line-numbered text with a fixed number of characters per line and a
paragraph mark at the end of the line.
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Text with line numbers

You can switch back to a paragraph numbered text at all times. To do this, right-click
in the text and select Convert to Paragraph Numbered Text.
Please note: MAXQDA uses soft returns (Shift+Return) for line numbering. When
switching back to paragraph numbering, these are replaced by regular paragraphs
(Returns). If a text contains soft returns before the conversion to line numbering, the
paragraph numbering can be different than before the line numbering. MAXQDA
informs you before converting to line numbering if a text contains soft line breaks.

Rename and Delete Documents
Document groups, document sets, and individual documents can be renamed at any
point. Simply right-click on any of these objects and select the appropriate entry from
the context menu. It is not recommended that you have more than one document
with the same name. It is possible, but it can be very confusing.
Right-clicking on documents opens the context menu, giving you the option Delete
Document, which also deletes the coded segments, memos, and links associated with
it. In the context menu for a document group, you also have the Delete option, which
deletes all the documents in a group in one single action.
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Context menu for a document

Assign a Color to a Document
You have the option of assigning a color to each of your documents. This color is then
used in all tables and visualizations, including in MAXMaps. For example, you can use
color attributes to indicate the processing status of a document or to make other
features, such as the interviewer or the location, visible. Color attributes are also useful
for organizing the assignment of documents to team members.
To assign a color, right-click on the document and select Color from the context menu
that appears.
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Choose a color in the context menu

Click on one of the standard colors and it will be displayed on the document symbol.
Click on the icons to the right of the color circles to select your own colors.
Note: If you select MAXQDA's default color blue, no colored square will appear on the
document icon.
MAXMaps, MAXQDA's tool for concept maps and modelling, also includes the color
attributes of the documents: The document symbol is displayed in its color.

The Document Properties Window
If you right-click on a document in the “Document System” or "Data Editor for
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Document Variables" and select Properties, the following window will appear,
which lets you view and change certain settings for that document:

Document properties window

Read-only – if this box is checked, the document will no longer be editable, even in
“Edit Mode”. This is the default setting for PDFs and image files.
External Document – If this box is checked, it means that the document is not actually
part of the MAXQDA project file. Instead, it has been copied into the folder for
externally-linked files. In this case, the file name is also indicated under Original
Path. To import an externally stored document into the MAXQDA project file, click on
the Embed external document button (of course, this button is only visible for PDF and
image documents that are stored as an external file).
Media file – If you want to link a document to an audio or video file, you can insert the
path to that document in this field. To do so, click on the line, then the button with
the three dots at the end of the line…
External link 1/2/3 – To create a link to a file that is accessible from your computer and
contains, for example, additional information about the interviewee or image, click in
the line for the external links and then click the three points at the end of the line.
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04 - Codes
The "Code System"
Codes have a hierarchical structure, meaning you can create multiple subcodes,
followed by subcodes of subcodes. All of the codes are shown in the “Code System”
window.
At the beginning of a project, this window is empty except for the “Code System” and
“Sets” icons and their associated icons.
MAXQDA’s “Code System” has the following characteristics:
●

●
●
●

A code is a text with a maximum of 63 characters consisting of one or more words.
A code can contain empty spaces and special characters.
The number of codes is unlimited.
The hierarchical structure can contain up to ten levels.
Codes can be assigned a color.

There may be some special codes in the “Code System” window:
●

●

●

●

Color codes are like text markers and change the background color of the marked
text. You can recognize them by their highlighter icons.
For so-called “emoticodes”, an emoji symbol appears in the “Code System” in the
place of the code symbol. Emoticodes do not have a name when first used, this can
be added if needed.
In the section “Focus Group Speakers”, all codes appear that are used to assign the
contributions of a speaker. These codes can be identified by this icon .
The code “Paraphrased Segments” is applied automatically to all data segments for
which you have written a paraphrase.

Working with coded segments (of text, images, and videos) and the “Code System” is
a central aspect of computer-supported analysis. This work is usually not done
automatically by the software, but rather is controlled by the researcher, although this
often requires a significant amount of time. The “Code System” is shown as a tree
structure on the screen. A triangle symbol before the code name indicates whether or
not a code contains subcodes. You can expand or close the sub-categories by clicking
on this triangle.
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Hide subcodes

You can click on the triangle symbol before the code to reveal or hide its subcodes.
Tip: With the function Collapse all Subcodes, which is accessible from the context
menu of the top-level of the “Code System”, you can conveniently collapse all codes
so only the top level codes will be visible.
Using MAXMaps you can build a network structure of codes to be used during the
coding process, meaning you can code selected segments within a document and
code them by dragging them onto a code in the network map.

The “Code System” toolbar
The following frequently-used functions for codes can be selected in the toolbar at the
top of the "Code System" window:
Reset activations – resets current code activations.
Display codes in activated documents only - reduces the display in the “Code
System” window to codes that have been assigned to at least one of the activated
documents. To preserve the hierarchy structure of the code system, not assigned
parent codes are included if necessary.
New code – adds new code into the code system.
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Display search toolbar – allows you to search for a specific code.
Settings - opens a dialog with locally relevant options (see below).
Undock window
Maximize window
Hide window
In addition to using the toolbar to access functions in the “Code System,” you can
also use the context menus that appear when you right-click on various icons in the
window (e.g., on a code or the “Code System” icon, etc.).

Codes and Coding in MAXQDA
Coding parts (or "segments") of a document is one of the core functions of
MAXQDA. Coding is the process of assigning one or more codes to a segment that
you have selected with your mouse in the "Document Browser". This process allows
you to, for example, conduct a systematic qualitative content analysis.
So, what is a "code", exactly? Libraries have always used keyword catalogs, and
researchers in the social sciences should also be familiar with the use of “categories”,
for example from the grounded theory approach or from content analyses. Other
synonyms are "keyword" or "label". What the code represents depends on the task
and the given situation. Broadly speaking, however, a code is a tool for identifying the
content of a document, perhaps classifying it, and making it easier to find it again.
Codes create order – this can be illustrated by the example of the keyword catalog.
These catalogs help you find the right book and at the same time provide an overview
of the topics on which the library has many or just a few books. Of course, how useful
such a catalog is will depend on the complexity and usability of the index system and
on the accuracy of the keywords used.
In technical terms, a code in MAXQDA is a text of up to 63 characters. Codes are like
card index boxes that contain index cards to which text passages, parts of images, or
video segments are attached and on which a category name is written at the top. The
name of a code is like a label that acts as a tab in the index box. This label can be
easily changed without affecting the structure of the index box or the index cards
themselves.
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Create a New Code
The word “Code System” at the top of the list represents the root of your system of
codes (or hierarchical "Code Tree"). You can gradually build up a system of categories
from this point.

Adding codes at the top level of your "Code System"
In order to insert a code at the top level, click on the green plus sign that appears
when you move the mouse over the first line of the code system:

Creating a new code using the green plus sign

The following dialog box for code definition will appear:

Dialog to enter a new code

Type the name of the new code into the text field in the upper part of the window
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(MAXQDA allows a length of 63 characters for a code name). You can select a color
attribute for the new code below.
If you select the option Use as the default color for new codes, all newly created codes
in the project will use this chosen color. Of course, you can change this default color
each time you create a new code using this dialog.
Click OK to create the new code and close the window. If on the other hand, you click
on Add Code, the window remains open, and you can define further codes at the top
level.

Adding subcodes
If you want to define subcodes, click on the green plus sign that appears when you
move the mouse over the desired parent code:

Creating a new subcode using the green plus sign at the parent code

Alternatively, you can right-click a code and select New Code from the context menu.
You can also create a new code using the Alt+N (Windows) or ⌘+⌥+N keyboard
shortcut (macOS) or the New code icon in the toolbar. Note, however, that the
highlight must be on the code for which you want to create a subcode.
If a check mark is placed in the option Use color of parent code when defining
subcodes, the color of the upper code is assigned to this newly defined subcode. In
the text field Code memo, you can enter a comment to this code, e.g., the definition
of the code. After closing the dialog, you can - if you have entered something in the
field Code memo - recognize the symbol for a code memo next to the newly defined
code.
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Newly added subcodes with memo symbol

Please note: Newly defined codes are always inserted at the top of the category system
in the "Code System" window. This applies to all levels of the hierarchy. If you prefer
to insert subcodes at the end of existing subcodes instead, the option Insert new
subcodes at the bottom can be selected in the local settings for the "Code System".
The local settings can be accessed by clicking on the gear icon in the "Code System"
toolbar.

Settings for the “Code System” window
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Import Codes and Code Memos from Excel
MAXQDA can create a code system from the rows in an Excel spreadsheet. The
reading of a code system from a table is useful when you want to define multiple
codes in advance.
The first row of the table must include the keywords Code and Memo. Each additional
row corresponds to a new code and associated memo. In the Code column, you can
define subcodes using a backslash "\".
Tip: To insert a backslash "\" on a Mac, press ⌥+⇧+7.
To start the import, select the function Import Codes and Memos from Excel
Spreadsheet from the Codes tab.
Example

Code
Codename 1
Codename 1\Subcode 1.1
Codename 2\Subcode 2.1\Subcode 2.1.1

Memo
Here is a text, e.g., with the code definition
Here is a text, e.g., with the code definition
Here is a text, e.g., with the code definition

When importing a table, MAXQDA proceeds as follows:
1. Unless they already exist in the MAXQDA project, new codes are created. In the
example, five codes are created: "Codename 1" and "Codename 2" are created at
the top level. "Codename 1" is assigned the subcode "Subcode 1.1" and
"Codename 2" is assigned the subcode "Subcode 2.1", which in turn is assigned
the subcode "Subcode 2.1.1".

2. In addition, each newly inserted code is assigned the corresponding text from the
second column as a code memo.
3. Code names and subcode names are each shortened to 63 characters.
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Edit Code Properties
You can right-click on the name of any code and choose Properties in the drop-down
menu in order to open the Properties window:

Properties window for a code

In this Properties window, you can…
●
●
●
●

Change the name of the code (max. 63 characters available),
Assign or adjust a Code Alias (max. 255 characters),
Modify the code color,
Assign a keyboard shortcut.

Since the number of characters for a code is limited to 63, longer code designations
can be assigned as code aliases. For example, they may be exported instead of the
code names when using the Smart Publisher.

Changing the color of a code
A color attribute can be assigned to each code or subcode. To do this, right-click on a
code and click on one of the default colors in the context menu. The icons on the
right-hand side of the context menu allow you to define your own colors and list the
colors already used in the project.
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Select a color for a code in this context menu

Tip: If you change the color of a parent code, MAXQDA asks if you want to apply the
color to all the subcodes as well.
The color is visualized in the “Document Browser” and in visualizations created with
the visual tools offered by MAXQDA. In the “Document Browser” the coding stripes
are displayed in the corresponding code color. This makes it easy to identify which
segments are assigned to a code.

Coding stripes of various colors in the “Document System”

The color is also seen in the bottom right of the icon next to each code in the “Code
System”.
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Differently colored codes

The color attribute is also displayed in all MAXQDA tables that contain codes, e.g., in
the “Overview of Coded Segments” table that is available for each document group
and each document. There, the color attribute may be used as a criterion for sorting
the table. This is done by clicking on the column header of the column containing the
colored icons. Unless you have changed the order of the table’s columns, this column
will be the first one in the table.

Color attribute in the first column of the “Overview of Coded Segments”

The color attribute plays an important role in all visual tools of MAXQDA. For instance,
the Document Portrait is based completely on the colors of the codes that are assigned
to a particular document. Thus, the selection of colors is an important step: colors
should be assigned according to the kind of analysis that you plan to conduct. For
instance, a psychologist could assign red colors to aggressive statements and green
colors to friendly statements. When analyzing documents in regard to the topics
mentioned a meaningful association of topics and codes is recommended. Thus, you
are able to identify topics and combinations of topics with one glance. When working
with focus groups, you should associate the speakers with the different colors, in order
to quickly find out when a person is speaking.

Adding a code alias
Code names in MAXQDA can be 63 characters in length. However, it is sometimes
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desirable to note a shorter or longer description in addition to the code name. This
allows you to employ an automatically generated report with selected coded
segments, for example, in Smart Publisher.
To create a code alias for a code, right-click on the code in the code system and select
Properties. This will open a window where you can enter a code alias, among other
options.

Creating a Code Alias in the “Code Properties” 2indow

Alternatively, you can click Code Alias Table in the Codes menu tab, which will
generate a table in which you can conveniently enter multiple code aliases, and view
for which codes an alias has already been assigned.

Code Alias table

Edit the "Code System"
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Moving codes
Changing the structure of the category system is not difficult. All codes can be moved
with the mouse and the drag-and-drop function.
In the following example, the “Code System” contains four codes (A, B, C and D).

Moving codes with the mouse

To move Code D to the top of the list, you would need to do the following: click on
Code D and drag it above Code A while holding down the left mouse button, then,
when a line appears, drop the code.
It is also easy to make a code a subcode of another code. If you want Code B to
become a subcode of Code A, for example, you would carry out the following actions:
click on Code B, drag it to Code A, and release as soon as Code A has a colored
background. Code B is then added as a subcode of Code A.

Move multiple codes
You can select multiple separate codes while holding down the Alt (Windows) or
option ⌥ key (mac OS) and then move your selection while holding down the mouse
button. To select a range of codes, first click on a code and then click on a second
code while holding down the Shift key ⇧. This will then also select all codes between
the clicked codes.

Sorting subcodes
Subcodes can be sorted in ascending and descending order by name and by
frequency, by right-clicking the parent code and selecting Subcodes... > Sort... from
the context menu.
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Dividing a code into subcodes
Often when working with a code system, it is desirable to differentiate between
elements grouped under one code. In MAXQDA this corresponds to dividing a code
into two or more subcodes. For example, imagine you have created a code named
“Family” and have assigned document segments, in which an interviewee talks about
his family, to this code. Then imagine that it becomes necessary to differentiate
between “Mother”, “Father”, and “Siblings”.

This differentiation of a category does not work automatically, but requires that each
segment previously coded under "Family" is re-read by the researchers and assigned
to one of the three new subcategories. This can be done particularly conveniently in
the Smart Coding Tool, which was specifically designed for this purpose.
Alternatively, codes can be divided as follows:
1. Activate all documents and the code “Family.”
2. Create three subcodes for “Family”: “Mother,” “Father,” and “Siblings.” Only the
code to be differentiated, in this case "Family", should still be activated, but not the
three new subcategories, in order to be able to carry out the reassignment
conveniently.

Splitting up a code

3. Start with the first segment in the "Retrieved Segments" window and decide to
which of the three subcodes this segment is to be assigned.
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4. Click on the coding stripe to the left of the segment and move it to the selected
subcode while holding down the left mouse button. During this process, the
segment is moved to the selected subcode, i.e. the coding with the parent code is
deleted immediately.
Tip: If you hold down the Ctrl key (Windows) or the command ⌘ key (macOS) during
this operation, the encoding is copied from the source code to the target code and
remains in the parent code.
This is how you can work with all segments, so you continue in the same manner for
the second. When you get to the end of the list, all segments will have been reclassified - they have been assigned to one of the three codes in question.
Alternatively, you can click on the document name below a segment in the "Retrieved
Segments" window in step 4 to display the segment in the "Document Browser".
There you can code as usual, i.e. by clicking and dragging with the mouse and
assigning the desired subcode. With this procedure, however, the old codings in the
upper code are still retained, i.e. all segments still have the assignments to the code
"Family".
However, this is normally not the intention - the old encodings of the parent code
must be removed. You can double-click on the parent code to list its encodings in the
"Overview of Coded Segments", select all encodings and then remove them by
clicking on the delete symbol in the toolbar.

Merging Codes
It is often necessary to combine two or more codes that capture something similar in
the data material into a single code.

Merging two codes with the mouse
For two codes, this can be done very easily via drag & drop: click on the code you
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want to merge with another code and drag it to the highlighted word "Merge" that
appears to the right of the target code and release the mouse cursor on that word.

Merging codes using the mouse

As soon as you release the mouse button on the word “Merge”, MAXQDA moves all
coded segments of the source code into the target code and deletes the source code.
In the example, the 4 coded segments of Code D are added to the 5 segments already
existing in Code C. The Code D is then deleted.
To indicate that the segments of another code were inserted into a code by fusion, a
plus sign in brackets “(+)” is added after the target’s code name. This plus sign is used
only as an identifier and can be removed at any time by renaming the code.
Please note: If you merge a code that has subcodes with another code, the subcodes
are attached to the target code. It is not possible to merge a parent code with one of
its subcodes.

Merging multiple codes using the context menu
You can also merge several codes at once at any time:
1. To select all codes you want to merge, hold down the Alt (Windows) or the option
⌥ key (macOS) and click on each code with the mouse button.
2. After that, right-click on the code into which all other codes are to be merged.
3. Select Merge Codes from the context menu that appears.
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Code memo behavior during mergers
If the box Insert merging history in code memos in the “Code System” preferences is
checked and a code is merged into another code, an audit trail with the merge date
and information is added to the code memo. If no memo exists yet, a new one is
created.

Code memo with merging info

In MAXQDA, each code can have only one code memo, so the question arises what
happens with the code memos of the codes that are being merged:
●

●

If only one of the merged codes has a memo, it is attached to the remaining target
code.
If several codes have a memo, MAXQDA asks whether the memo texts should be
combined at the target code or whether the memos should be converted into free
memos. Free memos are not directly assigned to any element in MAXQDA and can
be displayed e.g. via the Memos tab.
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Copying subcodes
In some cases, you will be setting up the same subcodes for various codes. You might,
for example, have the codes “Childhood,” “Teenage Years,” and “Adult Life,” which
should each have the subcodes “Education,” “Family,” “Friends,” and “Memorable
Experiences.” So that you don’t have to create these four subcodes three times, you
have the option of setting them up for one of the main codes, copying its subcodes,
and pasting them into the other main codes. To do so, you would follow these steps:
1. Right-click on the code and select Subcodes... > Copy from the context menu.
2. Click on any other code and select Subcodes... > Paste from the context menu.
MAXQDA then adds the copied sub-codes in the same order as the original code. The
newly inserted sub-codes keep the Color previously assigned to them.

Delete Codes
Deleting a code from the “Code System” is somewhat like cutting off a branch from a
tree. By deleting that code, you are also deleting any subcodes, which are like smaller
branches attached to the bigger one you cut off. At the same time, all coded
segments that had been created with those codes are deleted.
The easiest way to delete codes is to go directly to the "Code System": click on the
red X that appears as soon as you move the mouse over the line of the code to be
deleted.
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Delete code using the delete icon in the “Code System”

You can also right-click on the code to be deleted and select Delete Code or Delete
Code Incl. Subcodes from the context menu. Alternatively, you can also select a code
with the left mouse button and then press the Del key (Windows) or the Delete key
(macOS).

Deleting several codes at once
1. Highlight several codes in the code tree by clicking on them while holding down the
Alt key (Windows) and the option ⌥ key (macOS). To highlight a range of codes,
click on the first code, hold the shift ⇧ key, and click on the last code.
2. Then right-click on one of the highlighted codes and choose Delete Codes from the
context menu.
Alternatively, you can switch to the table view of the “Code System” window:
1. To do so, click on the gear wheel icon in the “Code System” toolbar to open the
local preferences, select option Table view, and click OK.
2. Use Ctrl key (Windows) and ⌘ key (macOS) to select single codes. Use shift ⇧ key
to select a range of codes.
3. Then right-click on one of the highlighted codes and choose Delete Codes from the
context menu.
Codes can also be deleted in this manner in the “Overview of Codes”, accessible via
the Code menu tab or the context menu in the “Document System”.

Create Code Sets
With MAXQDA it is possible to store temporary combinations of codes as code sets.
This allows you to group the same codes in different ways or to make frequently used
codes available for coding. The code sets only contain references to existing codes, so
removing a code from a set has no further consequences.
To create a new code set, right-click on the word Set in the "Code System", then
select New Set.
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Create a new code set in the “Code System”

After you enter a name for the set, you can drag and drop the desired codes into the
new set with the mouse. The codes can also be moved within the set or to another set
using the mouse.
Tip: If you activate codes before creating a new code set, MAXQDA places the
activated codes directly into the new code set.

Overview of Codes
It might be of interest to take a look at how many times each code was assigned to
individual, multiple, or all documents. Alternatively to the visual display of the Code
Matrix Browser you can also open the Overview of Codes, which you can find in
several places in the program:
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●
●
●
●

In the Reports tab,
In the context menu at the root of the “Document System”,
In the context menu of a document group or document set, or
In the context menu of an individual document.

“Overview of Codes” for documents from group “Interviews New York” (see top left) with 21 codes (see top right)

A table view of all of the codes that occur in the relevant documents will appear. The
table may contain more or fewer lines depending on the place in the program from
which it was called up. In the title of the overview, you can see which documents the
overview applies to and to how many (different) codes in the document a segment is
assigned.
Please note: When the Overview of Codes is opened in the Reports tab, codes with no
coded segments are displayed as well. Otherwise, only codes with at least one coded
segment in the relevant document will be displayed.

Overview of codes for all documents (see top left) with 20 codes (see top right)
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The other columns consist of:
●
●

●

●

●

●

●
●

Code – The name of the code that appears in the “Code System”
Parent code – Contains the parent code for easy identification of a code. If the
“Parent code” column is empty, the code in this row belongs to the top level of the
code system.
Cod. seg. (all documents) – The number of segments in the analyzed documents
that have been coded with a particular code or subcode.
Cod. seg. (activated documents) – Takes only activated documents into account. If
this column displays all zeros, then presumably because no documents are activated.
Once you activate documents, you can directly observe how the values in this
column change.
% Cod. seg. (all documents) – The percentage of segments that have been coded
with the particular code or subcode, in relation to the total number of coded
segments in column “Cod. seg. (all documents)”. The sum of the column is 100%.
% Cod. seg. (activated documents) – As in the “% Cod. seg. (all documents)”
column but takes only activated documents into account.
Documents – Number of documents in which the code or subcode appears.
Code alias – Alternative name for a code with up to 255 characters, that e.g., may
be exported in the Smart Publisher report instead of the code name itself.

Right-clicking a row opens a context menu with various options, you can open the
overview tables of Coded Segments or Linked Memos, for example. You can also
change the color attribute of a code from this menu.
A toolbar is displayed at the top of the window from which the following special
functions can be accessed:
Aggregate on 1st level – Only the codes at the top level of the code system will be
displayed. Here, the code frequencies of the subcodes are added, as well as the
number of documents in which the code occurs.
Statistics – Displays the values of the columns “Cod. seg. (all documents)” and
“Cod. seg. (activated documents)” as a frequency table or chart. For more
information, see Frequency Tables and Charts for Subcodes
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Transfer the "Code System" to Other
Project
It is possible to export an entire "Code System" and import it into another MAXQDA
project file. This function is especially useful as it allows you to build a “Code System”
in one project, then apply it to another. In this case, importing and exporting the
“Code System” eliminates the need to enter new codes.
To export your "Code System", go to the Codes menu and select Export Code System
> MAXQDA Format.
The “Code System” will be converted into a specific file format with the extension
MTR. You can then import the “Code System” into a new MAXQDA project with the
corresponding procedure Import Code System.
Please note: MAXQDA can also export and import the cross-software QDC format
(REFI QDA Codebook). You can select this format in the drop-down menu when
clicking on Export Code System in the Codes menu tab.
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05 - Coding
How to code
Assigning codes to text, image or video segments in MAXQDA is known as “coding”.
You can code a document or document segment with any desired number of codes.
The technical limit for the number of coded segments per document is so high that it
usually has no practical significance. Moreover, coded segments can overlap, intersect,
or be completely contained within other coded segments.

Selecting the segment you want to code
The process of coding can be done in many different ways, but you always start by
selecting a part of a text or an image in the "Document Browser” with your mouse.
You can see an example of a selected text passage in the “Document Browser” below:

A highlighted segment of text

Please note: The smallest part of a text that can be coded is a single character. In most
cases, one would code at least an entire word.

Coding texts and image segments in a PDF
You can select text segments in a PDF as usual by highlighting them with the mouse.
If you want to select an image in a PDF, for example, because you want to analyze a
scanned PDF whose text cannot be converted into a “selectable” text using OCR
(character recognition), you can use the mouse to draw a frame. To do this, you only
have to start the selection process in an area that does not contain any selectable
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characters. You can adjust the selected area later by clicking the corners and dragging
them to a suitable size.

Highlighted text (above) and highlighted image segment (below) in a PDF

Selecting segments of images
In image files, you can drag a frame with the pressed mouse button in the same way
as in PDF documents. The edges of the frame can be adjusted later by clicking and
dragging the corners.

Selecting texts in tables
To select a text in a table, double-click the cell. As soon as the cell shows an orange
frame, you can select text in this cell with the mouse. You cannot select multiple cells
at the same time.

Selecting segments of videos
Videos are analyzed and coded in a separate window, the "Multimedia Browser". In
the Coding Videos section, you'll find detailed explanations for how to code videos.

Code the selected text with your mouse
The simplest way to code in MAXQDA is to drag and drop a selected text or image
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segment onto a code with your mouse.
Move the mouse to the area of the selected segment, press the left mouse button,
and move the mouse to the desired code in the "Code System". Here, release the
mouse button and “drop” the selected segment onto the code.

Coding via drag and drop

Tip: The same segment can also be assigned consecutively to several codes.
Alternatively, you can also do the reverse, that is, drag your desired code to the
selected segment and then release the mouse button.
Please note: MAXQDA makes sure that the same code is not assigned to the same
segment multiple times. Segments assigned with the same code will therefore never
overlap.

Display Coded Segments in the "Code
System"
Information on how many coded segments are assigned to a specific code can be
found in the “Code System”. This information is displayed in the frequency column at
the right of the code name. In the picture below you can see that a total number of 47
segments have been coded with the code "Flexibility".
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Information on the number of coded segments

When you "collapse" the subcodes of a code by clicking on the triangle symbol to the
left of the code, the code frequencies of the subcodes are added to the frequencies of
the parent code. In this case, MAXQDA displays how many segments have been coded
with a collapsed code including all its subcodes. If you prefer seeing only the
frequencies of the parent codes (regardless of whether the code is collapsed or not)
you may change the setting by deactivating the option Sum up frequencies of
subcodes in the preferences window of the "Code System".

Options for displaying the frequencies in the "Code System".
You may set the preferences of the "Code System" by clicking on the gear icon on the
toolbar of this window.
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Code system preferences

The topmost option Display frequency allows you to define which frequencies
MAXQDA should show in the "Code System". You may choose between the
following options, each of which offers a different analytical information:
Selected option

Analytical relevance

Coded segments in all
documents

How often was a code assigned in all documents?
This is the default option as described above, which is
always used automatically when opening a project.

Coded segments in all
activated documents

How often has a code been assigned in the currently
activated documents?
The numbers are automatically updated when you
activate or deactivate documents.

How often has a code been assigned in the document
Coded segments in opened currently opened in the "Document Browser"?
document
Coded segments in audio and video files are not taken
into account here.
Document groups

In how many document groups does a code occur?
It does not matter whether a code was assigned once or
several times in a document group.
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Document sets

In how many document sets does a code occur?
It does not matter whether a code was assigned once or
several times in a document set.

Documents

In how many documents does a code occur?
It does not matter whether a code was assigned once or
several times in a document.

Display Coded Segments in the Document
Browser
As soon as you have coded a document or image segment, a vertical stripe appears in
the column at the left side of the “Document Browser”. Those visualizations are called
"coding stripes" or "coding brackets" and they show where the document has been
coded.
As default setting the coding stripes appear on the left side of the document. This
setting may be changed easily. To do this, open the local preferences by clicking on
the gear icon in the toolbar of the "Document Browser" and select the option Display
coding stripes on the right.
The coding stripe column can be resized by clicking on the vertical line between the
coding stripe column and the document and by dragging the separator to the right or
left.

Visualization of coding stripes on the left side of the “Document Browser” window

You can also choose whether code names should be permanently shown in the coding
stripe column or not. By clicking on the gray gear icon at the top of the coding stripe
column, you can open a window with various options. One of those options is
to Display code names.
You will always be able to see the code name in the tooltip that appears if you hover
your mouse over the “coding stripe”. The tooltip also shows the assigned weight, the
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creator of the coded segment, the date that the segment was coded, and the last time
it was edited.

Tooltip appearing from the coding stripe

The tooltip always displays the complete code name, with all its possibly existing
"parent codes". The permanent display next to the coding stripe is limited to the
lowest code level. In the example above the whole code name shown in the tooltip is
“INTERVIEW CODES/Dissatisfaction/Dissatisfied with time spent working”. In the
coding stripe column it is shown as “..Dissatisfied with time spent working”. The two
preceding dots indicate that the code is a subcode.
If there are many coded segments, that overlap each other, it may at first sight be
difficult to see which coding stripe belongs to which code name. In this case just hover
your mouse over a coding stripe. The color of the coding stripe will turn paler, and the
corresponding code name will be underlined.

Coding stripe column visualization options
By clicking on the cogwheel icon in the coding stripe column (or with a right-click
anywhere into the column) you can open a window with various visualization options
for coded segments.
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Option window for the visualization of coding stripes

Here you can adjust the following settings:
●
●
●
●

●

●
●

●

Only activated codes - You can choose to only display activated codes.
Only user - You can choose to only display coded segments created by a certain user.
Colors - You can choose to only display coded segments of certain colors.
Display coded segments in code color - You can choose to use the code color as
background color of coded text segments in text and PDF documents.
Display frames around coded image segments – You can choose whether frames
around coded image sections should be shown permanently.
Display code names - You can choose to display or hide code names.
Display author and date in tooltip - You can choose whether the tooltips that
appears when hovering over a code name or coding stripe with the mouse should
include the information about the author and date of creation.
Display emoticodes - Display or hide emoticodes.

The option to switch off codes with selected colors is particularly useful when you are
working in a team with independent coders. In this case, the coders should be defined
as codes on the highest level of the code hierarchy and the different coders should use
the same code tree organized as subcodes of the coders. Now, while training the
coders, they can hide the visualization of other coders’ work. Later, they can compare
their coding with the coding done by the others.
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The option to color the text according to code colors only makes sense if you do not
have many overlapping codes. Overlapping codes cause the color of the text to be a
mix of those overlapping codes, which can make it very difficult to interpret.

Listing codes assigned to a segment
Often, it's useful to determine which codes are assigned to a specific text or image
excerpt. To do this, select a text segment or image section, right-click on it and select
List Assigned Codes in the context menu. This will display a menu in which all assigned
codes are listed. Click on an entry in the list to highlight the code in the “Code
System” window.

List of assigned codes for a segment

Further Ways of Coding
Beyond the classic coding technique of drag and drop, MAXQDA offers several other
ways to code a selected segment:
●

●

●

●

●

●

●

Coding with newly defined codes: As in grounded theory, a segment can be
assigned a new (free) code.
In vivo coding: Select and highlight meaningful terms in a text and automatically add
them as codes in your code system while coding the text segment with the code.
Coding with selected codes from the Quick List: Documents are worked through
regarding on the occurrence of one or more pre-selected codes, and segments
coded where applicable.
Simultaneous coding with multiple codes: A segment is coded with the activated
codes.
Coding with Code Favorites: Selected codes are displayed in a separate window from
which they can be easily applied to segments to be coded.
Coding with self-defined keyboard shortcuts: Up to nine codes can be assigned a
keyboard shortcut, which can be used to quickly code a highlighted segment.
Coding with MAXMaps: Highlighted segments are dragged onto selected codes,
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●

●

●

●

which are arranged on a concept map, e.g. on a surface.
Coding with the Open Coding Mode: After selecting a segment, a window for
creating and assigning a new (open) code appears automatically.
Color coding: This works like highlighting a text passage in a book with a colored
text marker. In MAXQDA, five different colors can be used for color coding: red,
green, yellow, blue, and magenta.
Coding with symbols and emoticons: Selected segments are coded with emoticodes,
that is an emoticon or a symbol.
Coding in the "Retrieved Segments" window and "Overview of Coded Segments":
Coded text passages can be compiled in a list. In these compiled segments you can
then select and code further text passages. For more information, see the section
Coding in the "Retrieved Segments" window and the "Overview of Coded
Segments".

This chapter describes in detail how these techniques are used. Some of the options
can be chosen from the context menu that pops up when you right click on a selected
segment in the "Document Browser" window.

Context menu with coding functions for a selected segment.

1. Coding with newly defined codes
An easy way to create a new code - a code that is not yet listed in the “Code System”
- is to use the shortcut Alt+W (Windows) or cmd+W (macOS). Alternatively, right click
on the selected segment and choose With new code or click the Code with a new
code icon in the "Document Browser" toolbar.

Coding toolbar in the “Document Browser“ window

A dialog window opens, in which you can type in the name of the new code. The
code will be added to the “Code System” at the highest level of the hierarchy. If
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necessary, you can move the code to another level of the “Code System” later using
drag and drop.
Tip: You can also define several new codes and assign them to the same selected
segment. To do this, click the Additional code button in the dialog box instead of just
clicking OK.

2. In vivo coding
Another way of coding is the so-called "in vivo coding". If you, for example, select the
word “global village” in your document and then click on the Code in vivo symbol in
the toolbar of the “Document Browser”, the word “global village” is added to the
“Code System” as the code for this short text segment. The shortcut Alt+I (Windows)
or ⌘+I (macOS) has the same effect.
If you want to code a whole segment of text with the in vivo coding function, we
recommend this procedure: As the name of the new code will automatically be taken
from the selected text passage, code one or two meaningful words with this function
first. Next, select the entire text segment (including the word) and drag it to the newly
created code in the “Code System“ window. MAXQDA expands the coded segment
automatically.

3. Code with selected code in the Quick List
The Coding toolbar provides quick access to frequently used coding functions.
Whenever you click on a code in the "Code System", or when coding is in progress,
the corresponding code appears at the top of the Quick List. Click on the symbol Code
highlighted segment
directly to the right of the Quick List to assign the code shown
in the list to the selected segment. This way, multiple segments of a document can be
coded without having to select the code each time.
Tip: You can also use the keyboard shortcut Alt+L (Windows) or ⌘+L (macOS) to code
a segment with the last code you have used.

4. Coding with multiple codes simultaneously
As a first step, activate the codes you wish to assign simultaneously in the “Code
System”. To activate a code, you can right-click on the code in the “Code System“
and select Activate. Then select a segment to be coded, right-click on it and choose
With Activated Codes in the section Code.
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5. Coding with Code Favorites
If you are working with a large “Code System”, it can be difficult to work efficiently,
since you need to scroll up and down to find the appropriate code. One solution could
be to use the "Quick list" to get access to a certain code quickly, but this option does
only work for one code at once. If you need to have quick access to several codes at a
time, you may define "Code favorites".
And how does it work? Simply right click on a code and select Add Code To...> Code
Favorites. After you have added the first code, the code favorites window will appear.
You can then continue adding more codes to the list repeating this step.
Tip: You can also drag and drop codes from the “Code System” window into the
open “Code favorites” window.

The Code Favorites window

You can now begin to code your documents. Simply highlight the segment as usual
and click on the code in the Code Favorites window. In the coding column on the left
side of the “Document Browser”, you can see that the segments have been coded.
Tip: You can also drag and drop a highlighted segment on a code in the code favorites
window or vice versa drag and drop a code onto a highlighted segment.
When you are finished using the Code Favorite window, simply close it. To re-open the
window, you can either add another code (via the context menu) or select Code
Favorites from the Codes section of the main menu.
You may rearrange the sequence of the codes within the code favorites list with drag
and drop. If you wish to move more than one code at once, just press the ctrl key
(Windows) / ⌘ key (macOS) while selecting the codes. Selected codes may be removed
from the code favorites list with a click on the x appearing next to the code name
while hovering over it with the mouse.
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6. Coding with keyboard shortcuts
For quick coding using your keyboard, you can assign keyboard shortcuts for up to
nine codes. To do so, select the feature Keyboard Shortcuts for Codes in the Codes
tab of the main menu:

The Keyboard Shortcuts for Codes window

In the left column, you can see the available keyboard shortcuts Ctrl + 1 to Ctrl + 9
(Windows) or ⌘ + 1 to ⌘ + 9 (macOS). You can drag and drop a code from the
“Code System“ window into one of the nine rows, to assign a keyboard shortcut to
the code. If a shortcut has already been assigned, it will be overwritten by this action.
For clarity, the name of the code appears in the right column, along with the parent
code if necessary – not the entire code hierarchy.
To cancel the assignment of a shortcut to a code, click on the appropriate row and
click the Remove shortcut button.
For coding, it may be helpful to leave the keyboard shortcuts window open until you
have memorized the shortcuts. It does not matter if the window is open or not when
coding: simply highlight a segment in the “Document Browser“ and hit the selected
shortcut keys. MAXQDA will then code the selected segment with the associated
code.
Tip: When you right-click on a code and select Properties, a window will open in which
you can assign the code directly to one of the nine available keyboard shortcuts.
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Creating shortcuts via the Properties menu of a code

7. Coding with MAXMaps
The “Code System” is organized in a hierarchical tree structure, which does not allow
for multiple cross-relationships between subcodes. In some cases, it may be necessary
to create a non-hierarchical structure to form network relationships and organize
codes in a different structure.
This is possible with MAXMaps, the mapping tool that is part of MAXQDA. Open
MAXMaps in the Visual Tools tab to start the tool and create a new map. Use drag
and drop or Alt+double-click (Windows) or option+double-click (macOS) to copy codes
from your code system to the map. Codes can be freely arranged on the map, linked
to each other with arrows or lines, and free symbols or images can be added to the
map.
Coding is simple: drag a selected segment from the “Document Browser” to a code in
the map.
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Coding with codes in a map

Open Coding Mode
Particularly in research projects that are applying a grounded theory approach, many
so-called "open codes" are created: in a first step, a text is reviewed line by line, and
identified aspects are recorded in numerous new codes. For this case of application the
mode "Open Coding" is particularly suitable. It allows to immediately create a new
code for a marked segment, to assign it and if necessary to write a code memo as well
as a comment for the created coded segment.

Activating the Open Coding Mode
Click the Open Coding Mode icon in the coding toolbar of the “Document Browser”.

Activating the Open Coding Mode
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Please note: The mode automatically turns off when opening a new document. The
mode is not available for table documents.

Using the Open Coding mode
Using the Open Coding Mode is easy: as soon as the mouse key is released after
selecting a text segment, the following dialog window appears:

Example for using the open coding mode

The dialog is, in principle, very similar to the dialog for creating new codes:
●

●

●

You can type the name of the new code in the upper dialog field (max. 63
characters) and select a color attribute for it below.
The text written in the dialog field "Code memo" is used as a memo for the newly
created code (which can be assessed by clicking on the memo icon in the "Code
System").
The "Comment on the coded segment" can contain up to 255 characters (about 2-3
sentences) and is directly assigned to the coded segment.

Tip: You can fold in and out the areas for the code memo and the comment on the
coded segment by clicking on the arrows. You can enlarge the input fields by clicking
on one of the corners of the window and dragging the entire dialog larger while
holding the mouse button.

05 - Coding

219

Color Coding (Highlighting)
Color coding text is a technique that is especially useful at the beginning of the
analysis process. It is similar to the marking of text in a book with a highlighter. It
allows you to color code the passages you find particularly interesting when reading
through the text for the first time. Before you decide which codes to use and before
you start analyzing your text in categories, this technique lets you keep track of what
seems important. You can find five color coding highlighters in the “Coding toolbar”
of the “Document browser”.

The “Document Browser“ code toolbar with five color options

To color code a segment of text, just select the text segment with your mouse and
click on one of the five colors in the toolbar. The text segment will now be highlighted
in that color and color coded accordingly. A new coding stripe will be visible in the
coding column next to the document.

A section of text coded with “BLUE”

Actually, color coding does much more than changing the color of the text. As the
section of text is coded with the color code, you can later get a compilation of all text
passages, marked with that color. Retrieving all codes with a specific color coding can
be done by activating all documents in the “Document System” and activating the
appropriate color code in the “Code System”. You can then assign these passages to
more specific codes.
If you delete a code from a segment in the “Document browser”, the specific segment
will be removed from the code and the text will not be highlighted any longer. If you
completely delete a color code from the “Code System”, all coded segments are
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deleted and none of your texts will be highlighted with that color any longer.
Color codes are displayed with a specific symbol in the "Code System":

Symbol for a color code in the “Code System“

Tip: You can change the name of a color code in the "Code System" at any time.

Emoticode: Coding with Emojis and
Symbols
The “Emoticode” function allows you to assign symbols and Emojis to text and image
segments, as well as audio and video clips. It can generally be employed with the same
functionality as “normal coding:” All the functions of conventional coding are
supported, meaning Emojis and icons will be displayed in the overview tables of coded
segments and in visualizations such as the Document Portrait.

Emojis and symbols
You can access the full Unicode emoticode library of your operating system with more
than 3000 symbols in MAXQDA. This means that you can use the same symbols you
know and love from sending messages on your smartphone to code your data in
MAXQDA.

Opening the Emoticode window
In order to code using emoticodes, you must first open the emoticode window. You
can do so by clicking the corresponding symbol in the coding toolbar in the
"Document Browser".

Activate emoticode function

After being called up, the window containing the collection of Emojis appears and can
be moved anywhere on the screen.
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The emoticode window

If more symbols are included in a thematic section than can be displayed in the
window, you can scroll through all symbols in the section using the scrollbar on the
right side of the window.
When you click on the clock icon, MAXQDA displays the most recently used symbols
and Emojis. In addition, you can add frequently used symbols to favorites. To do so,
right-click the symbol and select Add to favorites. The symbol is then shown
additionally in the 2nd tab from the left, marked with a star. Symbols can be removed
from the favorites list using the same method.
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Add and remove symbols from favorites

Coding with Emojis
Coding segments with Emojis is just like color coding or coding with the toolbar. The
segment is selected in the “Document Browser” or “Multimedia Browser,” then you
can subsequently click on the desired symbol or emoticon in the emoticode window. If
the Emoji has already been used in the existing “Code System,” the reverse is also
possible – meaning the selected segment can be dragged into the code, or the code
into the segment.

Emoticode display in the “Document Browser”
In the "Document Browser" the selected Emoji appears in the middle of the coding
stripe in place of the normal code icon. By default all new emoticodes get the color
blue, the color can be changed as usual in the "Code System" and is then also used
for the coding stripe in the "Document Browser".

Coding stripe with emoticode in the “Document Browser”

In the selection window for the displayed coding stripe (which can be called up with a
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right-click on the mouse in the visualization area), you can hide or show coding stripes
with emoticodes in the “Document Browser.”

Select “Display emoticodes” to emoticodes on the coding stripe

Emoticodes in the “Code System”
When the “Code System” is displayed in the normal tree structure, the emoticodes
appear in the place of the usual code symbols. The display of codes in the code system
can, if desired, be restricted to emoticodes. To do so click on the settings icon in the
"Code System" window and select Display emoticodes only. This setting is
automatically reset when you open another project.
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Display only emoticodes in the “Code System”

Emoticodes in the “Retrieved Segments” and “Overview of coded
segments”
Emojis, in most cases, replace code symbols, and are therefore found in the source list
in the “Retrieved Segments.” In the table view, as in the Overview of coded segments
Emojis are displayed instead of the circle containing the code colors, allowing the
entire table to be sorted by Emojis.
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Emoticodes in the "Retrieved Segments" window and the Overview of Coded Segments

Emoticodes in MAXMaps and other MAXQDA visual tools
In MAXMaps, the appropriate emoticon will appear in the place of the code symbol. In
the Code Matrix Browser, Code Relations Browser, and Codeline, the Emoji will also
be displayed in the place of the code symbol.
In the Document Comparison Chart each code that is present in the paragraph is
represented by a colored section of the bar. Code colors, not Emojis, are used.
The Document Portrait is displayed with emoticodes rather than code colors if the
“Mix” feature is turned off. When the “Mix” feature is turned on, it mixes the code
colors where codes overlap. In this case, the code color of the emoticode is used.

Coding Videos
The Multimedia Browser
Using the “Multimedia Browser“, you can easily play and code audio and video files.
To open the “Multimedia Browser“, click the Open video file
or Open audio file
symbol in the "Document Browser" toolbar.

Open the “Multimedia Browser“ in the “Document Browser“

The symbol is only displayed when there is a media file attached to the opened
document.
The “Multimedia Browser“ looks like this:
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The Multimedia Browser window

Detailed instructions on coding videos in the "Multimedia Browser" can be found in
the chapter "Code Videos Directly".

Remove Code Assignments
In several locations, MAXQDA offers the option of removing single or multiple codes
from a segment.
Please note: If you delete a code in the “Code System“ window, the code is removed
from all coded segments in all documents.

Remove code assigments in the “Document Browser” window
1. Move the mouse over the coding stripe or over the code name.
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2. Right-click and select Delete.

Removing a code assignment in the “Document Browser” window

Remove code assigments in the “Retrieved Segments” window
1. Right-click anywhere on a coded segment or on the coding strip.
2. Select Delete.

Removing a code assignment in the “Retrieved Segments“ window

Remove code assignments in the “Overview of Coded Segments” or
“Retrieved Segments” windows in table view
1. Right-click on a row or select multiple rows while holding down the Ctrl key
(Windows) or cmd key (macOS) to simultaneously delete multiple coded segments.
2. Select Delete.
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Deleting coded segments in the “Overview of Coded Segments”

Remove most recent code assignments with the "Undo Coding" icon
If you need to first find the location of a coded segment in a document, removing the
code in this way may not be very convenient. A better way is to use MAXQDA’s Undo
Coding function. In the “Code” toolbar on top of the “Document Browser” window,
there is an Undo button. Clicking on it opens a list containing the last codes
assigned. This can be especially helpful to remove code assignments created with one
of MAXQDA's automatic coding functions.

Undo Coding function in the code toolbar

The most recent coded segments are shown at the top of the list. By clicking on the
third coding, only this one will be removed, the two codings listed above will be
retained.
Please note: If only the size of a coded segment is changed, this action does not
appear as a new entry at the top of the list.
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Modify Coded Segments
There are various ways to modify coded segments:
●
●
●

By assigning an additional code to a coded segment.
By assigning another code in the place of an existing code.
By modifying the segment boundaries, i.e., enlarging or reducing the scope of a
coded segment while the code remains in place.

All three of these modifications can be easily carried out in MAXQDA.

Coding a segment with an additional code
Sometimes it is necessary to assign a coded segment to an additional code. There are
several different ways of doing that:
●

●

●

●

Code with additional code manually - After having coded a segment, the segment
remains selected (except for color coding). It is possible to directly attach more codes
to the same segment, for example, using drag-and-drop. If you want to assign
additional codes later, the segment must be selected again. The easiest way to do
this is to click on the existing coding stripe of this segment. The segment will be
highlighted again and you can assign an additional code in the usual way.
Copy from “Document Browser” - A faster way is to drag the coding stripe from the
“Document Browser” directly onto another code of the “Code System”. The text
passage will additionally be coded with the new code.
Copy from “Retrieved Segments” window - If the coded segment is shown in the
"Retrieved Segments" window, drag the coding stripe next to the relevant segment
to another code while holding down the Ctrl key (Windows) or ⌘ key (macOS).
Copy from “Overview of Coded Segments” - A coded segment can be copied from
the table view of the “Retrieved Segments” windows or the “Overview of Coded
Segments” to a different code in the same manner. Simply drag the row to another
code.

Move a coded segment to a new code
When reviewing your analysis, you may decide that the wrong code was assigned to a
segment. Or you may decide that the “Code System” is not precise enough, so it is
necessary to expand the “Code System” and distinguish between different codes. In
both cases, you will need to replace one code assigned to a text with another.
This can be done in several ways:
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●

●

●

●

Code with a new code and delete old code - Assign the new code as additional
code, e.g., by first clicking on the coding stripe to mark the segment and then
dragging the segment onto the new code with the mouse. Then delete the previous
coding by right-clicking on the old coding stripe and selecting Delete.
Move from “Document Browser” - A faster way is to drag the coding stripe directly
onto the new code while holding down the Ctrl key (Windows) or ⌘ key (macOS).
This moves the segment to the new code and deletes it from the old one
automatically.
Move from “Retrieved Segments” window - If the coded segment is shown in the
"Retrieved Segments" window, drag the coding stripe next to the relevant segment
to another code (without holding down a key). This moves the segment to the new
code and deletes it from the old one automatically. If the other code is not activated,
it may be that the coded segment was removed from the “Retrieved Segments”
window.
Move from “Overview of Coded Segments” - A coded segment can be moved from
the table view of the “Retrieved Segments” windows or the “Overview of Coded
Segments” to a different code in the same manner. Simply drag the row to another
code while holding down the Ctrl key (Windows) or ⌘ key (macOS).

Click and drag to move the coded segment to the desired code

Editing the size of a coded segment
Sometimes a segment may be coded outside of its logical boundaries, meaning it is
too short or too long. The coded segment will, therefore, be difficult to understand
because it is out of context. Segment boundaries can be adjusted in the following
way:
1. Select the segment by clicking on the corresponding coding stripe or code name in
the “Document Browser”. The segment is now highlighted in the original
document.
2. The coded segment can now easily be resized with the code grabbers that are
displayed at the beginning and end of a segment.
3. The segment boundaries can also be redefined by selecting the correct text

05 - Coding

231

segment and coding it again with the same code. Alternatively, you can select the
correct text segment, right click on the existing coding stripe and select Recode
with Highlighted Segment.
MAXQDA automatically adjusts to the newly defined segment boundaries.

Changing the size of the coded segment

Please note: Existing coded image segments in image or PDF documents will only be
adjusted when the newly selected area either completely includes the existing segment
or when the newly selected area is completely inside the area of the existing coded
segment.
While the "Recode" function always adjusts the segment borders to the current
highlighted area, you can also expand the segment boundaries with an overlapping
highlight:
1. Highlight a passage that overlaps with the beginning or the end of an existing
segment.
2. Right-click on the coding stripe and choose the entry Extend with Highlighted
Segment.

Move or Copy all Coded Segments of a
Code
The Modify Coded Segments section has already described how you can move or copy
individual coded segments.

Moving all the coded segments of a code
If you move a code from one position in the “Code System” to another, the code
references move automatically together with the code. This is like moving a drawer
from one place to another in a cabinet; the drawer’s contents move together.
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To move a complete drawer is something other than to move only its contents. The
same is true with code assignments. If you only want to move these to another code,
you cannot use the procedure described above. There is another procedure that leaves
the drawer in its place and merely shifts its contents:
1. Right-click on a code in the “Code System”.
2. Select Move Coded Segments. This transfers the code references to an internal
clipboard. (Up to this point, nothing has really changed in the “Code System”. The
number of coded segments for this code remain the same.)
3. Right-click the target code and choose Move Coded Segments (from ‘first code‘).
MAXQDA asks you to confirm the command before executing it.

Moving coded segments

The first code remains in the “Code System” until you delete it, but the number of its
coded segments is now zero. If you no longer need the code, you can simply delete it
from the “Code System“. But be careful: its subcodes will be removed as well!

Handling code conflicts
It may happen that some of the segments which you have moved to the target code
have already been coded with this code. Suppose that you move the codings from
"Code B" to "Code A", MAXQDA proceeds as follows in the case of an overlapping
code:
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●

●

●
●

●

The outer segment boundaries of both encodings are retained. Thus, if a segment
with "Code B" is from word 1 to 5 and the words 4 to 10 have already been coded
with the target code "A", the new segment ranges from word 1 to 10.
If both coded segments have a comment, the comment on the target code is
retained. The comment on the moved code is deleted.
If only one of the two coded segments has a comment, this comment is preserved.
The coding weights of the target code "A" are retained, regardless of the coding
weight of the shifted code.
If several existing segments of the target code "A" are combined into one large
coded segment because they all lie in the segment boundaries of a "B" coded
segment, then this large segment receives the weight of the oldest "A" coded
segment. Only the comment of the oldest coded segment of "Code A" will be
taken, all other comments of code will be deleted, even if the oldest coding has no
comment. If none of the existing coded segments has a comment, the comment is
taken from "B".

Because of overlapping coded segments, the number of coded segments of the target
code after you shifted codes can, of course, be smaller. If you move 10 coded
segments from "Code B" to "Code A" with 20 coded segments and several segments
overlap, you will not see 30 but fewer segments under "Code A".

Copying all the coded segments of a code
The function “Copy Coded Segments” is similar to the “Move Coded Segments”
function. The important difference is that the original code assignment will be
retained; that is to say, the coded segment will be duplicated and assigned to a new
code in addition to the original code.
This action is performed as follows:
1. Right-click on the selected code in the “Code System”.
2. Select Copy Coded Segments from the context menu that appears.
3. Move the cursor to the target code to which you want to copy the coding added
and click on it with the right mouse button.
4. Select Paste Coded Segments (from ‘old code‘) from the context menu that appears
Tip: In the code system, you can also copy a code including all segments assigned to it.
To do this, select the Duplicate Code with Coded Segments option from the context
menu of a code. Directly below the code, the new code is inserted at the same level
with the same name, supplemented by a consecutive number.
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Weight Scores for Coded Segments
When coding a document, you are attaching a segment of a text or image to a code in
the “Code System”. MAXQDA also allows you to assign a weight score to each of
these coded segments to indicate how important that particular coded segment is. It
may be that certain coded segments represent a typical argument or theoretical
concept that you want to be sure and hold on to. In this case, these segments are a
sort of signpost.
MAXQDA allows you to indicate how important or appropriate a segment is for the
code it is coded with by giving it a weight score between 0 and 100. This weight score
could be described as a “fuzzy variable”, because it is not meant to give an exact
numerical worth for the segment. Rather, it is intended to be a guide, so you can later
sort your retrievals based on the weight assigned.
The weight score can later be used as a sorting criterion for coded segments. In
numerous analysis functions it can be used as a selection criterion, allowing you to
include only coded segments with a specific weight into your analysis.
Please note: Every newly coded segment automatically receives the default weight
score, which can be a number from 0 to 100.
When you use MAXQDA for the first time, the default weight will be set to 0. This can
be changed in two places in the program:
●

●

In the main preferences which you can access via the gear symbol in the top right
corner of the MAXQDA window.
In the status bar at the bottom of the screen, by clicking on the Default weight icon.
A dialog window will appear where you can set a new default weight value. The
current value is always visible in the status bar.

Changing the default weight in the status bar

Code weight score display
The weight of a coded segment is shown in the source information below each
retrieved segment in the “Retrieved Segments” window. It is displayed behind the
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code name in brackets.

Weight score in the “Retrieved Segments“ window

Please note: The display of weight scores in your "Retrieved Segments" window can
be suppressed in the local window settings, which you can access via the gear symbol
at the top right. Uncheck the option Show weight to hide the weight score.
The “Overview of Coded Segments”, for example, which is available for document
groups, each individual document, and the whole project, also includes the weight
scores for each coded segment.

Adjusting the weight score for coded segments
When coding, the default weight score is always used automatically. A different
weight score can either be assigned in the window “Document Browser“, in the
“Retrieved Segments“ window, or in the “Overview of Coded Segments“.
Please note: How you choose to use different scales of weights is up to you. You could
make a ranking list with the top score of “1“, or use “100“ in the sense of a
maximum weight for important segments.

Assigning weight scores in the “Document Browser”
1. Right-click on the coding stripe for the coded segment that you would like to alter
the weight score for.
2. Select Modify Weight.
3. You can then enter a number between 0 and 100.
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Changing the weight score in the “Document Browser”

Assigning weight scores in the “Retrieved Segments” window
A weight score can also be assigned and modified in the “Retrieved Segments”
window. Right click anywhere on the coded segment or on the coding stripe displayed
next to it to open a context menu, where you can select Modify Weight and enter a
number from 0 to 100.

Changing the weight score in the “Retrieved Segments” window

Assigning weight scores in the “Overview of Coded Segments”
In the “Overview of Coded Segments” table, you will find a column for the weight
score of each coded segment. By double-clicking on a cell in the column, you will be
able to enter a new weight from 0 to 100.
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Change the weight score in the “Overview of Coded Segments“

Tip: You can also adjust the weight for several segments in this overview. To do this,
select all the rows of segments whose weight you want to change, and by rightclicking on the segment to open the context menu, select the Modify Weight option.

Comments for Coded Segments
You have the option of creating a short comment for each of your coded segments.
This might be an overview of the coded segment or a comment about its significance
for your analysis. Comments are particularly useful for the category development.
The difference between memos and comments is explained in the following research
blog article:
Read article
To create a comment for a coded segment, follow these steps:
●

●

In the “Document Browser”: Double-click on a coding stripe or on a code name - or
right-click on the coding stripe and select Edit Comment.
In the “Retrieved Segments” window: Double-click or right-click on the coded
segment or the coding stripe displayed next to it.

A window will appear in which you can enter the comment. The comment can contain
up to 255 characters, which corresponds to approximately 2 to 3 sentences, that is,
the length of this paragraph. Use Shift + Enter (⇧ + ↵) to create a line break.
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Window for entering comments

You can easily determine if a comment has been written for a coded segment when
you look at its coding stripe. Normally the inner part of the little circle is white in color,
independent of the color of the code symbol. When a comment is attached, the inner
circle appears in the same color as the outer line of the symbol. If you hold the mouse
on the coding stripe, the comment appears in the tooltip.

A coded segment with a comment (the circle in the middle of the coding stripe is filled)

Displaying comments in the sidebar of the “Document Browser“
You can display comments on coded segments right next to the data it is attached to:
right-click on the document displayed in the "Document Browser" and select Sidebar
> Comments.
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Displaying comments in the sidebar

You can adjust the width of the sidebar by dragging the border between the sidebar
and the document to the right or to the left. Right-click into the sidebar to see further
display options and to optionally also display memos at the same time.
Please note: It is not possible to display comments and paraphrases at the same time.
If you select to display paraphrases, comments are automatically switched off - and
vice versa.

Hover over a comment to highlight coded segment and to display delete option

If you move the mouse over a comment in the sidebar, the corresponding segment is
highlighted in the document as shown in the figure above. Click on the X at the right
top of the comment to delete it.

Edit and search your comments in the “Overview of Coded Segments“
As long as you haven’t changed the standard view, you can search all of your
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comments in the “Overview of Coded Segments” table in the second column. Here,
you can also insert new comments and delete/edit existing ones. By right-clicking on
the column header, the overview is sorted according to this header. You can search for
comments by right-clicking on the "Comment" column header and selecting Search.

Create, edit and search for comments in the “Overview of Coded Segments“

The Overview of Documents for a Code
To answer the question in which documents or document groups a certain code was
used, MAXQDA gives you the option to use the “Overview of Documents“. To show
this overview, right-click on a code and choose Documents in the “Overview“ section
of the context menu. It makes no difference whether the code has collapsed subcodes
or not – the “Overview of Documents“ takes into account only the code in question.
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Access the “Overview of Documents“ in the context menu for a code

A tabular list of all documents that have segments coded with the chosen code will
open. In the following example, the code “Siblings” was used in 6 documents and 2
different document groups. The column “Coded Segments” shows how many coded
segments were found in each document.
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“Overview of Documents” for a code

In the overview's head, the function Aggregate to document groups
is available.
This function aggregates the shown result from documents to document groups. It
shows all document groups in which the selected code appears. Taking the example
above, after clicking the button, the table consists of two rows with the document
groups “Interviews New York” and “Interviews Indiana”. The number of coded
segments is summed up.

Aggregating to document groups

Smart Coding Tool: Working with Coded
Text Segments
The Smart Coding Tool is designed for working with coded text segments and is very
well suited to performing the following tasks:
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●
●
●

Getting an overview of the contents of a category,
Reviewing and, if necessary, changing relevant categories,
Customizing your categorization system(s), particularly differentiating (i.e. breaking
down) parent-codes or aggregating codes.

To open the Smart Coding Tool for all coded segments of a project, navigate to the
Codes menu tab and click on the Smart Coding Tool icon.

Start Smart Coding Tool in the menu tab “Codes“

The Smart Coding Tool can also be opened for a compiled list of coded segments: click
on the Smart Coding Tool icon
●
●

in the “Retrieved Segments” window or
the tabular “Overview of Coded Segments“.

Opening the Smart Coding Tool from the “Overview of Coded Segments“

The Smart Coding Tool environment looks like this:
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The Smart Coding Tool

The window is divided into two display areas. The code system is displayed in the left
area. Here, you can select a code to display its coded segments in a table in the right
area. The selected code is highlighted in the code system tree and is displayed above
the table. Here, MAXQDA also displays how many coded segments (from how many
documents) are displayed in the table, that is, how many rows the table contains.
Please note: When you open the Smart Coding Tool from the “Overview of Coded
Segments” or the “Retrieved Segments” window, only the codes assigned to the
compiled coded segments will be displayed in the code system. To retain the
hierarchical structure, sometimes non-activated parent codes are also displayed. The
number at the end of a code row in the system indicates how often the code
appeared in the selected documents. When the Smart Coding Tool is opened, only the
documents from which the compiled coded segments originated will be activated.
Only their coded segments are displayed.
The individual columns in the table contain the following information:
Document – The source document from which the coded segment originates.
Coded segments – The coded segments of text, images, and PDFs.
Codes – The list of codes assigned in the area of the displayed coded segment. It
doesn't matter whether the code has only been assigned to one character of the
segment, the entire segment, or even beyond the boundaries of the segment. Only the
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codes that are visible on the left in the code system are listed. The selected code in the
code system tree and the direct parent code of this code are never listed in this column
to avoid redundant information.
Comments – A text field that can be freely edited (max. 255 characters) to add
comments to coded segments.
Like all MAXQDA table widows, the individual areas can be adjusted: the columns can
be adjusted in width and position with the mouse or hidden with a right-click on a
column heading. A click on the heading sorts the column in ascending order, another
click in descending order.
Please note: All other MAXQDA functions are locked while the Smart Coding Tool is
open.
When starting the Smart Coding Tool from the "Retrieved Segments" window, the
weight filter is ignored. Therefore, if segments were not displayed in the "Retrieved
Segments" due to the weight filter, they will still appear in the Smart Coding Tool.

Options in the ribbon menu
Only Activated Codes – restricts the display of the code system to the activated
codes only. This option is selected automatically when you open the Smart Coding
Tool form the “Overview of Coded Segments“ or the “Retrieved Segments“ window.
When turned off, all your codes and subcodes are displayed.
Only Activated Documents – restricts the display of coded segments to those in
currently activated documents. The display of frequencies in the code tree is adjusted
accordingly.
Filter – applies the filters you can define by right-clicking on the column heading
and selecting Set Filter.
Reset all Filters – removes all filters from all columns.
Display Parent Code – in addition to the code, the “Codes“ column also displays
its parent code.
Display Comments – displays the “Comments“ column.
Display Favorite Variables – shows additional columns for each favorite variable.
For example, you can display the age of a person or other background information
about a case. You can set favorite variables via selecting Variables > List of Document
Variables in the menu ribbon of MAXQDA’s main window.
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At the top right of the window there are two icons for the local undo function:
Undo – undoes the last action in the Smart Coding Tool.
Redo – redoes the last action in the Smart Coding Tool.

Create new code
You can always add new codes to use to code selected segments:
1. Click on the green plus symbol that appears while hovering over an existing code.

Add new code by clicking on the
green plus symbol
2. In the dialog window that appears, enter the code name. To better distinguish
between different subcodes, you can use different colors. You can also enter the
description of the new code into the “Code memo” field.
3. Click on Additional code if you want to add further codes. Click on OK to finish
creating new codes.
Newly created codes are automatically activated so that these are displayed in the
code system.
Please note: All changes to the code system using the Smart Coding Tool, including
the creation of new codes, are added directly to your overall “Code System”.

Assign a code
To assign a code to a coded segment, click and drag the line of the code to one of the
displayed codes in the code system. The newly assigned code is then immediately
displayed in the “Codes“ column. To code only part of a coded segment, first doubleclick on the whole coded segment text, then select the portion of text you want to
code, and drag it to one of the codes in the code system. Even if you assign the same
code to several sections of a coded segment's text, the code name will only be listed
once in the "Codes" column.
If you hold down the Ctrl key (Windows) or ⌘ key (macOS) while dragging-anddropping a whole line with a coded segment onto a code, the complete coded
segment is moved to the selected code. It will thus no longer be displayed.
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Assigning a code to a coded segment text.

Tip: By right-clicking on a row and selecting Create and Assign New Code, you can
add a code and assign it to the entire coded segment.

Search and autocode coded segments
You can search the text segments in the Smart Coding tool for terms and have the
results automatically coded with a code.
Autocode hits from local search
To perform a local search in the segments currently displayed in the right window:
1. Click on the magnifying glass in the header of the table at the top right to show the
search bar.
2. Enter a search term.
3. Click on the filter icon in the search bar to display only the answers with hits (this
step is not mandatory for autocoding, but it is very helpful for a quick overview of
the segments containing the search hit).
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Hits of local search

To code the segments that contain a search hit, click the Autocode search results with
a new code icon in the search bar:

Autocode local search hits

A menu opens in which you can set whether only the hit should be coded with a new
code or whether the surrounding sentences or paragraphs should be coded. For short
segments, the first option is usually the best choice, because then the entire segments
in which the search item was found is coded.
After selecting the context to be coded, a dialog box for creating a new code appears.
And after clicking OK, the code is assigned to the selected context:

Automatically coded segments

The code name can be adjusted at any time in the code system on the left.
Perform complex searches and autocode results
The local search bar provides only limited search functionality and is limited to the
segments currently listed in the right pane. If you want to perform more complex
searches, click Search and Autocode in the ribbon menu:
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Start text search

This opens the MAXQDA “Text search” window:

The “Text search“ window

In the window, several search items can be entered that must appear all in a coded
segment; in the example, a search is performed for the words “happiness” AND
“psychology” within the same response. The search for two or more search items
using the AND search can also be limited to paragraphs or sentences.
The options for the search correspond to those of the text search and are described
there in detail. In addition, there is the option Only in listed segments, which ensures
that only the segments currently listed in the right-hand window are searched. If you
switch off the option, MAXQDA will search all answers that are currently available in
the working environment (the number of available segments is shown in the first line
of the code tree in the left pane).
After clicking Search, the segments with hits are listed in the right pane of the
window:
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List of search hits and starting autocoding procedure

To automatically code the segments with a new code, click on the icon of the same
name as shown in the previous figure. A menu appears where you can set the context
for autocoding:
●
●

Either the entire segment is coded
or the highlighted search hits only.

After selecting the context to be coded, a dialog box for creating a new code appears.
After clicking OK, the code is assigned to the selected context. The code name can be
adjusted at any time in the code system on the left.

Remove assigned codes
To remove an assigned code, click the "X" that appears when you move the mouse
over a code in the "Codes" column. All assigned codes are then removed from the
coded segment.

Removing an assigned code from a coded segment.

Customize your code system
Your code system can be customized throughout the entire analysis process. You can
change the order of codes with the mouse and even insert them as sub-subcodes. By
right-clicking on a code, all the functions from the overall "Code System" are available
to customize your code system in this window:
●

Delete code
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●
●
●

Sort subcodes (alphabetically or by category frequency)
Change code color
Create or edit code memo

Click a code in the code system to list all the segments coded with this code. This way
you always have an overview of the contents of your categories. The selected code in
the code system is highlighted. The name of the selected code is also displayed above
the listed segments.

Display all codes of a coded segment

Please note: The "Codes" column always shows which codes have been assigned to
the segment in addition to the currently selected code. This column will never show
the parent code of the selected code.

Moving or copying individual coded segments
By default, if you drag a coded segment onto a code, that code will be assigned to the
segment in addition to other previous codes assigned to it. The segment will still be
coded with the code whose other segments are displayed in the right window.
If you hold down the Ctrl key (Windows) or ⌘ key (macOS), however, while dragging
a coded segment to a code, the code will be replaced. That is, the code whose
segments are currently listed in the right window is removed and the segment you
dragged to a different code disappears from that list.
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This function is especially useful if you want to transfer a coded segment from one
subcode to another subcode, because the latter suits better in terms of content.

Moving or copying all coded segments of one code to another
To move or copy all segments of a code to another code, right-click on a code and
select the function Move Coded Segments or Copy Coded Segments in the context
menu.
Then right-click on the target code and select the corresponding function: Paste
Coded Segments (from ‘Code xy‘). For more information on this feature, refer to the
section Move or copy all coded segments of a code.

Working with comments on coded segment
In the “Comments“ column, you can write a comment regarding each coded
segment. The comments are stored as Coded Segment Comments for the code
currently selected in the code tree on the left.
In the comments field, you can add notes about the coded segment texts, ideas for
new categories, and more. They are also suitable for keeping track of your analytical
procedure (i.e. "still unclear“ – "come back to this again later") or for other team
members ("please cross-check this!").
Double-click on a cell in the "Comments" column to enter a new comment or edit an
existing one.

Entering a comment on a coded segment.

Export your display
Your current display can be exported via the usual icons at the top right of the
window. All the rows (coded segments) in the right field are always exported.
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Export – Creates a table (XLSX), a text document (DOCX) or a website (HTML).
Open as Word document – Creates a Word document and opens it.
Open as Excel spreadsheet – Creates an Excel spreadsheet and opens it.

Code Cloud
Code Clouds visualize the most frequently used codes as word clouds. They are
particularly suitable for exploring and illustrating the use of codes in a project. The
code cloud can represent the codes used across all the documents in a project or only
a selection of documents.

Code Cloud

Opening the code cloud
You can generate a Code Cloud for a single document, a document group, a
document set, or all documents in a project. Right-click on the appropriate level in the
"Document System" and select the entry Code Cloud.
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Alternatively, you can also access this function via Codes > Code Cloud in the main
ribbon menu. A dialog box will appear in which you can select documents and codes
to be considered in the visualization.

Code Cloud settings
The settings for Code Clouds are very similar to those of word clouds and are
described in detail there. The differences are minimal:
●

●

●

The entire code name is always displayed and can therefore consist of several words,
as in the example in "unpaid work".
The Minimum Frequency option in the Start tab refers to the number of codes
assigned in the selected documents.
Some functions of the word cloud, such as "Word Frequencies", the "Stop Word
List" and "Ignore Numbers" are not available, since these do not make sense for a
code cloud.

05 - Coding

255

06 - Creative Coding
The Idea behind Creative Coding
During an open coding stage of their analysis process, researchers may create many
codes which in hindsight vary greatly in their scope and level of abstraction. Creative
Coding effectively supports the creative process in which these codes are generated,
sorted, and organized, and in which a hierarchical code structure is created based on
the relationships between codes. The function provides a large workspace on which
you can move codes and form meaningful groups. You can place codes that belong
together next to one another, insert parent codes, rename codes, change their color,
and create a logical structure. Usually, however, this logical structure is the result of a
long period of open coding and working with the codes.
The functionality of Creative Coding is carried out in three steps:
●

●

●

First, drag the codes you want to work with from the "Code System" into the
Creative Coding workspace.
Next, group and organize the codes, create parent and subcodes, define new codes
if necessary, and change the color of the codes as desired.
Finally, transfer the changes to your existing "Code System".

Start Creative Coding and Select Codes
To start the Creative Coding process, click Creative Coding in the Codes menu tab.
MAXMaps will then activate Creative Coding Mode and the following workspace will
appear:
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Selecting Codes for Creative Coding

Now, single codes can be dragged from the "Code System" onto the blank workspace
on the right with the mouse. If you select a code with subcodes, MAXQDA will insert
the subcodes automatically onto the workspace.
You can select multiple separate codes by holding down the Alt key (Windows) or
option key ⌥ (macOS) and then drag the selection onto the Creative Coding
workspace while holding down the mouse button. To select a range of codes, first
click on a code and then click on a second code while holding down the Shift key ⇧.
This will also select all codes between the clicked codes.
To search for a code in a potentially very long code system, you can click on the
magnifying glass above the codes. There is also a sort icon to sort the codes within
each hierarchy level by alphabet.

06 - Creative Coding

257

Selected codes for Creative Coding

To remove a code from the workspace, right-click the code and select
Map in the menu tab Start.
After completing your selection, click the
left of the screen.

Remove from

Start Organizing Codes symbol at the top

Please note: While MAXQDA's Creative Coding Mode is activated, the MAXQDA
application is blocked and no further changes can be made to the open project until
Creative Coding is finished.

Organize Codes
Once you have clicked on Start Organizing Codes on the Start menu tab, you can
start structuring and organization your codes. The display will change at this point; the
"Code System" on the left will close and a color panel appears that displays all of the
colors currently in use in the project together with the standard colors of MAXQDA.
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Organizing codes on the Creative Coding workspace

All codes can be freely arranged on the workspace with the mouse. You can move
multiple codes at once by drawing a border around them with the mouse and then
positioning them as desired.
The following options are available in Creative Coding Mode:
●
●
●
●
●
●

Creating relationships between codes
Creating new codes
Merging codes
Modifying code colors
Undoing changes
Displaying coded segments and code frequency of a code

Please note: All changes made in Creative Coding Mode are not directly added to the
"Code System". These are added when Creative Coding is closed.

Creating connections between codes
As displayed in the image above, connections between codes are shown with an
arrow: When an arrow is pointing at a code, it means that this code is a subcode of
the other. In the above image, for example, the code "Sports" is a subcode of the
code "Interests".
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To make Code A a subcode of Code B, proceed as follows:
1. Go into Link Mode by clicking the Link (Define as Subcode)
symbol on the Start
menu tab. Alternatively, use the shortcut Ctrl+L (Windows) and ⌘+L (macOS) to
activate/deactivate the Link Mode.
2. Click on the desired top-level code and draw an arrow to the desired subcode.
To avoid the occurrence of circular references, existing assignments of the subcode to
other codes are removed.
To delete an arrow, right-click on it and select Remove from Map.

Adding new codes
Users often wish to group multiple codes under an abstract concept. For this purpose,
you can always create new codes by clicking the New code symbol on the Start
menu tab. MAXQDA will subsequently insert the new code in the top left of the
workspace.
You can rename the code by double-clicking on its label.

Merging codes
To merge two codes, proceed as follows:
1. Drag a code with the mouse button pressed down onto another code until the info
box "Merge codes" appears at the mouse cursor.
2. When you release the mouse button, the following confirmation message will
appear:

Confirmation message for
merging of codes
3. After clicking on Yes, the shifted code disappears from the map and its code
assignments are assigned to the target code.
If you have activated the display of the code frequencies, you can directly see that the
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number of coded segments under the target code has increased. Since some segments
may already be coded with the target code, the frequency displayed may be less than
the sum of the code frequencies of the merged codes. The merge is provisional until
you quit Creative Coding, thereby updating the code system. Then the coded
segments are assigned to the target code and the source code is deleted in the code
system.
If you choose Don’t ask again, the inquiry for the merging of codes will no longer
appear in the current Creative Coding session.

Dealing with memos when merging codes
Of course, both codes may include a code memo. In this case MAXQDA will ask you
how to deal with the memo content of the moved code:

Changing the color and appearance of codes
The color of codes can be modified as follows:
1. First, make sure that the Link Mode is off. If necessary, click on the white surface
once to turn off Link Mode.
2. Click the code whose color you wish to change. To select multiple codes at once,
draw a border around the codes with the mouse or click on each code while
holding the Ctrl key (Windows) or ⌘ key (macOS).
3. To assign a color, click on a displayed color in the color panel on the left or click on
Choose new color… to select another one.
If you change the color of a parent code, the color of the subcodes will also be
changed following confirmation.
As soon as you select one or more codes, the Format menu tab appears at the top of
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the window. You can use this tab to adjust the way the codes are displayed, for
example, to enlarge the caption and make it bold.

Undoing changes
Recent actions can be undone step-by-step by clicking the Undo Changes
the top right corner of the user interface.

symbol in

Displaying the code frequency and coded segments of a code
In order to organize codes, it can be helpful to visualize the amount of associated
coded segments. By clicking the Code Frequencies
symbol on the Start menu tab,
the code frequency will be automatically displayed in brackets after the code name.
When you right-click on a code, a context menu will appear from which you can
access the following options:
●
●

●

Memo – Opens the associated code memo.
Overview of Coded Segments – Opens a tabular overview, in which you can inspect
the coded segments of the code.
Overview of Linked Memos – Opens a tabular overview in which you can browse all
memos of the selected code.

Saving the current state of the process as a MAXMap
Working on the code structure with Creative Coding may take some time and may
include different stages of development. While you start with arranging codes in
groups first, you possibly are merging codes and creating new higher-level codes later
on. To track these different stages, MAXQDA allows you to save the current status of
your work as a regular MAXMap: just click on
Save as a Map in MAXMaps icon on
the Start menu tab. The map will be available after quitting Creative Coding when you
start Visual Tools > MAXMaps from the main menu.

Quit Creative Coding and Transfer
Changes to Code System
Changes made in Creative Coding Mode will be applied to the “Code System”
window only once you quit Creative Coding. To do this, click the Quit Creative
Coding symbol on the Start menu tab in the top left of the window. The following
message will appear:
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Quit Creative Coding

The following options are available:
Yes – the code structure will be transferred to the existing Code System
●

●
●
●

●

All codes from the Creative Coding workspace that do not have a parent code will
be sorted alphabetically and inserted at the top of the Code System. This applies also
to newly created codes.
Subcodes will be inserted according to their hierarchical position.
Any color changes to codes will be applied.
Merged codes will be merged, i.e. the origin code will be deleted and its coded
segments will be moved to the target code.
The Creative Coding map will be converted into a normal MAXMap.

No – Creative Coding will be closed without transferring the changes to the "Code
System". This means all changes will be lost!
Cancel – returns to Creative Coding.
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07 - Transcription
Transcribe Audio and Video Files
MAXQDA enables you to transcribe audio and video files manually. Automatic
transcribing is not supported, but MAXDQA can easily import transcripts created with
tools for automatic transcription. In the section Import transcripts you will find a list of
tools for automatic transcription for which the transfer of time stamps is easily
possible.
To get started with your transcription in MAXQDA, you must first import the audio or
video file into your project. To do this, simply drag the file into MAXQDA’s “Document
System” window with your mouse. Alternatively, go to the Import menu tab and click
on the Audio or Videos icon (for more details on import, see here).
Please note: During import of a media file, you will be asked if you already have a
transcript for the selected media file that you want to import – you must answer No to
this question.
When importing a recording, an empty text document is created in the "Document
System", to which the audio or video file is assigned and in which you can write the
transcript. These text documents with their associated media file can be recognized by
special symbols in the "Document System". Transcripts of audio files feature a musical
"note" and transcripts of video files a video camera:

Special symbols for audio and video files in the “Document System” window

Activating Transcription Mode on
To start transcription, right-click on the document and select the option Transcribe
Audio File or Transcribe Video File.
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Start transcription by right-clicking a document

This activates MAXQDA’s Transcription Mode, in which the windows you need for
transcription are optimally arranged:
●
●

●

The “Multimedia Browser” is displayed and placed at the top of the screen.
The "Document Browser" with the transcript is displayed directly below - where you
can write your transcript.
A dialog window is displayed to the left of the “Multimedia Browser” where you can
adjust all your settings for the transcription.
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Transcription Mode

Starting the transcription process
Now you can play the recording and start writing. To play and pause,
●
●

●

press F4 or F5,
or press Ctrl (Windows) or Shift ⇧ (macOS) twice in succession (this way you don't
have to move your fingers very far),
or use the play and pause icon in the “Multimedia Browser”.

To quickly navigate to a certain spot in your audio file, use the slide control in the
“Multimedia Browser” window or use the keyboard combination F12 and ⇧+F12 to
forward or rewind 5 seconds.
Tip: How to use the function keys for transcription on a Mac is described in our
Frequently Asked Questions.
The transcript and the recording are linked to each other using time stamps. For
detailed information on using time stamps, see this section.
The transcription text is stored automatically in the project file every 5 minutes. You
can change this time interval in the global settings of MAXQDA. To access the
settings, click the gear icon at the top right of the MAXQDA main window.
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Adjusting the rewind interval, volume, and playback speed
A rewind interval of 2 seconds is set by default, so you can continue your flow when
you resume playback. You can adjust this interval at any time, to a time between 0
and 10 seconds, in the Transcription Settings.

Adjust rewind interval

Tip: You can close the Transcription Settings window if you don't need it. You can
open it at any time by clicking on the Transcription Settings icon on the left side of the
“Multimedia Browser”.

Open transcription settings and the control panel

To adjust the volume and playback speed, click the Control Panel icon in the
“Multimedia Browser”. The following dialog window will appear, which allows you to
adjust the volume and speed of playback.

Adjust the volume and speed of playback in the Control Panel
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Coding while transcribing
You can code the typed text with new or existing codes during transcription. To do
this, highlight a text segment, for example, and drag it to a code in the "Code
System".
TAll the usual functionality of the “Multimedia Browser” is also available. This makes it
possible to highlight and code sections, and to set memos and internal links directly in
the audio or video file. For detailed explanations on using the “Multimedia Browser”,
please refer to the section for coding videos.

Stopping and resuming the transcription
You can start and stop Transcription Mode at any time - just close the “Multimedia
Browser”.
To resume working on a transcript, right click on the document and select Transcribe
Audio File or Transcribe Video File.

Transcribing with a foot pedal
For faster and easier transcription, MAXQDA supports the following foot pedals from
Audiotranskription:
●

●

●

The yellow “Science” switch has the same functionality as the F4 or F5 key
(depending on the software setting inside the foot pedal): press once to play, and a
second time to stop.
The black “Science II” switch must be held down to play media data and will stop
playing when released.
The "Office" footswitch has three buttons: Press the left button to rewind 5
seconds, the right button to fast forward 5 seconds. Press and hold the middle
button to playback the media file and release to pause playback

Tip: The "Office" footswitch is the same as Infinity's popular 3-button footswitch.

Automatic Speaker Change and Autotext
Automatic speaker change
When transcribing a recording with two speakers, you can switch on the automatic
speaker change in the Transcription Settings. As a result, each new paragraph begins
automatically with a freely definable name, pseudonym, or abbreviation.
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Follow these steps:
1. If you have not already done so, start Transcription Mode by right-clicking on a text
document with an associated audio or video file and selecting Transcribe Audio
File/Video File
2. Select the option Automatic speaker change in the Transcription Settings dialog
window.
3. Enter names for each speaker. It's a good idea to add a space on the end too.
4. Select the Bold option if you want the speaker names to be emphasized.

Transcription Settings

If you can't see the transcription settings, you can open it by clicking the Transcription
Settings icon on the left side of the "Multimedia-Browser".
If "I:" and "R:" are entered for the names of the two speakers, as shown in the figure
above, the next name will be entered automatically for each paragraph change in the
transcript, saving you a lot of typing.
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Automatically entered “I:” and “R:”

Autotext
In the Transcription Settings you can also define abbreviations, which are automatically
replaced by text when two spaces are entered behind the abbreviation. This is
particularly useful when you transcribe a group discussion with several speakers,
because then the names of the participants can be filled with shortcuts and you can
save yourself a lot of typing. Likewise, you can also use frequently recurring and
difficult to type transcription elements with brackets, e.g., "(unintelligible)" or "(2)"
for 2 seconds pause as autotexts.
The autotexts shown in the following picture are defined for all new MAXQDA
projects by default. The abbreviations can be up to three letters long.

Autotexts make transcribing easier

You can use the Bold setting in the last column to control whether the text is inserted
in bold script.
The autotext is stored in your project so that you can also use different computers with
MAXQDA installed for transcription without having to reenter your required autotexts.
A total of 15 autotexts can be stored. The entire autotext function can be switched off
by deactivating this option in the Transcription Settings.
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Link Transcript to Recording with
Timestamps
With timestamps you can link your transcript to the original recording so that you can
always access the original sound and listen again to sections that are difficult to
understand.
By default, MAXQDA automatically enters a timestamp at each end of a transcribed
paragraph, which is usually at the end of a speaker's contribution. The timestamps
appear in a separate column in the “Document Browser”, left to the transcription text.

Timestamps in the “Document Browser”

Clicking on a timestamp (or the range between two timestamps) opens the associated
media file and starts playback at the stored position. Playback automatically ends at
the next timestamp.
Automatic timestamp addition can be activated and deactivated in the Transcription
Settings window. If the window sis hidden, you can open it by clicking on the
Transcription settings icon on the left side of the “Multimedia Browser”.

Turn on/off option to add timestamps at the end of a paragraph
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Please note: You can hide the display of the timestamps next to the transcript by rightclicking the text and de-selecting Display Timestamp Column.

Add timestamps manually
While transcribing, you can also manually insert timestamps into a transcript, such as
to mark a difficult to understand section:
●
●

To do this, click on the New timestamp icon in the “Document Browser”,
or press F6.

Add timestamps in current position

MAXQDA then inserts a timestamp where your cursor blinks in the text and visualizes
it in the time stamp column at the left margin. You can also create multiple
timestamps in a row, but only one timestamp is displayed in the timestamp column.
Timestamps can't be inserted at will, however, MAXQDA instead checks whether the
chronology of timestamps is retained by inserting a timestamp. If, for example, the
current playback position of an audio file is at 3 minutes, but before the current text
position a timestamp already exists at 4 minutes, no further timestamp can be added.
Please note: New time stamps can be inserted not only during transcription (i.e., in
Transcription Mode), but also later in Edit Mode (see Insert Timestamp into a
Transcript).

Delete timestamps
To delete an unnecessary timestamp, click on the symbol in the timestamp column
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with the right mouse button and select Delete Timestamp in the context menu.
There is also an "Overview of Timestamps", which lists all timestamps of the currently
opened transcript. You can open the overview by clicking on the icon with the same
name at the top of the “Document Browser”. In the overview, you can delete
timestamps by marking one or more rows and clicking the delete icon.

The “Overview of Timestamps” lists all the timestamps in a transcript

Insert Timestamps into a Transcript
MAXQDA lets you insert timestamps into a transcript retroactively in order to link
places in the text with the corresponding locations in the audio or video file. This can
be helpful in several cases:
●

●

●

After the transcription, an important text passage was identified where access to the
original sound should be possible.
A transcript without timestamps was imported and the timestamps automatically set
during import are to be supplemented or changed.
An incorrectly set timestamp is to be corrected.

Requirement: an audio or video file is associated with the transcript
A prerequisite for inserting time stamps in a transcript is that an audio or video file has
been assigned to it in the “Document System”. You can see whether this is the case
by checking the symbol of the text document. Transcripts with assigned audio file have
a note as symbol and transcripts with assigned video file have a camera:
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Transcripts with assigned audio and video file in the “Document System”

In case your transcript does not have an audio or video file associated with it yet, you
can accomplish it this way:
1. Right-click the document and select Link Audio/Video File.
2. In the file dialog that appears, select the associated media file.
3. A dialog appears in which you can specify that timestamps should be set
automatically at a specified distance (the timestamps are distributed linearly across
the transcript, so clicking on a timestamp only positions the playback approximately
at the corresponding position).

Inserting timestamps into a transcript
Preparations:
1. Open the transcript by double-clicking on the document name in the “Document
System” so that it is displayed in the “Document Browser”.
2. To the left of the text, you should now see the column for the timestamps. You can
recognize them by the clock symbol that appears at the very top of the column:

Timestamp column left to
the transcript in the “Document Browser”
3. If the column is not visible, right-click in the text and check if the Display Timestamp
Column option is enabled.
4. Open the media player by right-clicking on the document name in the “Document
System” and selecting the Open Audio File or Open Video File option. (Alternatively,
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you can also click on the small note or camera icon in the “Document Browser”
toolbar).
5. Switch on Edit Mode by clicking on the pencil icon in the top right corner of the
“Document Browser”.

Switch on Edit Mode in “Document Browser”

Start playback and insert timestamp:
6. Place the blinking text cursor at the text position where you want to insert a
timestamp.
7. Position the playback in the "Multimedia Browser" to the corresponding audio or
video location. You can start and pause playback by pressing the F4 or F5 function
key or by pressing twice the Ctrl key (Windows) and Shift ⇧ key (macOS). For quick
navigation, use the slider in the “Multimedia Browser” or press F12 and ⇧+F12 to
fast-forward and rewind five seconds. If your transcript already has timestamps,
click a timestamp before the insertion point to start playback at that point.
8. Now click on the icon New timestamp in the "Document Browser" or press F6.
Tip: How to use the function keys for transcription on a Mac is described in our
Frequently Asked Questions.
In the timestamp column, you can see that for every new timestamp a symbol is
inserted at the desired position.
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Insert timestamp into a transcript

Timestamps can’t be inserted at will, however, MAXQDA instead checks whether the
chronology of timestamps is retained by inserting a timestamp. If, for example, the
current playback position of an audio file is at 3 minutes, but before the current text
position a timestamp already exists at 4 minutes, no further timestamp can be added.

Listen and View Transcript and Sound at
Same Time
MAXQDA allows you to play an audio or video file at the same time as the transcript.
You can view media files synchronized to their transcribed texts, like a teleprompter
for a television presenter, or karaoke, in which you can read the text along to the
sound playback.
To start a synchronized playback, follow these steps:
1. Quit the Transcription Mode if it is still switched on.
2. Open the transcript by double-clicking on the document name in the “Document
System”. This will display it in the "Document Browser" window.
3. Click on the Sync Mode symbol in the “Document Browser” toolbar.
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Activate Sync Mode in the “Document Browser”
4. Open the “Multimedia Browser” by clicking on the icon Open audio file (file
name), also found in the “Document Browser” toolbar.
5. Start Playback using the Play symbol in the “Multimedia Browser” or the F4 key.
If you change the playback position with the slider in the “Multimedia Browser”, the
transcript jumps to the corresponding text point. This also works when you click
anywhere in the media file, which in turn changes the playback position.

The Overview of Timestamps
The “Overview of Timestamps” lists all timestamps in the currently opened transcript.
To open this overview, click on the icon of the same name in the "Document
Browser" toolbar.

Open the “Overview of Timestamps”

The “Overview of Timestamps” has as many rows as there are timestamps in the
document, and every row has several columns. The first two columns contain the start
and end points of that segment. In the third column, you have the option of writing in
a short comment about that particular segment. The “Duration” column provides the
length of the respective segment.
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The “Overview of Timestamps”

This “Overview of Timestamps” table and the “Comment” column both function just
like any other MAXQDA table. You sort the order of comments or search for a
comment.
Tip: To search for a comment, right-click on the “Comment” column header and
select Search.
The option to write your comments in the list of timestamps also gives you a new way
to find sections of your media file. You can use comments to organize and quickly
access certain sections. Double-clicking on a row takes you to that section of the text
in the “Document Browser” and starts playback of the media file from that point.
Please note: Each transcript to which a media file is assigned contains at least one
timestamp at position 0, the beginning of the document.
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08 - Memos
About Memos
MAXQDA makes it possible to create your own notes and remarks and to attach them
like post-it notes to text passages, texts, document groups, images, audio/video clips
and of course codes. In MAXQDA these remarks are called "memos". Such a memo
can contain very different things: While one memo contains a short summary of an
interview or hints for its course, another memo contains first ideas for theory
development or hints for the use of a developed category.
Especially in social science it is common to work with memos and there it is above all
the research style of Grounded Theory developed by Glaser and Strauss in which
memos play an important role. But regardless of the research method chosen, it is
important to clarify the difference between the memos and the qualitative data: The
qualitative data are processed and analyzed but are usually not significantly changed
once the evaluation and coding has begun - at best, typos are eliminated. Memos, on
the other hand, are a dynamic type of text, they are products of the users and can be
changed, supplemented, modified, and integrated at any time.
Please note: The difference between memos and coding comments is explained in this
research blog article.
In MAXQDA you can assign memos in numerous places:

„Document System“

• Documents
• Documentgroups
• Documentsets
• Root of the Document System

„Document Browser“

• Segments in texts, spreadsheets and images

„Multimedia Browser“

• Positions in audio and video files

„Code System“

• Codes
• Codesets
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Memos in the MAXQDA User Interface

There is also a memo type, the "free memo", which is not directly assigned to a
position in the data, nor to a document or code. Such memos also exist in the research
style of Grounded Theory, they do not belong to a certain original text, but exist freely
floating without concrete assignment.

Opening and Editing Memos
To view and edit an existing memo, double-click the yellow memo icon with the left
mouse button and the following memo window will appear.
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The Memo Window

In the upper area of the memo, you can assign a meaningful memo title - just click on
the bold title with the mouse. A memo title may contain up to 127 characters. In the
upper right corner MAXQDA shows when and by whom the memo was last edited.
Hold the mouse cursor over this information to see who originally created the memo.
The actual memo is written into the large text window:
●

●
●

At the top, there is a toolbar for formatting the text, so you can create enumerations
and numbers, for example.
By clicking on the icon, you can prepend the creation date to a new entry.
A table can be inserted by right-clicking in the text window and selecting Insert
Table.

Tip: If you want to use parts of a text opened in the “Document Browser” in a memo
as a quote, you can select a text passage and drag it into the memo by holding down
the mouse button. By default, MAXQDA automatically adds the document name and
the position of the inserted text as source at the end of the text.

Saving memo content
MAXQDA is saving all entered information and changes to a memo when closing the
window. In addition, the memo window will be saved regularly, and you can adjust
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the time interval in MAXQDA’s global settings. The default setting is 5 minutes.

Memo symbols
You can assign either the yellow standard post-it symbol or one of eleven other
symbols to each memo. This makes it possible to indicate what kind of memo it is. The
following symbols are available:

Memo visualization options

Each user can assign the symbols to specific memo types as desired. For those who
work according to the Grounded Theory method, it is recommended, for example, to
use the symbol T for theory memos, M for method memos, and the question mark for
memos that refer to the further collection of data (theoretical sampling).
By clicking on the cogwheel symbol in the memo window, you can record the
meaning of each memo symbol in the current research project. The so-called “memo
labels” are saved on a project-by-project basis, i.e., different memo labels can be
defined in different project files.

Define memo labels by clicking on the cogwheel symbol in the memo window

Tip: By moving the mouse over a yellow memo symbol in MAXQDA, a small
information window appears with the title of the memo, the last modification date, if
defined the assigned label for the memo type as well as the beginning of the memo
text.

Deleting memos
To delete an open memo, click on the red "X" at the top right of the window.
Tip: You can also delete a memo on the spot by right-clicking the memo icon and
selecting Delete Memo.

Copying memos
You can duplicate a memo by right-clicking the memo icon and selecting Copy Memo.
Click again with the right mouse button on a place in MAXQDA where you can place
a memo - e.g., in the memo column in the "Document System" - and select the
option Paste Memo here.
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Print and export individual memos
To print an open memo, click the Print
window.

icon in the toolbar at the top of the memo

To export an open memo, click the Export
icon at the top of the memo window. In
the dialog box that appears, you can select export format (DOCX, HTML, or PDF) and
the contents to be exported. For example, you can include the codes linked to the
memo in the export.

Options for exporting a memo

Opening Multiple Memos at Once
You can double-click several memo symbols one after the other to open each memo in
its own tab. The tab display makes it possible to quickly switch back and forth
between different memos. A click on the symbol "x" in the tab line closes the
currently displayed memo.

Multiple open memos in tab display

Tip: Click the Undock window
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symbol to pull individual tabs out of the memo window, so you can view multiple
memos at the same time, each in their own Memo window.

Memos in Documents
Memos can be attached to any text or image position similar to sticky notes in a book
or article:
You can create memos in documents like this:
1. In the document, select an area to which you want to assign a memo, e.g., a text
passage that is interesting for theory or contains contradictory content.
2. Right-click the selected segment and choose Insert Memo for Selection from the
context menu.

Insert memo for selected text segment

The memo window in which you can write your memo appears. MAXQDA
automatically assigns the memo title “Memo x” to new in-document memos, where x
stands for a consecutive number. You can change this title at any time by clicking on it
with the mouse.
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In-document memo

After closing the memo, the selected memo symbol appears to the left of the
document in the so-called “Memo column”. If the sidebar is switched on, the memo
text is also displayed to the right of the document.

Memo icon in the memo column (left) and display of the memo in the sidebar (right)

To reopen the memo later, double-click on the memo icon in the left memo column or
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on the memo display in the right sidebar.
Please note: If you turn on Edit mode and delete a text passage to which a memo is
assigned, the memo is retained and automatically assigned to the previous text. This
feature is designed to prevent valuable notes from being deleted unintentionally.

Creating memos by double-clicking in the memo column
You can also create a memo directly in the memo column to the left of the text at any
time: Double-click at desired document position to attach the memo.

Creating a memo by double-clicking in the memo column

When creating a memo by double-clicking in the memo column, the memo is
automatically attached to the document position at the click position on the left
margin.
The number of memos per document and per document location is not technically
restricted, i.e., you can create several memos at the same height in the “Document
Browser”. MAXQDA then automatically displays them next to each other, the memo
column width is automatically adjusted.

Modifying document position of a memo
You can adjust the assignment of a memo to a text or image section any time:
1. Select the area to which you wish to assign the memo.
2. Right-click the memo icon in the memo column in the “Document Browser” and
select Attach Memo to Current Selection.

Displaying memos in the sidebar
In the sidebar to the right of the document, you can display memos, paraphrases, and
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comments on coded segments. To display the sidebar, you can either
●
●

right-click in a document and select Sidebar > Memos or
click on the small icon Show Sidebar in the upper right corner of the "Document
Browser".

Display memo in sidebar

The contents of the memos are displayed in the sidebar at the height of the
corresponding text or image segment. Since memos can be very long, only one memo
at a time is displayed in the sidebar; the blue arrow icons within the yellow memo
indicator jump back and forth to the next or previous memo. The memo content
displayed is limited to 2,000 characters, corresponding to about three quarters of a
page of text.
Displaying memos in the "Document Browser" is interactive:
●

●

●

Click a memo icon in the left memo column once to highlight the corresponding text
or image segment and display the memo content in the sidebar.
Double-click the memo icon in the left memo column or the sidebar to open it for
editing.
When you hover the mouse over a memo in the right sidebar, the corresponding text
or image segment will be highlighted.

In the sidebar, in addition to the memos, the paraphrases of the document or the
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comments of coded segments can be displayed, but not both at the same time. If you
right-click on the sidebar (not on a memo, but on the grey background area), a
context menu will appear in which you can specify which content should be displayed
in the sidebar.

Select contents of sidebar

Memos in the Document System Window
Memos can be assigned at all levels in the "Document System" window, i.e., the
individual documents, the document groups, the document sets, and also to the root
of the document tree. Unlike positions within a document, only one memo can be
assigned to each object.
There are several options for creating a new memo in the “Document System”:
●

●

●

Right-click on a level of the Document System and select the Memo option from the
context menu.
Alternatively, you can create a memo for the currently selected document or level
using the keyboard shortcut Alt+⇧+M (Windows) or ⌥+⇧+M (mac OS).
The fastest way to create a new memo is to double-click in the memo column to the
left of the code frequencies.
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Creating a memo for a document from the context menu

The appearing memo window is exactly the same as for other memos. As title, the
new memo automatically uses the document name, which can be changed at any time
by clicking on the title.
Whether a document or a document group has a memo is visualized in the
"Document System" by the selected memo symbol.

Visualization of a memo in the “Document System”

The memo in the first row of the window, the so called “project memo”, can be used
to enter a description of the whole project. The memos of individual documents can
be used, for example, to save a summary of the text that is always immediately
accessible. One should also consider that when moving the mouse over a memo
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symbol, an information window appears containing the first lines of the memo text. It
is therefore a good idea to start the memo with some important information

Document summaries
Each document of a MAXQDA project can be assigned a memo in the “Document
System” window, the so-called “document memo”. These memos offer an additional
text field at the bottom in which a summary for a document can be recorded, called
the “document summary”. Here, for example, you can write down the most important
contents of an interview, while the memo text is used for notes on the interview
situation.

Document summary in a document memo

If you have created case overview tables with thematic summaries using the Analysis >
Summary Tables feature, you can use the document summaries in the memos for an
integrative case summary. For this purpose, the summaries of a case are consolidated
in condensed form in the document summary.
For more information on working with summary features in MAXQDA, refer to the
chapter Summarizing.

Code Memos
You can write a memo for each code. Code memos can be used, for example, to
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retain the definition of a category, including anchor examples that illustrate the
meaning of the category using original quotations. If you work according to the
research style of Grounded Theory, you can record all thoughts about the concept or
category in a code memo.
There are several options for creating a new memo in the "Code System":
●
●

●

Right-click on a code and select Memo from the context menu.
Alternatively, you can create a memo for the currently selected code using the
keyboard shortcut Alt+⇧+M (Windows) or ⌥ (option)+⇧+M (mac OS).
The fastest way to create a new memo is to double-click in the memo column to the
left of the code frequencies.

Creating a code memo

The appearing memo window is exactly the same as for other memos. As title, the
new memo uses the code name, which can be changed at any time by clicking on the
title.
Please note: If you change the name of a code in the “Code System”, MAXQDA will
automatically change the memo title if you have not already entered a different title
than the code name.
After closing the memo, you will see a yellow memo symbol next to the code in the
“Code System”, making it easy to recognize that this code has a memo attached to it.
Tip: For code memos, you will often want to insert an example quote from the data to
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illustrate for which parts of the data the code should be used. To insert parts of a text
opened in the “Document Browser” in a memo, simply highlight the desired text, then
drag and drop it into the memo with the left mouse button.

Code summaries
Code memos offer an additional text field at the bottom, titled “Code summary”.
While the upper memo text is typically used for a definition and rules for the use of
the code, you can record important contents of the associated coded segments in the
lower code summary.

Write code summary in a code memo

If you have created case overview tables with thematic summaries using the Analysis >
Summary Tables function, you can use the code summaries in the memos for an
integrative summary of the respective topic or aspect. For this purpose, the summaries
of a code are combined across cases and in condensed form in the code summary.
Example: For 10 interviewees, you have written summaries capturing their typical
workday. In the code summary, you can integrate and consolidate the information in
these summaries, into one text – write a summary of the summaries, so to speak.
For more information on working with summary features in MAXQDA, refer to the
chapter Summarizing.
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Free Memos
Free memos are neither directly assigned to a position in the data nor to a document
or code. They are, so to speak, free-floating and are suitable, for example, for
recording general notes on the research project, thoughts on the development of an
object-related theory, or ideas for analysis.
It is possible to create a new free memo in different places:
●
●
●

Main window of MAXQDA: click on New Free Memo in the Memos tab.
Memo Manager: click on New Free Memo in the Start tab.
"Overview of Memos": click on the New Free Memo icon in the toolbar.

The memo window for free memos is identical to all other memos in MAXQDA.
To access your free memos later, you also have various options at your disposal:
●

●

By clicking on the Free Memos icon in the Memos tab, all free memos of the project
are opened in the Memo Manager, where you can conveniently view, manage, edit,
merge, or differentiate between the free memos.
Alternatively, you can use the Memos tab to call up the “Overview of Memos” table
with all memos of the project, which also contains all free memos.

The Memo Manager
The Memo Manager provides a clearly structured working space for the memos of a
project, in which you can manage numerous tasks around your memos:
●

●

●

●

The remarks for a selected case (in the form of in-document memos) or all category
definitions (in the form of code memos) can be reviewed, edited, adjusted, and
integrated.
The Memo Manager is the ideal place to work with free memos that are neither
directly assigned to a location in the data nor to a document or code.
Various sorting and filtering functions provide easy access to memos, for example
memos written by a specific person or at a specific time.
Memos can be organized into a group, a so-called "set".

The Memo Manager is opened via the Memos tab. After clicking on one of the memo
types, the following view appears:
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The Memo Manager

The Memo Manager is divided into two parts: on the left, the memos are listed in a
tree structure, on the right, the memo currently selected in the tree is opened. In the
image above, the item “In-Document Memos” is selected in the tree, therefore all indocument memos of the project including a preview are listed on the right side.

Opening Memos
To open a memo in the Memo Manager, click on it in the tree view on the left with
the mouse. On the right side, the memo content will appear; as soon as you click into
the memo content with the mouse, MAXQDA automatically switches to the Format
tab, where you have numerous options for formatting the memo.

08 - Memos

294

Memo opened in the Memo Manager

By checking the Open in Tabs option (in the toolbar on the left side of the window),
each additional memo you click on the left side will be opened in a new tab, while the
memos already opened will remain open in their own tab.
Tip: You can detach individual memos from the window and display them in a
separate one.
To open all memos of a document in tabs simultaneously, right-click the document on
the left side of the window and select Open Memos. The option Open Memos in New
Window is also available here, which will open all memos of a document in a separate
memo window outside the Memo Manager.

Display and hide different types of Memos
On the Start tab, all memo types of MAXQDA are listed, with the number of memos
of this type currently available in the project displayed in brackets. Click on one of
these icons to display or hide the respective memos in the Memo Manager.
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Only In-document memos are displayed in the Memo Manager

You will usually only want to work with one memo type at a time, but in principle it is
possible to display all memo types at the same time. The names of the different memo
types are self-explanatory, but it should be noted that “In-Media Memos” refer to the
memos assigned to an audio or video file in the "Multimedia Browser".

Sorting and filtering Memos
In the left window, you can set how the memos are to be sorted in the tree view at
any time in the toolbar at the top:

Options for sorting memos

You can use the first two icons on the toolbar to reduce the selection to the currently
activated documents and the currently activated codes.
The third icon will open the following filter dialog:
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Set filters for memos

Last edited by allows filtering by users who last worked on the displayed memos.
Last edited allows filtering by the date of the last edit, with MAXQDA automatically
setting the most distant and most recent edit dates.
Memos linked to an activated code reduces the display to all memos linked to an
activated code. The view in the Memo Manager is responsive to changes in activations
in the "Code System".
Memo Icon allows the selection of memos with a specific memo icon.
The filter becomes active as soon as you close the filter window by clicking outside of
it. If filters are set, the filter icon is grayed out and a filter bar appears indicating the
effects of the filter:
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Filter bar indicates that a filter has been set

The filter always refers to the left side of the memo manager and hides memos there.
Open memos on the right side are not affected by this, but after closing you can only
open them if they are displayed on the left side despite filtering.
To turn off the filter, click the "X" icon in the filter bar. All filters are automatically
reset when closing the Memo Manager.
Please note: The numbers of the icon labels in the Start tab are not affected by the
filtering.

Search Memos

Search the list of memos
You can search within the entries of the tree view using the magnifying glass in the
toolbar on the left side of the Memo Manager. Here, for example, a code memo is
searched for:

Search within the entries of the tree view

Search Memo Contents
To search all memos of a project, click on Search in Memos in the Start tab of the
Memo Manager. The memo search is explained in detail here. It can also be accessed
via the Memos tab in MAXQDA's main window when the Memo Manager is closed.
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Assembling Memos in sets
You can create sets containing as many memos as you like. For example, it is possible
to group thematically related free memos with code memos and in-document memos.
You can create memo sets like this:
1. Right-click the word Sets in the left window of the Memo Manager and select New
Set.
2. MAXQDA automatically assigns a name to the set, which you can change at any
time by right-clicking on the name and selecting Rename Set from the context
menu.
3. Use the mouse to consecutively drag memos into the set.

Set containing three memos

You can add more memos to a set later at any time. To remove a memo from a set,
right-click the memo and select Remove Memo from Set.
Tip: You can select and move multiple memos at the same time to add them into an
existing set. To do so, click on the memos while holding down the ctrl/cmd or shift key
and drag them into an existing set. If you drag several memos to the word "Sets", a
new set with the selected memos will be created.

Export and Print Memos
You can export and print all memos of a project or a selection of memos at any time
using the Memo Manager. At the top right you will find two icons to access the export
and print functions:
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Export and print memos

By clicking on both the Print icon and the Export icon, a context menu with three
entries will appear, allowing you to decide which memos to print or export:
Print/Export Memos in Left Window - all memos listed in the left window of the Memo
Manager, including memos in sets.
Print/Export Memos in Right Window- all currently displayed memos on the right
(depending on the view, a single memo, all memos opened in tabs, or all memos listed
in yellow boxes).
Print/Export All Memos in Project
You can export in Word format (DOCX) or PDF format.

The Overview of Memos
Memos aren’t only accessible from their location next to documents, codes, document
segments, etc. They are also available as an Overview of Memos. You can access these
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overviews in various ways.
●

●

An overview of all memos in the entire project can be displayed via Memos >
Overview of Memos
In the “Document System”, you can compile all the memos in a document, in a
document group or document set. To do this, select the option Memos in a context
menu accessed by right-clicking the document, group or set.

Open the “Overview of Memos” in the “Reports” tab

No matter from where you access the “Overview of Memos”, a tabular list of the
corresponding memos appears. Each memo represents one row in this table. A click
on a row displays the memo in the upper window of the overview.

The “Overview of Memos”

The columns in the table contain all important information about the memo,
including:
●

The name of the document and document group in which the memo is found (or
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●

●
●
●
●

the name of the code for code memos).
For memos attached to document segments, the paragraph number of that segment
is listed.
The author of the memo.
Last edit date.
A preview of the memo text made up of the first 63 characters
The origin of the memo (e.g., the document, document group, document segment,
or code the memo is attached to).

The upper section of the window displays the memo text, so that various memos can
be scrolled through without opening individual memo windows for each. Memos
cannot be modified or deleted in the “Overview of Memos”. Instead, right-click on the
memo’s row in the list and select Delete Memo.
Please note: To modify a memo, double-click on its row. The memo window will open,
allowing you to modify the memo.
The overview can be adapted like all MAXQDA overview tables: The columns can be
changed with the mouse in their width and position, and by right-clicking on a column
header. A click on the header sorts the column in ascending order, another click in
descending order.

Filtering the Overview of Memos
As with all overviews in MAXQDA, the tabular “Overview of Memos” can be filtered
according to diverse criteria. This is particularly helpful, if you want to compile only the
code memos of a project or user, or only the memos that were created after a certain
date. Click on a column header with the right mouse button and select Set filter to set
a filter for the selected column.
For more information on filtering overviews, see Filtering Table Overviews.

Predefined filters
In the “Overview of Memos” toolbar, you will find, besides the standard filter
possibilities for table overviews, a pop-up menu with numerous predefined filters. This
allows you to filter the currently listed memos.
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Predefined filters in the “Overview of Memos”

The predefined filters work independently from the filter options described for the
table overviews above.

Searching the Overview of Memos
It is also possible to search in the various columns of the overview. To search in a
specific column, right-click on the column header and select Search. The instances
where the search term appears are immediately highlighted, and the up and down
arrows allow you to navigate between memos. To search multiple columns
simultaneously, select the Choose search columns symbol. When you use the
magnifying glass symbol
in the "Overview of Memos" toolbar, the search will
automatically be carried out in all columns.
Please note: When you search the “Preview” column, only the first 63 characters of
the memo will be included in the search. If you want to search the entire memo text,
use the feature Memos > Search in Memos.

Creating a new free memo
In the "Overview of Memos" toolbar you will find the New free memo
icon. You
can create a new free memo, which is not assigned to any particular document, code,
or text by clicking on this symbol. Alternatively, you can create a new free memo by
selecting New Free Memo in the Memos tab.
Please note: Free memos are only visible in the "Overview of Memos" if the overview
was opened via Memos > Overview of Memos, in the Memo Manager or by right-
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clicking on the top entry in the "Document System".

Jumping from the Overview of Memos to the memo origin
The “Overview of Memos” is interactively linked to the positions where your memos
were created. Clicking on a row in the table, makes MAXQDA “navigate” to the
respective memo:
●

●

●

●

For in-document memos, the source document is displayed in the “Document
Browser” window positioned at the height where the memo is assigned to.
For in-media memos assigned to an audio or video position, the playback is set to
the appropriate position, but only if the “Multimedia Browser” is visible.
For code memos, the code in question is selected in the "Code System" (highlighted
in blue).
For document memos the document in question is highlighted blue in the
"Document System".

Export Memo Texts from the Overview
All memos in your "Overview of Memos" can be exported as a sequential listing of the
memo texts in a text file for Word or other writing programs (DOCX and RTF format)
or as a table in Excel, HTML or TXT format.
The export can be initiated via the symbols at the top right of the “Overview of
Memos”:
Open as Excel Table – Creates an Excel file and opens it.
Open as HTML table – Creates a web page in HTML format and opens it with the
default browser.
Export – Creates a Word file (DOCX format) with memos formatted as text or
table, an Excel file (XLSX format), a web page (HTML format) or in some other rarely
used formats.
The entire table is exported unless individual rows are selected (highlighted in green).
Tip: To export code memos as a codebook with category definitions, MAXQDA
provides a special report feature which can be accessed via Reports > Codebook. See
here for details.
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Search within Memos
To search the contents of memos, select Memos > Search in Memos and enter the
word(s) you are looking for on the left side of the appearing window.

Searching for “career” in the project memos

After clicking on Run search, the Memo Manager opens and lists the memos for which
one or more words were found in the memo texts.
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Search results

A click on a line in the left window or a click on a memo in the right list opens the
respective memo, highlighting the search hits in the memo.
Please note: The search does not consider the memo titles.

Linking Memo Content with Content in
Documents
In MAXQDA, you can link two text, image, or memo segments to each other with
internal links. A click on the link at one position then jumps to the other position. The
two linked segments can be in the same document/memo or in two different
documents/memos.
To insert a link into a memo:
1. Select the text passage in the memo that you want to link.
2. Right-click on the marking and select Insert Internal Link (Anchor/Target) from the
context menu. In the Memo Manager, you can alternatively access this function in
Format tab.
3. Select the target segment in a document or memo and repeat the process.
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Inserting an internal link in a memo

Existing links in a memo are displayed in blue and underlined text. A click on the link
will take you to the linked destination - and vice versa. If you hover the mouse cursor
over the link, a preview of the target is displayed.
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Preview of an internal link in a memo

Link Memos to Code(s) or Coded
Segments
Codes can be assigned to a memo similar as to a text segment. To do this, drag a code
directly from the code system into the open memo window and drop it there.
The bottom part of the memo shows how many and which codes are currently
assigned to the memo. The bottom section can be collapsed and expanded at any time
and its height can be changed so that you can adapt the view to your needs.

08 - Memos

308

Linking a memo to a code

Click the

symbol to activate all the codes currently associated with the memo.

If you want to remove the link to a specific code later, move the mouse over a code in
the memo window and click on the "X" symbol at the end of the line.

Compile memos linked to a code
How do you find memos that are linked to a certain code? In the "Code System"
window, right-click the code of interest and select the option Linked Memos from the
context menu. The result is a list of memos that are linked to the code displayed in the
Memo Manager where you can read and modify the memos.

Compile memos linked to activated codes
It is also possible to compile memos linked to the currently activated codes:
1. In the "Code System", activate all codes for which you want to compile memos.
2. Open the "Overview of Memos" via the Memos tab.
3. Select Memos linked to an activated code from the drop-down menu in the toolbar
to filter the memos.
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Memos of activated codes in the “Overview of Memos”

If the filter is switched on, you can also activate and deactivate codes later, the
“Overview of Memos” then displays the appropriate memos.
Tip: There is also a filter in Memos > Memo Manager with which the currently
displayed memos can be reduced to memos that are linked to an activated code.

Linking memos and coded segments
You can also link coded segments to a memo. To do this, drag a coded segment from
the “Document Browser”, the “Retrieved Segments”, or the “Overview of Coded
Segments” into the open memo window using the mouse.
The bottom part of the memo shows how many and which segments are currently
linked with the memo.
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Link coded segments to a memo

To display memos that are linked to a coded segment, right-click the coded segment
and select Linked Memos from the context menu (if option is greyed out, there are no
linked memos). MAXQDA then opens the Memo Manager and displays the linked
memos. There are three ways to open the Memo Manager for linked memos:
●
●
●

Right-click on the coding stripe or code name in the "Document Browser"
Right-click on a row in the "Overview of Coded Segments"
Right-click on a segment in the "Retrieved Segments" window

Convert Memos into Documents
Since memos are used to assist in the development of ideas and hypotheses, it could
happen that they quickly become very important to your analysis. In some cases, these
memos may be important enough that you wish to convert them into documents, so
they can be analyzed and coded. It is only possible to associate an entire memo with
codes, while every single character of a document can theoretically be coded as many
times as needed.
To convert a memo into a document, follow these steps:
1. Click Overview of Memos in the Memos tab
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2. Right-click on the memo to be transformed
3. Select Convert Memo into a Document
The newly-created document will now be listed as the first document in the
“Document System”. The first lines of the document are the former memo’s title,
author, and creation date.
Tip: The function is also available in the context menu of any memo symbol. Right-click
on a memo icon in MAXQDA and choose Convert into a Document to transform the
memo into a document in the "Document System".

The Logbook
The logbook is a MAXQDA feature that lets you write a journal of sorts to keep track
of your analysis work. The term “logbook” is usually a nautical term, used to record
significant events and observations, and it can be used in a similar way for your
project. The Logbook is set up to have the newest entries at the top.
You can open the Logbook from the Home tab or with the keyboard shortcut
Ctrl+Alt+B (Windows) or cmd+⌥+B (mac OS).

Opening the Logbook

The Logbook window is a simple window with a toolbar, which is fairly selfexplanatory and lets you format the text as you want. You can, for example, edit the
font style and size; use bold, underline, and italics; and change the text color. The
icons on the far right let you print or export the Logbook.
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Logbook

To create a new entry, click on the New Logbook Entry
symbol on the far left of the
toolbar. This automatically inserts a date and time stamp at the top of the page, and
you can enter your text directly below it.
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09 - Links
Links in MAXQDA
MAXQDA distinguishes between four types of links:
●

●

●

●

Internal links represent a connection between two text, video, or image segments
(e.g. to show the contrast between two interviewees’ responses to the same
question, you could link them with each other). By using internal links, it is also
possible to link a text passage in a memo to a passage in another memo or any
document.
External links create a connection between a text or image segment and an external
document (e.g. a picture, document, audio/video file, etc.) that is not part of the
MAXQDA project.
Web links are connections between a text or image segment and a webpage. By
clicking on this link, you can open the website in your standard browser.
Geolinks create a connection between a text or image segment and a place on the
globe. This place is based on GPS coordinates and is shown in Google Earth or other
similar programs.

Links can be set (and if necessary deleted) within the "Document Browser", within a
memo, within the "Multimedia Browser" or in MAXMaps, the modeler of MAXQDA,
which can be used to create interactive visual representations of data, concepts, and
context models.
The four types of links are listed in a table view and visualized with various symbols in
the “Overview of Links”.

Internal Links
Internal links are a tool to connect two locations within a MAXDQA project. These
locations can be within documents, video files, audio files as well as memos. Internal
links always connect two points with each other, an anchor point and a target point.
As soon as you click on an anchor point of an existing link, the corresponding target
point is opened up. In MAXQDA, these links work as two-way links. If you click on the
target point, you get back to the starting point of the internal link.
You can link two text or image passages like this:
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1. Select a text or image segment in the "Document Browser" with the mouse.
2. Right-click on the marker and select the Insert Internal Link (Anchor/Target) option.
Alternatively, you can use the Ctrl+L (Windows) or ⌘+L (macOS) keyboard shortcut,
or click the Insert Internal Link icon icon
in the coding bar of the “Document
Browser". The display of the marked position changes now: in texts it appears blue
underlined in PDF and image files a blue frame is drawn.

Toolbar button for creating an internal link

3. You can now select the target point of the link, either in the same document or in
another, and repeat step 2.
If, after the first step, the user decides against creating the link or wants to change the
text that had been selected, clicking the Remove anchor of internal link icon removes
it.

Toolbar button to cancel inserting an internal link

You can recognize links within a text in the "Document Browser" by their blue color
and underlined text. As soon as you move the mouse over the link, a small pop-up
window appears with information about target document and a preview of the linked
location.
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Blue underlined internal link with tooltip

These pop-up windows of the text linked to a text passage sometimes suggest
anchoring the link not only to a single word, but to an entire sentence or section. To
jump from a link in the "Document Browser" to the associated location, simply click
on the blue link. The document containing the destination point is loaded immediately
and positioned exactly at the point of the link.
Tip: If the second "Document Browser" is open, MAXQDA automatically jumps to a
link in the other "Document Browser" window. This allows you to view both of the
two linked document locations at the same time.

Deleting internal links
To delete an internal link, right-click on the link and choose
context menu.

Remove Link from the

Internal links in videos
You can also link a video clip to another video clip or document, e.g. a transcript.
1. Open the video file in the Multimedia Browser
2. Select a part of the video and click the Insert Internal Link (Anchor/Target) icon
from the toolbar.
3. You can now choose the document or document segment that the anchor should
be linked to, as is described above.

Internal links in memos
You can also insert internal links in memos to link a location in a memo to a location in
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another memo, document, or video:
1. Open the memo.
2. Mark the desired text in the memo that is to be linked.
3. Right-click on the selection and select Insert Internal Link (Anchor/Target). .
Alternatively, you can click the icon
on the Format tab in the Memo Manager.
4. In the same way, set the link target in another memo or as described above in the
"Document Browser" or in the "Multimedia Browser".

External Links
External links are links between a segment of a text or image in MAXQDA and a
document outside of the project (e.g. to link part of an interview transcript in
MAXQDA with a picture of the person saved elsewhere on your computer).

Insert external links in an open document
To insert an external link, simply highlight a section of text or image, right-click on it,
and select Insert External Link. A window will then appear where you can select the
appropriate external document to be linked. This can be on your internal hard drive,
an external medium like a flash drive, or a network location.
External links, for text documents, are blue and underlined like the internal links, or in
a blue frame for PDF and image documents. When you hover over the link, a tooltip
appears with the name and location of the linked document. Clicking on the link
opens the document in the appropriate program. For example, clicking on a link to an
image file in JPG format will open the file in an image viewer program.

Defining external links for documents
You can not only insert external links for a position in a document, but also define an
external link for the entire document. Such an external link is not created in the
"Document Browser", where the content of the document is displayed, but in the
"List of Documents", where all data of a project is listed.
To add an external link to a whole document:
1. Right-click the document name and choose Properties from the context menu.
2. A window will open in which you can assign up to three links to external files in the
"External Links" section. Click on one of the three lines with the mouse to select it
and then click on the icon with the three dots to select a file.
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The external links appear in the context menu of a document and can be opened from
there at any time:
Please note: This form of external links is not listed in the "Overview of Links".

Web Links
Web links in MAXQDA are links between a text or image segment and a website. A
web link can be created as follows:
1. Highlight the text or image segment to be linked with the web address.
2. Right-click on the highlighted segment and select Insert Web Link.
A window will open in which you can then enter a web address.

Window to insert a web link

Please note: If a link was saved to the Windows clipboard, it will be automatically
displayed in the input field.
As for external links, you can hover over the web link to see the linked website in the
tooltip. Double-clicking on the link will open the website in your standard Internet
browser.

Geolinks
With the creation of programs like Google Earth and Google Maps, it has become
possible to view any point on the globe with the appropriate coordinates. Geolinks or
Georeferences are links between elements in MAXQDA and a selected place on the
globe. You could, for example, choose to link each interview transcript in MAXQDA
with the place the interviewee lives.
MAXQDA includes a column in the “Document Browser” specifically for these
geolinks. To create one, follow these steps:
1. Go to the location in Google Earth that you would like to link to. You can then save
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the location by right-clicking on it and selecting Save Place As …
2. Highlight the text or image segment to be linked in MAXQDA, right-click on it, and
select Insert Geolink. Simply select the saved KML file in the window that appears,
and the geolink has been created.
The KML file contains the coordinates to the saved place and everything else that
Google Earth™ needs to take you directly to that location. When you click on the
geolink in MAXQDA, Google Maps will open in your Internet browser and the location
will be marked with a red dot.
Geolinks are visualized similar to other links (blue and underlined), but they also have
their own visualization column next to the opened document. If the column is not
shown, right-click somewhere in the document in the “Document Browser” and select
Display Geolink Column. This bar makes it easy to differentiate between regular
internal links and the geolinks.
By hovering your mouse over the geolink visualization, you will see the coordinates
that are saved for that location.

Geolink in the 'Document Browser'

Please note: When you add a geolink, the KML file is imported into the MAXQDA
project itself. Storing it in the project file makes it easier to pass on the entire project
with all the associated KML files to the other members of the research team.
Segments that contain geolinks can be coded just as any other segment can.
Geolinks can be easily viewed in the “Overview of links” table, which you can open in
the “Document System” at multiple levels (project, document group, document set, or
document context menu). In the first column of the chart, geolinks are marked with a
locator symbol. If you click on the column header of this column, the column will be
sorted by the symbols, so it is possible to obtain a successive list of all geolinks.
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Overview of links with geolinks indicated with the orange locator symbol

Inserting geolinks as objects in MAXMaps
Geolinks can also be inserted in MAXMaps by right-clicking in a map and selecting
Insert Geolink. You will then be able to select the appropriate KML file from the
window that appears.
The MAXMaps screen then looks as follows:

A geolink inserted in MAXMaps

The name of the location in Google Earth is automatically inserted as the label for the
geolink in the map. This label is usually long and can be easily changed.
The inserted geolink can then be set up, visualized, linked to other objects, and moved
around just like any other object in MAXMaps. You can, for example, insert a picture
to replace the blue circle, change its size, etc.
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Geolink along with other elements in a MAXMaps map

Geolinking for codes, documents, memos and coded segments in
MAXMaps
All MAXQDA objects inserted in MAXMaps can be connected to a geolink. As with the
free objects mentioned above, an orange location symbol appears in the top right of
object’s frame when it is clicked on. Double-clicking on the ball opens Google Earth
and takes you to the assigned location.

Using a background image with geolinks in MAXMaps
Google Earth™ allows you to save any view as a JPG file, which can be inserted in
MAXMaps as the background.
Invisible hotspots as well as all aspects of your MAXQDA project can then be inserted
and placed on the newly-imported background.

The Overview of Links
Internal links, the most common form of link, are easily seen in the “Document
Browser”, but if you have created many links, it is difficult to get an overview of them.
For this reason, MAXQDA makes it possible to view all links in an overview table. This
overview table is similar to the one used for the “Overview of Coded Segments”.
To view the “Overview of Links”, right-click on a document, document group,
document set, or the Documents icon (representing the entire project) in the
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“Document System” and select Links. When right-clicking on a document or
document group, only those links from that document or group will be shown.
Alternatively you can open the Overview of Links from the Reports tab in the main
menu.
The overview contains the following information:
Anchor point (Document/Memo 1), paragraph, preview, second location
(Document/Memo 2), paragraph, preview.
In other words, you see the document name, paragraph number, and a preview of
each side of a link. Internal links are not hierarchical, meaning they don’t have a
specific direction. A link from Point A to Point B is also a link from Point B to Point A.
You will therefore see each link listed twice: once as Point A to Point B, and once as
Point B to Point A.

Overview of Links for a project

In the Overview of Links, each type of link can be distinguished by the symbol that
appears in the column on the far left:
Internal links
External links and web links
Geolinks
The “Overview of Links” table works like other MAXQDA tables. You can choose to
sort it alphabetically or reverse alphabetically by clicking on the column headers.
Clicking once on an internal link opens the linked document segment in the
“Document Browser”, showing you where the link is located.
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Exporting the “Overview of Links”
You can also access the usual export functions in the toolbar of the overview window:
Open as Excel Table - Creates an Excel file and opens it.
Open as HTML table - Creates a web page in HTML format and opens it in the
default Internet browser.
Export – Creates a table as an Excel file (XLSX format), as a web page (HTML
format), as a Word document (DOCX format), or in other formats, which are less
common.
If any rows are selected, only these are exported, otherwise all rows are exported.
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10 - Text Search
Search in the Four Main Windows
All four main windows in MAXQDA have a magnifying glass icon in their toolbars.
Clicking on the Search icon opens a search field. Below you can see the search field
in the “Document Browser”.

Search in the “Document Browser”

As soon as you type in a search string, MAXDA shows you how often that particular
search string has been found in the currently searched window. You can use the arrow
icons next to the search field or the arrow keys on your keyboard to skip through the
search results.
By default, all occurrences of the entered text are taken into account, even those that
occur in the middle of a word, such as, for example, “less” in “lessons”. The search
can be customized using the icons in the search bar:
Case-sensitive – The letters in the search term and the term found must be the
same, including whether they are upper or lower case.
Starting letters - The beginning of a word must match the search characters. The
search for "erica" finds the name "Erica", but not "America".
Whole word – The search is checked for word-to-word consistency: if the search
term is "teacher", "teachers" is not registered as a hit. This option always includes the
option "Starting letters".
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Find and replace search terms (e.g., for anonymizing)
In the very right of the search bar there is another icon that opens a field for replacing
the found hits with a new term.

Find and replace

With the help of this function, various options are available:
●

●
●

In the “Document System”, you can search in document names and replace them,
for example, to unify them.
In the “Code System”, you can search for code names and replace them.
In the “Document Browser”, you can search a text to be analyzed and, for example,
anonymize it.

Please note: As long as Edit Mode is active in the “Document Browser”, the
replacements can be undone by clicking the Undo text changes icon in the Edit bar.

Text Search
The Text Search function allows you to explore your documents without first coding
them. If you have already coded data, you can also search only the coded segments
which are currently listed in the “Retrieved Segments” window.
The Text Search function can be started by clicking on the magnifying glass icon in the
Analysis menu tab.

Text Search icon in the “Analysis” menu tab

The following window will appear:
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The dialog window for the Text Search

Entering a search item
When the dialog box first comes up, the left pane is empty, and you can just start
typing to enter the word or string (called the “search item”) that you want to find. Use
the return key to enter multiple search items.
To add additional search items later, click on “New entry …”. To edit an existing
search item, click on it once.
Search item may consist of one word, multiple words, or only of a part of a word. For
instance, you can search for “Tom Hanks,” “Hanks,” or only “anks.” Quotation marks
are not necessary if a search string consists of more than one word - it would lead
MAXQDA to only search for words that are placed in quotation marks.
Tip: If you highlight text in the „Document Browser“ then right-click on it and select
the option Search for Selected Text, the highlighted text will be displayed directly in
the Text Search window.
Search strings may contain so-called “wildcard” characters. You can use the following
wildcard characters:
?

single chracter

l?ve finds
"love" and "live"

10 - Text Search

326

*

h*ks finds
multiple chracters "hanks" and "hawks”, if the option "Whole word" was
selected (see below)

<(...) word beginning

<(inter) finds
"interests" and "internal", but not "winter"

(...)> word end

(sh)> finds "slash" and "flash", but not "ashes".

Deleting a search item
To remove search items from the list, click the x symbol next to the word or select the
whole line and click the delete symbol at the top of the dialog window. By holding
down the Ctrl key (Windows) or ⌘ key (macOS), you can delete multiple search strings
at once.

Text search options
You will find the options for the search procedure in the right pane of the Text Search
window.
First, you must specify where you wish to search: In documents or In memos.
Other options:
●

●

●

●

●

Find whole words – Search only for strings that are exactly the same as the search
string. For example, if you search for “teach,” the string “teacher” will not be
included in the search results. If you turn this function off, “teach” would also give
you the strings “teacher” or “teaching” as results.
Case sensitive – Search only for strings in which the same letters are capitalized as in
the search string.
Interpret search items as regular expressions – The entered search terms are
interpreted as "regular expressions". Regular expressions can be used to perform
complex searches (see below for more information).
Ignore hyphens in words (PDF) – If this option is enabled, search in PDF documents
will also find words that contain a hyphen, e.g., because they are hyphenated at the
end of a line due to hyphenation and continue on the next line. Searching for
“climate” will then also find “cli-mate”.
Find all word forms (lemma list) – Searches are conducted not only for an entered
search term but also for all its word forms. A search for "go" will also find the word
"went". The option affects only single words, not composite words. MAXQDA uses
lemmata lists in different languages for this option, so you also have to set the
language of the search items in the drop-down menu.

Please note: You can view and edit the lemma lists used by MAXQDA. In the Help
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from MAXDictio you can find detailed information about the location of these lists. If
you use the word-form function for your search and publish the results, you need to
include a license reference in your publication because the used lists are available
under an open license.
You can also choose how the search items are linked with each other:
●

●

With the OR combination, a hit is always included in the results list when one of the
search terms is found.
With the AND combination, all the search terms must occur within a defined
distance of each other in an adjustable search range. As soon as you have selected
AND, another option is made available directly below it:Within xx
document/paragraph/sentence. With xx you define the maximum distance of the
search items. The following options are available as a search range:
Document – the two search terms must occur somewhere within a document. In
this case, the maximum distance cannot be set.
Paragraph (Text, Tables) – the two search terms must occur within xx paragraphs.
The search only includes text and table documents.
Sentence (Text, Tables, PDFs) – the two search terms must occur within xx
sentences. In addition to text and table documents, the search also includes PDF
files.
❍

❍

❍

Example 1: You search for the terms "public" AND "citizen" within a document.
MAXQDA will then check that both of the two terms occur at least once. A row is
displayed in the results table for each document in which both terms occur at least
once.
Example 2: You search for the terms "public" AND "citizen" within 1 paragraph. The
list of results then contains as many rows as there are paragraphs in which both search
terms occur.
Example 3: You search for the terms "public" AND "citizen" within 2 paragraphs. For
example, if paragraph 12 contains the term "public", then "citizen" must appear in
paragraphs 11, 12, or 13. Only then will this count as a hit.
As soon as you click the Search button, the search will begin.
Depending on how many documents you search and how complex the search is, it
could take some time to find all of the results.

Searching with regular expressions
If you select the option Interpret search items as regular expressions, MAXQDA
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interprets the entered search terms as "regular expressions". These are widely used in
information technology and allow complex searches to be carried out. The following
table contains some examples of regular expression searches:
Search term

Explanation

d

Number from 0 to 9

[…]

One of the
characters in
brackets

(|)

\?

Example
200d
finds all years from 2000 to 2009
h[oôó]tel
finds hotel, hôtel, hótel
200[0-9]
finds all years from 2000 to 2009
Class [34][a-d]
finds class 3a, class 3b to class 4d

One of the character
M(ay|ey|ai|ei)er
combinations in
finds Mayer, Meyer, Maier, and Meier
brackets
The question mark is
searched for; it is not
Why\?
interpreted as
finds all text parts equal to “Why?”
wildcard of any
single character

As an example, a helpful tutorial on the use of regular expressions can be found on
the following website:
https://medium.com/factory-mind/regex-tutorial-a-simple-cheatsheet-by-examples649dc1c3f285
Please note: There are several technical implementations of regular expressions. Perlcompatible expressions (PCRE) are implemented in MAXQDA.

Saving search terms
Searches can be saved, i.e., you won't have to enter the search terms again. Click
Save, enter the name of the saved scan, and then click Save again. Search files are
saved with the extension .SEA (an abbreviation for search). Saved searches can be
loaded at any time.

Search Results
Your results of a search within documents will be shown in a table that appears as
follows:
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Example search results

At the top right, you can see the number of search hits and from how many
documents and document groups they originate.
Tip: Once you click on a hit, the corresponding document is opened and positioned
exactly where the reference is located. The search term found is highlighted.
Along with the usual filter functions, the toolbar at the top of the results window
provides access to the following functions:
Save number of hits per document as document variable – Adds a new document
variable that contains the number of hits for each document. The variable for further
analysis can be used for further analysis.
Search – Opens an input field with which you can search within the entire result
table.
Autocode search results – Codes search results with an existing code. All search
results that have been excluded from the selection (and which therefore display a Stop
symbol in the first column) will be autocoded.
Autocode search results with a new code – Codes search results with a new
code. All search results that have not been excluded from the selection (and which
therefore display a Stop
symbol in the first column) will not be autocoded.
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Autocode/Export: ignore hit – Exclude currently selected rows from autocoding
and exportation by clicking on this icon.
Activate documents with hits – Adjusts the activation of the documents in the
"Document System" so that only those documents are activated for which a search
term was found. This makes it possible to perform further analyses for these
documents, for example, to only consider the activated documents in a group
comparison.
Refresh – Opens the search dialog box again, e.g. to adjust the search settings.
Open as Excel table – The search table will be exported in Excel format and
opened. All rows that do not show a stop symbol will be exported.
Open as HTML table – The search table will be exported as an HTML table and
opened in your standard internet browser. All rows that do not show a stop symbol
will be exported.
Export – The table can be saved as a Word or Excel file, as well as in HTML, Rich
Text or TXT (Tab delimited) format. All rows that do not display a stop symbol will be
exported.
The table of search results can be handled in the same way as other tables in
MAXQDA: clicking on any column header will sort the table according to this criterion.
For instance, clicking on Document will arrange the document names included in the
table in alphabetical order. Clicking here again changes the sequence to descending
order. A little triangle indicates the sort attribute and order (ascending or descending).
The entire table or parts of it can be copied to the Windows clipboard (by selecting all
or part of it and pressing Ctrl+C (Windows) or ⌘+C (macOS).

Search results when using the AND combination with search terms
If you search for more than one search item within the whole document, paragraph,
or sentence, the search results table will not only list the hits for each search item
separately. Instead, it will contain as many entries as combinations of the search items
have been found in the defined contexts, thus the number of documents, paragraphs,
or sentences in which all the search items exist. The following screen shows this for
the search for „happiness“ AND „satisfaction“. In the column „Context“ MAXQDA
informs you, if these search strings exist within a document, paragraph, or sentence.
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Search for “happiness“ and “satisfaction“ within one paragraph

If you have searched using the option Within x sentences or paragraphs, a click on a
row, marks the respective sentence or paragraph in the “Document Browser”.
If you have searched using the Within a document option, clicking on a row will
highlight the first search item in the document.
To get a list of each individual hit of search items, click on the icon
Detailed list of
hits. For example, if you search for “family” and “friends” within a given paragraph,
the detailed list contains all the hits found individually for “learning group” and
“tutorial” where both search terms appear in the same paragraph.
Please note: When exporting the search hits or when autocoding them, MAXQDA uses
the detailed list of search items.

Opening your last search result
As long as your project is still open, you can always go back and review the last search
result, thus saving time in case you need to do the same search again. Go to the
Analysis menu tab, click at the label Text Search & Autocode to open a drop-down
menu and select Last Search Result (do not click on the icon, this will open the simple
Text Search).
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Export Search Results
The results table of the Text Search tool offers the possibility to export search results
by clicking on the Export
icon in the toolbar of the results window. The following
options window will appear, where the range of the data to be exported in relation to
the search items can be defined, for example, to create a keyword-in-context (KWIC)
listing:

Options for search results export

The options window is divided into two parts. Options for the export of search results
from a PDF document can be selected in the upper section, with the corresponding
options for search results from text and table documents in the lower section. Exports
of pure search results as a simple list is generally not useful; therefore you can define
the range for the export of search results.
For PDF documents, you can define how many words or sentences before and after
the actual search item are exported. For text and spreadsheet documents, also the
option Paragraph is available.
Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only
paragraphs in which the search item is found will be exported. If the item appears
several times in the same paragraph, the paragraph is still listed only once.
Setting 1 Paragraphs after means that the paragraph containing the search item, as
well as the following paragraph, will be exported.
Please note: Read the chapter on Extended Text Search to learn how MAXQDA
recognizes sentences.
The recognition of sentences in PDF documents is optimized for left-to-right languages
and may not work as expected with right-to-left languages.
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When you click OK, a window will pop up in which you can select the file name,
format, and location to be saved. The following options are available:
●
●
●
●
●
●

Word – Text (DOCX),
Word – Table (DOCX),
Excel (XLS/X),
Website (HTML),
Rich Text Format (RTF)
Tab Delimited Text (TXT)

Exclude search results from export
Generally, all search hits that appear in the results list will be exported. However,
before starting the export function, you can review the list of search hits in order to
decide whether each hit should be included or not. Once one or more lines in the
results table have been selected, click on the icon
Autocode/Export: ignore hit in
order to exclude the hit.

Exclude search terms from export

Tip: The fastest way to exclude a term is to double-click in the first column.

Autocode Search Results
Like the segments in the “Retrieved Segments” windows, Text Search results can be
automatically coded, meaning all text passages found in the search are assigned to a
specific code. This automatic coding has the advantage of being easy and reliable. The
disadvantage, however, in comparison to manual coding, is of course that you can’t
examine the relevance of each respective text passage during the coding process. The
occurrence of a specified string in the text automatically triggers the coding. For
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example, if the word “Mother” is automatically coded with the code “Family”,
references to “Mother Earth” would also be included.
To code the search results automatically, follow these steps:
1. Click on the Autocode search results with a new code symbol.

Start autocode procedure
2. In the dialog box that appears, you can define the new code as usual. MAXQDA
automatically enters the search item as the code's name and the search settings as
a code memo. You can modify both, if required. Then click OK. The new code will
be inserted at the top of the code system.

Autocode search results: Define
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a new code
3. In the ensuing options window, you can set the range before and after the search
term as well as the weight, which is established during the coding process.

Setting options for automatic coding of search results

In the “PDF documents” section, you can set whether only the respective search result
should be coded, or whether additional words or sentences before and after the
search results should be coded as well. Due to the different handling of text layers in
PDF documents, using the option “Sentences before and after” for PDFs can lead to
unexpected results in certain cases.
Please note: Read the chapter on Extended Text Search to learn how MAXQDA
recognizes sentences.
In the “Text and table documents” section, you can additionally select to autocode
paragraphs containing the search result.
Setting Paragraph with 0 Paragraphs before and 0 Paragraphs after means that only
the paragraph in which the search item is found will be coded. If the item appears
several times in one paragraph, it will nevertheless be coded only once
The setting 1 Paragraph after means that the paragraph in which the search item is
found as well as the following paragraph will be coded. Again, if the term appears
several times in one paragraph, it will nevertheless be coded only once.

Autocode search results with an existing code
If you do not want to code with a new code, but with an existing code from the
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"Code System”, you can use the Autocode search results
option from the toolbar.
Before you start the process, click on the desired code in the “Code System” window,
which will cause the code to appear in the list of recently used codes in the Autocode
options window.
Please note: Text segments that are already coded with the selected code will be
ignored during the autocoding process - even if a text segment contains the search
item. This ensures that you do not accidentally overwrite your manually coded
segments during the automatic coding process.

Exclude search results from autocoding
Generally, all search items that appear in the results list will be autocoded. However,
before executing the autocode function, you can review the list of search hits in order
to decide whether each hit should be included or not. Once one or more lines in the
results table have been selected, click on the red icon
Autocode/Export: ignore hit
in order to exclude the hit.
The fastest way to exclude a term is to double-click in the first column.

Exclude search terms from autocoding

Please note: The selected codes are incorporated into the undo coding list which can
be accessed from the Code toolbar in the Document-Browser window with the
icon. This action can be reversed with a single command if necessary. This function is
also available after reopening the project and it can be called independently of the
global undo function.

Extended Text Search
The Analysis > Extended Text Search function, as with the simple search option, allows
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you to analyze your documents to a certain extent without having to have already
done any coding. If you have already coded data, you can also search only the coded
segments which are currently listed in the “Retrieved Segments” window.
To start an extended Text Search:
1. Go to the Analysis menu tab and click at the bottom of the Lexical Search entry.
2. Click on the label of the Text Search & Autocode icon (not on the symbol, this will
start the simple Text Search).
3. From the drop down menu select Extended Text Search.
The following search dialog will appear:

Extended Text Search dialog box

The dialog is separated into several parts. At first you can enter search items in the text
fields
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●
●
●

Include all these search items (AND combination)
One of these search items (OR combination)
None of these search strings (search strings for exclusion)

Please note, that you can separate different search strings with a space. If you want to
enter a combined search string you can use quotation marks like “Mahatma Gandhi”
around your search string. Question mark (“?”) and asterisk (“*”) work as
placeholders for a single character or for one or more charaters. Use <(word) for word
begin and (word)> for word end, <(inter) will find “interest” and “interesting”, but
not “winter”, and (ks)> will find “banks” and “thanks”, but not “bankside”.
All three search entries will be combined with AND. In the screen above MAXQDA will
present all sentences in which “climate” and “energy” exist together, but not
“politics”.
The options Find whole word etc. are explained in detail in section Text Search.
In the upper right part of the dialog you can define, in which part of the project
MAXQDA will search an in the options on the right you can define in which context
the search items have to exist.
Please note: Sentences are defined by MAXQDA according to the following rules: A
sentence always begins following a period, question mark, exclamation mark, or
colon. The following exceptions apply:
# A number that is not four digits appears before a period (e.g. 1. or 2.).
# A single character appears before a period (to exclude abbreviations).
# Two identical characters appear directly before a period (e.g. ff. or pp.).
# Literal speech in quotation marks belonging to the sentence itself.
# First letter after a sentence is in small letters.
# A number appears directly following the end of a sentence.
# Quotation marks appear immediately after the end of a sentence.
In text or table documents, a new sentence always begins after a paragraph.
The recognition of sentences in PDF documents is optimized for left-to-right languages
and may not work as expected with right-to-left languages.

The Word Explorer
In which documents does the word "friend" occur frequently and in which summaries
and paraphrases? Which words frequently occur together with "friend" in a sentence?
These and many more questions can be answered with the Word Explorer.
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The Word Explorer gives you an overview of the use of terms throughout your project.
Both the imported text data and your own text input in memos, coding comments,
summaries and paraphrases are searched. The Word Explorer is suitable for different
phases of a study:
●
●

●

At the beginning of the analysis, the use of words in the data can be explored.
During the main analysis phase, conjectures about the use of interesting words can
be made and verified.
For report-writing purposes, important quotations from the original data and
references in one’s own written passages can be found that include a particular
term.

The Word Explorer
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How to use the Word Explorer
1. Start the function via Analysis > Word Explorer in the MAXQDA main menu.
2. In the Word Explorer window, enter a search term in the search field. This can be a
part of a word ("glob") or a whole word ("change"). Multiple words ("global
warming") are also possible.
3. If necessary, select options from the Start menu, such as applying a stop word list.
4. Click the Explore button.
Please note: In the search term, you can use "?" as a wildcard for a single character
and "*" as a wildcard for any number of characters. When using wildcards, the Find
Whole Word option is automatically applied, regardless of whether the option is
selected in the Start tab.

Presentation of results
The results are presented in six interactive sections: click on a result to get more details
about the corresponding search hits.

In documents

“In documents” section

This section informs you about the number of hits and in how many different
documents, document groups, and document sets they are located.

hits – total number of hits in the searched documents. Click this line to open a listing
of all hits.
documents – number of documents in which the search term appears at least once.
Click this line to activate all documents with at least one search hit in the “Document
System” window. The percentage refers to all documents in the project. However, if
only activated documents were evaluated, then the percentage refers to hits within
these activated documents.
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document groups / document sets – number of document groups and document sets
in which at least one search hit occurs. The percentage refers to all groups/sets in the
project regardless of document activation.

In my writing

“In my writing” section

The numbers indicate how many memos, coding comments, summaries, and
paraphrases were found in which the search term occurs at least once.
Click on one of the lines to display the found memos, comments, summaries, and
paraphrases.

Most frequent in these documents

“Most frequent in these documents“ section

This section displays the documents in which the search term occurs most frequently.
The numbers indicate how often the search term occurs in the corresponding
document, and documents are displayed in descending order of frequency according
to these numbers. The small horizontal bar charts visualize the frequencies so that
differences between documents can be assessed easily. The small “dash” charts at the
right show where the search hits occur in the document. For example, the search hits
for “Tatjana” are mostly located in the middle of the text, followed by one search hit

10 - Text Search

342

in the last quarter.
Click on a line to get a listing of the search hits in the corresponding document.
Please note: If multiple documents have the same number of search hits, the
documents will be listed in the order defined in the “Document System”.

Most frequent codes

“Most frequent codes” section

This section shows the codes that were most frequently assigned to text passages with
search hits. The numbers indicate how often the search term occurs in segments of
the corresponding code; sorting follows a descending order according to these
numbers. The small horizontal bar charts visualize the frequencies so that differences
between codes can be assessed easily.
Example: The line “10 Free time, self-care” in the figure means that the search term
“friend” occurs 10 times in text sections that were coded with the code “Free time,
self-care”.
Click on a line to get a listing of search hits within that code.
Please note: If several codes contain the same number of search hits, the codes are
sorted according to the “Code System” window. If there are several search hits within
a coded segment, the applied code is counted for each search hit.

Most frequent word combinations
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“Most frequent word combinations” section

This section shows the most frequent 2- to 4-word combinations that contain the
search term. The most frequent word combinations in the example are “encourage
friends” and “meeting friends”.
If the Apply Stop Word List option is selected in the Start tab, all word combinations
containing a word from the selected list will be excluded. The same applies to the
Ignore Numbers option.
Click on a line to open a compilation of the corresponding word combination and
explore the search hits in detail.
Please note: Only combinations of words from partial sentences are presented. This
means that no combinations of words separated by commas, semicolons, parentheses,
line breaks, etc. are output. Users with a “MAXQDA Plus” or “MAXQDA Analytics
Pro” license can set the separators for identifying partial sentences via MAXDictio >
Word Combinations.
If several word combinations occur with the same frequency, they are output
according to the number of words per word combination (1st sort criterion) and
alphabetically ascending (2nd sort criterion).

Most frequent context words

“Most frequent context words” section
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This section displays the most frequent words within a definable distance around the
search hits. The distance can be defined in the Advanced Options tab; by default, the
5 words before the search hit and the 5 words after it are included. Only words within
the same sentence are considered. For the determination of sentences, MAXQDA
applies the procedure described here.
Please note: If several words occur with the same frequency, they are output in
alphabetically ascending order.

Switch off sections
If a section is currently not of interest for the analysis, it can be temporarily switched
off. This can be helpful for saving computing time when working with large amounts
of data. To deactivate a section, click the respective on/off symbol at the top right:

Temporarily switch off section

Clicking again turns the section back on.

Choose options
In the Word Explorer Start menu tab, you can set the following options for your
search:
●

●

●

●

●

●

Only Activated Documents – limits the search to the currently activated documents.
This option affects all sections.
Only Activated Codes – Restricts the search to the currently activated codes. This
option affects the “In my writing” section (code memos, coding comments, and
summaries) as well as the “Most frequent codes” section.
Most Frequent [3-50] – Define how many entries should be displayed in the four
lower sections.
Case Sensitivity – If this option is enabled, words are analyzed and presented casesensitively.
Starting Letters – If this option is enabled, only hits that start with the entered search
term are considered. Searching for “tree” finds “tree”, “trees”, “treehouse” but not
"street".
Find Whole Words – If this option is enabled, all hits are ignored where the search
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●

●

●

term is only a part of the word, i.e., there must be a space or a separator before and
after the hit. This option overrides the “Starting Letters” option. A search for
“teach” will not find “teacher” or “teaching”.
Find all Word Forms (Lemma List) [language selection] – Other word forms from the
lemma list of the selected language are included in the search if option is switched
on. Searching for “go” will also find “went” and “gone”. This option has no effect
if the search term includes several words. More information about the lemma lists
used can be found here.
Apply Stop Word List – Select a stop word list here and use this option to exclude
search hits from the “Most frequent word combinations” and “Most frequent
context words” sections. After clicking on the three dots, a window opens where
you can edit the stop word lists.
Ignore Numbers – If this option is enabled, word combinations containing a number
and context words consisting only of a number will not be output. Numbers entered
in the search field are never ignored. If you enter “2021” as a search term,
MAXQDA will output all hits with this number.

The Advanced Options menu tab of the Word Explorer provides more options:
●

●

●

Characters to be Cut Off – Clicking on the button with the three dots opens a small
dialog box in which you can enter characters that are to be separated from the
words in the searched texts and ignored during counting. The selected characters
apply to all word-based functions in MAXQDA and MAXDictio (the dialog can be
accessed in several places).
Context Words (before/after) [number 1-15] – here you can set the maximum
number of context words that will be considered before and after the search hit. By
default, 5 words before and after search hit are considered as long as they belong to
the same sentence.
Language Options – Here you can specify that the analyzed texts are in Japanese. In
this case, MAXQDA uses a special library to separate the words from each other,
since Japanese does not require spaces. You can also select here that Japanese
particles are ignored for analysis.

Launch Word Explorer from the Document Browser window
Right-click on a selected text passage in the “Document Browser” and select Explore
in Word Explorer to start the Word Explorer directly for the marked text. By default, all
documents are searched; you can of course limit the search in the Word Explorer
window.
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Start Word Explorer via context for a selected text in the “Document Browser” window

Launch Word Explorer from the Word Cloud
Right-click a word in the word cloud and select Explore in Word Explorer to start a
search in all documents with the clicked word.

Launch Word Explorer from the Word Frequency List
You can create a list of word frequencies, by accessing Word Frequencies in the Word
Cloud window or via the MAXDictio > Word Frequencies function. Right-click on a
word in the word list and select Explore in Word Explorer to start an exploration in all
documents with the clicked word.

Start Word Explorer via context menu from the word frequency list

Export results
While hovering, a copy symbol appears at the top right of each results section, with
which the respective section can be copied to the clipboard. All entries of the range
will be exported as an image, even entries that may not be visible. You can paste the
image into Word, PowerPoint, and other programs, for example, using the keyboard
shortcut Ctrl+V (Windows) or ⌘+V (macOS).
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Copy section to clipboard
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11 - Segment Retrieval
Activation: The Principle of Segment
Retrieval
After you have assigned codes to document segments, you will be able to call up all
segments that were coded with the same code. MAXQDA offers various ways to do
this retrieval, but it is all based on activation of documents and codes.
The retrieval principle in MAXQDA is very simple:
All segments from activated documents that were coded with any of the activated
codes will be called up and shown in the “Retrieved Segments” window.

Activating documents
First the documents: All documents and document groups are listed in the “Document
System”. The starting point, then, is an inactivated document. The current state of the
activation can be recognized by the color of the document name and the document
symbol: Activated documents are displayed in red and the grey circle in front of them
changes to a red arrow.

An inactivated document

An activated document

As soon as at least one document is activated in a document group, a red arrow also
appears in front of the document group symbol:
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Activated document in “Document System”

There are several ways to activate documents:

1. Activation with the mouse
The easiest way to activate a document is with the mouse: Click with the left mouse
button on the symbol of a document to activate it. Alternatively, you can click on the
grey circle in front of the document symbol or on the displayed number of coded
segments at the end of each document row.
All documents in a document group or document set can be activated in the same
way: To do this, click on the folder icon of the document group or document set. All
the documents in the project can also be activated with a single click by clicking on the
folder symbol of the "Documents" entry at the top of the "Document System".

Activate documents by clicking on the symbol with the mouse

2. Activation via the context menu
You can also activate a document via the context menu: Right-click the document
name or icon and choose Activate from the context menu.
In the same way, you can also activate all documents of a document group or
document set at the same time by right-clicking the group or set and selecting
Activate All documents. This menu entry is also available at the very top level,
"Documents", the root of the Document System.

3. Activation with the Ctrl or cmd Key
Similar to selecting files in Windows Explorer or Mac Finder, you can also hold down
the Ctrl key (Windows) or ⌘ key (macOS) and click on the required document,
document group, or document set with the left mouse key.
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Activating codes
Activating codes works in the same way as for documents. Either right-click on a code
and click Activate in the context menu or click on the all symbols of the codes you
want to activate.

Activating a code via the context menu

The activation of the codes is also indicated by a red arrow and the red color of the
code name.
Tip: If you hold down the keys Ctrl+⇧ (Windows) or ⌘+⇧ (macOS) when clicking a
parent code, only the parent code and not its subcodes are activated.
The status bar at the bottom of the MAXQDA window gives you information about
the number of activated documents, activated codes, and the number of document
segments that are being called up based on those activations.

Activation information in the status bar

Compiling coded segments in the "Retrieved Segments" window
All of the document segments that were found based on your activations are called
retrieved segments or coded segments and are displayed in the “Retrieved Segments”
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window - if it is currently open.

Called up document segments (coded segments) based on activated documents and codes

More activation methods

Activation via search in document and code names
Both in the "Document System" and in the "Code System" a local search for
document and code names can be performed. If you click on the magnifying glass in
the window title of the "Code System", the following search bar appears:

Activate code names with search hits

By clicking on the red symbol Activate codes with search hits (far right) all codes are
activated in the example where the searched word occurs. This process overwrites the
previous activation status.
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Activating by variables
Activating documents and codes can done manually, but also automatically depending
on certain variable values. This type of activation is referred to in MAXQDA as Logical
Activation or Activation via Document and Code Variables, and is described in detail
here.

Activating by color
Documents and codes can be activated not only manually (by clicking them) and
automatically (by document and code variables), but also by color. In both the
"Document System" and "Code System" windows you will find the Activate by Color
entry in the context menu that appears when you click on the top entry of the
hierarchical "tree", More... > Activate Documents/Codes by Color.
A dialog field will appear with all the colors that have been used for documents/codes
so far. You can then check the box next to the colors to be activated. The two buttons
at the top also let you check or uncheck all of the colors with a single click.

The colors representing codes or documents to be activated

Activate documents by random
In addition to activation with variables and colors, documents can also be randomly
selected. Right-click on the root of the documents and choose More... > Activate
Documents by Random.
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In the dialog that appears, MAXQDA displays how many documents are available in
the project and allows you to enter a number of documents to be activated.

Activation of documents depending on code distribution
To activate all documents in which a selected code exists at least once, right-click the
code in the code system and choose Activate Documents with this Code from the
context menu. The current activation in the "Document System" will then be
overwritten.

Resetting activations
Cancelling the activation of documents or codes operates on the same principle as
activation: either via the context menu or with the mouse (eventually using the Ctrl or
⌘ key.) When you want to start a new Coding Query, but already have documents
and codes activated from a previous retrieval, the easiest way to proceed is to
automatically deactivate all of those documents and codes.
In the Start tab, you will find a Reset Activations button, which fulfills this function.

Button to “Reset activations”

If you want to reset activations for only the documents or only the codes, you can do
so with the button available in the “Document System” or “Code System” toolbars.

Button to “Reset activations” for all documents in the “Document System”

Button to “Reset activations” for all codes in the “Code System”

It is also possible to deactivate all codes or documents by right-clicking on the
Documents icon in the “Document System” or the Codes icon in the “Code System”
and selecting Deactivate all documents or Deactivate all, respectively.
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The "Retrieved Segments" Window
The “Retrieved Segments” window is a results window – it shows you all of the coded
segments that were coded with any of the activated codes in any of the activated
documents. The principle of the segment retrieval is as follows:
For all activated documents, the segments to which activated codes are assigned are
compiled in the “Retrieved Segments” window.

Retrieved segments in the “Retrieved Segments” window

The top line shows you how many coded segments from how many different
documents and document groups are currently listed.
Below each segment there is an indication of origin, which informs you about the
document and the position of the segment in the document as well as about the
assigned code. The third segment in the image above is from the document “Jamie”,
where line 24 was coded with the blue code “Partner”. To the far left of the
segments, coding strips are displayed in the color of the assigned code, very similar to
the “Document Browser”, but without the code name.
Tip: If you click with the left mouse button on the line with the source information or
on the coding stripe, the source text is loaded into the “Document Browser” and the
coded segment is highlighted. At the same time, the corresponding code is
highlighted in the “Code System” window. If you click on the origin of an audio or
video segment, the “Multimedia Browser” opens and the clip is highlighted.
To the left of the segments there is a column for displaying memo symbols. If memos
are assigned in the area of the segment, you will see the same memo symbols here as
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in the “Document Browser”. As usual, the memo symbol is interactive:
●

●

A single click with the mouse marks the segment assigned to the memo in the
“Document Browser” and displays it in its sidebar, provided that these are visible,
and memos are enabled for display in the sidebar.
A double click on the symbol opens the memo for editing.

Working with Comments for Coded Segments
As in the “Document Browser”, you can switch on a sidebar to the right of the coded
segments in which the comments on coded segments are displayed. You can display
or hide the column with the comments by clicking on the icon Display comments on
coded segments in the toolbar of the window.

Comment column in the “Retrieved Segments“ window

Double-click a comment in the sidebar to edit it. To create a new comment, right-click
the coded segment and select Edit Comment from the context menu.
Tip: Alternatively, a double-click on the coding stripe opens the comment window at
any time to create new comments or edit existing ones.

Display Favorite Variables
It is often helpful to obtain further background information on the coded segments,
for example how old the person was who expressed a certain opinion in the interview
or in which industry a company operates, whose website texts are analyzed. For this
purpose, you can display the so-called favorite variables of the documents in the
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“Retrieved Segments” window at any time.
This is how you proceed:
1. Switch to the Variables tab and open the List of Document Variables.
2. Check the “Favorite variable” column for all variables that are interesting for your
analysis and close the window again.
3. Click the Display Favorite Variables icon at the top of the “Retrieved Segments”
window - if it was not already enabled.

Selecting Favorite Variables in the List of Document Variables
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Show variable information in the “Retrieved Segments” window

The selected variable information then appears directly below the document name:
Jamie, for example, is 18 years old, lives alone and has completed Junior College.

Deleting coded segments and adjusting the weight
If you click with the right mouse button on a segment or its coding stripe, the
following context menu appears, which you may already know from the “Document
Browser”:

Context menu for a coded segment

Here you can delete the coded segment, i.e. it is permanently removed from the
project and the coded segment is no longer displayed in the “Retrieved Segments”
window.
You can also change the weight of the clicked coded segment, which is displayed in
brackets at the end of the assigned code name. After selecting the menu option
Modify Weight, a dialog window appears in which the new value can be entered.
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Modifying the weight score of a coded segment

Please note: You can turn off the display of weights in the “Retrieved Segments”
window if required. To do this, click on the gear icon for the local settings in the
window title (as shown in the next figure) and deactivate the Show weight option.

Sorting segments in the “Retrieved Segments” window
You can adjust the sorting of the coded segments at any time in the local settings of
the window. To do this, click on the gear in the upper right corner of the window title:

Local settings in the “Retrieved Segments” window

You can also carry out other functions by right-clicking on a gray area of the
“Retrieved Segments” window in which the info boxes appear.
There are three possible variations:
●

●

Ordered by Document System – this means that the segments are listed in the same
sequence as in the “Document System”. The list starts with the segments of the first
activated document in the “Document System”, then those of the second activated
document are given, and so on. Search results in this order would let you compare
what one respondent said to different selected topics. For example, given that the
first respondent’s answers were contained in one document or interview, followed
by a second respondent’s answers in a separate second interview, all of the retrieved
segments from the first interview would be listed before those from the second
interview.
Ordered by Code System – this means that the segments are listed in the same
sequence as the codes in the “Code System”, starting with the uppermost activated
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●

code.
Ordered by weight score (ascending/descending) – This sorts the segments according
to the weight that has been assigned to them.

Tip: In the status bar at the bottom of the screen, the currently selected sort sequence
is represented by an icon. This symbol, for example, symbolizes sort by documents .
To customize the sort sequence, simply click the icon.

The table view in the “Retrieved Segments” window
The “Retrieved Segments” can be displayed in a table view. To do this, open the local
settings as shown in the figure above and select the option Table view. MAXQDA will
then display the coded segments in the same manner as the “Overview of Coded
Segments” in the preview window. This display is interactive: click on a row to show
the corresponding segment in the “Document Browser”.

The “Retrieved Segments” in a table view

The “Overview of Coded Segments”
An easy way to get an overview of your retrieved segments is to open the “Overview
of Coded Segments” by clicking on the appropriate icon in the toolbar at the top of
the “Retrieved Segments” window.

Opening the “Overview of Coded Segments” in the toolbar

Structure of the “Overview of Coded Segments”
The overview is divided into two parts: a list representation of the retrieved segments
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is displayed in the bottom half of the window, while the upper half displays a detailed
view of the segment you have clicked in the bottom list. Simultaneously, the
"Document Browser" (or the “Multimedia Browser” for video coding) is positioned
accordingly, so that you can also see the surrounding context of the respective
segment. The larger the screen, the better this function is.

The two-section window in the Overview of Retrieved Segments

Tip: The overview table is also the best place to write comments on your coded
segments. You read the segment in the upper window and write your comment
below. Just double-click the field for comments in the matrix and type in your
annotation.

Coding texts directly in the “Overview of Coded Segments”
You can code text segments, which are displayed in the upper window of the
“Overview of Coded Segments”. To do this, select any text area in the upper window
area and drag the selected text onto any code. In the "Document Browser", the new
coded segments will be visible as a coding stripe - provided no filters are set for the
display of the coding stripes.

The toolbar in the “Overview of Coded Segments”
The following functions - alongside the usual icons for filtering, searching, and
deleting - can be accessed from the toolbar:
Code retrieved segments with a new code – the selected coded segments (marked
in blue) from the list will be assigned to a new code. It is possible to select multiple
rows by holding down the Ctrl key (Windows) or ⌘ key (macOS). If no rows are
selected, the entire table will be coded.
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Activate documents containing segments – activates all documents that contain
any of the displayed segments. Previous activations are overwritten.
Open as Excel table – exports the table in Excel format and opens it. If nothing is
selected, the entire table will be displayed. If individual rows are selected (highlighted),
only these rows will be exported.
Open as HTML table – a table in HTML format is created and displayed with the
default browser. If nothing is selected, the entire table will be displayed. If individual
rows are selected and highlighted in blue, only these rows will be exported.
Export retrieved segments – lets you export the overview as a continuous text in
Word format, as a table in Excel format, or as an HTML-formatted web page. The
options are described in detail in Printing and Exporting Retrieved Segments.

What information can be found in the columns of the overview?
Regardless of the document type, the following columns of the table have the same
meaning:
●
●
●
●

●
●

●

Document group – document group from which the coded segment originates
Document – document from which the coded segment originates
Weight – weight of the coded segment (can be modified directly in the overview!)
Comment – comment on the coded segment (can be modified directly in the
overview!)
Code – the code with which the segment is coded
Created/Modified by – person who originally coded the segment/last changed the
coding
Created/Modified – the date on which the segment was originally coded/last
changed the coding

Depending on the document type, the following columns have different significations:

Text Documents
●
●
●

●
●

Start – paragraph in which the coded segment begins
End – paragraph in which the coded segment ends
Preview – the first 63 characters of the encoded text (when exporting the output
contains the entire coded segment)
Area – number of characters in the coded segment
Coverage % – number of characters in the coded segment in relation to the number
of characters of the text as a whole
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PDF Documents
●

●

●

●

●

Start – for text coding, the page at which the coded segment begins. For image
coding, the lower left corner of the segment.
End – for text coding, the page at which the coded segment ends. For image coding,
the upper right corner of the segment.
Preview – the first 63 characters of the coded text. For images, <IMAGE> will be
displayed (upon exportation the entire coded text and image segment will be
displayed)
Area – for coded text segment, the number of coded characters; for a coded image
segment, the coded area in square pixels
Coverage % – for text, the number of coded characters in relation to the total
number of characters in the text; for images, the coded area in relation to the total
area of the PDF

Image Documents
●
●
●

●

●

Start – the upper left corner, at which the coded segment begins
End – the lower right corner, at which the coded segment ends
Preview – always displayed as <IMAGE> (coded image segment will be displayed
upon exportation)
Area – coded area, in square pixels, where the side lengths are each reduced by 1
pixel
Coverage % – coded area in relation to the total area of the image

Table Documents
●
●
●

●
●

Start – cell in which the coded segment is found
End – identical to “Start,” as coded segments are always in the same cell
Preview – displays the first 63 characters of coded text (when exported, will include
the entire coded segment)
Area – Number of characters in the coded segment
Coverage % – for text coding, the position of the character at which the coded
segment begins. For image coding, the lower left corner of the segment.

Audio and Video Files
●
●
●

●
●

Start – the time at which the coded segment begins
End – the time at which the coded segment ends
Preview – always displayed as <AUDIO> or <VIDEO> (image of beginning of clip will
be displayed upon exportation)
Area – length of coded media clips
Coverage % – length of coded media clips in relation to total length of the file
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Sort, Hide, and Reveal Columns
As with all tables, you can also organize the Overview of Retrieved Segments as you
wish:
●
●
●

Drag & Drop columns to change their order.
Sort the table by a column by clicking on the column heading.
Hide or reveal columns by right-clicking on the column heading.

Opening the “Overview of Coded Segments”
Which retrieved segments are included in the overview depends on the context, for
which the overview is requested:

All coded segments from the project:
●
●

●

Reports > Overview of Coded Segments or
Right-click on the stem of the “Document System” or “Code System” and select
Overview of Coded Segments or
Double-click on the stem of the “Code System” window

Coded segments that currently appear in the “Retrieved Segments”
window:
●

Click on the Overview of Retrieved Segments symbol in the “Retrieved Segments”
toolbar

All coded segments of a code:
●
●

Double-click on the expanded code, or
Right-click on the expanded code and select Overview of Coded Segments

All coded segments of a code and its subcodes
●
●

Double-click on the collapsed code, or
Right-click on the collapsed code and select Overview of Coded Segments

Print and Export Retrieved Segments
You may wish to continue to work with the segments in the "Retrieved Segments"
window. MAXQDA makes it possible for you to print out these segments, copy them
to the clipboard, or to export them as a file.
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Printing retrieved segments
To print out the retrieved segments,
●

●

●

Click on the Print retrieved segments icon
in the “Retrieved Segments” window
toolbar.
Click in the window to place it in focus (recognizable by the green marker in the
window title), and use the keyboard shortcut Ctrl + P (Windows) or ⌘ + P (macOS)
or,
Switch to the Reports tab, click the Print icon and select the Retrieved Segments
option.

You will then see the standard option for selecting your printer. In this window, you
can also select the print layout and choose to print out only certain pages.

Printout of the “Retrieved Segments” window

If you want to be able to edit aspects of the formatting, it is recommended that you
first export the retrieved segments, open them for edit in a word processor, and then
print them out.

Exporting retrieved segments
To export your retrieved segments, click the Export icon
in the toolbar of the
window. Alternatively, open the function from the ribbon menu: Reports > Export >
Retrieved Segments.
The following option menu will appear:
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Options for the export of retrieved segments

In the left window, specify which supplementary information should be exported in
addition to the coded segments, including:
Memos - If you select this option, all memos assigned to the coded area of the
segment, displayed in the "Retrieved Segments" window, will also be exported. When
exported as an Excel document or as a web page, all memos from one coded segment
will be included in a single cell.
Duration (for transcripts with timestamps) - For segments from a transcript, both the
time at which an coded text starts and the time span of the coded text are exported.
You can then check when exactly a statement in an interview was made. The specific
points in time and time spans are determined according to the timestamps in the
transcript and the number of characters of a coded segment and, if necessary,
extrapolated if the coded segment does not exactly match the time stamps.
Other codes assigned to the segments - For each coded segment, the export file writes
which codes were assigned to it. Each overlap with another code is listed, including its
weight. With the option Only activated codes, only the activated codes are taken into
account.
Favorite variables – When this option is selected, all variables that are selected as
"favorites" in the "List of document variables“ will be exported. For export in XLS/X or
HTML format, each favorite variable will be assigned to its own column.
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Document Variables (x selected) - Click on the button with the three points to select at
which point variables should be exported. With each coded segment, the variable
values of the corresponding documents are then additionally exported. When
exporting as an Excel document or as a webpage in HTML format, each variable has its
own column.
In the section to the right, you can specify which source data should be exported with
each segment.
Choose between the three export formats: Word Document (DOCX), Excel Document
(XLSX), and Web page in HTML format. After clicking on OK, you can enter the file
name and location, whereupon the export is started and the exported file is opened
with the preset program for the respective file type.

Export Retrieved Segments as text

Tip: You can also export the coded segments in the “Overview of Coded Segments”
this way.

Copying retrieved segments to the clipboard - including source
information
In a research project, citations (e.g. interview passages) are often integrated into the
final report. It is important to note the source information of these citations - the
document and paragraph or line from which they were taken. MAXQDA simplifies this
process with the function Copy Segment (with Source Information). You can access
this function by right-clicking on the source information in the “Retrieved Segments”
window.
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Getting a segment's source information from the context menu

Tip: The function can also be activated by right-clicking on
(1) a coding stripe in the "Retrieved Segments" window,
(2) a coding stripe in the "Document Browser", or
(3) a line in the "Overview of Coded Segments".
When you open the function from the context menu, MAXQDA copies the selected
segment into the clipboard. Now you can paste the citation into your word processing
program by pressing Ctrl+V (Windows) or ⌘+V (macOS). At the end of the citation,
the document name from the “Document System,” as well as the paragraph or line
number, will automatically be inserted.

Citation with source information in word processing program

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to send the currently selected coded segments to a new or existing
worksheet.

Code Retrieved Segments
MAXQDA makes it possible for you to code some or all of your retrieved segments in
the “Retrieved Segments” window. In this way, you can search and code quickly
within specific segments that have been called up.
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Let’s say you've carried out a retrieval of the intersections between the codes “Health”
and “Relationship” for all persons in your interview sample. You can then choose to
code all of these segments with a code called “Health + Relationship”. To do this, click
on the
Code retrieved segments with a new code in the toolbar of the "Retrieved
Segments" window and enter the new code name. After clicking OK, MAXQDA will
code all segments in the "Retrieved Segments" window with the new code.

Coding retrieved segments with a new code

Please note: If the listed coded segments overlap because the same location in the
data material was coded with different currently activated codes, then the outermost
segment boundaries of the overlapping segments are used. The number of newly
created coded segments may therefore be less than the number of listed coded
segments.
This action will be added to the list of coding actions in the Undo coding menu in the
“Coding” toolbar. When you open this list (the
icon is in the coding toolbar in the
"Document Browser"), you will see the most recent coding actions at the top with the
number of segments coded in each action in parentheses after the code name. If you
have coded many segments at one time with the autocoding function, the code
assignments can all be removed at the same time by clicking once on the appropriate
line in this list.

11 - Segment Retrieval

369

Undoing coding actions

Coding segments in the “Overview of Coded Segments”
You can also add a code to the segments listed in the “Overview of Retrieved
Segments”. Two symbols are available in the toolbar of the window for this purpose:

Code retrieved segments - an existing code is assigned to the selected retrieved
segments of the list. Several rows can be selected by holding down the Ctrl key
(Windows) or the ⌘ key (macOS). If no rows are selected, the entire table is coded.
Existing codings with the selected code are not changed.
Code retrieved segments with a new code - the selected retrieved segments of the
list are assigned a code, which can be created by clicking on the icon. Several rows can
be selected by holding down the Ctrl key (Windows) or the ⌘ key (macOS). If no rows
are selected, the entire table is coded.
If you code the segments with an existing code, a dialog appears in which you can
select the code from the "Quicklist of Codes". The quicklist contains all codes last
used or clicked, so you may need to click on the desired code before starting the
function.
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Options for automatic coding of the segments in the “Overview of Coded Segments” with an existing code

Coding text passages in the "Retrieved Segments" window
As soon as text segments are displayed in the "Retrieved Segments" window, you can
select any part of these segments and drag and drop them onto a code in the "Code
System". MAXQDA then generates a coded segment of the selected text section and
assigns it the selected code.

Coding text passages directly in the “Retrieved Segments” window

Please note: You can’t use this function if text passages from different segments is
selected.

Coding text passages in the “Overview of Coded Segments”
You can similarly code text passages in the “Overview of Coded Segments”:
1. Select a text section in the upper window area in the “Overview of Coded
Segments”.
2. Use your mouse to drag your selection onto a code in the "Code System".
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Coding text passages direcly in the “Overview of Coded Segments” section

Simple Coding Query
The Coding Query tool facilitates the retrieval process and the compilation of coded
segments. This tool allows you to control all essential settings from within a dialog
window. Before opening the Coding Query tool, you should activate the selected
documents and codes. You can then open the "Coding Query" dialog window from
the Analysis tab: click on the small arrow next to Complex Coding Query and select
Coding Query from the drop-down menu.
The following window will then appear:

You can determine various settings for the query from the dialog window:
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Only activated documents – Select whether all documents, or only activated
documents, should be considered in the query. The number in brackets indicates how
many documents are currently activated.
Only activated codes – Same options as for Documents.
Include subcodes – If selected, subcodes of codes will be included in the query.
Use weight filter – The output of coded segments can here be limited to segments of a
specific weight range.
Only coded segments of users – The output of coded segments can here be limited to
segments that were created by a specific user.

Complex Coding Query
By default, the “Retrieved Segments” window shows all segments that are coded with
the activated codes in the activated documents. If several codes are activated, they are
OR-linked, i.e., it does not matter with which activated code a segment was coded to
be listed.
Using the Complex Coding Query instead, you can search for coded segments, while
logically combining several codes, for example, outputting only segments where
several of the activated codes overlap or where another code has been assigned
nearby.
You can call up the Complex Coding Query in different ways:
●
●

Select Complex Coding Query from the Analysis menu or
click on the icon
in the status bar at the bottom of the MAXQDA screen.

Access to the Complex Coding Query in the Analysis tab

The following dialog window will open:

11 - Segment Retrieval

373

Complex Coding Query window

The dialog window has the following aspects:
●

●
●

●

●

●

The "Function" field allows you to choose the analysis function, ie, a combination
mode of the codes, the operation of which is described in each case.
Below that, there are three windows, labeled A, B, and C.
Window A is important for almost every retrieval option and holds the selection of
codes to be included in the selection function. To add codes, activate them in the
“Code System” and then click the button to add All activated codes.
B is also for selecting codes, but you can do so from the quick list. Simply click on the
symbol to the right of window B to view the list. To transfer a code to the quick list,
simply click on it in the "Code System".
C allows you to set certain parameters (e.g. the maximum distance between two
coded segments).
The "Results" field underneath offer functions to select what should be listed as a
result in the "Retrieved Segments".

Tip: You can also drag codes directly from the “Code System” to the A and B window
section with your mouse.
The "Options" section lets you apply the following settings:
Only activated documents [number of currently activated documents] - the query is
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limited to the currently activated documents. You can also adjust the activation in the
“Document System” when the dialog window is open.
Include subcodes - when this option is activated, not only the selected codes but also
their subcodes are taken into account. Think of this option as follows: the codes in the
code system are collapsed and all coded segments of the subcodes are included in the
coding query. Details on this option can be found in the Include Subcodes in Retrieval
section. This option can also be activated in the status toolbar after you have
completed your search.
Use weight filter - if the option is activated, only the coded segments whose weight is
within the entered range are retrieved. The weight filter can also be set in the status
bar after a successful search.
Only coded segments of users - if this option is activated, only the coded segments
created by the selected users are taken into account.
Above the buttons you can see how many segments have been found, i.e. for how
many segments the set conditions apply.
The retrieval begins when you click on the Start button.
The following table gives you an overview of the various functions:
Name
Intersection
(”small picture”)
Intersection (Set)
Overlapping
(”big picture”)
Only one code
Only this code
If inside

If outside

Description
Retrieve only the part segments that have all of the codes listed
in "A" assigned to them.
Retrieve only the part segments that have at least X of the codes
listed in "A" assigned to them (the number X is specified in
"C").
Retrieve the full segments where at least one part has all the
codes listed in "A" assigned to it.
Search for segments where only one of the codes listed in "A" is
assigned (and none of the other codes listed in "A").
Search for segments where the code selected in "B" is assigned,
but none of the codes listed in "A" are assigned.
Search for segments assigned to any one of the codes listed in
"A" that are also completely surrounded by a segment assigned
to the code selected in "B".
Search for segments assigned to any one of the codes listed in
"A" that has no overlap or intersection with a segment assigned
to the code selected in "B".
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Followed by

Near

Search for segments assigned to any one of the codes listed in
"A" that is followed by a segment assigned to the code selected
in "B" within no more than X paragraphs. The number X is
specified in "C". (Does not work in image or PDF documents.)
Search for segments assigned to any one of the codes listed in
"A" that is preceded or followed by a segment assigned to the
code selected in "B" within no more than X paragraphs. The
number X is specified in "C". (Does not work in image or PDF
documents.)

You can see which retrieval function is currently active in the status bar at the bottom
of MAXQDA, in this case it is the “Near” function:

Retrieval function in the status bar

Please note: If there are no segments shown in the “Retrieved Segments” window, it
could be because a complex retrieval function was accidentally activated. You can
quickly check for this in the status bar.

Complex Retrieval Functions
Intersection (“small picture”)
Definition: Retrieve only the part segments that have all of the codes listed in "A"
assigned to them.

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
Attention: All selected codes in Window A must be assigned to a segment in order for
them to be listed!
Changing the activations in the “Document System” immediately changes your
results.
It is often helpful for this function to activate the option Include the subcodes, so that
all combinations of intersections between each code (and its subcodes) are
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automatically included. The easiest way to include the subcodes is to click on the
symbol at the bottom of the screen.

Example:

Intersection (Set)
Definition: Retrieve only the part segments that have at least X of the codes listed in
"A" assigned to them (the number X is specified in "C").

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
4. Set the minimum number of codes that must intersect in Window C.
You can see in the “Results” window how many retrieved segments would be found
based on intersections.
If, as displayed in the example, the codes “Friends”, “Happy”, and “Leisure” are
entered in Window A, and you have entered in Window C that at least two
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intersections are required, only the intersection of “Friends” and “Leisure” fulfills the
condition and would be listed in the “Retrieved Segments” window. Only the section
of the coded segments that is coded with two of the codes is displayed.

Example:

Overlapping (“big picture”)
Definition: Retrieve the full segments where at least one part has all the codes listed in
"A" assigned to it.

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
Attention: Segments will only be listed if they are coded with all codes listed in
Window A.
The “Overlapping” function works just like the “Intersection” function, except that
the results are displayed differently. The results of “Overlapping” include the entirety
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of each coded segment that overlaps, rather than just showing the section that is
coded with both codes.
As with the “Intersection” function, it is often helpful to include subcodes in the
query. Then all combinations of subcodes are tested for overlap.

Example:

Only one code
Definition: Search for segments where only one of the codes listed in "A" is assigned
(and none of the other codes listed in "A").

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
If the codes “Friends” and “Happy” are in Window A, the first two examples on the
right would be included in the retrieval, because they don’t overlap each other. The
fact that "Happy” and “Nature” overlap makes no difference, because “Nature” is
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not in Window A. The last example would not be included in the retrieval because the
codes “Friends” and “Happy” intersect.

Example:

Only this code
Definition: Search for segments where the code selected in "B" is assigned, but none
of the codes listed in "A" are assigned.
This function is very similar to the “Only One Code” function, but it targets only one
selected code. The target code is selected in Window B. The other codes are selected
as usual in Window A.

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
4. Select the relevant code in Window B. The fastest way to do this is to drag it with
the mouse from the "Code System" into Window B.
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Example: The code “Friends” is the selected code in Window B. “Nature” and
“Happy” are the codes in Window A. When either “Nature” or “Happy” intersect
with “Friends”, “Friends” is not listed. This is the case in the second and third example
on the right. Only the first example shows an instance of “Friends” that isn’t
intersected by “Nature” or “Happy”. It would be listed in the “Retrieved Segments”
window.

Example:

If outside
Definition: Search for segments assigned to any one of the codes listed in "A" that has
no overlap or intersection with a segment assigned to the code selected in "B".

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
4. Select the relevant code in Window B. The fastest way to do this is to drag it with
the mouse from the "Code System" into Window B.
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Example: This function would be helpful if you were looking for text segments in
which people talk about happiness, but don’t want to include those instances that are
in the context of these peoples friendships.
“Happy” is in Window A, and “Friends” is in Window B. This means you are looking
for instances of “Happy” that are completely outside of “Friends”. In the example on
the right, only the third example would be called up. In the first example, “Happy”
isn’t even there, and in the second, “Happy” is not completely outside of “Friends”.

Example:

If inside
Definition: Lists segments where the code in Window A is completely surrounded by
the code in Window B. Results can be the segments of the inner code (Window A) or
the outer code (Window B).

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
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4. Select the relevant code in Window B. The fastest way to do this is to drag it with
the mouse from the "Code System" into Window B.
Example: Let’s say you are interested in the things people said about their happiness,
but only in the context of statements about their friends. In the examples on the right,
only the first shows a case where “Happy” (Window A) is found completely inside
“Friends” (Window B). That is not the case in the second or the third example.

Example:

Followed by
Definition: Search for segments assigned to any one of the codes listed in "A" that is
followed by a segment assigned to the code selected in "B" within no more than X
paragraphs. The number X is specified in "C". (Does not work in image or PDF
documents.)

How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
4. Select the relevant code in Window B. The fastest way to do this is to drag it with

11 - Segment Retrieval

383

the mouse from the "Code System" into Window B.
5. Enter a maximum allowed number of paragraphs between the codes in Window C.
If zero is entered as a number, B must begin in the same paragraph as A.
You can define what results should be generated as result of this function: The
segments of the code in Window A which are within distance X before Window B's
code, the coded segments of Window B's code, or both. The last option, however, will
rarely be necessary.
In the example on the right, we are looking for “Friends” (Window B) following
“Happy” (Window A) within one paragraph. This condition applies to both
appearances of “Happy”, because it is directly followed by “Friends” in both cases.

Example:

Near
Definition: Search for segments assigned to any one of the codes listed in "A" that is
preceded or followed by a segment assigned to the code selected in "B" within no
more than X paragraphs. The number X is specified in "C". (Does not work in image
or PDF documents.)
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How it works:
1. Activate the relevant documents in the "Document System".
2. Go to Analysis > Complex Coding Query and select this function.
3. Activate the required codes in the "Code System" and then click on All activated
codes in Window A.
4. Select the relevant code in Window B. The fastest way to do this is to drag it with
the mouse from the "Code System" into Window B.
5. Enter a maximum allowed number of paragraphs between the codes in Window C.
If zero is entered as a number, B must begin in the same paragraph as A.
You can define what results should be generated as result of this function: The
segments of the code in Window A which are within distance X before Window B's
code, the coded segments of Window B's code, or both. The last option, however, will
rarely be necessary.
Example: We are looking for places where “Happy” (Window A) and “Friends”
(Window B) are found within one paragraph of each other (Window C). “Happy” is
found two times in the screenshot, both times within one paragraphs of “Friends”.
We chose to view the Window A code in the Retrieved Segments, but we could have
theoretically chosen to list the Window B code or even both of them.

Example:
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Use Weight Filter
All segments that appear in the “Retrieved Segments” window have their weight
listed next to the source data (in brackets after the code).

Weight scores “Retrieved Segments” window

These weight scores can be used for the retrieval process. The user can define a range
for the weight scores in order to retrieve only those document segments with scores
inside of that range. To define this area, click on the gear symbol in the upper right
corner of the window of the "Retrieved Segments" window, and select Edit weight
filter.
The following window will then appear, in which you can enter any number from 0 to
100.

Setting the range for the Weight filter
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To turn the filter on and turn it on, you must switch it on again: Click on the gear
symbol in the "Retrieved Segments" window again and select Use weight filter.
This will cause only those segments to be displayed in the “Retrieved Segments”
window that have a weight score within the defined range. The weight filter affects all
retrieval functions, including “Intersection” and all functions of the Complex Coding
Query.
The status line at the bottom of the screen indicates whether the weighting option is
currently activated or not. When the function is switched on, the weight range applied
in the "Retrieved Segments" window is displayed.

Display of weight filter in the status bar

Tip: Click the weight filter icon in the status bar to turn the weight filter on and off.
To the left of the weight filter, the default value for the weight is also displayed in the
status bar. After clicking on this icon, you can change the value assigned by default
when assigning codes.

Include Subcodes in Retrieval
A hierarchical system of codes can be constructed with MAXQDA. The program offers
an easy way to make use of the hierarchical structure.

Example
Imagine you have defined the following codes:

●

Success criteria [parent code without coded segments]
ecologically
economically
socially
❍
❍
❍
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●

Ideal projection [parent code without coded segments]
ecologically
economically
socially
❍
❍
❍

If you now want to assemble all the coded document locations that have been
assigned a subcode of "success criteria" as well as any subcode of "ideal projection",
you could use the Complex Coding Query to search for all possible overlaps of two
subcodes. This approach would, however, be very cumbersome, especially if you are
dealing with still deeper code hierarchies or a large number of subcodes.

Including subcodes in a code search
MAXQDA offers the convenient option including subcodes in a coding query. To do
this, select the Include subcodes option in the local settings of the “Retrieved
Segments” window. In the example, it would be sufficient to only activate the two
upper codes and choose the Include subcodes option. Now all subcodes of the two
activated codes are taken into account in the search for overlaps.

The “Include subcodes” option in the context menu of the “Retrieved Segments” window

Whether the subcodes are included in the code search or not can be recognized in the
context menu of the “Retrieved Segments” window (by the marked or unmarked
checkbox). It is also shown in the status bar, whether or not the subcodes (or “code
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children”) are included. If there is a checkmark on the symbol, the subcodes are
included.

Subcode inclusion shown in the status bar

Tip: You can also select the option directly in the status bar by clicking on the icon –
this acts as a switch and changes the setting.

Include subcodes in the simple Coding Query
The option for subcodes also applies to the simple coding query: in this case it’s
sufficient to activate a parent code in order to automatically display the coded
segments of its non-activated subcodes in the “Retrieved Segments” window.
But, as described, the search function's full potential can be seen in the Complex
Coding Query, in which several codes are combined with one another.
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12 - Visual Tools
Code Matrix Browser: Visualize Codes per
Case
The Code Matrix Browser (CMB) visualizes which codes have been assigned to which
documents. The matrix provides an overview of how many document segments from
each document have been assigned a specific code, and this for each existing code.
The Code Matrix Browser is constructed as follows: Documents are listed in the
columns while codes are listed in the rows. The symbols at the conjunction points
represent the number of coded segments that are coded with a particular code. The
larger the symbol, the more coded segments are assigned to the code in question.
Document groups, document sets, or focus group speakers can also be displayed in
the columns of the CMB, for example, to compare individual cases or groups of cases.

The Code Matrix Browser

The Code Matrix Browser can be opened in the following ways:
●
●

Selecting Code Matrix Browser from the Visual Tools menu tab, or
using the keyboard shortcut Ctrl+Alt+M (Windows) or ⌘+⌥+M (macOS)

Code Matrix Browser options
After opening the Code Matrix Browser an options window will appear, which allows
you to change display options. Often, only the activated documents might be of
interest, for example.
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Code Matrix Browser options dialog window

First, you have to decide whether the results should be grouped or not:
Documents – No grouping, every document has a column.
Document groups – The columns are made up of document groups. The coded
segments of the documents in each group will be summed up.
Document sets – The columns are made up of document sets. The coded segments of
the documents in each document set will be summed up.
Focus group speakers – Focus group participants are displayed in the columns.
Further options allow you to restrict the visualization to selected data:
Only for activated documents – Only the activated documents will be taken into
account.
Only for activated focus group speakers - Only the activated speakers are displayed in
the columns. This option is only visible if you selected the focus group participants to
be displayed in the columns.
Only for activated codes – Only the activated codes will be displayed as rows.
Use weight filter – Only coded segments with a weight within the limits of the
currently defined weight filter will be used.
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Code Matrix Browser toolbar
The toolbar is the first thing you will see at the top of the Code Matrix Browser
window. Here you have access to the following functions:
Interactive Quote Matrix – Displays the coded segments associated with the cells
in an interactive view.
Display codes with hierarchy - If the option is activated, the codes are displayed in
the tree structure of the code system. Even if the “Only activated codes” option is
selected, non-activated upper codes are also included to preserve the tree structure. If
the option is deactivated, all codes are displayed on one level. If the “Only activated
codes” option is activated, then only the activated codes are displayed.
Names, columns: none/short/full – There are three possible options for
displaying the names of documents, document groups, document sets, and focus
group participants in the column headings:
●
●
●

no names: The column headers remain empty.
short names: Display of the first eight characters (usually recommended).
full names: Full name will be displayed.

Place the mouse cursor on a column heading to display the full document name,
including its document group.
Calculation of symbol size refers to all coded segments.
Calculation of symbol size refers to the column.
Calculation of symbol size refers to the row.
Display nodes as squares.
Display nodes as circles.
Display nodes as values.
Display heatmap with values.
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The Code Matrix Browser displayed as a heatmap

Count hits per document only once – Representation in the CMB does not refer to
the number of segments, but to the documents, i.e., it is only considered whether the
relevant code is present in a document or not. With collapsed subcodes, the code
frequencies of the subcodes are summed up.
Binarize view – Regardless of how many coded segments are presented in a cell,
this function displays only whether a coding is present or not; the symbol size is
therefore unified. Even when a collapsed subcode with multiple codings is present,
only one will be counted.
Sum – Displays the sum of rows and columns.
Sort columns by similarity of code pattern – By default, the order of columns is
based on the “Document System”. Clicking this icon, sorts the current display, so that
columns with many codes are placed on the left and columns with few codes on the
right. Columns with identical code patterns and frequencies are placed next to each
other. This feature is helpful to identify patterns and regularities and to find similarities
between cases or groups.
Refresh – Updates display by recalling the function.

Information window for a node
The size and color of the symbols in the matrix show how many segments of a code
have been assigned to each document, document group, document set, or focus
group speaker. The larger the symbol, the more segments were assigned for this code.
When you move the mouse cursor on a node, a small info window appears:
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Info window in the Code Matrix Browser

If documents are displayed in the columns, the name of the document, the code or
subcode, and the number of coded segments assigned to the code are shown in the
box. If the option Count hits only once per document is selected, the actual number of
codes for the node is additionally displayed in brackets behind the number used for
the visualization. In the example, “1(3)” means that 1 coded segment for “Typical
workday” is displayed in the column with the document "Riley", but actually, there
are 3 coded segments with this code in the document.
Tip: If you have written a summary for a node document x code in MAXQDA’s
Summary Grid, it will be displayed in the info window on a Code Matrix Browser’s
node (as shown in the previous screenshot).

What happens when collapsing codes?
By default, the codes are displayed in the CMB in the same way as in the “Code
System”, that is, in a hierarchical “tree” structure. Subcodes can be collapsed in the
usual way, by clicking the > symbol. When the subcodes are collapsed, the number of
coded segments is summed up on the parent code level. For example, if a parent code
(that hasn’t been applied in a document) has three subcodes with 10 coded segments
each, when you collapse the subcodes, the parent code will show 30 coded segments.

Compiling the coded segment for a node
The coded segments “behind” a node, can be called up immediately by doubleclicking on the node. The relevant document and code are then activated and the
coded segments appear in the “Retrieved Segments” window. It is possible to keep
the CMB open, allowing one to easily view the contents of different nodes.

How is the symbol size determined?
MAXQDA determines the smallest and largest code frequency of all displayed nodes
and then divides the distance between these two values into seven equally-sized value
ranges. For the smallest value range, the smallest symbol is used and for the largest
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value range the largest. In addition, the maximum distance between the displayed
code frequencies is taken into account. For example, if codes occur only once or twice
in the displayed documents, this distance is very small, and neither the smallest nor the
largest squares will be used, but two medium-sized ones, to not over-emphasize the
difference. The following graphic shows which square sizes are used at which distance
between the smallest and largest values (the range). If the smallest displayed value is
e.g. 5, and the highest is 8, then the range is 8-5 = 3. The cells with value 5 are then
assigned the smallest square from row “Range = 3”, the cells with value 8, the largest
from this row. If all the visualized numbers are identical (“Range = 0”), a mediumsized square will be displayed for all values.

Square sizes in the Code Matrix Browser

Collapsing or expanding codes can change the overall view because this may change
the smallest and/or the greatest value in the display.
If the Calculation of symbol size refers to the column/row option is selected, the
described mechanism is applied individually to each column or row.

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to save the current view in a new or existing worksheet.
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Exporting the Code Matrix Browser
In the CMB toolbar, there are three icons on the right that can be used to export the
display:
Copy current display as an image to clipboard - Copies the visible area to the
clipboard so that you can easily paste the results into reports or presentations by, for
example, using Ctrl + V (Windows) or ⌘+V (macOS).
Open as Excel table – Exports the complete matrix with the frequencies as an
Excel file and opens it. The columns and rows are swapped to allow easy import into
SPSS and other statistical software.
Export – Exports the complete matrix with the frequencies in Excel or HTML
format. The columns and rows are swapped to allow easy import into SPSS and other
statistical software. Exporting as a graphics file is also possible.

Code Relations Browser: Visualize Code
Co-occurrences
The Code Relations Browser (CRB) visualizes the relationships between codes and
displays which codes co-occur how often within a document. From this graphical
representation, it is much easier to see at a glance which codes are associated with
each other than from a number matrix.
The CRB is constructed as follows: Codes form the columns and the rows. The symbols
at the individual nodes indicate how many segments were coded with both the row's
code and the column's code. The larger the symbol, the more segments there are.

An example of the Code Relations Browser visualization
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You can open the CRB in different ways:
●
●
●

Click on Code Relations Browser in the Visual tools menu tab,
Use the keyboard shortcut Ctrl+Alt+R (Windows) or ⌘+⌥+R (macOS)
Click the Code Relations Browser icon
in the "Retrieved Segments" window.

Code Relations Browser options
After opening the Code Relations Browser an options window will appear, which
allows you to change display options. Often, only the activated documents might be of
interest, for example.

Code Relations Browser options dialog

First, you have to decide which codes will be shown as rows:
All codes – All codes will be shown, the order being the same as it is in the “Code
System”.
Activated codes – Only the activated codes will be shown as rows.
A similar decision has to be made for the columns in the Code Relations Browser, with
the added option of Choose top-level code. Selecting this option will open another
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dialog window after pressing OK, allowing you to select as many top-level codes as
you want. The selected top-level codes and their subcodes will be shown as columns in
the Code Relations Browser.
In the section “Type of analysis” you can select which relations MAXQDA will analyze:
Intersection of codes in a segment – Only “real” overlaps of codes will be analyzed,
which means that a segment has to be coded with both codes and the codes need to
overlap.
Proximity of codes in same document – Alternatively the Code Relations Browser can
analyze how often two codes are present at a defined distance from one another. The
distance can be set to a specific number of paragraphs (text), rows (tables), or seconds
(audio/video).
If you search with the “Proximity” function and chose distance “0” you may find more
hits than searching for intersections of codes. The function “Proximity” only evaluates
if two codes are assigned somewhere in the same paragraph – not at the same
segment.
Please note: The “Proximity” function does not work for PDF documents and images.
Occurrence of codes in the same document – In this analysis type the Code Relations
Browser shows in how many documents both codes occur. The codes do not have to
intersect or be in specific proximity to each other.
In the lower area of the options window, you can restrict the Code Relations Browser
display to certain documents or parts of documents coded with specific codes.
Only for activated documents - This setting is used to restrict the analysis to the
documents currently activated in the “Document System”.
Only for segments of the following codes - This setting limits the search to segments
coded with specific codes. If you drag a code from the "Code System" into the field
with this mouse, MAXQDA only analyzes code co-occurrences within segments that
have been coded with these codes.

Code Relations Browser toolbar
At the top of the screen, you will find the toolbar with the following functions:
Code Map – Opens a "Code Map" visualization that displays the relations of the
codes on a map. All codes that occur both in the rows and in the columns will be
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taken into account. The Code Map is created based on the code frequencies displayed
in the Code Relations Browser. However, whether a code is collapsed in the left list or
not will not be considered.
Interactive Quote Matrix – Displays the coded segments in an interactive matrix.
When choosing “Intersection of codes in a segment” as the type of analysis, only the
overlapping part of the segments will be displayed in the output. In “Proximity of
codes in same document” mode, segments that are close to each other will be
outputted. In “Occurrences of codes in same document” mode, segments that occur
together in a document will be displayed.
Display codes with hierarchy - If this option is activated, the codes are displayed in
the hierarchical structure of the code system, even if the option "Only activated
codes" is set, non-activated parent codes are also included to maintain the tree
structure. If the option is deactivated, all codes are displayed on one level. If the "Only
activated codes" option is activated, then only the activated codes are displayed.
Names, columns: none/short/full – There are three possible options for
displaying the names of documents, document groups, document sets, and focus
group participants in the column headings:
●
●
●

no names: The column headers remain empty.
short names: Display of the first eight characters (usually recommended).
full names: Full name will be displayed.
Display nodes as squares.
Display nodes as circles.
Display nodes as values.
Display heatmap with values.

Count hits per document only once – The Code Relations Browser display will be
based not on the number of code relations but of documents, meaning it will analyze
only whether a code relation occurs in a document and not how often. For collapsed
subcodes, the code relation frequencies of the subcodes will be summed up. When
using the analysis mode “Occurrence of codes in same document” this option is
selected automatically and hidden from the display window.
Binarize view – If selected, the Code Relations Browser will show only whether a
code relation is present or not; all symbols are displayed in the same size. For collapsed
subcodes, the code relations frequency of the subcodes will not be aggregated.
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Sum – displays the sum of rows and columns.
Sort columns by similarity of code pattern – By default, the order of columns is
based on the “Document System”. Clicking this icon, sorts the current display, so that
columns with many codes are placed on the left and columns with few codes on the
right. Columns with identical code patterns and frequencies are placed next to each
other. This feature is helpful to identify patterns and regularities and to find similarities
between cases or groups.
Tip: You can hide columns from the display by right-clicking on the column header
and choosing Remove.
Refresh – updates display via the Refresh function.

Information window for a node
Each symbol in the matrix represents the number of co-occurrences of the two codes.
The larger the symbol, the larger the number of co-occurrences. If you hover over a
node with your mouse, a small window appears informing you about the node codes
and the number of their relations.

Node information window

How are symbol sizes determined?
How MAXQDA determines the symbol sizes is explained in detail in the Code Matrix
Browser section.

Compiling the coded segments for a node
You can jump to the segments with co-occurring codes by double-clicking on the
node representing them. MAXQDA will compile all the segments in question in the
“Retrieved Segments” window. The CRB can remain open, so you can quickly go from
one set of co-occurring codes to another.
Please note: If you are in mode "Proximity" and double-click on a node, that has
collapsed codes, the collapsed subcodes will be expanded automatically and only the
higher code will be evaluated, not the previously collapsed codes.
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If you are in mode “Occurrence of codes in same document” and double-click on a
node, all of the documents in which the relation occurs are activated.

Export adjacency matrix for network analysis software packages
If you want to perform a network analysis of categories with a program like Gephi,
you can export the results of the Code Relations Browser as an adjacency matrix:
1. Clicl the Export icon
at the top right of the window.
2. In the file dialog, select "Adjacency Matrix (*.xlsx)" as the file format.

Relationen als Adjazenzmatrix exportieren

MAXQDA exports the frequencies of relations as follows:
●
●

●

The matrix is exported as if all codes were expanded.
Codes, that are displayed only in the columns are added to the rows and vice versa.
This creates a symmetrical matrix.
If the name of a code occurs more than once, the name of the parent code is
prefixed to ensure uniqueness of the code names.

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to save the current view in a new or existing worksheet.

Exporting the Code Relations Browser
In the CRB toolbar, there are three icons on the right that can be used to export the
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display:
Copy current display as an image to clipboard - Copies the visible area to the
clipboard so that you can easily paste the results into reports or presentations by, for
example, using Ctrl + V (Windows) or ⌘+V (macOS).
Open as Excel table – Exports the complete matrix with the frequencies as an
Excel file and opens it. The columns and rows are swapped to allow easy import into
SPSS and other statistical software.
Export – Exports the complete matrix with the frequencies in Excel or HTML
format. The columns and rows are swapped to allow easy import into SPSS and other
statistical software. Exporting as a graphics file is also possible.

Code Map: Position Codes According to
Similarity
In the Code Map, selected codes are displayed as on a map. The more two codes cooccur, i.e., the more similar they are in terms of their use in the data, the closer they
are placed together on the map.
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A Code Map

Creating a code map
To create a code map, follow these steps:
1. Select Visual Tools > Code Map in the ribbon menu. The following dialog box will

then appear:
Options for
a new Code Map
2. Use your mouse to drag all the codes from the “Code System” that you want to
place on the Code Map into the upper area of the dialog box. You can also activate
codes and transfer them directly to the dialog box via the Paste activated codes
button.
3. 3. Select one of the following three options, which determine what type of cooccurrence should be analyzed to determine the similarity between two codes:
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Intersection of codes in a segment – Counts the number of times two codes have
been assigned to the same segment. It is sufficient, if codes intersect; they do not
have to cover 100% of the same area.
Proximity of codes in same document – Counts the number of times two codes
were assigned at a definable distance in the same document or in the same media
file. You can define the maximum distance in the number field.
Occurrence of codes in same document – Counts the number of documents in
which two codes occur. The location of the two codes is irrelevant; they must both
have been assigned at least once in the document.
4. If necessary, restrict your analysis to currently activated documents only.
Click on OK and MAXQDA will open an accordingly generated code map:

Code map window

What does a Code Map display?
Each circle symbolizes a code, with the distances between two codes representing
how similarly the codes have been applied in the data. As a further option, the larger
the circles the more code assignments have been made with that code. Colors can be
used to highlight groupings (clusters). In addition, connecting lines between the codes
can be activated, which indicate which codes co-occur. Optionally, the connection
lines are displayed thicker the more coincidences there are between two codes.

12 - Visual Tools

404

Please note: (1) If a code selected in the options dialog box does not occur together
with any other selected code, it will not be placed on the Code Map. (2) Several codes
may be placed at the same position on the map if their similarity to other codes is
identical.

Toolbar options
You can use the toolbar at the top to adjust various settings for your Code Map.
The first three symbols allow you to set what type of co-occurrence is analyzed to
determine the similarity between two codes. These are the three options explained for
the settings dialog box above:
Analyzed relation of codes – Intersection of codes in a segment.
Analyzed relation of codes – Proximity of codes in same document.
Analyzed relation of codes – Occurrence of codes in same document..
Changing these similarity settings recalculates the display of your code map.
Futher options:
Display code frequencies - Displays the code frequency in the analyzed documents
after the code name.
Size of code symbols reflects code frequency – The more frequently a code is
used, the larger its symbol will be displayed.
Font size reflects code frequency – The more frequently a code is used, the larger
its name will be displayed.
Grid – Turns on and off a grid, as known from a real map, to better estimate the
relative distances between codes. The grid works with a fixed distance of 100 pixels.
Distances can therefore only be compared within a map, not between different maps.
Font – Select a font for the display, e.g. to adapt it to the font used in your
publication.
Increase and decrease font size – Adjusts the font size of the code
namessubcode names.
– Determines the color of the code symbols:
●

Cluster (map position) – Codes are assigned a color according to their group
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●

●
●

affiliation. The positions of the codes on the map are taken into account for the
group identification. The clusters do not take into account the exact calculated
distances, but only their projection on the two-dimensional surface. That is, codes
can be grouped together that are further away from each other in the
multidimensional space. You can determine the number of clusters in the numeric
field.
Cluster (distance matrix) – Recommended setting: Codes are assigned a color
according to their group affiliation. The calculated distances between the codes are
used for group determination. Due to the representation on a surface, even codes
that are close to each other can be colored differently (if two codes from different
clusters are displayed on the same map position, a black circle appears instead of the
color dot). You can determine the number of clusters in the numeric field.
Code System – Color is taken from the "Code System".
Uniform – All codes symbols are assigned the same color.
Zoom out, Zoom in – Zooms in and out of the displayed section of your map.
Refresh – Reopens the options dialog box to select other codes or documents.

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to save the current view in a new or existing worksheet.

Export code map
Symbols for export and further processing are available at the top right-hand corner:
Copy current view to clipboard – Inserts a high-resolution image into the clipboard
so you can paste it directly into a report or presentation.
Save as map in MAXMaps - Creates a new map in MAXMaps, the tool for concept
maps in MAXQDA, and inserts the content of your code map here. You can edit the
map later viaVisual Tools > MAXMaps.
Export – Saves the display as an image file in PNG or SVG format. If you select
Excel (XLSX) as the export format, all the calculated values are entered in the export
file: (similarity matrix, distance matrix, and coordinates).

Code Map interactivity
Code Maps are interactive:
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●
●

Click on a code to select it in the "Code System”.
Right-click a code and select Remove to delete it from the map. The map will then
re-generate itself with the remaining codes.

Opening a code map from the Code Relations Browser
If you use the Code Relations Browser, MAXQDA creates a matrix that displays the cooccurrences of two codes. Since exactly such an analysis forms the basis for the Code
Map, it can also be opened directly from the Code Relations Browser.
To do this, click on the first icon on the far left:

Open a code map from the Code Relations Browser

MAXQDA will then create a Code Map with all codes that are displayed both in the
columns and in the rows of the Code Relations Browser and that occur together with
at least one other of these codes.
Please note: (1) In the Code Map that appears, you can’t switch to other analysis
modes of the relationships between codes. The mode will have already been defined
in the Code Relations Browser. (2) Codes collapsed in the Code Relations Browser are
not aggregated, instead, all subcodes are considered individually.

Notes on the analysis process and presentation
The classic multidimensional scaling method is used to position the codes on the map.
For this purpose, a similarity matrix is first calculated according to the display in the
Code Relations Browser and then converted into a distance matrix. For the conversion,
the column sums are calculated first, so for each code it is determined how often it
occurs together with any other code. The maximum of these column sums is defined
as the maximum possible similarity. In each cell, the similarity of two codes is
subtracted from this maximum.
Therefore, a distance of 0 means that two codes only ever occur together, i.e., never
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without the other. A distance corresponding to the maximum means that these codes
never occur together. Please note that due to the reduction to a maximum of 2
dimensions (i.e. on one map) and this consequent angle of view, two codes may
appear visually closer together than the distance matrix would suggest.
If the Color: Cluster (map position) option is selected, the codes are clustered and
colored using a hierarchical cluster analysis of the positions on the two-dimensional
surface. If the Color: Cluster (distance matrix) option is selected, clustering is
performed using the underlying distance matrix. Unweighted average linkage is used
as the clustering method.
If the option Size of code symbols reflects code frequency is enabled, the
determination of symbol sizes is similar as the calculation of symbol sizes in the Code
Matrix Browser and Code Relations Browser: MAXQDA determines the smallest and
largest code frequency of all displayed symbols and then divides the distance between
these two values into seven equally-sized value ranges. The smallest value range gets
the smallest symbol and the largest value range the largest. In addition, the maximum
distance between the displayed code frequencies is taken into account. For example, if
codes occur only once or twice in the displayed documents, this distance is very small,
and neither the smallest nor the largest symbols will be used, but two medium-sized
ones, so as not to over-emphasize the difference.
The following image shows which symbol sizes are used at which distance between
the smallest and largest values (the range). For example, if the smallest displayed value
is 5, and the highest is 8, then the range is 8-5 = 3. The cells with value 5 are then
assigned the smallest symbol from row “Range = 3”, the cells with value 8, the largest
from this row. If all the visualized numbers are identical (“Range = 0”), a mediumsized symbol will be displayed for all values.
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Determination of symbol size as dependent on distances

Document Map: Position Documents
According to Similarity
The Document Map is a visual tool that displays selected documents as though they
were arranged on a map. The greater the similarity between two documents with
regard to codes assigned to them, the closer their circle symbols are located to each
other; the less similar they are, the further away they are from each other. If required,
the variable values of the documents can also be taken into account when
determining their similarity. Documents that are similar in terms of their code
assignments and variables can be marked with matching colors. Optionally, the size of
the circles themselves can be set to reflect the number of code assignments made in
the respective document.
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The Document Map

The Document Map is an ideal tool for visual grouping of cases (documents) and can
serve as a basis for building typologies or more in-depth explorations of the identified
groups.

Generating a Document Map
To generate a Document Map:
1. Select Visual Tools > Document Map in the MAXQDA main menu. An empty
document map will appear with its own menu.
2. In the Document Map window, under Start > Select Documents, select the
documents you want to place on the map.
3. Via Start > Select Codes, select the codes you want to take into account when
determining the similarity between documents.
MAXQDA will now place all the selected documents on the map.

Select the analysis mode
Two different modes can be selected in the Start tab to determine the distances
between the documents:
Frequency of Codes/Variable Values – The frequency with which a code has been
assigned in a document is taken into account. So if the code "Parents" was assigned
twice to Document A and three times to Document B, this is considered a difference.
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Occurrence of Codes/Variable Values – Only whether a code has been assigned to a
document at all is taken into account. In the above example, Documents A and B
would count as identical with regard to the code "Parents", because the code was
assigned in both cases – how often the code was assigned does not matter here.
Depending on the selected calculation mode, different similarity or distance measures
can be selected. These are described in detail in the Similarity Analysis for Documents
section.
Please note: When several documents are located in the same place because they were
coded identically with regard to the currently selected analysis mode, the number of
documents in this location is displayed instead of just one document. The
corresponding documents are listed in full when you move your mouse cursor over
them.

Taking variable values into account
By clicking on the Start > Select Variables icon, you can select document variables to
be taken into account when determining the similarity between documents, in
addition or as an alternative to codes. If the calculation mode “Frequency of
Codes/Variable Values” is selected in the Start tab, variables of the types “Integer”
and “Decimal” can be selected. If the variant “Occurrence of Codes/Variable Values”
is selected, variables of the types “Text”, “Date” and “Boolean” can be selected.
As there may be missing values for the selected documents in a document variable,
you have the option of choosing between two alternatives as to how to proceed in
this case:
Missing values: Set to 0 – The variable value is set to 0. Selecting this option usually
only makes sense in the Frequency of Codes/Variable Values mode.
Missing values: Exclude Documents – Documents with at least one missing value for
the selected variables are not placed on the map. In brackets behind this option, you
can see how many documents are affected and therefore not visible on the map.

Document Map interactivity
The Document Map is interactive:
●
●
●

Click on a document to select it in the "Document System".
Double-click a document to open it.
Hover your cursor over a document name or icon: A tooltip will appear displaying
which of the selected codes have been assigned in this document.
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●

●

Right-click a document and choose Remove to delete it from the map. The map will
then regenerate itself with the remaining documents.
Right-click on a document and select Activate Documents in this Cluster to select
only the documents of the clicked color in the “Document System”. This allows you
to perform analyses that only take into account the documents in this cluster.
Alternatively, select the Save Documents in this Cluster as a Set option to not only
activate the documents, but to compile them into a new set in the “Document
System” window.

Context menu for a document displayed on a Document Map

Customizing the display
In the Format menu you will find several options for interactively adjusting the
appearance of the Document Map:

Adjusting the Document Map in the “Format” tab

Number of Codes – Displays in brackets after the document name how many of the
selected codes occur in the document.
Size Reflects Number – The more analyzed codes have been assigned in the document,
the larger the circle will be symbolizing that document.
Font Size Reflects Number – The more analyzed codes have been assigned in the
document, the larger the font of the document’s name.
Grid – Turns on and off a grid, as known from a real map, to better estimate the
relative distances between codes. The grid works with a fixed distance of 100 pixels.
Distances can therefore only be compared within a map, not between different
maps./p>
Color: Cluster / Document System / Uniform – Specifies how the documents are to be
assigned a color:
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●

●

●
●

Cluster (map position) – Documents are assigned a color according to their group
affiliation. The positions of the documents on the map are taken into account for the
group identification. The clusters do not take into account the exact calculated
distances with respect to the selected codes and documents, but only their
projection on the two-dimensional surface. That is, documents can be grouped
together that are further away from each other in the multidimensional space. You
can determine the number of clusters in the numeric field.
Cluster (distance matrix) – Recommended setting for cluster display: documents are
assigned a color according to their group affiliation. The calculated distances
between the documents with respect to the selected codes and variables are used
for group determination. Due to the representation on a surface, even documents
that are close to each other can be colored differently (if two documents from
different clusters are displayed on the same map position, no color dot appears
there, but a black circle). You can determine the number of clusters in the numeric
field.
Document System – Color is taken from the "Document System".
Uniform – All document symbols are assigned the same color.

Comparing and investigating clusters
To better assess the similarities of the documents in a cluster and the differences
between the clusters, the function Format > Typology Table: Cluster is available. This
opens the following window:

Typology Table for comparison of individual clusters

The selected codes and variables are listed in the first column. The other columns are
made up of clusters.
In the Occurrence of Codes/Variable Values analysis mode, the number of documents
in which the code or variable value occurs is specified in the Typology Table. In the
Frequency of Codes/Variable Values analysis mode, the mean value and standard
deviation of the documents are displayed instead.
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In the example above, the first cluster consists of seven documents, the other two of
one and two documents, respectively. The first row shows that the code
“Grandparents” was assigned on average 0.4 times in Cluster 1, three times in Cluster
2, and not at all in Cluster 3. And from the last line, it can be seen that the people in
Cluster 1 are on average 20.4 years old.
Tip: The table is interactive. If you change the number of clusters in the Document
Map while the window is open, the number of columns in the Typology Table
automatically changes.
The allocation of individual documents to clusters can also be saved as variables so
that these can be used later for grouping the data. To do so, select Start > Save
Cluster As Variables. The Data Editor for document variables will open, to which a new
column with the cluster allocation will have been added.

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to save the current view in a new or existing worksheet.

Exporting a Document Map and calculations
The Start tab provides functions for exporting and refining the map as well as its
underlying calculations:
Export Matrix – Saves an Excel file with the following contents: distance matrix,
coordinates, and additionally, a similarity matrix if the analysis mode “Occurrence of
Codes/Variable Values” was selected.
Save As Map in MAXMaps – Creates a new map in MAXMaps – the tool for
Concept Maps in MAXQDA – and inserts the contents of the Document Map here.
You can edit the map later in MAXMaps.
Copy Display – Saves a high-resolution image of the map to the clipboard so you
can paste it directly into a report or presentation.
Export – Saves the display as an image file in PNG or SVG format. If you select
Excel (XLSX) as the export format, the same calculations are exported as with the
Export Matrix option.
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Notes on Document Map calculations and display
The classic multi-dimensional scaling method is used to locate the documents on the
map.
For this purpose a distance matrix of the documents is calculated for the selected
analysis mode Frequency of Codes/Variables as described in the section Similarity
Analysis for Documents. If the evaluation mode Occurrence of Codes/Variable Values is
selected, the resulting similarity matrix is first converted into a distance matrix. Since
the similarity values can be a minimum of 0 and a maximum of 1, the conversion is
performed by subtracting each similarity value from 1.
A distance of 0 means that two documents are identical with regard to the number or
frequency of the selected codes and the considered variable values.
Please note: Due to the reduction to a maximum of two dimensions (i.e., the mapping
of the document positions onto one plane) and the viewing angle taken, two
documents can appear visually closer together than the distance matrix would suggest.
If the Color: Cluster (map position) option is selected, the documents are clustered and
colored using a hierarchical cluster analysis of the positions on the two-dimensional
surface. If the Color: Cluster (distance matrix) option is selected, clustering is
performed using the underlying distance matrix. Unweighted average linkage is used
as the clustering method.
If the option Size Reflects is switched on, the same principle is used to determine
symbol sizes as with a Code Map.

Document Comparison Chart: A Visual
Comparison of Coded Text
This visualization works for several documents at one time and offers a sort of mix
between the Document Portrait and the Codeline. Simply choose the documents and
codes that you wish to include in the visualization by activating them before calling up
the function.
Please note: Only texts and table documents can be analyzed with the Document
Comparison Chart.
The Document Comparison Chart shows the documents in the rows, making it
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possible to compare the sequence of codes in each document. The cells show the
codes that exist in each paragraph of each document with a bar assigned the same
color as the code it represents. Each code that is present in the paragraph is
represented by a colored section of the bar. If a code is used more than once in a
paragraph, it is still only visualized once. To give you an idea of how this works, see
the image below. In this example, you can see 10 paragraphs for three different
documents. You can see that there were no coded segments in any of the documents
in the first paragraph. In “Doc 1,” the first coded segments are in paragraph two,
where two blue and one red code are visualized.
1
Text 1
Text 2
Text 3

2
3
■■■ ■■

4
■

■

5
■

6
■
■

7
■
■■
■

8
■■
■

9

10

■
■

■
■

If several codes appear in the same paragraph, the colors of both codes are listed in
the cell of the chart provided for that paragraph. By default, each paragraph is the
same width, regardless of how many characters it includes. In the case of several
codes, the available space is assigned proportionally to the coded segments in the
paragraph, taking into account how frequently a code has been assigned in the
paragraph - not how extensive the segment is. If a code occurs three times in the
paragraph, another code only once, then the first code gets ¾ of the area, the second
only ¼ of the area.
Like in Document Portrait, codes and colors must correspond in a meaningful way.
Otherwise, the diagram will have no meaning for you.
You can open the Document Comparison Chart by selecting Document Comparison
Chart via the Visual tools menu tab.
The visualization looks like this:

Example of a Document Comparison Chart
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The Document Comparison Chart is particularly useful for the analysis of structured
documents. In this case, all the documents have the same number of paragraphs and
allow for a direct comparison. You are more or less looking at a Document Portrait for
each selected document at the same time.

Interactive links with to the sources
As in all visualizations, the symbols representing the coded segments are interactive,
meaning you can jump directly to the coded segments in the original document in the
“Document Browser” by double-clicking on the symbol.

Standardize document length
In order to be able to compare texts of different lengths for the sequences of their
coded segments, the Document Comparison Chart offers the Standardize Document
Length option , which you can find as a symbol at the far left of the toolbar.
Activating this function means that MAXQDA does not present the analyzed texts in
paragraphs but divides them into 100 sections with equal length and visualizes the
coded segments present in each section.

Adjust window width
Activating the option
Fit to window width compresses the display horizontally to
fit your window. This is particularly useful for publications in which the entire coding
process of several documents needs to be displayed on one page.
Usually, you will use this option together with standardized document lengths, so that
all documents in the window can be compared directly with each other, even if they
are of different sizes.
The slider in the toolbar can be used to adjust the width of the columns, i.e. the
"resolution" of the subdivision with vertical lines.

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to save the current view in a new or existing worksheet.

Exporting the Document Comparison Chart as an image file
In the toolbar, there are three icons on the right that can be used to export the
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display:
Copy current display as an image to clipboard – Copies the visible area to the
clipboard so that you can easily paste the results into reports or presentations by, for
example, using Ctrl+V (Windows) or ⌘+V (macOS).
Open as Excel table - Exports the complete matrix with the frequencies as an Excel
file and opens it. The frequencies in the cells correspond to the number of codes
assigned in this section.
Export – Exports the complete matrix with the frequencies in Excel or HTML
format. The frequencies in the cells correspond to the number of codes assigned in
this section. Exporting as a graphics file is also possible.

Profile Comparison Chart: Compare Code
Frequencies and Variable Values
The Visual Tool Profile Comparison Chart allows you to compare cases in terms of their
code frequencies and variable values. Using this tool, you can identify similarities and
differences between cases, as well as patterns regarding code assignments and
variable values.
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The Profile Comparison Chart

The Profile Comparison Chart shows a line for each case—the so-called profile line.
Selected codes and variables are arranged on the horizontal axis, and vertical axes are
placed above each code and variable. The vertical axes are all the same height, but
their scaling may differ: it ranges from the minimum to the maximum value of the
displayed profiles. In the figure above, the first vertical axis above the code
"Childcare" ranges from 0 coded segments to 3. The last vertical axis on the far right
for the variable "Age" ranges from 22 to 46 years.
The following units from the "Document System" can be shown as profiles (please
note that they cannot be combined in one chart):
●
●
●

Documents
Focus Group Speakers
Document groups
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●

Document sets

The profile lines are colored differently. When documents or focus group speakers are
visualized, the lines can be colored according to their belonging to document groups
or by their variable values to visualize group membership. For example, in the figure
above, the variable "Number of children" is used to color the lines. All profile lines of
persons without children are colored light blue and the profile line of the only person
with three children is shown in dark blue. The coloring by document groups or
variables makes it possible to identify differences between groups of cases. At the
same time, however, the lines of individual cases remain clearly visible.
The profile comparison diagram is suitable, among other things, for the identification
of extreme cases and can be used for creating typologies. Or if you have automatically
coded the occurrence of words with Lexical Search or with MAXDictio's dictionary, you
can use the chart to visualize differences in coding frequencies between cases. The
combination of code frequencies and variable values in one plot also makes the tool
particularly interesting for mixed methods studies.
Note: The display is limited to 15 profile lines.

To create a Profile Comparison Chart

Step 1
In the menu ribbon of MAXQDA's main window, select Visual Tools > Document
Comparison Chart. An empty chart window will open with its own menu ribbon at the
top.

Step 2
In the chart window, click on Start > Select Documents to choose which cases you
want to display as a profile line in the comparison chart. You can select documents,
document groups, document sets, or focus group speakers.
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Select documents

Step 3
Via Start > Select codes, select the codes to be displayed. In the selection window of
the codes, check the Aggregate subcodes option if the code frequencies of all
subcodes are to be summed-up per case.
Example: The following code has three sub-codes. The numbers in brackets represent
how often each of the codes has been applied to the document “Interview with Joe”:

If the parent code “Satisfied with leisure time” is included in the chart with the option
switched on, for document “Joe” not only 1, but 1+3+1+0 = 5 coded segments are
taken into account.

Step 4
Alternatively, or in addition to the codes, select variables to be included in the chart via
Start > Select variables.
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Select variables (left) and sort variable values (right)

Note: When document groups or document sets are displayed, only numeric variables
(integer and decimal) are available for selection.
If you select a variable in the left part of the window, all associated variable values are
listed in the right part of the window. By default, numeric variables are sorted in
descending order and text variables are sorted alphabetically in ascending order. The
order set for a variable in the right part of the window is adopted in the chart. By
clicking on the AZ and ZA icons, you can reverse the sort order for individual variables.
In addition, for text variables, the order of their values can be adjusted as desired by
clicking and dragging with the mouse, so that, for example, the values
●
●
●

high
medium
low

are not displayed alphabetically, but in a meaningful order in the diagram.
Select the Exclude documents with missing values option to ignore all documents in
the display where no value or a value defined as missing is entered for the selected
variables.
Example: There is no information about a person’s income in a study and therefore a 99 was entered in the data editor under the variable "Income". In the "List of
Document Variables", the number -99 was defined as a missing value. If the exclusion
option is enabled, no profile line will be drawn for this person.
If this option is switched off, all documents with a missing value for a variable are
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assigned the value "missing". This is always output as the lowest value of the variable
axis.
Note: The Exclude documents with missing values option is automatically switched on
when document groups or document sets are displayed.

Customize display
In the Start tab of the Profile Comparison Chart, various options are available for
customizing the display:

Options for the display

Color By – Use this drop-down menu to specify how colors are assigned to profile
lines. The following choices are available:
●
●

All profiles different: Each line is given a different color.
Variable ‹variable name›: This setting is visible when variables are displayed. All
documents sharing the same value for the selected variable are assigned the same
color. The profile lines in the figure at the top are colored according to this option,
namely according to the variable "Number of children". For example, all persons
with 1 child are shown in green.
The following choices are additionally available if the lines represent documents or
focus group speakers:

●

●

Document System: The line colors correspond to the assigned colors to each
document in the "Document System".
Document group (top level): All documents in a document group have the same
color. This selection is analytically very valuable to compare groups of cases.

Display – this option is available only when you display document groups or document
sets. Here you define the unit of the vertical axes
●

●

Sum / Mean / Median: The sum, mean, or median of the code frequencies and
variable values are displayed.
Number (documents): The number of documents in the respective document group
or set in which the code has been assigned at least once is used for the display.
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●

Percent (documents): The "Number (documents)" (explained above) is presented
relative to the number of all documents in the document group or document set.
Activations in the document group or set are not taken into account.

Note: If the option "Number (documents)" or "Percent (documents)" is selected for
the display, no variables can be selected.
Sort Legend by 'Document System' – By default, legend entries are sorted to match
the order of the profile lines on the first vertical axis. Select this option to arrange the
entries according to the tree structure in the "List of documents" instead.
Set 0 as Minimum for Codes – By default, the lowest code frequency of a displayed
profile is taken as the minimum for the vertical code axes. If you select this option, all
code axes will always start at 0, regardless of whether there is a profile with this code
frequency.
Color Scheme – Select one of several color schemes for the profile lines here.

Save chart in "Questions – Themes – Theories"
Questions – Themes – Theories (QTT) offers a workspace in your MAXQDA project
where you can compile your findings. To save the Profile Comparison Chart in a QTT
worksheet, click Send to QTT Worksheet in the menu ribbon and select the desired
worksheet from the drop-down menu.

Export chart
The Export
icon allows you to export the current display of the Profile Comparison
Chart as a file. This file can then be inserted into a PowerPoint presentation or a Word
text, for example.
By clicking the
Copy to Clipboard icon, the current display is copied to the clipboard
and can be pasted, e.g., by using Ctrl+V (Windows) or cmd+V (Mac), into Word,
PowerPoint, and other programs.

Document Portrait: Picture the Coded
Segments of a Document
This visualization is for a specific document, making it a case-oriented function. The
document is shown as a picture of all the coded segments based on the order and
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colors of the codes.
You can access the Document Portrait for the displayed document in the “Document
Browser” window…
●

●

by selecting Visual Tools > Document Portrait from the menuribbon (for the
displayed document in the “Document Browser”),
by right-clicking on a document and selecting Document Portrait in the context
menu that appears(for the clicked document).

The results of this function are only meaningful if you have made use of the
opportunity to assign colors to codes. The visualization of a document can only be
fruitful if this association of colors makes sense to you. Here are a few examples:
●

●

●

Imagine a psychologist has coded an in-depth interview in a way that categories
related to aggression have red colors and categories for quiet and friendly behavior
have green colors. A Document Portrait would show you at a glance how often the
interview shows aggressive behavior and when during the interview this happened.
In biographical research, the color red can be chosen for critical life events, thus
making it easy to get an idea of the life course of a person and the concentration of
critical events.
For thematic analysis, it may be useful to associate different colors to different topics.
Now, you can easily see which topics dominate the discussion and which topics are
closely related.

Tip: The document portrait can’t be used for coded image files and image segments in
PDFs.
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Example of a Document Portrait

What does a Document Portrait show?
A Document Portrait shows the sequence of codes for a selected document. To better
understand what happens, it is useful to take a look at the “Overview of Coded
Segments” for a selected document. All coded segments are listed in this overview.
The first column displays the color associated with the code. This is the material that is
used to “paint” the Document Portrait. Only those colors displayed in the first column
of the overview table will appear in the visualization. In the overview table, all
segments are equal regardless of their size. The Document Portrait, however, takes the
size of the segments into account and “weights” the color according to the segment’s
size.
The color attributes of the codes associated with the document are displayed in a
matrix with lots of little squares (by default arranged in 30 rows, each one with 40
squares). The representation starts with the first square on the left in the first line and
ends with the last square on the right of the last line. The picture is set up in the same
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way as a classic television screen, where an electronic stripe goes along the screen
from left to right. All 1,200 squares are divided up according to the share of the coded
segments. If a document only had segment coded with a blue code, then the
Document Portrait would be totally blue. If this segment were coded with two codes,
red and blue, the Document Portrait would consist of 600 blue and 600 red squares. If
two segments were coded (again with red and blue codes) and the first segment was
twice as extensive as the second, the picture would start with 800 hundred red
squares followed by 400 blue squares.
Thus, Document Portrait displays the structure of documents in terms of codes as a
colorful picture. This helps to immediately identify the basic tone of a document, for
instance, if emotions have been coded with meaningful colors (aggressive= red,
tolerant= green, and so on).
Try out the Document Portrait – right-click on a document of your choice in the
“Document System” and choose Document Portrait. Of course, meaningful results can
only be obtained if you have assigned colors that make sense for your codes.

Document Portrait visualization options
Visualize entire document - If you choose this option, the visualization will include
white squares for sections of the document that have no code assigned to them. If
option is turned off, the Document Portrait only visualizes segments of the document
that were coded.
Mixed colors for overlapping codes (yes/no) - This setting decides how segments
should be visualized that are coded with more than one code. If the above option is
off, each of the colors of the codes used to code the same segment will be listed
sequentially, one after the other, similar to how it works in the “Overview of Coded
Segments”. If the option is turned on, the colors of each assigned code are mixed
together.
Display nodes as circles (on/off) - This icon lets you switch the symbols in the
visualization from squares to circles.
Using the three icons below you can toggle between different sorting of the tiles:
Sorted by document - The sorting of the coded segments visualized in the
Document Portrait is determined by their occurrence in the document.
Sorted by color - The coded segments are sorted by colors, same colors are
grouped.
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Sorted by color frequency - In this special display option, the portrait will be “tidied
up”: all symbols with the same colors are stacked like in a bar chart and the bar with
the most tiles is placed left. Only the most frequent 20 colors will be visualized.
The size of the document portrait can be adjusted using the drop-down menu in the
toolbar. By default a rectangular visualization of 30 x 40 tiles is displyed.

Interactive link with the source material
The square or circle symbols in the Document Portrait are also directly connected to
the original data, which means you can click on any symbol to call up that coded
segment in the “Document Browser.” (This is not possible if you have chosen to mix
colors for overlaps.) If you right-click on a symbol you will find the option Retrieve
Coded Segmentswith this Color which will list all coded segments with the chosen
color in the “Retrieved Segments” window.

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to save the current view in a new or existing worksheet.

Exporting the Document Portrait as an image file
In the toolbar, there are two icons on the right that can be used to export the display:
Copy current display as an image to clipboard - to copy the actual view into the
clipboard. Now you can open Word, PowerPoint, or other programs and paste the
image into it by choosing Ctrl+V (Windows) or cmd+V (Mac).
Export - Exports the Document Portrait as a graphics file.

Codeline: The Sequential Visualization of a
Document
The Codeline is a case-based visual function that displays a sequential view of a
document’s coded segments. The Codeline visualization is available for texts, PDF
documents, tables and also for videos. The picture is quite similar to that of a score of
a piece of music. For a text, the columns display its paragraphs, starting with
paragraph 1 and ending with the last paragraph of the particular text. The rows

12 - Visual Tools

428

display the codes. The cells of the Codeline are filled with a color if the code has been
assigned to the paragraph.
The basic idea behind the visualization can be seen below. There are 12 paragraphs
and three codes shown. You can see that nothing was coded in the first paragraph of
any of the documents. In the second, eleventh, and twelfth paragraph, Code1 is used.
In paragraph five, both Code2 and Code3 were used. This shows you already how you
can use this visualization. It gives you a visual overview of a document, so for the
phases of an interview, you can quickly identify which codes appear and co-occur.

1
Code1
Code2
Code3

2
■

3

4

5

■

■
■

Paragraph
6
7
■

■

8

9

10

■

11
■
■

■

12
■
■

You can open MAXQDA's Codeline either
●
●

via the main ribbon menu: Visual Tools > Codeline or
by selecting Codeline in the context menu for a text, table, or PDF document

Codeline options
When you call up the Codeline, MAXQDA offers the following options:
Only for activated codes – this limits the codes to be included in the visualization to
those that you have already activated in the “Code System”. If you have activated a
subcode, also its parents will be integrated into the visualization.
Aggregate on the 1st level – this option means that only top-level/parent codes will be
visualized. The subcodes of each parent code will be handled as if they were instances
of the parent code.
Use weight filter – if you select this option, MAXQDA will open another dialog after
clicking OK, in which you can set a range for the coding weight. Only those segments,
that fit into this range will be displayed in the Codeline.
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Options for the Codeline visualization

Codeline display
Unlike the Document Portrait, the Codeline tool can be used even if you have not
associated meaningful colors to your codes. The Codeline graphics display the color,
but if you have not selected colors, only green symbols will be displayed. The function
of Codeline is to show where in a document the different codes have been applied,
and this diagram also makes sense and can be interpreted without color
differentiation.
What can the Codeline be used for?
●
●

●

●

Codeline gives a good overview of the coding and can therefore be used universally.
The diagram may be of use for exploration – just follow a particular code, see when
it appears and which other codes appear near it.
The opportunity to display only selected codes enables comparing two or more codes
in the course of an interview.
When analyzing focus groups, you can see at a glance which speakers react to each
other and what the topics are in relation to the speakers.

Example of a Codeline visualization
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What does MAXQDA's Codeline display?
●
●

●

●

MAXQDA's Codeline creates a "codes x paragraphs" table for texts.
The codes are listed in the sequence of the text's paragraphs, starting with the first
paragraph, i.e. the beginning of the text. The paragraphs form the X-axis, i.e., the
diagram has exactly as many columns as the text has paragraphs.
If a code has been assigned within the paragraph, you will see its code color
depicted as a rectangle in the corresponding column. If codes have been assigned to
several paragraphs consecutively, you will see a continuous bar.
When a parent code is collapsed, the subcodes are added to this parent code and
displayed in the color of the parent code.

The Codeline function is available for all document types that MAXQDA supports,
except for images. Depending on the document type, different units will be used for
the columns:
Text
Table
PDF
Audio and Video file

paragraphs
rows
pages
seconds or minutes for files not longer than 10 minutes
minutes for files longer than 10 minutes

Display options
Above the Codeline you will see a toolbar, which offers several options for the display:
Codeline for linked media file – This option is displayed only when the Codeline is
opened for a text document that has an audio or video file associated with it. Turn this
option on to create the Codeline for the associated media file.
Standardize width of units and color them completely – If you select this option all
paragraphs of a text document will be displayed with the same width, independent
from their length. Furthermore, the whole paragraph width will be filled with the color
of the code, no matter how large or small the coded segments within this paragraph
are.
For the other document types, the behavior is as follows when the option is enabled:
●

●

●

For tables, the table rows are displayed with the same width and each table row
containing a code is visualized as if it were fully coded with the code.
For PDF documents, the pages are displayed with the same width and each page
containing a code is visualized as if it were fully coded with the code.
Audio and video files already have standardized units (seconds and minutes), so
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there is no standardization. However, each second or minute is visualized as if it
were fully coded with the code.

Display codes with hierarchy – If the option is activated, the codes are displayed in the
tree structure of the code system. Even if the “Only activated codes” option is
selected, non-activated upper codes are also included to preserve the tree structure. If
the option is deactivated, all codes are displayed on one level. If the “Only activated
codes” option is activated, then only the activated codes are displayed.
Fit to window width - Selecting this option will “compress” the Codeline into the
horizontal space of the window. This is very helpful for any publication in which you
want to include an image of the whole Codeline, but in which the space is usually
limited to a single page. The proportions of the visualized coded segments will stay the
same, only very short coded segments get a special treatment: they will be reduced to
a minimum of a thin vertical line only, but will not be excluded from the view.
You can use the slider next to the icons to adjust the column width.

Interactive link with source files
The display of the coded segments is interactive. If you hover the mouse over a
symbol, a short information window appears with the code or subcode name and the
position. Double-clicking on in the Codeline highlights the corresponding segment(s)
in the “Document Browser” or “Multimedia Browser”.

Store view in Questions – Themes – Theories
In the Questions – Themes – Theories window, you can collect and comment on all the
important results of your project. Click the Send to QTT Worksheet icon in the upper
right corner to save the current view in a new or existing worksheet.

Exporting Codeline
In the toolbar, there are two icons on the right that can be used to export the display:
Copy current display as an image to clipboard - Copies the current view to the
clipboard so that you can easily paste the display into reports or presentations by, for
example, using Ctrl+V (Windows) or ⌘+V (macOS).
Export - Exports the whole Codeline as a graphics file.
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Word Cloud: Visualize Word Frequencies
Word clouds are used to visualize the most common words in a text. They are ideal for
exploring large amounts of text and creating informative visualizations for
presentations.

Word Cloud

Generating a word cloud
Word Clouds can be generated for individual documents, document groups,
document sets, or for all the documents in a project. Right-click on the level in the
“Document Browser” for which you want to generate the word cloud and select the
entry Word Cloud.
Alternatively, you can also open the Word Cloud function via the icon with the same
name in the Visual Tools tab. A dialog box will then open in which you can select the
relevant documents.
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Start Word Cloud feature in the “Visual Tools” menu tab

Tip: You can create a word cloud of the currently listed text segments in the
“Retrieved Segments” window. To do so, click on the
icon in the toolbar of the
“Retrieved Segments” window.

Stop word list: Excluding words in the Word Cloud
So that your Word Cloud does not consist mainly of insignificant words or words
bearing very little meaning, you can create a stop word list of these words. The easiest
way to do this is to open the Word Frequencies function in the Start tab of the Word
Cloud window. The table that appears lists all the words in the text in their order of
frequency.
Double-clicking on the green icon icon in front of a specific word will put it in the stop
word list, which means it won’t be considered for Word Clouds. You can also select
several words in the list (using Ctrl+ or ⌘+the left mouse button or ⇧+the left mouse
button for an area in the list) and then right-click and select Add to Stop Word List. An
icon with the same name is also available in the toolbar.

Word frequency list

When you click the Refresh and apply stop word list, the Word Cloud is regenerated
excluding words from the stop word list.
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Tip: You can always right-click a single word in the Word Cloud and select Add to
Stop Word List to exclude it from the Word Cloud. To re-create the Word Cloud
without the excluded words, click the Rearrange icon in the “Start” tab.

Editing the stop word list
The option Edit Stop Word List displays the complete stop word list used for word
clouds in the current project. You can remove words from this list or add new words,
although the way of doing this described above, by clicking in the frequency list, is
actually much easier. Here you can also save and load already defined stop word lists
to exchange them between projects.
Tip: “MAXQDA Plus” and “MAXQDA Analytics Pro” users can also edit the stop list via
MAXDictio > Stop Word Lists and easily exchange items between different lists.

Working with the word frequency list
Via Start > Word Frequencies you can open a list of all the words contained in the
analyzed texts. This list shows, amongst other things, how often each individual word
occurs. It is also possible to combine several words into one. To do this, click and drag
one or more words onto another word with your mouse.

Adjusting the display
You can use the numerous options in the Start and Format tabs to customize the
appearance of the word cloud, including the number of words displayed, their font,
their shape, and color.

The Start tab

Functions in the Start tab

Word Frequencies – Opens a list of all words contained in the analyzed texts (without
the stop words) and shows their frequencies. Words can easily be transferred from the
word frequency list to the stop list.
Edit Stop Word List – Opens the list of all excluded words and lets you import existing
stop word lists.
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Words – Specifies how many words are visualized. You can use the slider to
incrementally remove rarer words. If several words occur with the same frequency,
words starting with letters earlier in the alphabet are selected first.
Lemmatize Words – When this option is activated, the inflected forms of a word are
grouped together, for example, “go”, “went”, “gone” are all treated as “go” and
“houses”, “housed”, “housing” are all treated as “house”.
Minimum Frequency – Defines the minimum number of times a word must occur in
order to be displayed.
Characters to be Cut Off – Clicking on the button with the three dots opens a small
dialog box in which you can enter characters that should be cut off from words and
ignored during counting. The selected characters then apply to all word-based
functions in MAXQDA and MAXDictio.
Case Sensitivity – If this option is activated, a distinction is made between capitalized
and non-capitalized words. For example, the words "earth", "Earth" and "EARTH"
are treated as three different words.
Ignore Numbers – Excludes all "words" consisting only of numbers.
Language Options – Change the language to Japanese to create Word Clouds from
Japanese texts.
Rearrange – Regenerates the word cloud, placing words in different random locations.

The Format tab

Functions in the Format tab

Shape – Allows to define the outer borders of the Word Cloud. There are various
variations to choose from:
●
●
●
●

predefined forms (circle, ellipse, square, triangle)
most frequent word
a word you have entered
a custom-selected image (is converted into a black and white image with the black
area filled in, hence black and white images are best)
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Example of a custom-selected image as a Word Cloud contour

Please note: For some selected shapes you need to increase the number of words to fill
in the shape completely. It is also helpful to use the Smallest Word slider to adjust the
size differences of the words (and thus the required space) to fill the shapes evenly.
Alignment – Lets you define the alignment of words. The following options are
available:
●
●
●

●

Horizontal: All words are displayed horizontally
Vertical: All words are displayed vertically
Horizontal and vertical: Words are randomly aligned horizontally and vertically, the
most common word is always displayed horizontally
30/45 degrees: Some words are additionally displayed at the selected angle
diagonally upwards or downwards.

Colors – Lets you choose from a range of different color schemes.
Font / Bold – Lets you specify the font.
Word Distance – Defines the minimum distance between words
Smallest Word – Defines the size of the smallest word. The smaller this size is, the
greater the difference in size compared to the most common words will be.
Size by – Defines the size of the words. Here you can choose from the following:
●
●

Frequency: The more frequently a word occurs, the larger it is.
Rank: The higher the rank of a word in the word frequency list, the larger the word.
If you choose this option, the absolute difference between the word frequencies is
irrelevant.
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●

Number of documents: The larger the word, the more documents it appears in. The
number of documents can be seen in the list of word frequencies. This option only
makes sense if you are analyzing several documents, as otherwise there will be no
size difference between the words.

Scale – Influences the differences in size between common and rare words. The
following options are available, which refer to the dimensions set under "Size by":
●
●

●

Linear: The font size is linearly proportional to the word frequency.
Most frequent greater: The font size is proportional to the square of the word
frequencies. This makes the common words appear larger compared to the “Linear”
option.
Most frequent smaller: The font size is proportional to the root of the word
frequencies. As a result, the common words appear smaller in relation to the
"Linear" option.

Largest word – Lets you set the placement of the largest word: centered, somewhere
near the edge, or at random.
Rearrange – Regenerates the word cloud, placing words in different random locations.

Display the occurrence of a word in the texts
The Word Cloud is interactively linked to the original texts:
●
●

Clicking on a word will list all the occurrences of that word in the analyzed texts.
If you hover your cursor over a word, the frequency of the word will be presented in
a small information window (regardless of the selection made in “Size by:…”).

Autocode hits of a word
You can autocode all occurrences of a displayed word with a new code. This makes it
possible, for example, to code all sentences in which an interesting word occurs in
order to analyze these sentences further:
1. Right-click on a word in the Word Cloud and select Autocode '‹word›' with a New
Code.
2. In the dialog that appears, you can enter the name for the new code or accept
MAXQDA’s suggestion.
3. In the subsequent dialog, you can specify the context that is to be coded: only the
word or also the surrounding words, sentences, or paragraphs (paragraphs cannot
be selected for PDF documents).
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Start autocoding function in the context menu of a word

Tip By selecting the Explore in Word Explorer option in the context menu of a word,
you can get more information about the usage of the clicked word in the entire text
corpus.

Save chart in "Questions – Themes – Theories"
In the Questions – Themes – Theories (QTT) you can collect and comment on all the
important results of your project. Click the
Send to QTT Worksheet icon in the
Start menu ribbon to save the current view in a new or existing worksheet.

Exporting the Word Cloud
In the Start tab, there are two icons on the right that can be used to export the
display:
Copy Display – Copies the current view to the clipboard so that you can easily paste
the display into reports or presentations by, for example, using Ctrl+V (Windows) or
⌘+V (macOS).
Export – Exports the whole Word Cloud as a graphics file.
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13 - Visual Tools (Concept Maps)
What Does MAXMaps Do?
MAXMaps allows you to visualize connections and relations. MAXMaps is primarily
intended to graphically represent the different elements of MAXQDA (codes,
documents, memos, coded segments) visually on a workspace, a so-called map, and to
put them in relation to one another. It is also possible to create maps that are not
related to the MAXQDA project.
MAXMaps can be used for different purposes:
●

●

●

Maps can help to explore and organize data. They allow you to develop your ideas
and to communicate them to your research team.
Maps can also be a valuable tool for scientific explanation and can help to visualize
complex relationships and theories. For instance, you can create tables and
worksheets to gain a better perspective of the different elements within a project.
MAXMaps can also be used for presentations and lectures. The different layers of a
map may be displayed in arbitrary order; thus, a variety of different options for
designing presentations are available.

With MAXMaps, it is possible to display:
●
●
●
●
●

●
●
●

The relationships between different codes and categories.
An overview of different facts and phenomena within the research field.
The different memos belonging to a document or a group of documents.
The results of a Grounded Theory study.
The context or important facts of the research, e.g. photographs of locations or
persons.
A graphical overview of the research methods used.
A research timeline.
The research design and characteristics of the sample.

MAXMaps can also have different functions for researchers. You can, for instance, use
MAXMaps to organize and manage your code system. Or you can link codes, text, and
memos in a hypothetical order to then further test the relationships in a second step.
MAXMaps offers multiple automatic templates to support the creation of maps for
different scenarios, e.g. to visualize the relationship of different cases.
MAXMaps is not merely a graphics tool that works with icons and symbols, though.
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All the elements used in a map are interactive, meaning they are connected to the
MAXQDA project. This makes an icon that symbolizes a text document not only a
passive icon but allows you to double-click on the icon to open the document in
MAXQDA’s “Document Browser.” Then you can read and browse through the
document. The same is true for memos. As soon as you click on the memo symbol, the
memo appears and can be read or even modified. In the case of symbols for coded
segments, one click displays the segment, which allows you to examine and compare
different segments of your map.
MAXMaps not only allows you to define links and relationships, it also offers a way to
make links and relationships that have already been implemented in your project
visible. Examples are memos that have been assigned to a document: MAXMaps can
import all the connected memos automatically. These memos are displayed as symbols
and you can open and check them. The same is true for codes: If you have imported a
code in your map, all the memos linked to this particular code can also be imported
automatically. Moreover, you can search and insert all of the codes overlapping with a
code on your map and automatically connect them to the code.
This visual method of data display is supported by the variety and flexibility that
characterizes MAXMaps. All elements used in a map may be designed individually.
Codes, memos, and texts are not always displayed with the same symbols and colors.
You can select different symbols, colors, fonts, and sizes, or even import your own
symbols unique to each element of your map. All labels, images, and symbols can be
managed individually. You can also import your own photographs, icons, or clip art.

The MAXMaps Interface
A project's maps are created and managed in their own workspace called
"MAXMaps". MAXMaps is accessed via the first icon on the left side of the Visual
Tools tab. The following interface will appear in a separate window:
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The MAXMaps window when you open this function

The MAXMaps interface is divided into several areas. On the left you'll see the "List of
Maps", which will contain a single entry called "New Map" when MAXMaps is
opened for the first time. Later, as shown in the figure, all your created maps will be
listed. The space on the right displays your map, the space in which you can model it,
insert objects, position and link them etc.
At the top you will see a menu with several tabs. In the Start tab, you'll find everything
you need to create and edit a map. Use the Insert tab to insert new codes, texts,
images, and shapes into the map. The Format tab and Line Format tab appear as soon
as you select an element or a line to display all available formatting options.
Tip: You can reduce the ribbon menu by clicking the
icon to make more space
available for your map. The "List of Maps" can also be hidden by clicking on the small
cross at its window edge to further widen the working area.

Undocking your "List of Maps"
You can undock the "List of Maps" window to move it somewhere else on your
screen. To do this, click on the small double-window icon at the top right-hand edge
of the list to release it from its fixed position at the window edge. You can place the
undocked window wherever you like, dragging and dropping it, even to a second
monitor. To re-dock it, drag the window to the left edge of the MAXMaps window.
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Undocking the List of Maps

Undoing actions
At the top right of the MAXMaps window there are two arrow icons to undo and
restore your last action.

Undo icons in MAXMaps

The Undo function always only applies to the currently open map. As soon as you
open another map or close the MAXMaps window, the "back-up memory" is deleted.
The global undo function of MAXQDA has no effect on saved maps in MAXMaps.

Zoom function
Using the zoom options at the bottom right of the screen, you can zoom in and out,
and jump to your first object, the "origin" of a map.

Zoom options in MAXMaps
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Create a Map and Add Objects
Creating a map
To create a new map, click the New Map icon on the Start tab. A new map is
immediately inserted into the "List of Maps" with the default name "New Map" and
an empty workspace is provided. The default name can be changed at any time by
right-clicking and selecting the Rename option in the context menu.
Any number of maps can be created. They are saved in MAXQDA but can also be
exported in the form of JPG or SVG files and then inserted into text files. The storage
of maps in the MAXQDA project file is done automatically every minute, as well as
when the MAXMaps window is closed. No separate command is required to save.
Tip: You can add a comment to each map, for example to note the status of a map
("first sketch", "finished") or important hints for a checked assumption. Click on the
comment symbol in the header of the "List of Maps" and enter a comment in the
window that appears. The comment is displayed as a symbol next to the name of the
map and can be opened by double-clicking on it.
You can create folders in the "List of Maps" where you can arrange your maps for a
better overview. To create a new folder, click the icon at the top of the page window.

Types of objects in MAXMaps
The following distinction is made between elements on a map:
●
●
●

Standard objects
Free objects
Connecting objects

Standard objects originate from MAXQDA, e.g. a code, a text, or a memo. They can
only be inserted into a drawing pad once. So a document can be contained within a
map once only. Modifications on standard objects have no effects on the MAXQDA
project. For instance, if you modify the name of a text imported from MAXQDA, the

13 - Visual Tools (Concept Maps)

444

name in MAXQDA’s “Document System” nevertheless remains the same. Objects
removed from the drawing pad are not simultaneously removed from the MAXQDA
project. No matter how you arrange an object, connections to the MAXQDA database
will always be preserved. This also means that a text that is represented only as a
picture will open via double-click in MAXQDA’s “Document Browser.”

Free objects are not connected with items of the current MAXQDA project. In this
sense, they are independent of the analyzed data.
Connecting objects are lines, which interconnect two objects.
Both standard and free objects consist of an object label and an object picture.
Standard objects receive the appropriate icon from MAXQDA as a picture and the
appropriate name from MAXQDA as a label. For example, as with a MAXQDA
document, the document name will be taken from the “Document System”.
Connecting objects can also be labeled and the type and characteristics of the
connecting line can be customized.

Inserting objects into your map
Each object that is imported into the workspace – be it a code, a memo, a text, a
coded segment, or a so-called free object – consists of two elements:
●
●

A symbol, and
a label.

When importing a MAXQDA object, the MAXQDA default icon (or "symbol") is
carried over as the picture and the MAXQDA name as the label. For example, when
importing a code, the code icon from the list of codes and the code name are carried
over.
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Code, memo, and document after import

Both the label and the icon can be changed, or an image, a diagram, symbol, or photo
can be imported. The label can also be changed along with the font type, font size,
and other properties.

How to import standard objects from MAXQDA
There are three ways to import an element from MAXQDA:

●

●

●

hold down the Alt key (Windows) or the ⌥ key (macOS) and double-click on the
selected object while in MAXQDA,
click on the element with the right mouse button and select the Insert into Map
option from the context menu, or
drag and drop the element into the map with the left mouse button.

The selected element is inserted into the drawing area at the next free point as viewed
from the top left.
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Inserting an element via the context menu

The following MAXQDA elements can be inserted. The brackets state where the
elements are located in MAXQDA:
●
●
●
●

Documents (“Document System”).
Document groups (“Document System”).
Document sets (“Document System”).
Codes and subcodes (“Code System”).
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●
●
●

●
●

Code memos and Memos on code sets(“Code System”).
Memos attached to parts of documents (“Document Browser”).
Memos attached to documents, document groups or document sets (“Document
System”).
Free Memos (Memo Manager, “Overview of Memos”).
Coded segments (“Retrieved Segments”, “Overview of Coded Segments”,
“Document Browser”, “Multimedia Browser”).

All these functions are only available with the MAXMaps window open. The object is
always imported into the currently open map.
For documents, codes, subcodes and coded segments, the assigned color is always
adopted. The assigned memo icon is always used for memos.
Tip: The fastest way to import objects is by holding down the Alt key (Windows) or ⌥
key (macOS) and double-clicking on the selected item.

Importing multiple documents or codes at once
You can import all documents or codes currently activated in the MAXQDA project
into an open map at once:
1. Select the desired codes or documents in the MAXQDA window. For example, you
can use the Mixed Methods > Activate Documents by Variables function to select all
documents with a specific property.
2. Then right-click on the white space in MAXMaps and select Insert Activated
Documents or Insert Activated Codes.

Inserting a new code
From the Insert tab in the MAXMaps window, you can create a code and paste it into
a map by clicking on the New Code icon. The dialog for creating new codes appears,
where you can specify the name, color, and description of the new code. The code is
inserted into the MAXQDA project at the top of the "Code System" and then its
symbol with the codename as a label is inserted in the opened map.
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The Insert tab in the MAXMaps window

Alternatively, this can be done by right-clicking on the white area of MAXMaps and
selecting the Insert New Code option.

Inserting a background image
You can insert a background image for each map, which is displayed behind all
objects. Right-click on the white workspace and select Insert Background Image.
Background images are always inserted in their original resolution and can be changed
as desired in their displayed size.
To change the image later, either right-click it and select Change Image... or insert a
different background image, this will replace the existing one.

Inserting free objects
The term "free objects" refers to objects that are not part of MAXQDA. Go to the
MAXMaps Insert tab to add one of the following free objects to your map:
●
●
●

New texts (a label without a visible icon is added)
New images from a file, e.g. a photo, a map or chart
Standard shapes such as squares, circles, and arrows

By clicking on New Code, New Text or New Image in the Insert tab, the new object is
inserted into the map at the next free position seen from the top left. For images you
have to select a graphic file. This file will then be saved in the MAXQDA project. In the
MAXMaps options, which can be accessed via the gear symbol at the top right of the
window, you can determine the quality with which images are saved in the map.
This is how you can insert one of the standard shapes (rectangles, circles, and arrows):
1. Click on the desired shape. The mouse pointer changes to a large cross.
2. Drag the shape to the desired position on the map by holding down the mouse
button and dragging the cross.
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Inserting free objects in a Map

Tip: Hold down the Shift key ⇧ to retain the proportions when dragging the mouse.
As a result, a square will remain a square and a circle will remain a circle.
Similarly, "free objects" also consist of an image and a label, except that no image is
displayed when a new text is inserted, and no label is displayed when images or
standard shapes are inserted. Image and label can be shown or hidden at any time.

Importing related MAXQDA objects
In MAXMaps, it is possible to import analytically related objects to an already imported
object, for example the coded segments of a code or the text of a memo.
To import related objects, right-click a MAXQDA element on a map. Depending on the
object selected, the context menu contains different options for importing.
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Context menu for the document icon in a map

The following list provides an overview of the import options for different objects:

Document icon
Import Memos - All memos that are contained in the selected document are inserted
into the workspace and linked to the document icon. The document memo from the
"Document System" is also inserted (if available).
Import Codes - Depending on the selection, all or the activated codes assigned in the
clicked document are inserted into the workspace and linked to the document icon.
Import Summaries - Depending on the choice of all or of activated codes, the
summaries that were written in the clicked document are inserted into the workspace
alongside the corresponding codes. The document is connected to the codes by lines,
which are also connected to the summaries by a line.
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Import document memos

Document group or document set icon
Import Summaries - Depending on the choice of all or activated codes, the summaries
that were written in the clicked document group or document set are inserted into the
workspace alongside the corresponding codes. The document is connected to the
codes by lines, which are also connected to the summaries by a line.
Import Paraphrases - All paraphrases that were written in a document of the clicked
document group or document set are inserted into the workspace and connected to
the icon by lines.

Code icon
Import...> Code Memo - If a code memo exists, it is inserted into the workspace and
connected with the clicked code symbol by a line.
Import...> Linked Memos - All memos that are linked with the clicked code are
inserted into the workspace and connected with the clicked code symbol by lines.
Import...> Co-occurring Codes - All codes associated with the selectedcode on the
same segment are inserted into the map. The inserted codes are connected with
dashed lines to the selected code icon. Optionally, the line strength can represent the
frequency: the thicker the line is represented, the more overlaps with the associated
code exist.
Import...> Subcodes - All subcodes up to the selected level are inserted into the
workspace and connected with the clicked code symbol. Subcodes on lower levels are
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ignored. Optionally the line thickness can represent the frequency: The thicker the line,
the more encodings were made with the subcode.
Import..> Coded Segments - Symbols (coding strips) for the coded segments of the
clicked code are inserted and connected to the code. The following dialog appears
before the import, in which you can select which segments and how they are to be
imported:

Import options for coded segments

At the top, select how many segments you want to import. If less than existing
segments are imported, it is also possible to prioritize according to highest weight or
largest segment. Change label to coded text or comment causes the text of the coded
segment or the comment on the coded segment to be automatically adopted as label
instead of the mere indication of origin.
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Imported segments of a code

Coded segment icon
Insert the text of the coded segment as a label - If the coded segment consists of a
text, a PDF or a table, the entire coded text is accepted as a label.
Insert the text of the associated summary as a label - If a summary exists for the code
and source document in the summary grid, the entire text of the summary is accepted
as a label.
Inserting a coded image segment as an "icon" - If the image segment is coded in a
PDF or an image, the coded section is taken to symbolize for the segment.

Memo icon
Insert memo text as a label - The text of the memo is adopted as a label for the
activated memo icon.

Deleting objects
Each object can be deleted from the map:
1. The object is first selected with the mouse. You can also select multiple objects by

13 - Visual Tools (Concept Maps)

454

highlighting them with the mouse.
2. Press the Delete key or click the Remove from Map icon on the Start tab.
Alternatively, you can also right-click on the object and choose Remove from Map
from the context menu.
The object and its connections to other objects are then removed from the map.
Please note: Removing objects from a map has no impact on your MAXQDA project
data. If you remove a code from a map, it will remain in the code system.

Customize Objects in MAXMaps
You can easily customize the look and position of objects to create a map that suits
your analysis.

Selecting and moving objects
To do this, you must first select the objects you want to customize. Click an object
with the mouse or drag a frame that covers multiple objects to select several objects at
the same time. Selected objects are indicated by their additional blue frame.
If several objects are already selected, you can add additional objects for selection or
remove individual objects from the selection by clicking the objects while holding
down the Shift key.
Use the key combination Ctrl + A (Windows) or ⌘ + A (macOS) to select all objects on
a map.
Selected objects can be moved anywhere on the workspace by holding down the
mouse button.

The "Format" menu tab
The properties of selected objects are adjusted in tab Format and Line Format. The
menu items appear in the upper part of the window as soon as you select an object.

The Format menu tab
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The Format tab is divided into different areas:
"Label" Area
Here you define the appearance of the label of an object. You can adjust the font and
font size as well as the font color. The text width is specified in relative units: A width
of 10 means that the label is a maximum of 10 times as wide as the symbol.
By default, labels are displayed below a symbol. Click on the icon highlighted in the
next image to display the label above or not at all:

Options for label position

"Symbol" Area
Depending on the object type, there are different forms for the symbol, for example,
the different document symbols for a document from the "Document System".
You can also use a different image than the standard MAXMaps icons:
1. First click on the large Symbol icon and then select Add own icon... from the dropdown menu...
2. A file dialog appears in which you can select any image from your computer.
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Add own image as symbol

You can use the Display icon option to hide an icon so that only the label text remains
visible.
Tip: In order to hide all code symbols, for example to only operate with the code
names on the map, it is not necessary to switch the symbol to invisible for each
individual code. In the tab Start you will find the option Display Symbols > Codes,
which works like a switch: Click the option to hide all code symbols at once and click
the option again to show all symbols that are visible. Here you can also show or hide
the symbols of the Coded Segments.
"Object" Area
Here you can define the following properties for the entire object:
●
●

The layer on which the object is located.
The addition of a frame to the entire object in any color.

"Link" Area
In this area, you can assign two different links to an object after you have clicked the
Geo-Link/External Link icon:
External Link - Click on the three dots to select a file.
Geolink - Click on the three points to select a KML file.
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Add geo link to an object

To access the link later, right-click the object and select Open External Link or Open
Geolink.

Copying object properties
MAXMaps makes it possible to transfer properties from one object to other objects.
This of course makes it easier to give objects a uniform appearance. The function is
available for all objects, including link objects. In this case it is possible to transfer the
color and the line type from one link line to another.

Symbol for copying object properties

Here's how you do it:
1. Select the object whose properties are to be transferred to others.
2. Click on the Copy Format icon in the Format tab or the Line Format tab.
3. Select the object to which you want to apply the format.
Tip: If you double-click on the icon in the toolbar, the "Copy Format" mode remains
activated. Each object that you then click on is given the format originally selected. To
exit the mode, press the Esc key or click the Copy Format icon again.

13 - Visual Tools (Concept Maps)

458

Copying objects
Single or multiple selected objects can be copied to an internal clipboard of MAXMaps
using the function Start > Copy Object (or the keyboard shortcut Ctrl+C (Windows) or
⌘+C (macOS)). Start > Paste Object (or Ctrl+V (Windows) or ⌘+V (macOS)) inserts the
objects into the next free space in the top left corner of the map, while of course
preserving their design.
You can also right-click directly to the destination and choose Paste from the context
menu. The objects will then be inserted into the map in place.
Please note: Keep in mind that MAXQDA objects such as documents, codes and
memos can only be present once on the same map and may be ignored during
insertion.

Increasing and decreasing the size of objects
The following options are available for changing the size of selected objects:
●

●
●

Click on the blue dot at the lower right selection frame and pull the object larger or
smaller while holding down the mouse button.
On the Format tab, set the desired size in the number fields.
On the Format tab, click Increase Size or Decrease Size.

Change the size of an object in the format tab

The size ratio of symbol and label to each other can be adjusted by selecting the font
size in the object properties.

Adding and editing labels
Double-click a text in the workspace to edit the text in place. Hold down the Shift key
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⇧ and press the Enter key to insert a line break.
If an object does not yet have a label, you can add it by right-clicking on the object
and selecting the Add Label function.

Add a text to the symbol of a free object
Sometimes you may want to write a text in a free object such as a rectangle or a circle.
This can be done, of course, by creating another object via Insert > New Text and
placing it on top of the other object.
However, it is also possible to write a text that is linked to the object directly in the
free object: To do this, right-click on a free object and select Add Text from the
context menu.

Add text to an element

Tip: Double-clicking on the symbol of a free object directly opens the edit field for
entering and editing a text. The Format tab can be used to adjust the formatting of
the text. Selected formatting always applies to the entire text.

Grouping objects
Objects can be grouped so that their distances remain constant.
1. To do this you first have to drag a frame around the objects with the mouse. As an
alternative, you can also select individual objects to be grouped by clicking them
one by one while pressing the Shift ⇧ key. In the same way, the selection can also
be undone for individual objects.
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2. In the Start tab, click Group Objects, your selection will become a fixed group.
Alternatively, the option is also available after right-clicking on one of the selected
objects in the context menu.
The objects of a group can't be selected individually but are always selected together.
A change of object properties in the Properties window has the same effect on all
objects in the group, including changes in the size.
The group can be split up by clicking on the group and then clicking Ungroup objects
in the Start tab. Alternatively, the option is also available in the context menu for the
group.

You can group and ungroup objects with the icons framed in red.

Image exchange - importing images
The icons displayed in MAXMaps for MAXQDA object such as codes or documents,
are the standard MAXQDA icons - however, these can be exchanged against another
imported image, as follows:
1. Click the object with your right mouse button and select Change Image ... from the
context menu.
2. Instead of the default icon, you can now use any other image. The image formats
JPG, PNG and TIF are allowed.
Alternatively, you can use the Format tab to change the icon to a custom image by
first clicking the Icon button and then selecting Add own icon... from the pop-up
menu that appears.

Move objects to the front or back
To design a map in such a way that it reflects your ideas, you need to be able to
determine which objects should be placed in the foreground.
The procedure is quite intuitive:
1. Click the object you want to move. You can also select several objects at the same
time with the mouse.
2. Click the Bring Level Forward or
Send Level Back icons in the Start tab to
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arrange the sequence of your objects in the map. By clicking on the arrow below
these icons, the options Bring to Front and Send to Back are also visible, which
place an object all the way forward or back.

You can move objects further forward or back with the icons framed in red.

Alternatively, click on an object with the right mouse button and select one of the
positioning options in the Arrange menu. This menu also displays the key-shortcuts,
for example ⇧ + PgDown for "Send to back".

Aligning objects
To align several objects to each other, first select them. Then select the Align option in
the Start tab, which will give you several options:
The objects can be aligned horizontally, vertically or at the same distance from each
other. It is also possible to align the objects in a semicircle or circle. The alignment of
the objects always refers to the symbol of the object. Only if this symbol is hidden and
only the label is visible does the option refer to the text.

The Align option in the “Start” tab

Layers
Objects can be assigned to different layers. If you ignore this option, all newly inserted
objects will be assigned to the same standard “Base” layer. The Layer option makes it
possible to display or to remove parts of the drawing, so you can, for example, design
a presentation that gradually increases in complexity. You can start building a model
with only a few elements and gradually increase the number of elements that are
displayed, thus creating a structure that continually gains complexity.
The Layer function can be activated by clicking the layer icon in the Start tab. This will
open a window in which the existing layers are listed. At first, this includes only the
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“Base” layer. You can define a new layer by selecting New.

Layer window

Any object on the drawing pad can be assigned to a certain layer. Just choose the
option Layer after selecting the object with the right mouse button and assign the
object to the desired level in the menu.

Assigning an object to a layer

To display a level, simply put a checkmark in front of the desired layer in the dialogue
window.
Tip: You can also assign a selected object in the Format or Line Format tab using the
Select Layer function.

The Object Library
The object library is a helpful tool for simplifying the organization of your objects. You
can fill the library with any formatted object, so that you have quick access to the
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same shape in the future. To add an element to the library right-click on the object
and select Add to Library.

Add object to the library.

The selected object will be saved to your library and the "Library" window is opened
automatically on the left of the MAXMaps window.
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The Library window on the left side of the MAXMaps window.

The Library window can be opened or closed via the Library button in the Start tab at
any time.
Double-click on an object in the library to insert it into your map. All formatting is the
same as in the original.
At the top of the Library window are two icons that allow you to insert objects from
the library onto the map and delete objects from the library.

Linking Objects
To link two objects, click the Link icon in the Start tab to activate MAXMaps' Link
Mode. Alternatively, use the shortcut CTRL+L / ⌘+L to activate/deactivate the Link
Mode. In this mode, you can't select or move objects, but only create directional or
non-directional linking lines between two objects.
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Activating Link Mode in the “Start” tab.

Objects are linked to one another by clicking on one object and dragging the
connection line to the target object while holding down the mouse button.
If you later move objects on the desktop, the connections are preserved and move
with the objects.

Formatting lines
Connecting lines can be adjusted regarding line thickness, line color, line type, label,
and arrow direction.
If you click on a line, the Link Mode is deactivated, the line is selected, and the tab Line
Format opens to display options to adjust the line appearance.
To select multiple lines at once hold down the Shift key ⇧ while clicking on the lines
and adjust their properties all at once.

Edit appearance of linking lines in the “Line Format” tab

Tip: You can also format connecting lines as curved connections. To do this, click the
icon in the Format tab.

Print, Export, and Organize Maps
Printing a map
Any map created in the MAXMaps module can be printed in high quality. To start the
print procedure, click the Print icon at the top right of the MAXMaps window.

13 - Visual Tools (Concept Maps)

466

Adding maps to the "Document System" as new image documents
You can add a map as a new image document to the "Document System" at any
time, which allows you to analyze it further as an image. To do this, right-click on the
name of the map in your List of Maps and select Insert as Document.
Once you have added the map to your "Document System" you can analyze the map
like any image in MAXQDA, e.g. you can code parts of the image and add memos.

Copying maps to the clipboard
You can copy the current display of your map to the clipboard at any time, from
where you can then paste it into a report, presentation, or graphics program. In the
Start tab, click the Copy View icon.

Copying a map to the clipboard

Exporting a map as a graphic file
Maps can be exported in different formats. Thus, you can use them with other
software programs, such as Microsoft Word or PowerPoint. To start the export
procedure, click the Export Map icon in the Start tab.

The options dialog window for exporting a map.

The following file formats are available: SVG, JPG, PNG, and EMF for windows.

How to export and import a map
All maps are stored in the MAXQDA project file along with the rest of the files. Maps
can be transferred from one MAXQDA project to another project:
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1. Right-click a map in the "List of Maps" and select Export Map.
2. In the export dialog that appears, set the File format to "MAXMaps file (*.mod)"
3. Assign a file name and location for the exported file created with the extension
MOD.
4. In the target project, which can also be on another computer, open MAXMaps,
click on New Map (not on the symbol) in the Start tab so that the associated menu
opens and there you select the Import Map entry.

Importing map into a target project.

The connection between MAXQDA objects (such as codes and documents) on a map
and the MAXQDA project will, of course, be lost when importing a map. This is
because completely different codes and documents can exist in the target project.

Exporting and importing images
All images that you insert into a map or use as a symbol, are not stored in the
MAXQDA project, but instead in the MAXQDA folder for external files. This also
applies to coded image segments that have been inserted as symbols. If you have
imported images into a map, MAXQDA will additionally create a compressed ZIP file
with the images used when exporting the map as a MOD file in the same folder.
If you want to open the map on a different computer, you have to extract the images
from the ZIP file in the MAXQDA folder for external files on that computer. MAXQDA
does this work for you:
1. Open any MAXQDA project then, in the Home tab, click on the arrow next to
External Files and select Unpack Bundled Data Files from the menu that appears.
2. In the file dialog window, select the ZIP file created on the other computer.
MAXQDA then unpacks all the files from the ZIP file to the external files folder.
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Synchronize Map with MAXQDA Project
Data
The interesting thing about working with MAXMaps is that it always has a connection
to the MAXQDA project data. In the case of a code symbol this means, for example,
that when moving the mouse over the symbol in the map, the memo assigned to the
code appears at the mouse pointer and that a double-click opens the “Overview of
Coded Segments” associated with the code.
The following connections exist between the MAXQDA elements of a map and the
project data:
Document group and document set icon
●

●

mouse-over: display a preview of the memo of the document group or document set
at the mouse pointer (if available)
single click: focus the document group or the document set in the “Document
System”.

Document icon
●
●
●

mouse-over: display the document memo at the mouse pointer (if available)
single click: focus the document in the "Document System"
double-click: document is opened in the "Document Browser"

Memo icon
●
●

●

mouse-over: display the memo preview at the mouse pointer
single click: focus the memo (depending on the memo type in "Document System",
in "Code System", in the "Document Browser", in the "Multimedia Browser")
double-click: open the memo

Code icon
●
●
●

mouse-over: display of the code memo preview at the mouse pointer
single click: focus the code in the "Code System"
double-click: open the "Overview of Coded Segments" for this code (for codes that
have been inserted into a map by creating a model, only the segments that were
taken into account when creating the model are displayed in the overview)

Symbol of a coded segment
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●
●

mouse-over: preview of the segment at the mouse pointer
single click: focus the code in the "Code System", document is opened in the
"Document Browser" or "Media Browser" and moved to the position of the coded
segment

Activating documents and codes
It is also possible to activate a document or a code from MAXMaps. To do this, select
one or more documents, right-click on a selection and choose Activate Document /
Code from the context menu. The selected documents are activated in the "Document
System" in addition to any already activated documents.
Tip: You can also add one or more selected codes to an existing or new code set in the
“Code System” by using the context menu. Select the Add to Code Set function.

Opening code frequencies
In the Start tab, there is the Code Frequencies option, which allows you to show how
often the respective code was used in the data for MAXQDA codes in your map. The
code frequencies are displayed in brackets after the code name.

Code frequencies are displayed after the code name.

The code frequencies are dynamically linked to the original data. So if you delete or
complete a coded segment, the numbers brackets for each corresponding code in
MAXMaps are adjusted accordingly. Exceptions are codes that have been inserted into
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a map by creating a model. For these, the number in brackets indicates how many
codes were included in this code at the time the model was created. The number is
not updated with these codes, but the models always provide a snapshot of the code
frequencies at the time it was created.

Model Templates in MAXMaps
MAXQDA's model templates provide a unique tool for visualizing specific perspectives
on the data material. Very often, the research process focuses attention on parts of
the data, such as a specific document, a specific code, a common occurrence of codes,
or specific hypotheses and theoretical aspects described in memos. For such situations
the models in MAXMaps offer quickly accessible solutions, which can be adapted to
the respective circumstances and wishes by appropriate options well. MAXQDA then
produces a corresponding diagram and makes it available in the MAXMaps
workspace. This map can be further edited and supplemented in MAXMaps.

Models with focus on documents

Single-Case Model
All relevant data attached to a document is illustrated in the map. This includes all
appropriate memos, codes, and coded segments. Instead of the coded segments, the
summaries or paraphrases of the document can be output. The Single-Case Model can
be created for documents, document groups, document sets and focus group
participants. There is also a version with hierarchical code placements available.
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Example of a Single-Case Model

Two-Cases Model
This model visualizes which codes occur in both of the selected documents, document
groups or document sets, and also which codes only occur in one of the cases.

Example of a Two-Cases Model

Models with focus on codes
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Single-Code Model
Displays a selected code in the map and the associated coded segments or summaries,
as well as the code memo and the memos associated with the code.

Example of a Single-Code Model

Code Theory Model
This model is especially helpful for the development of theory. It automatically displays
all memos (with their ideas and hypotheses) attached to a specific code.
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Example of a Code Theory Model (with integration of subcodes on 1st level)

Code-Subcodes-Segments Model
A code and its subcodes are placed on the map. Each code or subcode is connected to
their coded segments. This model is also available in a hierarchical version.
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Example of a Code-Subcodes-Segments model

Hierarchical Codes-Subcodes Model
A code and its subcodes are placed on the map. The hierarchical levels of the subcode
are displayed like the levels of a building.

Example of a Hierarchical Code-Subcodes Model

13 - Visual Tools (Concept Maps)

475

Code Co-Occurrence Model
This model illustrates the associations and intersections between selected codes. The
model can be made more complex by including the subcodes in the visualization. As
an alternative to directly co-occurring codes on a segment, the proximity or occurrence
of codes in a document can also be analyzed.

Example of a Code Co-Occurrence Model

Creating a new model
To create a new model, follow these steps:
1. Click on New Document Model or New Code Model in the Start tab of MAXMaps
and selected a model from the dropdown menu.
2. MAXQDA creates a new blank map with the name of the model as a title and will
display a short tutorial on how to insert MAXQDA objects: Depending on whether
you are creating a case-oriented or a code-oriented model, you will now need to
drag objects from your "Document System" or "Code System" onto your map
(these are displayed directly in MAXMaps).
3. As soon as the documents or codes have been selected, a preview of the finished
model appears on the map. On the left side you will find all the options available
for creating the model. You can try any option - the preview of the map
automatically adjusts with each option change.
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4. To finish creating the map, click the Use Model button at the top of the options
area.

Interactive model building

These models allow you to explore the data in a unique way. All elements of the map
are synchronized with the data of the MAXQDA project, i.e. a mere movement of the
mouse over certain elements of the drawing layer displays a preview of the contents of
the symbolized memos or coded segments. A double-click on the symbol of a coded
segment takes you directly to the corresponding position in the document.

> Single-Case Model (Coded Segments)
Function of this model
In this model, a case from the “Document System” is at the center of the analysis
(Document, Document Group or Document Set). After selecting the model from the
menu, the case to be analyzed is dragged onto the MAXMaps workspace. The
purpose of the visualization is to make the memos, codes, and code segments for the
selected case accessible.
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Model display in the map

The elements of the model will be displayed in the map with the document in the
middle of the workspace and the other elements arranged in a star pattern around it.
If memos are included, they are positioned at the top of the map.
The various elements are connected to the document by non-directional connecting
lines. The line thickness between the document and the code symbolizes the number
of segments available for each code in seven levels - the thicker the link line, the more
segments are available with that code. Of course, it can happen that a document has a
large number of codes or memos assigned to it, or that a large number of places in
the document have been coded. For this reason, maximum numbers for codes and
memos to be displayed and the number of coded segments and selection criteria can
be set as options.

Creating a new model and determining its structure
After you have selected a Single-Case Model (Coded Segments) in the Start tab via
New Document Model, drag a document, a document group or a document set from
the "List of Documents" to the MAXMaps workspace.
An options dialog will appear, in which you can select the following elements for the
display:
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●
●
●

Memos associated with the case or associated code.
Codes associated with the case.
Segments from this case associated with the codes shown.

Tip: You can also call up the model directly from the "Document System" by rightclicking on a document, a document group or a document set and choosing SingleCase Model > Single-Case Model (Coded Segments).
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Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Memo options
For each memo type, it is possible to select separately whether they are to be
integrated into the model: Document memos, memos in the document, code memos
and memos linked with code.
Code options
Display only activated - Only the currently activated codes that occur in the case will be
inserted into the map.
X most frequent codes - Limits the number of codes to be displayed in the map. If less
codes are to be displayed than are assigned to the case, a ranking is created according
to the number of segments present, i.e. the codes with the most coded segments are
displayed, of course only in relation to the case selected for the model.
Code size reflects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMaps uses three different
sizes for code representation: Codes whose frequencies are in the range of a standard
deviation around the mean are represented in a medium size. Codes with more or less
coded segments receive a larger or smaller symbol. If the code frequencies are close
together, MAXMaps uses only the smallest or the smallest together with the mean
symbol size.
Line width reflects code frequency - If this option is enabled, lines are drawn thicker
the more segments are assigned to the code.
Arrange codes by frequency/code system - Use this option to determine how the codes
are arranged. Sort by frequency starts on the right with the code with the most coded
segments, sort by code system starts with the code that is at the top of the code
system.
Coded Segments options
Display coded segments, max. X - If this option is enabled, an adjustable number of
associated segments are displayed for each code, so that you can get a visual
impression of the code frequency.
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If there are more segments for the code than the desired maximum number, the
segments are selected either by highest priority or by largest segment (segments with
larger area have priority).
Change label to: coded text/comment - If this option is enabled, the comment for the
coded segment or the coded text for text coding is used as label instead of the mere
indication of origin.
Change symbol to: coded image - If this option is enabled, the default symbol for
coded images is replaced by the default symbol for coded images.

> Single-Case Model (Summaries)
Function of this model
This model focuses on a case from the "list of documents" (document, document
group, or document set). The purpose of the visual representation is to present the
summaries belonging to the case and to make them accessible for exploration. In
addition, the memos belonging to the case can be presented.

Model display in the map
An example of a single case model with summaries is shown in the following figure.
The case is centered, the codes to which summaries have been written form a circle
around the case and the summaries branch from each code. In addition, the memos
belonging to the case can be displayed.
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Creating a new model and determining its structure
After you have selected a Single-Case Model (Summaries) in the Start tab via New
Document Model, drag a document, a document group or a document set from the
"Document System" to the MAXMaps workspace.
An options dialog will appear, in which you can select the following elements for the
display:
●
●

Memos associated with the case or associated code.
Codes associated with the case.

The options are described in detail in the Single-Case Model (Coded Segments).
A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Tip: You can also call up the model directly from the "Document System" by rightclicking on a document, a document group or a document set and selecting SingleCase Model > Single-Case Model (Summaries).
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> Single-Case Model (Paraphrases)
Function of this model
This model focuses on a case from the "list of documents" (document, document
group or document set). The purpose of the visual representation is to present the
paraphrases belonging to the case and to make them accessible for exploration. In
addition, the memos belonging to the case can be presented.

Model display in the map
An example of a single case model with paraphrases is shown in the following figure.
The case is centered, the codes to which summaries have been written form a circle
around the case and the summaries branch from each code. In addition, the memos
belonging to the case can be displayed.

Creating a new model and determining its structure
After you have selected a Single-Case Model (Paraphrases) in the Start tab via New
Document Model, drag a document, a document group or a document set from the
"Document System" to the MAXMaps workspace.
An options dialog will appear, in which you can select the following elements for the
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display:
●
●

Memos associated with the case or associated code.
Codes associated with the case.

The options are described in detail in the Single-Case Model (Coded Segments).
A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Tip: You can also call up the model directly from the "Document System" by rightclicking on a document, a document group or a document set and selecting SingleCase Model > Single-Case Model (Paraphrases).

> Single-Case Model (Focus Group
Speaker)
Function of the Model
The Single Case Model for focus group speakers is structured in the same way as the
Single Case Model, except that the center of the graphic is not a document or a
document group, but a single focus group participant.

Display in a map
An example of a single case model for a focus group participant is shown in the
following figure. The participant is placed at the center, the codes assigned in his
speech contributions outside and - if requested - the corresponding coded segments in
another outer circle and the memos at the upper edge:
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Creating a new model and determining its structure
After starting to create a single case model for a focus group speaker via the New
Document Model menu in the Start tab, drag a focus group speaker from the
"Document System" to the MAXMaps workspace.
The following options dialog window will appear, allowing the same settings as the
dialog window for the single case model. Instead of a document memo, however, you
can display the speaker memo. Only the memos in the document that are within a
speech contribution of the selected participant are taken into account:

13 - Visual Tools (Concept Maps)

485

Model options window

> Single-Case Model (Code Hierarchy)
Function of this model
As with the normal Case Model, a case in the form of a document, a document group
or a document set is the focus of this model template. Unlike the normal single case
model, however, the codes used in the case are not arranged in a circle around the
case, but from top to bottom while maintaining their hierarchy. No coded segments
are shown in this model.
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Presentation in the map
This then looks like as in the following figure. The hierarchy of codes is symbolized by
arrows: A code pointed to by an arrow represents a subcode of the code at which the
arrow starts.

Create a new model and determining the structure
After opening a Single-Case Model (Code Hierarchy) via the New Document Model
menu in the Start tab, drag a document, a document group or a document set from
the "Document System" into the map. The following options dialog window will
appear:
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Model options window

A preview of the model is shown on the map, considering the selected options. Click
the Use Model button to use the model as it is currently displayed.
Memo options
You can select which memos are to be integrated here: The corresponding memo
from the "Document System" (document memo or document group memo), the
memos that were assigned in the evaluated documents of the case, the memos of the
codes that were assigned in the case, and the memos that are linked with such a code.
Code options
Display only activated - When this option is selected, only the codes from the code
system that are currently activated are taken into account.
X levels of subcode - Here you can set how many hierarchy levels of the code system
should be considered. 1 means: only the codes of the highest level are to be included;
2 means: also their subcodes are displayed, if they have been assigned in the case, and
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so on. The maximum number of displayed levels is 5.
X most frequent codes - Here you can define the maximum number of top-level codes
to be displayed. MAXMaps selects the codes with the most coded segments for the
display, for codes with the same frequency the code above is preferred in the code
system. The maximum number of displayed codes is 20.
Code size reflects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMaps uses three different
sizes for the code representation: Codes whose frequencies are in the range of a
standard deviation around the mean value are represented in an average size. Codes
with more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.
Usually the option Aggregate frequencies for parent codes will be enabled so that the
frequencies of the subcodes are taken into account when determining the size of the
codes above. Otherwise, the subcodes may be displayed much larger than their upper
codes, because the upper codes were only used very rarely or not at all.
Tip: You can also call up the model directly from the "Document System" by rightclicking on a document, document group or document set and choosing Single-Case
Model > Single-Case Model (Code Hierarchy).

> Two-Cases Model
Function of this model
Using the two-cases model, you can visualize the extent to which codes, e.g. Relevant
topics, occur in two cases or only in one case. The frequencies of the codes can be
produced per case and their memos can also be integrated.
With the two-cases model, you can contrast two documents, document groups,
document sets or a mixture of these levels.

Model display in the map
The following figure shows an example of this model:
●

●

The two selected cases (documents in this example) are compared at a fixed
distance.
At the middle between the two cases you will see the codes that appear in both
documents.
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●
●

The pages contain the codes that were used in only one case at a time.
The connection lines indicate the frequency of code usage.

Creating a new model and model options
Select New Document Model > Two-Cases Model in the Start tab, and drag two
documents, document groups or document sets from the "Document System" onto
the map. The following options dialog window will appear:

Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Memo options
Document/Document Group/Document Set memos - If this option is enabled, the two
memos belonging to the cases from the "Document System" are integrated into the
map.
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Code options
Display only activated - When this option is selected, only the codes from the code
system that are currently activated are taken into account.
X most frequent codes per column - The maximum number of codes displayed on the
sides and in the middle of the map is equal to the number you select here. If the codes
have the same frequency, the code above in the code system is preferred.
Code size reflects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMaps uses three different
sizes for the code representation: Codes whose frequencies are in the range of a
standard deviation around the mean value are represented in an average size. Codes
with more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.
Label lines with code frequency - This option ensures that the frequency with which a
code has been used in a given case is indicated on the lines.

> Single-Code Model (Coded Segments)
Function of this model
A code from the "Code System" is the focus of this model. The purpose of this model
is to display the selected code with all its connected memos and coded segments.
The Single-Code Model is similar to the Single-Case Model, except that a code is the
focus rather than a document.

Model display in the map
The icon for a selected code is placed in the center of the map and other elements in a
circle around it. Lines connect all the codes and coded segments and memos are
placed under the heading and the code memo is connected to the code by a line.
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Creating a new model and determining its structure
Once you have selected the Single-Code Model (Coded Segments) via the New Code
Model menu in the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear, in which the following elements are selected for
display:
●
●

Memos: both the code memo and any memos linked to the code.
Coded segments.
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Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Memo options
You can select which memos are to be integrated into the map here. The code memo
of the selected code and the memos linked to the code are available for selection.
Coded Segments options
Display coded segments, max. X - If this option is enabled, an adjustable number of
associated segments are displayed for each code, so that you can get a visual
impression of the code frequency.
If there are more segments for the code than the desired maximum number, the
segments are selected either by highest priority or by largest segment (segments with
larger area have priority).
Change label to: coded text/comment - If this option is enabled, the comment for the
coded segment or the coded text for text coding is used as label instead of the mere
indication of origin.
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Change symbol to: coded image - If this option is enabled, the default symbol for
coded images is replaced by the default symbol for coded images.
Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Single-Code Model (Coded Segments).

> Single-Code Model (Summaries)
Function of this model
The focus of interest in this model is a code from the "Code System". The purpose of
the model is to represent the summaries written for the topic of the code and, if
necessary, to integrate the memos related to the code into the representation.

Model display in the map
The symbol of a selected code is placed in the middle of the workspace and the
summaries written on the topic of the code are placed around the document. Code
and summaries are connected by undirected lines, the memos are placed under the
heading.
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Creating a new model and determining its structure
Once you have selected the Single-Code Model (Summaries) via the New Code Model
menu in the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear, in which the following elements are selected for
display:

Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Memo options
You can select which memos are to be integrated into the map here. The code memo
of the selected code and the memos linked to the code are available for selection.
Summary options
Only for activated documents - Restricts the display of summaries to the currently
activated documents.
Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Single-Code Model ( Summaries).

> Code Theory Model
Function of this model
This model is similar to the Single-Case Model. This model also focuses on one code,
but instead of displaying the code's coded segments it displays subcodes and memos.
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Model display in the map
The code icon is put in the center of the map with the subcodes arranged in a circle
around it. Subcodes can be arranged on two hierarchical levels, with the first level
forming an inner circle around the code, and the second level forming an outer circle.
The memos are connected to the codes/subcodes with a line. Since memos can be
linked to more than one code, each code may be connected with several lines.

Code Theory Model without subcodes. Code memos and linked memos of subcodes will be displayed
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Code Theory Model with integration of subcodes on 1st level: subcodes are displayed in a circle around the code. Memos are displayed in
an outer second circle. The code memos and linked memos are imported, too.

Code Theory model with integration of subcodes on two levels: The subcodes are displayed around the main code; the subcodes of the
2nd level are highlighted in orange in the example

Creating a new model and model options
Select New Code Model > Code Theory Model in the Start tab and drag a code from
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the "Code System" into the map. A dialog window with model options opens up:

Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Memo options
Code memos - If this checkbox is selected, the code memos from the "Code System"
are displayed in the map.
Memos linked with codes - If this option is selected, all memos linked to a code on the
surface will also be included in the map.
Subcode options
Display subcodes up to level X - You can choose whether and up to which level
subcodes are displayed (1 = only include the direct subcodes; 2 = also include the
subcodes of the subcodes).
Only activated codes - You can use this option to restrict the display of subcodes to
the currently activated subcodes.
Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code Theory Model.

> Code-Subcodes-Segments Model
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Function of this model
This model creates a map with a selected code, its subcodes, and the segments coded
with these codes. This model is similar in many ways to the Single-Case Model except
that a code is the focus, rather than a document.

Model display in the map
The icon of the selected code is placed in the center of the map. The subcodes of this
code (and their subcodes if any) are arranged in a circle around it and connected to
the code by non-directional connecting lines. Their coded segments (of the code and
its subcodes) also placed around them with non-directional connecting lines.

Creating a new model and determining its structure
Once you have selected the Code-Subcodes-Segments Model via the New Code Model
menu in the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear:
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Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Subcode options
Display only activated - The displayed subcodes are limited to the currently activated
codes. You can also set the maximum number of subcodes to be displayed.
(all,1,2,3) levels of subcodes - You can specify whether only the direct subcodes (level
1) of the selected code or subcodes of other levels are to be displayed.
Line width reflects code frequency - If you set this option, the connecting lines to
codes with many coded segments are drawn thicker than for codes with few coded
segments.
Arrange codes by frequency / code system - This option determines the order of the
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codes. Sorting by frequency starts on the right with the code with the most coded
segments, sorting by code system starts with the code that is at the top of the code
system.
Coded Segments options
Display coded segments, max. X - If this option is enabled, an adjustable number of
associated segments are displayed for each code, so that you can get a visual
impression of the code frequency.
If there are more segments for the code than the desired maximum number, the
segments are selected either by highest priority or by largest segment (segments with
larger area have priority).
Change label to: coded text/comment - If this option is enabled, the comment for the
coded segment or the coded text for text coding is used as label instead of the mere
indication of origin.
Change symbol to: coded image - If this option is enabled, the default symbol for
coded images is replaced by the default symbol for coded images.
Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code-Subcodes-Segments Model.

> Hierarchical Code-Subcodes Model
Functions of this model
The Code-Subcodes Model is useful for illustrating the hierarchical structure of a code
and its subcodes in combination with the code frequencies.

Display in the map
The icon for the selected code is placed directly under the heading of the model.
Underneath the, the direct subcodes are placed at a small distance, and a row
underneath them the subcodes of the subcodes, etc. Arrows point from each code to
its subcodes. Codes with many coded segments can be displayed larger than codes
with few coded segments.
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Creating a new model and determining its structure
Once you have selected the Hierarchical Code-Subcodes Model in the New Code
Model menu of the Start tab, drag a code from the "Code System" onto the map. The
following dialog window will appear:

Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Subcode options
Display only activated - When this option is selected, only the subcodes of the selected
code that are currently active are taken into account.
X levels of subcodes - A 1 here means: Only the direct subcodes are to be included; a
2 means: their subcodes are also displayed and a 3 means MAXMaps also displays the
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subcodes of the subcodes.
Code size reflects code frequency - Select this option to display codes with many
coded segments larger than codes with few segments. MAXMaps uses three different
sizes for the code representation: Codes whose frequencies are in the range of a
standard deviation around the mean value are represented in an average size. Codes
with more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.
Usually the option Aggregate frequencies for parent codes will be enabled, so that the
frequencies of the subcodes are taken into account when determining the size of the
codes above. Otherwise, the subcodes may be displayed much larger than their upper
codes, because the upper codes were only used very rarely or not at all.
Only for activated documents - When creating the model and determining the code
sizes, only the currently activated documents are taken into account if this option is
selected.
Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Hierarchical Code-Subcodes Model.

> Code Distribution Model
Functions of this model
The Code Distribution Model is suitable for illustrating how often a selected code
occurs in which documents.

Display in the map
The symbol of the selected code is placed in the middle and around it the documents
in which the code was assigned are displayed in a circle connected by lines. If desired,
the frequency of a code can be displayed on the connecting line. The code frequencies
can also determine the line thickness and the size of the document symbol.
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Creating a new model and determining its structure
After you have selected the Code Distribution Model in the Start tab via New Code
Model, drag a code from the "Code System" to the MAXMaps workspace. The
following options dialog will appear:

Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
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Document options
Only activated documents - If this option is selected, only documents that are currently
activated will be integrated into the map.
Document size reflects code frequency - Use this option to display documents with
many coded segments larger than documents with few segments. MAXMaps uses
three different display sizes: Documents with frequencies in the range of a standard
deviation around the mean value are displayed in a medium size. Documents with
more or less coded segments receive a larger or smaller symbol. If the code
frequencies are close together, MAXMaps uses only the smallest or the smallest
together with the mean symbol size.
Arrange documents by code frequency / document system - You use this option to
determine the sequence of the documents. Sort by frequency starts on the right with
the document with the most coded segments, sort by "Document System" with the
document that is at the top of the list in the document system.
Line options
Label lines with co-occurrence frequency - Shows how often the code was assigned in
the linked document on the lines.
Line width reflects co-occurrence frequency - If this option is enabled, the more
segments are assigned to the code in the respective document, the thicker the
connection lines will be drawn.
Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code Distribution Model.

> Code Co-Occurrence Model
Function of this model
The "Code Co-occurrence Model" serves to visualize the co- occurrence of codes as a
network structure. The same three modes as for the Code Relations Browser and the
Code Map are available for the analysis of the co-occurrence:
●

●

Code Intersection - It is evaluated how often two codes have been assigned to a
segment together. It is sufficient if the codes overlap; they do not have to cover
exactly the same area.
Code Proximity - It is evaluated how often two codes were assigned at a definable
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●

distance in the same document or the same media file. You can determine the
maximum distance.
Code Occurrence - It is evaluated how many documents contain two codes. The
position of the two codes is irrelevant; they must both have been assigned at least
once in the document.

The subcodes of the selected codes can be included in the model.

Model display in the map
The following example shows the structure of the model:
●
●

●

●

●

The selected codes are placed in a circle on the work surface.
MAXQDA evaluates which codes occur alongside the selected codes and places them
in an outer circle around the selected codes.
Codes that occur alongside the selected codes are linked with gray lines. Relations
between the codes in the outer circle are ignored.
If desired, the subcodes of the selected codes can be inserted and linked to their
upper code with a red line. The line is drawn regardless of whether the subcodes
occur alongside their upper code.
It is possible to display the frequency of the co-occurrence on the connecting lines
and for it to determine the line width.
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Creating a new model and determining its structure
1. Switch to the Start tab and click New Code Model.
2. Select the appropriate Code Co-occurrence Model from the menu that appears,
depending on the analysis mode you require.
3. Drag one or more codes from the "Code System" onto the MAXMaps workspace.
To select multiple codes in the list, hold down the Ctrl/Cmd key and click on the
desired codes.
After the code selection has been completed, the following option dialog appears:

Model options window

A preview of the model is shown on the map, taking into account the selected
options. Click the Use Model button to use the model as it is currently displayed.
Code / subcode options
Display only activated - The evaluation can be limited to the currently activated codes.
Only for activated documents - If this option is enabled, only the common occurrence
of the selected codes in the currently activated documents is taken into account during
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creation.
X levels of subcodes - You can choose whether and up to which level subcodes are
included (0 = do not display subcodes; 1 = include only the direct subcodes; 2 = also
level 2, i.e. include the subcodes of the subcodes etc.).
X min. number of co-occurrences - If the number set here is not reached, the
connection is not drawn. So only connecting lines between codes are shown, which
occur together at least as often as defined here.
Code-symbol-size - You can select here whether all codes should be displayed in the
same size or whether the analysis results should be taken into account for the code
size. With the option By frequency of overlapping coded segments, the system
evaluates how often the code occurs together with other codes, i.e., the sum of the
numbers on the connecting lines is taken into account. The option By frequency of
overlapping codes evaluates how many other codes on the map a code has relations
with, i.e. how many connecting lines a code has.
Line options
Label lines with co-occurrence frequency - If this option is enabled, a number is
displayed on the connecting lines between two codes indicating how often the two
codes occur together.
Line width reflects co-occurrence frequency - Select this option to make connecting
lines between codes with many relations appear thicker than between codes that are
less common.
Options for codings to consider
Weight filter - By selecting a range of segment weights, the entire representation can
be limited to encodings of a specific relevance. If, for example, the range is set to 80
to 100, only those overlaps will be taken into account for the representation where
the segment weights lie within this required range.
Tip: You can also access the model directly from the "Code System" by right-clicking
on a code and selecting Code Model > Code Co-occurrence Model (Code
Intersection).

Options in MAXMaps
By clicking on the

Options symbol in the top right corner of the MAXMaps window,
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a dialog will open where you can view and change standard settings.

The MAXMaps Options window

Apply grid – this option “snaps” your objects to a grid, which is visualized in the
background. This allows you to line up objects more easily in straight lines, and the
grid will not be shown in exported pictures.
Reduce imported images to this size – this setting determines how imported images
are handled. You can select "300px", "600px" (= standard), "1,200px" or “Original
size”. The longest side of an imported picture is then reduced to the maximum pixel
size. Background pictures are always imported in their original size.
Visualize internal links – when this box is checked, internal links are visualized by a
blue line between documents, as soon as documents are inserted into a map.
Display comment in tooltip of coded segment - when this box is checked, comments
to a coded segment are displayed as tooltips, when you hover the mouse cursor on
the coded segment while having the synchro mode activated.
Auto-save maps in cache [minutes] - when this box is checked, a temporary copy of
the map is saved to cache at the set interval.
Use code and document color as border - check this option to display code and
document symbols with colored borders in their respective code/document color. If
this option is unchecked all symbols are displayed with black borders and a small color
symbol.
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14 - Paraphrasing
About Paraphrasing in MAXQDA
Paraphrases are summaries of individual sections of your data, written in your own
words. MAXQDA makes it easy to write paraphrases for sections of text, image
segments, and video and audio clips and then categorize these paraphrases in order to
systematize and group them. These paraphrase functions can be used to work
systematically with summaries of text sections and the formation of categories.
Paraphrasing is often carried out within the framework of qualitative content analysis:
it is used especially in the exploration of data and as the basis for inductive category
development (Kuckartz, 2014, Mayring, 2015, Schreier, 2012). But paraphrasing is
useful in general whenever you need only to summarize the important contents of a
text, e.g. when a journalist paraphrases the key statements of an interview.
Both, paraphrases and summaries, can be used to summarize content, but they have
very different applications and requirements. The following research blog article gives
an extensive overview of the difference between paraphrases and summaries:
Read article

Paraphrasing and Teamwork
If you’re working in a team and have split the documents to be paraphrased between
your team members, you can use MAXQDA's Teamwork functions (in the "Home"
tab) to either merge two projects (with different documents that contain paraphrases)
or to transfer paraphrases between projects (that already contain the same
documents).

Paraphrase Text Passages and Image
Segments
Activating Paraphrase Mode
How to create paraphrases for text, PDF, and image documents:
1. Open the document or image you want to paraphrase in the "Document Browser"
window

14 - Paraphrasing

510

2. Turn on "Paraphrase Mode" by clicking the Paraphrase icon (not the label of the
icon) on the Analysis tab, or by pressing Ctrl+⇧+P (Windows) or cmd+⇧+P (Mac).
The icon will be highlighted in blue, indicating that Paraphrase Mode is active.

Activated Paraphrase Mode

Writing New Paraphrases
1. While "Paraphrase Mode" is active, highlight the section of the document or image
you want to paraphrase.
2. Immediately after you let go with your mouse, MAXQDA will display a window in
which you can write a paraphrase. A paraphrase has a maximum of 255 characters
including spaces.

Paraphrasing window

3. Pressing the Enter Key (↩) or clicking on OK closes this window.
Tip: To include a line break in your paraphrase, press ⇧ + Enter.
The newly-created paraphrase is then displayed to the right of the document or image
in the sidebar of the "Document Browser". The paraphrased segments are highlighted
in green, so you can immediately see which segments have already been paraphrased.
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Paraphrases displayed in the sidebar of the Document Browser

Paraphrases in text documents cannot overlap with existing ones. So, when you
highlight a section that is already (partially) paraphrased, the paraphrase window will
not open up. Paraphrases in images can partially overlap with existing ones. It is not
possible however to paraphrase an image segment that is completely enclosed by an
existing paraphrase or that encloses an existing one.

Editing or Deleting Paraphrases
To edit a paraphrase, double-click the paraphrase text in the "Paraphrase Column"
next to the text. The window with the paraphrase opens again in which it can be
edited.
To delete a paraphrase, click on the red cross in the top right corner of the paraphrase
text.

Editing and deleting paraphrases

Deactivating Paraphrase Mode
Paraphrase Mode is deactivated in the same way it is opened by clicking on the
Paraphrase button in the Analysis tab. The sidebar of the "Document Browser"
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remains visible to shows the paraphrases next to the documents.
"Paraphrase Mode" is automatically deactivated when you open another document or
select another tab in the menu.

Displaying Paraphrases in the Sidebar of the “Document Browser”
You can display or hide the "Document Browser" sidebar independently of Paraphrase
Mode when you want to display your paraphrases at any time. Right-click in a
document and select Sidebar > Paraphrases.

Displaying paraphrases in the sidebar

Tip: Adjust the width of the sidebar by clicking and dragging the vertical separator
with the mouse.

Print Document with Paraphrases in the Margin
It is possible to print the document currently displayed in the "Document Browser"
and output the created paraphrases in the margin of the page. To do this, choose
Paraphrase > Print Document with Paraphrases. from the Analysis tab.
MAXQDA will then display the following print preview:
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Options for printing documents with paraphrases

Adjust your printing settings on the left.
Paraphrase column width - define how much wide the paraphrases space should be.
Highlight paraphrased Segments - displays paraphrased segments with a colored
background.

Paraphrase Video and Audio Segments
You can use MAXQDA to paraphrase scenes of a video or audio file. This is explained
in detail in the chapter Paraphrase Videos.

The “Paraphrased Segments” entry in your
“Code System”
The process of paraphrasing is independent of coding, i.e., the process neither requires
coding of the data (from a methodological point of view) nor does it generate codes.
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However, an entry “Paraphrased Segments” appears in the “Code System” window as
soon as the first paraphrase in a project is created. This entry is very similar to a code
and gives you access to all paraphrases in the current project. You can use the entry
similarly to a code to call up all paraphrases for selected documents in the “Retrieved
Segments” window:
●
●

In the “Document System” window, activate a document that includes paraphrases.
Activate the “Paraphrased Segments” code in the “Code System” window.

Paraphrased texts of an interview in the “Retrieved Segments” window

The “Paraphrased Segments” entry in your “Code System” has some special features:
●
●

●
●
●

●

You can’t delete it, rename it or use it for coding.
By default, it is displayed at the bottom of the code system. In the local settings
(accessible by clicking on the cogwheel icon in the “Code System” header title), you
can choose to display it at the top of the code system instead.
Coded segments cannot be added to or copied from it.
Paraphrases are not indicated by a coding stripe in the “Document Browser”.
Paraphrases are ignored in the visual tool Document Portrait and also when creating
document models in MAXMaps.
Paraphrases are displayed in the visual tool Codeline.

Categorize Paraphrases
To systematize and group paraphrases, you can categorize them using codes. This
function supports, among other things, the inductive and data-driven development of
categories.
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To start the categorization of paraphrases, proceed as follows:
1. Activate the individual documents which include the paraphrases you would like to
work with.
2. Select Analysis > Paraphrase > Categorize Paraphrases (you have to click on the
label "Paraphrase", not on the symbol above it).
The following interactive table window will then appear:

Interactive table window for categorizing paraphrases

A code tree is displayed in the left field. When you open the function for the first time,
it will still be empty. You can enter new categories here and then assigned them to
individual paraphrases. The number at the end of the code line tells you how often the
category occurs in your paraphrases. If you activate the function again later, all codes
which have already been assigned to a paraphrase will be displayed in the code tree.
So, you can easily pause your work on paraphrases and pick it up again later.
Above the code system there is a toolbar offering the following functions:
Display only paraphrases from the selected category – if this option is enabled and
you click on a category in the Code System, only the paraphrases of the selected
category will be displayed.
New code – creates a new category in the code system, which can be used to
categorize your paraphrases.
In the right field, all the paraphrases in your project will be displayed – each listed in a
separate row. The number of currently listed paraphrases is displayed in the upper
right corner of the window.
The individual columns contain the following information:
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Document – Indication of origin, in which document and at which position the
paraphrase was created
Paraphrases – Contains the paraphrase that has been written for the paraphrased text
Codes – The list of codes applied to the paraphrases
Paraphrased text – Contains the text that was paraphrased (this column is
automatically hidden when the interactive table window is opened); <IMAGE> is
displayed for paraphrased image segments, not the paraphrased image segment itself.
The table can be adjusted like all MAXQDA tables: The width and position of columns
can be changed with the mouse, or by right-clicking on a column header. A click on
the heading sorts the column in ascending order, another click in descending order.
The lines with the paraphrases can be sorted by drag and drop with the mouse so that
similar paraphrases can be arranged one below the other, which is very helpful for
categorization. Sorting remains as long as the project is open. When new paraphrases
are added, they are appended at the bottom.
Please note: All other MAXQDA functions are locked, while the paraphrases function is
open.

Functions in the Menu Ribbon “Start”
At the top of the “Categorizing Paraphrases” window there is a toolbar with the
following functions:
Display all codes – if this option is activated, not only the codes that have been
newly created in the opened window or already assigned to a paraphrase as code are
displayed in the "Code System", but all codes in this project.
Only activated documents – only the paraphrases of activated documents are
displayed. The display of frequencies in the code tree is adjusted accordingly. If the
documents were activated when this function was opened, this option is automatically
activated.
Filter – applies the filters you can define by right-clicking on the column heading
and selecting Set Filter.
Reset all Filters – removes filters from all columns.
Display search toolbar – lets you to enter a search term to search for text in all or
specific columns.
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Display Parent Code – in addition to the code, the "Codes" column also displays
the parent code.
Display Paraphrased Segments – shows another column containing the
paraphrased texts.
At the top right of the window there are also two icons for the local undo function:
Undo – undoes the last action in the window.
Redo – redoes the last action in the window.

Creating and Assigning New Categories
Paraphrases can be categorized using codes. You can always create a new code and
assign it directly to a paraphrase:
1. Right-click on the paraphrase and select Create and Assign New Code.

Selecting a function from the context menu of a paraphrase

2. In the dialog window that appears, you can enter a code name and assign a code
color. You can also enter a description of the new code in the "Code memo" text
box.
3. After clicking OK the new code is added, displayed in the code tree on the left side,
and assigned to the paraphrase.
This categorization is immediately made clear by the display of the code in the
“Codes” column.
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Applied category in the “Codes” column

To assign a pre-existing category to a paraphrase, click and drag the row with the
paraphrase to one of the displayed codes in the code tree.
You can also create categories without assigning them directly to a paraphrase: click
on the green plus sign that appears when you hover with the mouse pointer over the
word “Code System” or an existing code.
●
●
●

To do this, click the New code icon in the toolbar,
Use the key combination alt+N (Windows) or ⌘+⌥+N (macOS) or
right-click on the top entry of the code tree and select New code.

Please note: All changes made to the code system in this window, including the
addition of new codes, are automatically incorporated into your overall “Code
System”.

Removing Assigned Categories
To remove a category assigned to a response, click the cross that appears when you
move the mouse over a code in the "Codes" column.

Removing a category assigned to a paraphrase

Customizing Your Category System
Your category system can be customized throughout the entire analysis process. You
can change the order of codes with the mouse and even insert them as sub-subcodes.
By right-clicking on a code, all the functions from the overall "Code System" are
available to customize your code system here:
●
●
●
●
●

Delete code
Sort subcodes (alphabetically or by category frequency)
Change code color
Create or edit code-memo
Copy, move, paste coded segments
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Exporting Paraphrases
Your current display can be exported via the usual icons at the top right of the
window. All the rows (paraphrases) in the right field are always exported.
Export – Creates a table as an Excel file (XLSX format), as a web page (HTML
format) or as a text document (Word or RTF format).
Open as Word document – Creates a Word document and opens it.
Open as Excel spreadsheet – Creates an Excel document and opens it.

Paraphrases Matrix
In the Paraphrases Matrix, paraphrases you have written for cases or groups can be
displayed together and compared in a table view. The table columns are formed by
either documents, document groups, or document sets, and their respective
paraphrases are listed in each column.

The Paraphrases Matrix

Creating a Paraphrases Matrix
To open the Paraphrases Matrix:
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1. Select the function Analysis > Paraphrases > Paraphrases Matrix in MAXQDA's main
menu (you need to click on the label “Paraphrases” not on the icon).
2. A dialog window will appear in which you can drag and drop documents,
document groups, or document sets from the "Documents System". Each row in
the selection window will later form a column in the Paraphrases Matrix.

Column selection window

Click OK and MAXQDA will display the Paraphrases Matrix.

Functions in the toolbar
In the Paraphrases Matrix itself, you can access the following functions in the toolbar
at the top left of the window:
Display origin – displays the source documents below your paraphrases. Clicking
on this source selects the relevant paraphrased segment in the "Document Browser".
Zoom out/in – minimizes/maximizes the display of the paraphrases in the
columns.
x of y columns – Lets you specify how many columns are to be displayed next to each
other in the window at the same time.
Refresh – opens the options dialog window to let you regenerate the paraphrase
matrix again to adopt new matrix specifications.

Exporting the Paraphrases Matrix
The contents of the Paraphrases Matrix can be exported using the usual symbols at the
top right of the window.
Open as Word document – Creates a Word document and opens it.
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Open as Excel table – Creates an Excel document and opens it.
Export – Creates a Word file (DOCX format), an Excel file (XLSX format), or a web
page (HTML format).

Overview of Paraphrases
The Overview of Paraphrases is available in the "Document System" on all levels
(document, document group, document set) and lists all existing paraphrases for the
selected level in an overview table typical to MAXQDA. The text of the paraphrase is
always completely visible; in other words, long paraphrases are displayed across several
rows.

The Overview of Paraphrases

Accessing the “Overview of Paraphrases”
To open the “Overview of Paraphrases”, right-click on a document, document group,
or document set in the “Document System”. Then select Paraphrases in the menu that
appears.
The Overview of Paraphrases will then appear with all the paraphrases from the
documents at the selected level. The overview is interactive:
●

●

Click a row to display the paraphrased segment in the “Document Browser”, for
example, to compare your paraphrased text with the original segment.
Double-click into the cell with the paraphrase itself to edit the paraphrase directly in
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this table.
Like all overviews in MAXQDA, you can sort the table by clicking on a column header
and arrange the columns in any order by clicking and dragging the column headers
with your mouse. You can also filter, search, and export the overview (see Managing
Table Overviews).

Overview of Paraphrased Segments
The "Overview of Paraphrased Segments" can be accessed via the "Code System" and
is very similar to the "Overview of Coded Segments". This overview contains all the
paraphrases in your project and displays the paraphrased text of the selected
paraphrase in the preview area. In contrast to the “Overview of Paraphrases”, it also
displays the original paraphrased segments and contains additional columns with
information such as the size of the paraphrased segment. The paraphrases themselves
are only displayed in one row.

The “Overview of Paraphrased Segments”

The "Overview of Paraphrased Segments" is very useful for seeing an overview of the
paraphrases in your project together with your paraphrased segments in a single
window.

Accessing the “Overview of Paraphrased Segments”
To access the Overview of Paraphrased Segments double-click Paraphrased Segments
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in the "Code System". Alternatively, right-click on Paraphrased Segments and select
the corresponding option in the context menu.

Accessing the Overview of Paraphrased Segments in the “Code System”

Tip: By default, the Paraphrased Segments entry is displayed in the bottom row of the
"Code System". Alternatively, you can display this entry at the top. To do this, click on
the gear symbol in the "Code System" to open the local settings and check the option
with the same name.
The “Overview of Paraphrased Segments” is interactive:
●
●

Click on a row to display the paraphrased segment in the “Document Browser”.
Double-click on the paraphrase text to edit it directly in the overview.

The individual columns of the overview have the following meanings:
Document group, Document name, Beginning, End – Specifies the source of the
paraphrased segment.
Weight – A weight can also be assigned to a paraphrase (as with codes). The weight
can be used, for example, to identify paraphrases that you are unsure about and that
you would like to look at again later, either yourself or as a team.
Created / Created by – These columns indicate when and by whom the paraphrase
was created.
Area – Size of the paraphrased segment (text segments in characters, image segments
in square pixels).
Coverage – Size of the paraphrased segment as a percentage of the total size of the
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document.
Like all overviews in MAXQDA, you can sort the table by clicking on a column header
and arrange the columns in any order by clicking and dragging the column headers
with your mouse. You can also filter, browse, and export the overview (see Managing
Table Overviews).

Coding Paraphrased Segments
You can code the listed paraphrased segments with a new code or with an existing
code. To do this, click on the corresponding icons in the toolbar:
Code paraphrased segments – Codes the paraphrased segments with an existing
code from your code system. To select an existing code, you must first click on it once
in the “Code System”.
Code paraphrased segments with new code – Codes the paraphrased segments
with a newly created code.
If individual rows are selected, only these are coded, otherwise, all currently listed
segments are coded with the code.
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15 - Summarizing
The Idea behind the Summary Grid
The systematic analysis of texts, but also of other data, is often about systematically
organizing the data within a structuring framework and summarizing them in a
focused way on individual themes (categories).
The idea is to look for theoretical explanations for certain phenomena as well as for
similarities and differences between cases. In this process, it is important to focus on
what the research participants precisely said. But on the other hand, the researcher
should also detach from the participants’ own words. The aim is to sum up and
express what was said abstractly, and to eventually present it in a way that is
understandable for the recipients. During this analytical procedure, the “raw data”,
that is for example interview transcripts, records, field notes, etc., should be accessible
at all times. MAXQDA’s summary functions are designed for this purpose.
Please note: Another MAXQDA feature that is used to summarize content is the
paraphrase function, but summaries and paraphrases have very different applications
and requirements. The following research blog article explains which function can be
used for what:
Read article
MAXQDA's Summary function distinguishes two work stages and offers two individual
working environments for these stages:
First, the phase of Summary Creation and second, the phase of Summary Analysis and
Summary Presentation. For the second phase, results tables (so-called "Summary
Tables") based on the summaries are available, as well as the Summary Explorer for
comparing summaries by individual cases and groups.
The summary functions can be accessed in the menu tab Analysis:

Summary functions in the Analysis Tab
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To create summaries, the segments that you want to analyze must already be coded
thematically. This might have been done with the use of structured interviews,
thematic coding, or automatic coding. If the text is already coded with a code system,
a structure “texts x codes” already exists; you can view it using the Code Matrix
Browser.
You can picture the summary level as a thematic grid, i.e. a matrix “documents x
categories (codes)”. MAXQDA offers a matrix like this called the Code Matrix Browser
(CMB). It displays the texts in the columns and the categories in the rows.
The Summary Grid is a second analytical level that contains the summaries written by
researchers for every node of the CMB. The researchers write individual summaries
and can edit them later, i.e., by adding or altering the information. The idea is to
present the summaries in overview tables at a later stage of the analysis. This grid
allows every summary to stay linked to the original text segment from the raw data.p>

Create and Edit Summaries
To create and edit summaries, click on the Summary Grid symbol in the Analysis tab.
MAXQDA opens a new window called “Summary Grid.” The window itself is divided
into three areas:
1. Left window: the thematic grid, the Code Matrix Browser display (documents x
codes).
2. Middle window: the coded segments, so exactly what is normally listed in the
“Retrieved Segments” window after double-clicking a node in the Code Matrix
Browser.
3. Right window: the summary, this is where the summary is displayed, written and
edited.
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Window “Summary Grid”

In the right summary window, you can write or change a summary for the selected cell
of the first column. The selection is made by simply clicking on a cell in the first
column. The summary is automatically saved when you switch to another node in the
first column or close the window. The green cell highlights in the left window indicate
for which nodes of the grid summaries have already been written.
Tip: Selected text passages in the middle column "Coded Segments" can be dragged
into the right summary window by holding down the left mouse button. This makes it
easy to add original quotations to the summary.
You can adjust the content of the columns and rows of the grid on the left with two
symbols:
Only activated documents –only documents that have been activated in the
“Document System” will appear as columns.
Only activated codes –only codes that have been activated in the “Code System”
will appear as rows.
Additional symbols offer the following functions:
Names, columns: none –in the left window, the document names will not be
displayed in the column header.
Names, columns: short – in the left window, only shortened document names will
be displayed in the column header.
Names, columns: full – in the left window, complete document names will be
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displayed in the column header.
Display nodes as squares – existing codes will be symbolized as squares in the left
pane.
Display nodes as circles – existing codes will be symbolized as circles in the left
pane.
Display origin - displays each coded segment's position in the document and the
weight assigned to it in the middle column "Coded Segments". The source data are
interactive: Click on the entry, MAXQDA loads the corresponding document into the
"document browser" and marks the segment.
Display comments on coded segments - shows the corresponding comment in the
middle column "Coded Segments" below the coded segments - if you have written
one for the segment.
Display memos - displays all memos attached to the segment in the middle
column "Coded Segments" below the coding. Click on the memo title to open the
corresponding memo.
Standardize font – with this setting, you can standardize the text font, size, and
line spacing to create a consistent display of your text segments. Font styles such as
bold and italics are not affected by this setting.
Summary tables– opens the “Summary Tables” window.

Summary Tables
A Summary Table is an overview table of summaries and document variables for
selected documents and codes. It serves as a compilation of the summaries for
selected topics. Summary Tables are a useful tool for presentations and publications.
To create summary tables and to view the summary tables that you have already
created, click the Summary Table icon on either
●
●

the Analysis tab or
the toolbar of the Summary Grid window.

This will open the Summary Tables window. On the left side, you find a list of the
Summary Tables you have already created and in the window on the right, you can
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view the Summary Table that is currently opened.

Create new “Summary Tables”

To create a new Summary Table, click the button
will appear that offers three options:
●

●

●

in the toolbar. A dialog window

You can decide whether to include all documents or only activated documents. This
defines the rows of the Summary Table.
You can select any number of codes, to be displayed in the columns of the Summary
Table.
You can choose which document variables should be output as supplementary
information. All variables that are placed in the “Variables for first column” pane will
appear in the first column with the document name. All variables that are placed in
the “Variables in own column” pane will appear in additional columns next to the
codes.
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Dialog to create a new Summary Table

By clicking OK, the table will be created according to the parameters you have chosen:
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Summary Table

The Summary Table lists all summaries for the selected codes.
In the first column of the Summary Table, you can see the document group and
document name. In addition, the variable values of the variables chosen are displayed
underneath each document. This enables you to include further information about a
case in the Summary Table.
All typical table functions of MAXQDA are available:
●
●

●

You can change the order of columns by clicking and dragging with the mouse.
You can hide or display columns (right-click on the column header and choose Select
columns).
You can order columns alphabetically by clicking on a column header.

The table is in plain text format, so the entire table is formatted with the same font.
Please note: You can edit any cell of the Summary Table, which means you can modify
the summaries displayed. Changing the content of a summary in the Summary Table
will change the corresponding summary in the Summary Grid (and vice versa). Variable
values cannot be changed.
Each cell of the Summary Table is connected invisibly to the assigned coded segments.
These can be viewed in the “Retrieved Segments” window by right-clicking in the cell
of the Summary Table and choosing Display associated coded segments.
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Interactive cells in the Summary Table

Saving a Column of the Summary Table as a Document Variable
Let’s say one column of your Summary Table contains short and similar summaries for
a topic in an interview study. This analytic work can be used as a document variable in
MAXQDA, e.g., to activate interviewees for whom you have written the same
summary: Right-click on the column heading and choose Transform into Document
Variable. MAXQDA will now create a new document variable that contains the
summaries as values and will be named as the column. If the variable already exists,
MAXQDA will add a number to the name. Please note that the values will be
shortened to 63 characters. The column in the Summary Table remains.

Swap Rows and Columns of a Summary Table
You can use the icon
in the toolbar of the Summary Table to rotate the view by
90°, which means you swap the rows and the columns for display. The documents will
be displayed in the columns then and the codes (and the variables displayed in an own
column) in the rows.
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Opening, Deleting, Duplicating, and Renaming Summary Tables
To open an existing Summary Table, double-click on the name of the Summary Table
in the left panel. You can also right-click on the name of a table to open a context
menu that allows you to open, rename, duplicate, or delete the table.

Context menu on a table name

Please note: The Summary Table is dynamically linked to MAXQDA data. As soon as
you open a Summary Table, it scans your project for deleted documents, codes, or
variables, so that they can be removed or updated if necessary. Variable values that
have been changed in the Data Editor for Document Variables will also be updated.

Insert Summary Table as a Table Document in the “Document System”
The displayed Summary Table can be stored as a table document so that you can then
analyze the data with all of MAXQDA functions. To do this, click the
Insert
summary table as a table document in the “Document System” icon in the toolbar.

Code and Document Summaries
Often there is a need to integrate the summaries of a topic or a case into a single text;
a need to write a summary of the summaries, so to speak. You can think of it as
consolidating the summaries of the Summary Table line by line or column by column:
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Schematic explanation of Code and Document summaries

A case-based Document Summary is created for the rows, and a theme-based Code
Summary is created for the summary columns.

What are Code and Document Summaries for?
In Code Summaries, the analytical results with regard to a code’s segments are
recorded. For example, in a study with 15 interviews, all text passages in which
interviewees provide information about their personal environmental behavior were
coded with the code “environmental behavior.” For the analysis of the coded
segments, a summary of the text passages was written in the Summary Grid for each
person. In a Summary Table, these case-based summaries were compiled for all or
selected respondents in one column of the table. The purpose of a Code Summary is
to write an overarching summary for this code: What environmental behaviors do our
interviewees report? What do they do? What do they find difficult? What do they
reject? Do we find differences in behavior between, say, younger and older
interviewees, those with children or those without?

Document Summaries are similar to Code Summaries in their function, but here a
summary is written for each person, therefore one can also speak of Case Summaries.
Again, the basis is a Summary Table, in which the case-related summaries of several
codes are displayed. Thus, I see for a particular interviewee, for example, what
environmental behavior he or she shows in everyday life, how he or she feels about
the climate crisis, what problems he or she currently considers to be the biggest world
problems, and whether he or she believes that influence is possible.
In MAXQDA, the Document Summary is stored in the document memo of the case
and the Code Summary is stored in the code memo of a code.
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How to Write a Code Summary in MAXQDA
1. Ensure that the option to swap columns and rows in Summary Table is switched
off, so that the documents are displayed in the rows as shown in the previous
schematic figure.
2. Double-click on the memo symbol in the header of the code column for which you
want to write a summary.
3. The code memo (this is the memo that appears next to the code name in the
“Code System” window) associated with the code will open. If no code memo
exists yet, it will be created.
4. Expand the “Code Summary” area in the memo window, if it is collapsed, and
write your summary in the text field. You can format the text using the symbols at
the top.

Writing Code Summaries in the code memo

The Code Summary is always available in the “Document System” window, so you
don’t need to open a Summary Table to access it: double-clicking the memo icon next
to the code name opens the memo window, where you can view, edit, and export the
Code Summary.

15 - Summarizing

536

Double click on memo icon in the “Code System” window opens the memo with the Code Summary

How to Write a Document Summary in MAXQDA
1. In the Summary Table window, activate the option Swap rows and columns by
clicking the symbol
in the toolbar.
2. Double-click on the memo icon in the header of the document for which you want
to write a summary.
3. The document memo associated with the document will open (the memo that
appears next to the document name in the “Document System” window). If no
document memo exists yet, it will be created.
4. Expand the “Document Summary” area in the memo window, if it is collapsed, and
write your summary in the text field. You can format the text using the icons at the
top.

Writing Document Summaries in the document memo
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Summary Explorer
The Summary Explorer allows you to compare the summaries of different cases or
groups in a table. The Explorer’s columns are formed by documents, document
groups, or document sets, each column containing the respective summaries of the
currently selected code (theme).

The Summary Explorer

The Summary Explorer can be used to answer questions such as “What are the
differences between Indiana and New York students in terms of career aspirations and
concerns? The Summary Explorer shown above compares summaries (written by
researchers) of the statements made by students in Indiana with summaries of the
statements made by students in New York. The Indiana group consists of 3
documents, and for each of these 3 documents a summary was written for the code
“Career”. All 3 summaries are displayed in the corresponding column.

Opening the Summary Explorer
To start the Summary Explorer:
1. Select Analysis > Summary Explorer in the MAXQDA main menu.
2. 2. A dialog window will appear into which you can drag and drop documents,
document groups, or document sets from the “Document System” and codes from
the “Code System”. Each row in the upper area of the dialog window will later
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form its own column in the Summary Explorer.

Dialog window for selecting columns

Click OK, and MAXQDA will open the Summary Explorer.
The Summary Explorer columns always display the summaries associated with the code
selected on the left.

Functions in the Toolbar
In the Summary Explorer, the following functions are available in the toolbar at the top
left of the window:
Display codes with hierarchy – If this option is activated, the codes are displayed in
a hierarchical tree structure. The non-activated parent codes may be displayed to
retain the hierarchical structure. When the option is deactivated, the codes are
displayed in a linear list.
Display origin – Displays the source documents, locations within these
documents, and the code weights in brackets below the coded segments. Clicking on
the displayed source document shows the corresponding document in the “Document
Browser” and highlights the coded segment.
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Zoom out/in – Minimizes/maximizes the display of the summaries in the
columns.
x of y columns – Allows you to specify how many columns should be displayed next to
each other in the window at the same time.
Display search toolbar - allows you to search within the Summary Explorer.
Refresh – Reopens the options window for the Summary Explorer, which lets you
customize the columns and included documents and codes.

Exporting the Summary Explorer
The contents of Summary Explorer can be exported using the usual icons at the top
right of the window. All the codes selected in the Explorer's dialog window are taken
into account for the export.
Open as Word document – Creates a Word document and opens it.
Open as Excel table – Creates an Excel document and opens it.
Export – Creates a Word file (DOCX format), an Excel file (XLSX format), or a web
page (HTML format).

Overview of Summaries
The “Overview of Summaries” allows quick access to the summaries of selected
documents. You can request it from the context menu at all levels of the “Document
System” window: Right-click on a document, document group, document set, or the
root labelled “Documents” and select Summaries. A listing in table form will appear
which contains all existing summaries of the documents in question, displayed in the
upper pane. As usual, the context of the listing is displayed in the upper left corner
(“All” in the following figure).
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Overview of Summaries

The “Document name” and “Code” columns contain information on the “node”
from which the summary is derived, the “Preview” column contains the first 63
characters of the summary, and the “Position” column lists all the positions from
which the underlying coded segments originate. In the example, the selected summary
originates from the document “Joanna” and belongs to the code “Significantly
Positive.” In this document four text segments were coded with this code, in
paragraphs 27, 29, 31, and 35.
In the Reports tab, you can open an “Overview of Summaries” containing all the
summaries of your open project.
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16 - Comparing Cases & Groups
MAXQDA allows you to compare different groups on a qualitative and quantitative
basis. In the case of qualitative analysis, coded contents and, where appropriate,
supplementary comments are compared. In the case of quantitative analysis, variant
code frequencies are compared. The groups are formed by document groups,
document sets or individual documents.
You can use this feature for many forms of comparison, because the functionality is so
flexible that it allows for not only group comparisons, but also comparisons of
individual cases, and combined comparisons of groups with individual cases.

Qualitative Comparison: Coded Segments
The comparative analysis of cases and groups is one of the most important techniques
of qualitative research. In MAXQDA there are numerous possibilities to compare the
data, for example to display only the statements of certain groups of persons in the
"Retrieved Segments" or to compare visualizations, such as Document Portraits, for
different cases.
The MAXQDA function Compare Cases & Groups allows you to easily compare coded
data (qualitative data) and code frequencies (qualitative data transformed into
quantitative data) for cases and groups. From the “Document System”, you can
include documents as cases and document groups as well as document sets as groups
in the comparison.

Perform a qualitative comparison
A comparison of coded segments can be performed as follows:
1. Select the function Analysis > Compare Cases & Groups > Qualitative. An options
dialog window will appear with two sections:
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Options dialog window for comparing coded contents

2. Drag at least two document groups, document sets or individual documents from
the "Document System" into the upper "Groups" area with the mouse button
pressed down. You can also combine document groups, document sets, and
documents. Entries can be deleted at any time by clicking on the X at the end of a
line.
3. Drag several codes from the "Code System" into the lower "Codes" area by
holding down the mouse button. Click on the Insert activated codes button to add
all activated and not yet selected codes below. You can adjust the sequence of the
codes later by holding down the mouse button.
After clicking OK, MAXQDA creates an interactive segment matrix and displays it
directly. The selected groups form the columns and the selected codes the rows of the
matrix. The cells contain the coded segments so that the coded contents for the
selected groups can be compared with each other.
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Results table for the comparison of coded contents: Interactive Quote Matrix

The functionality of the Interactive Quote Matrix is described in detail here.

Quantitative Comparison: Code
Frequencies
The comparative analysis of cases and groups is one of the most important techniques
of qualitative research. In MAXQDA there are numerous possibilities to compare the
data material, for example to display only the statements of certain groups of persons
in the "Retrieved Segments" or to compare visualizations, such as Document Portraits,
for different cases.
The MAXQDA function Compare Cases & Groups allows you to easily compare coded
data (qualitative data) and code frequencies (qualitative data transformed into
quantitative data) for cases and groups. From the “Document System”, you can
include documents as cases and document groups as well as document sets as groups
in the comparison.

Perform quantitative comparison
A group comparison for code frequencies is performed as follows:
1. Open the function Analysis > Compare Cases & Groups > Quantitative. An options
dialog window will appear with two sections:

16 - Comparing Cases & Groups

544

Options dialog window for comparing code frequencies

2. Drag at least two document groups, document sets or individual documents from
the "Document System" into the upper "Groups" area. You can also combine
document groups, document sets, and documents. Entries can be deleted at any
time by clicking on the X at the end of a line.
3. Drag several codes from the "Codes" into the bottom "Codes" area. Click on the
Insert activated codes button to add all activated and not yet selected codes below.
You can adjust the sequence of the codes later by holding down the mouse button.
Click on OK and MAXQDA creates a crosstab. The selected groups form the columns
and the selected codes the rows of the matrix:

Crosstab as result of a quantitative case or group comparison
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17 - Variables
Document and Code Variables in
MAXQDA
In MAXQDA you can store information in variables both for documents and at code
level. For the speakers of a group interview there are additional speaker variables
which are explained in detail in the chapter analysis of focus groups.

Document variables
Document variables are associated with an entire document (e.g. the person
interviewed in an interview transcript). In these cases, you can assign sociodemographic information like gender, age, education level, etc. that can then be
analyzed in conjunction with the actual text.
In the following example, the age, educational level, and state of the respondents was
noted, in addition to whether they were single or in a partnership:

Example of application of Document Variables

Code variables
Code variables in MAXQDA make it possible for you to apply variable values to coded
segments and use them as selection criteria during the analysis process. In this way,
you can, for example, activate codes by defined criteria.

Managing variables
Two views are available in MAXQDA for handling variables: the variable list and the
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data editor. In the variable list, all variables defined in the project are listed in tabular
form. The data editor displays the data table as a rectangular matrix “rows times
columns” in a similar way to statistics programs. The columns contain the variables,
the rows contain the documents for the document variables and the rows contain the
codes for the code variables.

The List of Document Variables
The List of Document Variables can be opened via Variables > List of Document
Variables.
When you open the List of Document Variables in a newly created project, the system
variables displayed in the image are already defined:
●

●
●

●
●

●

●
●
●
●
●

Document group – contains the name of the document group that a particular
document is a part of
Document name – contains the name of the document
Created by – contains the name of the user who was logged in when the document
was imported or created
Created – contains the date the document was imported or created
Modified by – contains the name of the user who last edited the document or
applied codes, added memos or links to it
Modified – contains the date, when the document was last edited or codes, memos,
or links were added to it
Coded segments – contains the number of coded segments in the document
Memos – contains the number of memos in the document
PDF Pages – contains the number of pages in PDF documents
Paragraphs – contains the number of paragraphs in text and table documents
Sentences/Words/Characters – contains the number of sentences/words/characters in
text and table documents and in PDF documents
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System Variables in the “List of document variables”

The system variables are indicated with a red symbol in the first column of the list of
variables. System-defined variables cannot be modified or deleted. User-defined
variables are indicated with a blue symbol in the first column - these variables can be
modified or deleted as desired.

The List of Code Variables
The List of Code Variables can be opened via Variables > List of Code Variables.
When you open the List of Code Variables in a newly created project, the following
system variables are displayed, as they can also be found in the “Overview of Codes”:
●
●
●
●

●

●

●
●
●
●

Parent code – Names of superior codes at the next higher level (if applicable)
Code – Code name
Cod. seg. (all documents) – Number of segments coded with this code
Cod. seg. (active. documents) – Number of segments coded with this code in
current activated documents (code needs to be activated)
% Cod. seg. (all documents) – relative frequency of "Coded segments (all
documents)"
% Cod. seg. (active. documents) – relative frequency of "Coded segments (activated
documents)"
Created by – User who created the code
Created – Date and time at which the code was created
Code alias – Alias name of the code if defined (up to 255 characters)
Modified by – User name of person who last edited or used the code
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●
●

Modified – Date of last editing or usage of the code
Documents – Number of documents in which the code appears

System variables in the List of Code Variables

Sorting the List of Variables
The list of variables can be sorted in alphabetical or reverse alphabetical order just like
any other table in MAXQDA. Simply click once or twice on the column header you
would like to sort by.
Tip: To restore the original sorting, right-click on a column header and choose Reset
Sorting..

Toolbar
Both the List of Document Variables and the List of Code Variables can be managed
from the toolbar, which contains similar symbols for both lists.
Import data – allows import of a data table in Excel format (XLS/X).
New variable – creates a new variable.
Delete selected items – deletes selected variables.
Convert to boolean variable – converts selected variables into dichotomous
boolean variables (works only for codes that have been transformed into document
variables).
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Convert to text variable – converts selected variables into text variables.
Document / Code Variable Statistics – generates a frequency table or chart for the
indicated variable.

Create and Edit Variables
You can add new variables to both the List of Document Variables and List of Code
Variables::
●
●

Select List of Document Variables or Code Variables from the Variables tab.
Click on the New variable
icon in the toolbar.

Creating a new variable with the icon in the toolbar

The following window will appear:

Defining a new variable

You can now insert a name for the variable and choose its type. The name can contain
up to 63 characters including There are five different types of variables to be chosen
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from:
●
●
●
●
●

Text
Integer
Decimal
Date/time
Boolean (true/false)

When creating an integer or an decimal variable, you also have the option of defining
whether it is a metric or a categorical variable. The variable for age, for example, can
be handled in various ways: if you want to enter the age in years, you are dealing with
a metric variable, for which you may want to establish a mean. If you have defined
ages into categories (e.g. 1 = under 18, 2 = 18-30, 3 = 31-50, 4 = 51+), then you are
dealing with a categorical variable, for which you would not want to find a mean
value.
You can also select what value should be inserted automatically for those cases where
there is a missing value. This is especially important if you are planning to do a
statistical analysis later.
Note: Document variables are created for the entire project, which means you cannot
create different variables for each document group.
For better readability of variable values in MAXQDA, it can often be more convenient
to use text variables instead of number variables. In a table column with the variable
"familial status", the variable "married" will be more readable than a numeric code
(like "2").
The number of variables is not limited in principle, that is, variables can be removed
from the list or added to the list at any time. By clicking on the New variable button,
you can mae new definitions. In the event that you want to define a large number of
variables and, if necessary, the values for the cases already exist in a table-like structure
or even as an SPSS record, you can save time by importing the file.

Rename and Delete Variables
Variables can be given a new name at any time. Double-click on the variable, and
enter the new name.
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Renaming a variable in the “List of Document Variables”

Renaming a variable is possible at any time and does not affect the variable’s stored
values.
To delete a variable, click on its row with the mouse to select it. Then click the Delete
variable
button in the toolbar. When you delete a variable, the whole column
including all its values will be removed from the Data Editor.

Change Variable Type
MAXQDA allows for changes in variable types for existing variables:
●

●

Document variables, which display how often a code exists (their source is
acknowledged as “code”) can be transformed into a binary variable by clicking on
the
Convert to boolean variable symbol in the toolbar. After it is transformed, the
variable will not show how often a code has been assigned in the document but if it
has been assigned in this document or not.
User defined variables Integer, Decimal, Date/Time and Boolean can be transformed
into text variables by clicking the symbol in the toolbar.

The Data Editor
When working with variables, two views are available in MAXQDA: the variables view
and the data view in the Data Editor. The Data Editor is similar to statistics programs in
that the data is displayed as a rectangular matrix with a “rows x columns” structure.
The variables are displayed in the columns; while the rows display the document
variables for documents or the code variables for codes. For document variables the
table will contain as many rows as there are documents in the “Document System”;
for example, in an interview study, the number of rows will correspond to the number
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of interviewees. For the code variables, the codes represent the cases.

Opening the Data Editor for Document Variables
The Data Editor for Document Variables can be opened in three ways:
●
●
●

via Variables > Data Editor for Document Variables,
from the List of Document Variables by clicking on the
Data Editor icon
in the “Document System” window, by selecting Variables in the context menu.
When called up at the top level, the table contains all the documents; at the
document group level, the data table contains only corresponding documents, and
at the document level, only data.

A table will appear, in which the selected documents and their corresponding variable
values are listed. System variables can be recognized by the black column heading; this
cannot be modified in the table. User-defined variables are indicated with a blue
heading; their values can be adjusted by double-clicking the appropriate cell.

Data Editor for Document Variables

In the Data Editor for Document Variables it is possible to access a document by rightclicking the appropriate row. A context menu will appear which lists the same options
for opening the document as in the "Document System".

Opening the Data Editor for Code Variables
The Data Editor for Code Variables can be opened in three ways:
●
●
●

via Variables > Data Editor for Code Variables,
from the List of Code Variables by clicking on the Data Editor
button, or,
in the “Code System” window, by selecting Variables in the context menu of a code.
If you click on a code, which does not contain subcodes, only the variable values for
this code will be listed in the table. If the code contains subcodes, the variables of
the subcodes will also be listed.

A table will appear which lists the selected codes and their corresponding variable
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values.
An extensive context menu, the same as in the “Code System”, is also available for
individual codes.

Entering variable values in the Data Editor
To insert variable values into the Data Editor:
Double-click on the cell of the table where you would like to insert a value. Use the
Enter key to jump to the next line to enter the variable values for your variables. Use
the Tab key to jump to the next column to enter the values case by case.
The values that have already been given to any of the cases in the column are in the
drop-down list, sorted alphabetically. You can view this list and select a value from it
by clicking on the triangle to the right of the cell you double-clicked on.

Options for the variable value in the Quick List

If the value isn’t available in the drop-down list, you can simply type in the value after
double-clicking in the cell.
Tip: Drop-down lists are less useful when a variable has many different values (e.g. the
exact income of every interviewee). Even if the value was in the drop-down list, it
would be faster to type it in than to search for it. You can stop the program from
displaying a column’s drop-down list by right-clicking on the column header and
selecting (to uncheck) List of values.

The Data Editor toolbar
At the top of the Data Editor there is a toolbar, which provides easy access to multiple
functions including the following:
Only activated documents – only the activated documents are shown.
Import data – allows you to import a data table (in SPSS format SAV or Excel
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format XLS/X) for code variables.
List of document variables – switches from the data view to variable view.
Data editor – switches from the Variable view to the Data view.
Open As Excel Table - Creates and opens an Excel Table containing the selected
rows. If no rows are selected, all are exported.
Open as HTML table - Creates and opens a table in HTML containing the selected
rows. If no rows are selected, all are exported.
Export – MAXQDA creates a table as an Excel file (XLSX format), as a web page
(HTML format) or as a text document (Word or RTF format).

Managing tables
If you have created a large number of variables, it quickly becomes difficult to see the
entire table at one time. You can view more columns at one time by making the
columns thinner (click and drag the separator between column headers), but
eventually even this does not suffice.
Of course there is the possibility to scroll through the table to the right and it is also
possible to change the order of the variables in the table by grabbing a variable
column with the left mouse button pressed and moving it to any other place in the
table. However, it is simpler to click the Select Columns icon in the toolbar. There are a
number of possibilities to influence the display in the variable table.
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Variable selection of columns to be viewed

Besides (un)checking the boxes one by one, you also have the following options:
●
●
●
●

select all fields
deselect all fields
only system fields (those automatically created by MAXQDA)
hide or show variables by checking or un-checking the box in front of the variable
name

Statistical analysis of a variable
You can start a statistical analysis of the variable values of a column at any time. Rightclick on the column header and choose Document Variable Statistics or Code Variable
Statistics.
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Open the statistical analysis in the Data Editor

MAXQDA then creates a frequency table for the selected variable, which can also be
displayed as a chart. Further information on the handling and design of frequency
tables and charts can be found here.

Frequency table for a document variable

Importing Data from Excel and SPSS
There are several situations in which you might want to import document variables
into MAXQDA, such as:
●
●

If a standardized questionnaire was used to augment interviews.
If you did statistical analysis on data that you exported from MAXQDA and now
want to reimport the results of your statistical analysis into MAXQDA. You could, for
example, have done a cluster analysis for 40 interviews and now want to import the
cluster assignments from each individual interview.
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Importing document variables from Excel
MAXQDA can import data from XLS/X files. The data must be organized as follows:
Document group

Document name

Group 1

Text 1

Group 1

Picture 1

Variable 1
Variable value for
Text 1
Variable value for
Picture 1

...

Variable N
Variable value for
Text 1
Variable value for
Picture 1

The first two column headers serve as markers for assigning variable values to the
documents and are required for successful import. Every row must have an entry for
the document group and document name columns. Only if these exact group and
document names are found in the “Document System” of the MAXQDA project, will
the variables and variable values be imported. You can then include as many different
variable columns as you wish.
Please note: The variable values for documents that do not belong to a document
group can also be imported. In order to do so, the appropriate cell in the “Document
Group” column must be left empty.
After preparing and saving the document, you can start the import procedure by
going to Variables > Import Document Variables. Alternatively, you can click on the
Import data (document variables)
symbol in the List of Document Variables.

Icon for importing document variables

A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.
MAXQDA does the following during the import:
●

All variables in the import file that did not yet exist in the MAXQDA project are
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●
●

created.
Variables that already existed will be updated with the new values in the import file.
Empty values (“system missings”) for variable types integer and decimal will be
imported as -999.

Tip: An easy way to set up an Excel file for importing new values is to first export the
variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the
variable list. An Excel file with all of the current variables will open up, and you can
then add new columns for new variables and update variable values that you want
changed. All you have to do after that is save the Excel file and import it into
MAXQDA.

Importing document variables from SPSS
You can also import a data matrix for the document variables from a SPSS data file
(extension SAV). For the import, MAXQDA needs to match the cases of the SPSS data
file with the document names in the opened MAXQDA project. Therefore it is
necessary, that the data file contains a variable (a column) for the document group as
well as a variable for the document name.
1. Start the import procedure via Variables > Import Document Variables.
Alternatively, you can click on the Import data (document variables) symbol in the
List of Document Variables.
2. Then choose a SPSS data file in the appearing file dialog.
3. A new dialog will appear, that allows you to set several options:

Options for importing a SPSS data file

In the upper part you can select which variables (= columns) contain the information
about the document group and the document name to match the cases with the
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appropriate document name. MAXQDA will choose the first two columns of the SPSS
data file if the data file doesn’t contain variables with the names “DocGroup” and
“DocName.” You will find the variable labels in brackets behind the variable names for
better navigation in the list of variables.
Furthermore, you can switch on two additional options:
Import variable label instead of variable name – If you choose this option, MAXQDA
won’t import the variable names, but their labels, which are usually longer and easier
to read and to understand. You should use this option, if you want to import a SPSS
data file that has been created by exporting the document variables from MAXQDA.
Then it will be easy to update a variable which values have been changed in SPSS.
Please note that the length of variable names in MAXQDA is limited to 63 characters,
so a longer label may be truncated.
Import value labels instead of values – usually, standardized answers will be
represented in SPSS by numbers, e.g. a 1 may be used for “female” and a 2 for
“male”. If you see these numbers only in MAXQDA without knowing what a “1” and
“2” means, it won’t be very useful, so this option should only be deactivated if you are
sure you want to import the values instead.
A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.
MAXQDA does the following during the import:
●

●
●

●
●

●

All variables in the import file that did not yet exist in the MAXQDA project are
created.
Variables that already existed will be updated with the new values in the import file.
If you have defined missing values in SPSS only the first missing value (defined in
section “Discrete missing values” in the SPSS dialog) will be imported (only for
variable types integer and floating).
System variables of MAXQDA won’t be changed.
If the import file contains identical document names in the same document group,
the last case will overwrite the previous ones.
Empty values (“system missings”) for variable types integer and decimal will be
imported as -999.

Importing code variables from Excel
MAXQDA can import data from XLS/X files. The data must be organized as follows:
Code

Variable 1

...
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Parent code 1\Code 1
Parent code 1\Code 2

Variable value for code 1
Variable value for code 2

Variable value for code 1
Variable value for subcode 2

The first column heading is the unambiguous assignment of variable values to a code,
so this column and its heading are mandatory. Each line must designate a code in the
corresponding column. For subcodes, the entire path must be specified in the code
system, in which the codes are separated by a backslash “\”.
Tip: To insert a backslash “\” on macOS, use the keyboard command ⌥+⇧+7.
Only when a code, which matches this information exactly, is found in the “Code
System” will the variable be imported. You can add as many variables as required in
the subsequent columns.
After preparing and saving the import data, you can then start the import procedure
by going to Variables > Import Code Variables. Alternatively, you can click on the
Import data (code variables) button in the List of Code Variables.
A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.
MAXQDA does the following during the import:
●

●

All variables in the import file that did not yet exist in the MAXQDA project are
created.
Variables that already existed will be updated with the new values in the import file.

Tip: An easy way to set up an Excel file for importing new values is to first export the
variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the
variable list. An Excel file with all of the current variables will open up, and you can
then add new columns for new variables and update variable values that you want
changed. All you have to do after that is save the Excel file and import it into
MAXQDA.

Exporting Data to Excel and SPSS
MAXQDA provides basic functions for the statistical analysis of variables and makes it
possible to create frequency tables and diagrams for individual variable values. For
further analysis, such as cluster or factor analysis, it is necessary to export the data
table of document or code variables in order to perform the statistical analysis in the
appropriate program.
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To export the variables:
1. Click on the
Export button in the toolbar of the Data Editor or select Variables >
Export Document Variables or Export Code Variables.
2. Give the exported file a name. You can also select exactly where you want to save
the file.
3. The following formats are suitable as file format for further processing in statistics
programs:
Excel (XLS/X)
SPSS Data File (SAV), which is only available for the document variables and works
fine in most statistics programs,
SPSS Syntax File (SPS), which is only available for the document variables,
Text (TXT, tab delimited)
Rich Text Format (RTF)
Website (HTML).
4. Select OK.
❍
❍

❍
❍
❍
❍

Exported data matrix in Excel

Tip: The data matrix can also be transferred via the clipboard. You can either select the
entire matrix using the keyboard shortcut Ctrl+A (Windows) or ⌘+A (macOS), or select
individual rows by clicking on them while holding down the Ctrl (Windows) or ⌘
(macOS) button. Use the keyboard shortcut Ctrl+C (Windows) or ⌘+C (macOS) to
copy the selected data into the clipboard.

Displaying Document Variables for
Documents and Coded Segments
Displaying Document Variables as Background Information for Documents
Often there is a desire to quickly find background information to a document in the
“Document System”, such as the age or the level of education of an interviewee. For
this purpose, you can select document variables whose respective values are displayed
as quick info at the mouse pointer in the “Document System”:
1. Open the local settings in the “Document System” window by clicking on the gear
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icon in the toolbar of the window.

Local settings in the “Document System”

2. Then check the Display favorite variables in the tooltip option and click the Select
variables. The following selection window appears:

Window for choosing document variables as favorite variables

If you now hold the mouse pointer on a document in the “Document System”, the
values of the selected variables appear in the quick info text. The following figure
shows that the interviewee “Riley” is 19 years old.
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Quick info display of variable value in a document

Displaying Document Variables as Background Information for Coded
Segments
Some background information about the case can also be very helpful for coded
segments, since these are often viewed separately from their document. Therefore,
you can also display variable values in the “Retrieved Segments” window and in the
tabular “Overview of Coded Segments”.
As it is rarely helpful for the analysis to see all variable values of a document, it is first
necessary to select some document variables:
1. Open Variables > List of Document Variables.
2. Activate the check mark in the Favorite variable column with a mouse click to select
the document variable for display.

Select document variable as favorite variable
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Display in the "Retrieved Segments".
After you have marked document variables as favorites, you can output these selected
variable details in the "Retrieved Segments". To do this, make sure that the Display
favorite variables option is selected in the window toolbar. The selected variable
information then appears directly below each document name as shown in the
following figure (when sorting the segments by document):

Display favorite variable in the “Retrieved Segments” window

Display in the "Overview of Coded Segments"
In the “Overview of Coded Segments”, you can display the favorite variables as
separate columns, so that you can view the variable values of the corresponding
document for each segment. To do this, click on the Display favorite variables icon in
the toolbar of the “Overview of Coded Segments”.

Display variable information on export
If you export the coded segments from the “Retrieved Segments” window or the
“Overview of Coded Segments” table, you can also export the associated variable
values of the document for each segment. For more information, see Print and Export
Retrieved Segments.
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19 - Questions - Themes -Theories (QTT)
The Idea behind "Questions - Themes Theories"
The "Questions – Themes – Theories" (QTT) workspace provides a bridge between
your MAXQDA project and your research report.
QTT helps you to focus on the research questions or perhaps even start developing
them. QTT can be compared to a scrapbook sheet on which everything about a
particular subject or research question is collected, questions are recorded, themes and
key categories are focused, and answers to the research questions are formulated.

The Questions – Themes – Theories window
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The QTT is the ideal place to collect everything you come up with for a topic and make
it easily accessible. It is like a super memo in which you can enter and bring together
findings, record conclusions and develop theories.
In the QTT workspace, you can create a separate worksheet for each of your different
topics or research questions and then fill it with associated analysis elements from
MAXQDA, including:
●
●
●
●
●

related codes,
important coded segments,
related memos,
visualizations and concept maps,
Summary Tables.

Of course, you can export individual or all parts of a worksheet to the clipboard or the
entire worksheet as a Word document.

Start the “Questions – Themes – Theories” workspace
1. Switch to the Analysis menu tab.
2. Click on QTT: Questions – Themes – Theories.

Open Questions – Themes – Theories in the Analysis tab

The QTT workspace will then open in a separate window while the main MAXQDA
window stays accessible in the background. In the workspace, you can create new
worksheets and edit and export your existing worksheets.

Create a Worksheet
Create new worksheet
To create a new worksheet in QTT, proceed as follows:
1. Open the QTT workspace via Analysis > QTT: Questions – Themes – Theories in
MAXQDA’s main menu.
2. Click New Worksheet in the QTT window.
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Create new worksheet

In the form that appears, enter a name for the worksheet at the top and record the
topic and research questions to which the worksheet should relate:

Fill in name, topic, and research question for new worksheet

After clicking OK, the worksheet is created, and you can start inserting elements from
your MAXQDA project into the worksheet:
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Newly created worksheet in QTT with typical sections for a qualitative study.

Create, sort, customize sections
As the previous image shows, worksheets in QTT can be divided into individual parts.
The following sections are available:
●
●
●
●
●
●
●

Related Codes & Themes
Important Segments
Summary Tables
Related Memos
Visuals
Concept Maps
Integration

When you create a new worksheet, all these sections are automatically inserted. The
tab bar with the sections of the worksheet is interactive:
●
●
●

Click on a tab to switch to that section.
Drag-and-drop a section tab with the mouse to adjust the order of the sections.
To remove a section from the worksheet, right-click on the name of a tab and select
the corresponding option.
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Remove section via context menu

●

By clicking the + Add Section button, you can insert the sections you need:

Add section to a worksheet

Please note: Each section can exist only once per worksheet. Therefore, already
existing sections are grayed out in the menu and are not clickable.

Rename or delete worksheet
To change the name of a worksheet, just click on the title and you will be able to edit
it.

In the QTT menu you will find an option to delete the worksheet:

Switch between worksheets
Once you have created multiple worksheets, you can switch between them by clicking
My Worksheets. The currently selected worksheet is always visible in the title bar at the
top of the QTT window.
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Switch between worksheets

Inserting Elements into a Worksheet
The most important task when working with "Questions – Themes – Theories" (QTT)
is, of course, to compile the results and findings of the analysis and to insert them into
a worksheet. In QTT, you can then comment on individual elements, draw conclusions,
and develop hypotheses and theories.
In order to insert elements into a worksheet, sections must be created beforehand.
The following image shows all sections that are automatically added when a new
worksheet is created:

Different sections of a worksheet in QTT

In the following, we will explain how to add elements for each section.
Please Note: In QTT, a copy of the element is saved at the time of insertion. You can
no longer change elements in QTT, only comment on them. For example, if you insert
a memo into a worksheet, the memo text is saved in QTT and can be viewed there. If
you change the memo in the MAXQDA project, the changes are not transferred to the
QTT worksheet.

Related codes & themes
1. Click the Add Element(s) button to get a selection dialog with the current code
system.
2. Select individual codes or click Activated Codes to insert the currently activated
codes.
3. After clicking OK, the selected codes will be inserted into the worksheet:
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Select codes to be inserted into QTT

Codes inserted in QTT

In QTT, each code is displayed in an interactive tile:
●

●

●
●

Hold the mouse over the code memo icon to preview the memo text. Double-click
the icon to display the memo (the memo cannot be modified in QTT).
Click Coded Segments to access a compilation of all segments coded with the code.
This compilation always refers to the current state of the project, not to the time
when the code was inserted into the QTT.
Drag-and-drop a tile with the mouse to adjust the order of the codes.
Right-click the tile to remove the code from the worksheet.

Below the codes you can record your insights in the text box.

19 - Questions - Themes -Theories (QTT)

572

Important segments
There are several ways to insert one coded segment (or several at once) into the QTT.

"Document Browser" and "Retrieved Segments" window
If you want to insert a relevant coded segment directly from the "Document Browser",
right-click on the associated coding stripe (the "coding bracket") next to the
document, select the option Send to QTT Worksheet and then the desired worksheet:

Send coded segment from “Document Browser” to QTT

Alternatively, drag the coding stripe directly into the QTT window with the mouse.
The context menu and drag-and-drop feature are also available for the coding stripe in
the "Retrieved Segments" window.

Tabular overview "Coded Segments”
In the tabular listing of coded segments, click the small Send to QTT Worksheet icon in
the upper right corner and select the desired sheet:
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Send coded segment from the Coded segments tabular overview to QTT

Alternatively, a selected segment (or multiple segments) can be dragged directly into
QTT with the mouse.

Display of the coded segments

Coded segments inserted in QTT

In QTT, each coded segment is displayed on an interactive tile:
●
●

Click and drag a tile to adjust the order.
Right-click the tile to copy the contents of the coded segment to the clipboard or to
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remove the segment from the worksheet.
Below the segments you can record your insights in the text box.

Summary tables
●
●

Click the Add Element(s) button to get a listing of all summary tables in the project.
Select a table and click OK.

Select summary table to be inserted into QTT

Summary table inserted in QTT

Below each summary table you can record your insights.
Right-click on a table to copy it to the clipboard or remove it from the worksheet.
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Related memos
1. Click the Add element(s) button to get a listing of all memos in the project.
2. Select memos and click OK to insert them into the worksheet:

Select memos to be inserted into QTT

Memos inserted in QTT

Each memo is presented on an interactive tile:
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●
●
●

Double-click the tile of a memo to display all of its content.
Drag-and-drop the tile to adjust the order.
Right-click the tile to remove the memo from the worksheet.

Below the memo tiles you can record your insights in the text box.
Tip: You can also directly send memos to QTT from the Memo Editor or the Memo
Manager by clicking on the small icon Send to QTT Worksheet.

Visualizations
To insert a visualization created with MAXQDA into QTT, click on the small Send to
QTT Worksheet icon in the top right corner of the visualization and select the desired
sheet:

Send visualization to QTT
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Visualization inserted in QTT

All visualizations that you create via the Visual Tools menu of MAXQDA can be
transferred to QTT using the Send to QTT Worksheet icon. Concept maps from
MAXMaps are inserted into their own section in QTT (see below).
Below each visualization you can record your insights in the text box.

Concept maps from MAXMaps
1. In QTT, click the Add element(s) button in the Concept Maps section to get a listing
of all maps in the project.
2. Select a map and click OK.

Select concept maps to be inserted into QTT
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Concept map inserted in QTT

Below each concept map you can record your insights in the text box.
It is also possible to insert a concept map by clicking on the corresponding icon directly
in the "MAXMaps" window.

Integration
The "Integration" section is a special section in the QTT workspace. This is the place
where you can bring together findings from all the other sections and from the project
as a whole:
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This is the place where you can express your hypotheses, integrating findings, and
theories.
We wish you many good ideas and inspirations for your projects!

Export Worksheet
When working with the QTT, many findings and conclusions arise that can become
important parts of the final report. Therefore, you can export an entire worksheet as a
Word file, as well as you can copy individual elements and individual areas to any
program via the clipboard.

Export entire worksheet
To export the entire worksheet, click the corresponding icon in the menu tab of the
QTT window:

Export a worksheet via the Start menu tab

A file dialog appears in which you can specify the file name and location. MAXQDA
exports the worksheet as a Word file in DOCX format, with each section starting on a
new page:
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Exported worksheet in Word

Export a single area
To export all the contents of a single section, right-click its tab name and select Copy
Content. Now you can paste the contents of the clipboard directly into Word or
another program, for example, by using the keyboard shortcut Ctrl+V (Windows) or
⌘+V (macOS).

Copy the contents of the Visualizations section to the clipboard

Export a single element
To export individual elements, such as a visualization or a memo, right-click on them
and select Copy. Now you can paste the contents of the clipboard directly into Word
or another program, for example, by using the keyboard shortcut Ctrl+V (Windows) or
⌘+V (macOS).
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Copy individual element
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18 - Mixed Methods
General Information about Mixed Methods
in MAXQDA
MAXQDA is one of the pioneers in the field of method integration. Functions for
combining qualitative and quantitative data are already found in the very first versions
of the program in the late 1980s and early 1990s. With the option to manage a data
set of standardized, quantitative data parallel to the texts, the foundation was laid.
Since version 10 there is a further tool in the form of code variables, which allows the
definition of variables below the case level of a document and since version 12.2 there
is a fully integrated statistics package "Stats" for carrying out descriptive and
inferential statistical calculations, the results of which can be used directly for the
integrative analysis of qualitative data.
Most of the mixed methods functions can be found in the Mixed Methods menu tab.
On the one hand, there are functions that link documents and document variables, for
example, the topics from qualitative interviews with the variables of standardized
interviews. With these functions, you can create so-called Joint Displays (Guetterman,
Creswell, and Kuckartz, 2015), in which qualitative and quantitative data and/or
results and conclusions are presented and analyzed together. On the other hand,
MAXQDA offers functions that enable the transformation of code frequencies into
document variables in order to subsequently use these for analysis, whether for the
selection of qualitative data or for use in statistical procedures such as similarity
analysis.
MAXQDA's mixed-methods functions support all typical basic designs in mixed
methods studies (Creswell and Plano Clark, 2018):
●
●
●

convergent Designs (qual. and quan. study parallel)
explanatory Designs (qual. study after quan.)
exploratory Designs (qual. study before quan.)

Further information about the mixed methods functions in MAXQDA and its
methodology can be found here:
●

Kuckartz, U., & Rädiker, S. (2021). Using MAXQDA for mixed methods research. In R.
B. Johnson & A. J. Onwuegbuzie (Hrsg.), The Routledge reviewer’s guide to mixed
methods analysis (S. 305–318). Routledge.
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●

●

https://doi.org/10.4324/9780203729434-26
Rädiker, S. & Kuckartz, U. (2019). Analyse qualitativer Daten mit MAXQDA. Text,
Audio, Video. Springer VS – speziell das Kapitel 13: https://doi.org/10.1007/978-3658-22095-2_13
Guetterman, T. C., Creswell, J. W., & Kuckartz, U. (2015). Using joint displays and
MAXQDA software to represent the results of mixed methods research. In M. T.
McCrudden, G. J. Schraw, & C. W. Buckendahl (Hrsg.), Use of visual displays in
research and testing: Coding, interpreting, and reporting data (S. 145–176).
Information Age Publishing.

The “Mixed Methods menu tab

Overview of the Functions in the Mixed Methods Menu Tab
●

●

●

●

●

●

Activate Documents by Variables - Lets you activate documents to be included in
further analysis such as Coding Query or Visual Tools based on document variable
values. You could, for example, use this function to identify what men between the
ages of 40 and 50 said about migration issues.
Interactive Quote Matrix - Creates an interactive table, “codes x groups”, that allows
you to compare coded segments for groups. These groups are formed by documents
with selected variable values. You could, for example, choose to see how those with
various levels of education differ on their approach to combating homelessness.
Crosstab - Works parallel to the Code Matrix Browser, except that this function
doesn’t work on the document level. Instead, you can create groups based on your
variable values and compare how often each of these groups talks about each
theme. You could, for example, compare how often men talk about relationships in
your life satisfaction interviews in comparison to women.
Quantitizing - This is the transformation of qualitative coding information into
quantitative variables. Quantitizing allows you to store the code frequencies as
document variables, such that for each document you have information about how
often a code appears in that document. This information can then be analyzed
statistically or used for the selection of cases.
Typology Table - Shows an overview of variable values for qualitative typologies that
you have created (e.g. for people with various views on combating their own
homelessness). You could see, for example, what the mean age, gender breakdown,
and average time already homeless is for the “apathetic pessimists” in comparison to
the “proactive optimists.”
Similarity Analysis for Documents – Selected documents are analyzed on the basis of
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●

●

●

existing coded segments and document variables for their similarity, and the results
are presented in a similarity or distance matrix.
Side-by-side Display of Results – This joint display compares the results of a
qualitative study with those of a quantitative study.
QUAL Themes by QUAN Groups – This joint display is used to compile coded
segments or summaries in a table for groups formed on the basis of variable values.
Statistics by QUAL Groups – The result of this function corresponds to the typology
table and divides documents into groups according to codes assigned to them. This
joint display allows you to compare average values, standard deviations, and
absolute and relative frequencies of selected variables for these groups.

In the “Code System” window, there are functions available, that allow you to use the
code frequencies for each document as document variables:
●

Transform code into document variable or categorical document variable – Codes
can be added as document variables that specify how often the code occurs in the
document ("Quantitizing" as described above) or which subcode occurs most
frequently in a document. The latter is particularly useful for evaluative qualitative
content analyses.

Activate Documents by Variables
The selection of documents for the analysis, such as searches for coded segments, can
be done easily by hand: You can activate all the documents of the project, the
documents of a particular document group, or even a single document. But more
complex selective coding searches are difficult to do by hand.
For this reason there are also automatic activation options. With the Activate
Documents by Variable function, you can choose to activate documents based on the
variable values that have been assigned to them. If you have defined variables for
gender, age, and education level, for example, you could choose to select only those
documents that represent women over the age of 40 that have at least a high school
education. These activations can be made by entering the appropriate conditions.
The Activate by Document Variables function always processes the entire project. You
can access the function by
●
●

●

selecting Activate Documents by Variables in the Mixed Methods tab or,
by right-clicking on the first row in the “Document System” and choosing Activate
Documents by Variables from the context menu that appears, or
clicking the icon with the same name in the "Document System"
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Accessing the function from the context menu or the icon in the “Document System”

A dialog window will appear where you can enter the logical conditions for activation.
The dialog window is made up of the following sections:
●

●
●

A section for the logical formulas and the buttons to create a new formula, delete
the currently selected formula, or delete all formulas.
Checkboxes for selecting operators.
Icons for opening or saving formulas.

Dialog field for activation by variable

All logical conditions must have the following components:

variable name / operator / value
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If you have created a variable called “Education” and defined the education levels as
"low", "intermediate" and "high", you can use the following formula in order to
activate those documents that are interviews with participants with a rather low
educational level:

Education = low
To create such an condition in MAXQDA, proceed as follows:
1. Double-click on the variable "Education" from the list of variables on the left side of
the window. You will see the following text in the condition window:
Education = <empty>
2. On the right side of the screen you will see a field where you can enter the variable
value. Here you could enter “low,” or simply click on the arrow to open the dropdown menu and select a value from the list of all the values that have been entered
for a document up to that point. In our example above, “low”, “intermediate” and
“high” would be in the menu. Using this menu helps you to avoid any typos.
For numeric variables, MAXQDA inserts the value 0 in each newly inserted
condition. For Boolean variables, you can use "0" for "false" and "1" for "true".
3. Since the “=” operator is used most often, it is automatically selected when you
start a new formula. If you want to use a different logical operator, simply choose it
from the right side of the window and MAXQDA automatically replaces the "="
operator.
The operators have the following meanings:
= (equal to) Selects variable values that are the same as the selected value.
< (smaller than) Selects variables values that are smaller than the selected value.
≤ (smaller or equal to) Selects variables values that are smaller or eqaul to the selected
value.
> (larger than) Selects variable values that are larger than the selected value.
≥ (larger or equal to) Selects variable values that are larger or equal to the selected
value.
≠ (unequal) Selects variable values that are not the same as the selected value.
⊃ (contains) This operator is only offered for text variables. Selects variable values that
contain the entered value within their text. The evaluation is not case sensitive.
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Tip: It is possible to specify the condition that a non-numerical variable value should be
<empty>. Then all documents to which no variable value was assigned will be
selected.

Results of activations by document variables
Once you have entered the correct logical formulas, you can start the automatic
activation. Click on the Activate button.
MAXQDA then checks the variable values assigned to each document whether it
matches the formulated criteria. The documents that matched the criteria are now
activated (marked red) in the “Document System.”
Tip: The status bar at the bottom of the MAXQDA window shows you how many
documents have been activated.
If you want to activate documents frequently based on the same criteria, it is
recommended that you save the activation model as a document set. To do so, select
the option New set from the dialog window. MAXQDA will then create a document
set containing the activated documents. This new document set can be activated at
any time in the “Document System,” without having to call up the function for
automatic activation via document variables.

Complex logical conditions
It is also possible to combine various logical conditions. The basic units of these
combinations are still the conditions in their basic form:

variable name / operator / value
Combining formulas just means that you are connecting two or more of these basic
formulas with an operator.
In the above example, we used the condition "Education=low" to activate all
documents of participants with a rather low level of education.
If you want to further limit the results, so that you only see what participants over 40
years with a low level of education had to say, you need to define a second condition,
namely "Age > 40". In addition, you need to combine these conditions by a logical
AND. The second condition, would be created just like the first condition:
1. Double-click on the variable Age from the list of variables. The new condition will
look like this: [Age] = <empty>
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2. Type in "40" for the value and choose the operator >(larger than).
3. MAXQDA automatically inserts the OR operator. To use the AND operator instead,
select the appropriate option in the right-hand pane. According to the schema, any
number of other logical combinations can be added. Click the Activate button to
begin.
In this way, you can add as many combinations of logical formulas as you want. You
can then click Activate to start the activations.
The combination operators OR and AND have the following ffect on the results of your
activation process: If you choose the OR option, MAXQDA looks for documents that
meet at least one of the various formulas’ criteria. If you entered the formulas
“Education = low” OR “Age > 40,” you will get all the documents of participants with
a low level of education as well as participants older than 40 years. For our example,
then, the OR option would not be appropriate. We want both formulas to be met, so
we would need to use the AND operator, so that it looks as follows:

A complex logical condition (AND-combination)

Deleting conditions
It is possible to go back and delete a formula at any time:
●
●

Click on the row you wish to delete.
Click on the
Delete button.

Changing and saving formulas
After starting the automatic activation process, the dialog window is no longer seen.
The formulas, however, will still be in that window the next time you open it.
You can change the logical formulas (operators and values) at any time:
●
●

Click on the Formula in the dialog window and select another operator.
If you want to change the value, simply enter the new value or select it from the
drop-down menu.

After you have changed the formula, click on the Activate button to restart the
activation.
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You can also save a formula, so that you can have quick access to it at a later time.
Just click on the Save
symbol at the bottom of the dialog window. You can then
give it a name and choose where you want to save it.
Files for saved logical formulas are saved by MAXQDA as .LOA (logical activation) files.
To open a saved formula, choose Open and navigate to the place you saved the .LOA
file. It makes sense to set up a folder for all of your LOA files, so they are easy to find.

Using code variables for Activation by code variables
It is not only possible to activate documents based on their document variables; you
can also activate codes based on their assigned code variables. The Activate by Code
Variable function can be accessed by right-clicking on the top level entry (Code
System) in the "Code System" and choosing the Activate Codes via Variables option in
the context menu.

Activate by Code Variables function in the “Code System” context menu

Crosstab
The Crosstab function has some similarities to the Code Matrix Browser, except that
documents are analyzed grouped by document variable. Social groups, such as men
and women, or people with different personal background, etc. can be compared
based on variable values. All of the variables that are in your project can be used to set
up a group.
Crosstab is a visualization of the relationship between document variables and codes.
The following example displays the number of times each code occurred in interviews
in rural and interviews in urban areas.
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Crosstab example based on regions

Creating a Crosstab

1. Choosing your codes
As usual in MAXQDA, the selection of codes is done via activation. The selection
should be completed before using the Crosstabs function, otherwise all codes will be
displayed in the Crosstab.
Tip: You can open the crosstab function by right-clicking on a code from the context
menu. In this case, only that specific code is shown in the cross table.

2. Define columns
The definition of the columns is done by defining appropriate variable conditions
(formulas) in the dialog window, which is similar to the Activate Documents by
Variables dialog window.
To do this, open the Crosstab function in the Mixed Methods tab.
After activating codes and selecting Crosstab, you will have the option to create logical
conditions that will be used to assign documents to each column. The window is
broken up into the following sections:
●
●
●
●

A list of all the document variables in the project.
A section for the definition of logical conditions.
Buttons for selecting operators and values.
Buttons for opening and saving logical conditions.
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The Crosstab dialog window

All logical conditions in the middle column “Columns” must have the following
components:

variable name / operator / value
If you have created a variable called “Region” and used the value “urban” for urban
regions and “rural” for rual regions, we would use the following formula in order to
create a crosstab that compares the code frequencies for the two types of regions:
>[Region] = urban
[Region] = rural

Tip: If you want to create columns by all values of a variable, follow these steps:
Select the option Insert all variable values as conditions.
Double-click the desired variable in the left pane of the window.
MAXQDA then lists the formulas for all variable values in the middle pane of the
window. If you double-click on the variable Region, MAXQDA will automatically insert
two rows, one with “urban” and one with “rural”, as in the example above.
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The Crosstabs created in this way would look as follows:

Crosstabs comparing the number of coded segments for each code by region

You can also save formulas, so that you can have quick access to them at a later time
and don’t have to reenter them one by one. Just click on the Save button at the
bottom of the dialog window. You can then give it a name and choose where you
want to save it.
Files for saved formulas are saved by MAXQDA as .LOA files. To open a saved set of
formulas, choose Open and navigate to the place you saved the .LOA file.

Functions in the toolbar
The Crosstab toolbar at the top of the window offers the following in addition to the
usual export functions:
Interactive Quote Matrix – Displays the coded segments from the table in an
interactive window.
Display codes with hierarchy – Displays code system with or without code
hierarchy.
Number of segments – Displays absolute frequencies, meaning the number of
segments of the selected codes in the documents of the respective column.
Row percentage – The percentage share of the cell calculated across the row
(horizontal percentage calculation).
Column percentage based on the sum of coded segments (row “SUM”) – The
percentage share of the cell calculated across the column (vertical percentage
calculation).
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Column percentages based on the number of documents “N (documents)” – The
column percentage in terms of the number of documents in the column (the option
Count hits per document only once will be selected automatically).
Count hits per document only once – The unit of analysis is set to Document. Each
document is analyzed based only on whether the code has been assigned or not; the
frequency with which a code occurs within a document is not taken into account.
Sum – displays the sum of rows and columns.
Highlight highest values – For better interpretation of the results higher values are
highlighted in green (depending on the evaluation function, the color intensity refers
to all cells, each row, or each column).
Refresh – Reopens the dialog window to recreate the table with different settings.

Interactive connection to source data
The cells in the crosstab are interactively linked to the data in your project:
●

●

Double-click on a cell to list its segments in the "Retrieved Segments" window. This
action automatically activates both the documents and codes connected with the
cell.
Right-click on a cell and choose Activate Documents from the context menu. This
activates the connected documents without changing your current code activation
selection.

Crosstab suitability
Crosstabs are well suited for the analysis of sub-categories and their distribution in
sub-groups of the sample. Imagine you have asked how students prepare for
examinations, and the different options (e.g. reading books, working together with
colleagues, etc.) are defined as codes. With the Crosstab function, you can compare
various groups with each other. Are female students participating more in training
groups? Do male students read more text? The options to view the values as row or
column percentages make the interpretation of the data even easier.

Interactive Quote Matrix
The Interactive Quote Matrix can be used to compare the coded segments for different
cases and groups in an interactive workspace. Codes are listed in the rows of the
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matrix and cases or groups in the columns. In the following schematic figure, for
example, the coded segments for the code "Satisfied with flexibility" are compared
between respondents with and without children:
Code
Number of children = 0
Satisfied Nah, I think that it is good the way it is
with
right now. I am very satisfied that this
flexibility flextime exists. For example, if there's
something on the agenda which
requires it, I could even spend a day
working in the home office. Or, I don't
know, when the letter carrier comes,
whatever. I think it's very good that
that if you have a dentist appointment,
for example, or something that, you
can do it before work and then go
there afterwards, instead of having to
take a whole day off or something like
that and not being able to use it for
leisure time at all, but rather wasting it
with private appointments that are
important anyway, but rather health
appointments.
Interviews\Riley : 9 - 9 (50) Mostly
satisfied with flexible hours and home
office.

Number of children ≥ 1
Actually it is flexible enough. Which
means that I currently wake up at
around the same time, but it
doesn't have to be the exact time. It
can be like fifteen minutes or half
an hour difference. And then
sometimes if I'm too lazy to cook, I
eat out, but the set of routines
stays. So I'm working very hard to
keep the important part of the day
the same, like every morning and
go for a run and then eat breakfast
because that's just me maintaining
my health. And I think it's a good
start for the morning.
Interviews\Thanh: 9 - 9 (50)

Very satisfied. The things I do at
work don’t usually happen behind a
desk, so it wouldn’t make sense if I
had to check in and out at a certain
time. So I need to be flexible to be
Yeah, right. The best thing, of course, successful.
would be to work even less and have Interviews\David: 9 - 9 (50)
more free time. Then you would also
have less money, which is of course a
back and forth. And in general, I would
say that universities are usually halfway
flexible. For example, if you have
children or are pregnant, it's not really
a problem to take some time off and
then possibly shorten your working
hours. But I am not affected by that
yet.
Interviews\Riley : 25 - 25 (50)

Follow these steps to open an Interactive Quote Matrix:
1. Activate the documents and codes you wish to include in the matrix. If none are
activated, all documents and codes will be included.

18 - Mixed Methods

595

2. Open the function via Mixed Methods > Interactive Quote Matrix. Interactive
Quote Matrix
3. Use variable conditions to determine which documents are to be displayed in the
columns (a separate column is created for each variable condition). You can find a
detailed introduction to defining columns in the section on Crosstabs.
4. If necessary, select the options Only for activated documents and/or Only for
activated codes.
5. Click OK – MAXQDA will open a new window with the interactive display:

Interactive Quote Matrix
The first column displays a list with the codes you selected. MAXQDA automatically
adds the parent codes of the activated codes in order to retain the code system's
hierarchical structure.
Tip: If you selected the option Only for activated codes, you can change this later in
your “Code System” to adjust the selection of displayed codes in the Interactive Quote
Matrix.
The other columns are the results of your selected variable conditions: for each defined
condition, a column is displayed. These columns contain the coded segments of the
documents which meet the respective variable condition. The number of documents
per column is indicated in the column headings.
Click on a code in the code tree to list its coded segments in the columns. The column
headers indicate how many coded segments are displayed in the column.
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Tip: The Interactive Quote Matrix function can also be opened directly from the Code
Matrix Browser or from a Crosstab. When working with the Code Matrix Browser or a
Crosstab, click the first icon on the very left. The Interactive Quote Matrix can also be
opened by selecting: Analysis > Compare groups > Qualitative.

Toolbar
Along the top edge you will see a symbol toolbar with the following functions:
Display codes with hierarchy – if this option is activated, the codes are displayed in
a hierarchical tree structure. The non-activated parent codes may be displayed to
retain its hierarchical structure. When the option is deactivated, the codes are
displayed in a linear list. Should you have selected the option "Only activated codes"
when creating the matrix, only the activated codes will be displayed.
Display origin – shows the source documents, locations within documents, and the
code weights in brackets below the coded segments. Clicking on the displayed source
information loads the corresponding document into the “Document Browser” and
highlights the coded segment.
Display comments for coded segments – displays all the comments on coded
segments (if there are any).
Display memos – displays below the coded segments the titles of memos that are
present at the level of the coded segments. Clicking on the displayed memo title
opens that memo.
Standardize font – with this setting, you can standardize the text font, size, and
line spacing to create a consistent display of your text segments. Font styles such as
bold and italics are not affected by this setting.
Zoom out – minimizes the display of the segments in the columns.
Zoom in – magnifies the display of the segments in the columns.
x of y columns – adjusts how many columns (x) of the total columns (y) are visible.
Display search toolbar - allows you to search within the Interactive Quote Matrix.
Refresh – reopens the options window for the Interactive Quote Matrix, which lets
you customize the columns and included documents and codes.
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Exporting the Interactive Quote Matrix
The Quote Matrix can be exported using the usual icons at the top right of the
window. The segments of all displayed codes are always exported. If you limited the
quote matrix to activated codes, only these activated codes are exported.
Open as Word document – Creates a Word document and opens it.
Open as Excel table – Creates an Excel spreadsheet and opens it.
Export – Creates a table as a Word file (DOCX format), an Excel file (XLS/X format),
or a web page (HTML format).

Typology Table
This function offers yet another way to combine quantitative data and your codes or
categorical variables. It is called a Typology Table, because it is able to calculate various
variables and their percentages (means, standard deviations, etc.) for qualitative
typologies.
The table is set up similarly to the following example from Creswell and Plano Clark’s
textbook “Designing and Conducting Mixed Methods Research” (2011: 292):

Example of a Typology Table

This table shows a comparison between two types of patients, “Depressed” patients
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(27 persons) and “Not Depressed” patients (21 persons). The last column p-Value
shows the statistic significance of the mathematical means. The first row "Age" shows
the average age of both groups and the standard deviation in brackets.
The row “Women” contains the number of women and their percentage. This means
that of the 27 depressed persons 21 are women, which is 79% (there is a mistake in
the table, correct would be 78%).
As we can see, the rows consist of variables, metric variables to be exact, and specific
values of categorical variables – either text or numerical variables. The columns follow
the pattern of Crosstabs, meaning the values of any categorical variables can be
selected.

Create a Typology Table
To create a Typology Table, proceed as follows:
1. Select Typology Table from the Mixed Methods menu tab.
2. For categorical variables, all respective variable values are listed in the dialog
window. For non-categorical (metric) variables, the variables themselves are listed.
For easy differentiation, non-categorical variables appear in red. Check the variable
values and variables you would like to include in the Typology Table and to
compare between groups.
3. Select the Exclude missing values option when the missing values of non-categorical
variables should be ignored. This will usually be the case.
4. When you click Continue a second dialog window will appear in which you can
define the columns of the Typology table, and where you can specify the elements
that should be compared with one another.
5. Create a variable condition (formula) for each desired column, for example “State =
Indiana” and “State = New York”. The quickest way to do so is by double-clicking
the variable in the variable column. When you click OK, MAXQDA will display the
Typology table.

Example of a Typology Table

The Typology Table toolbar
At the top of the Typology Table you will find a toolbar that – besides the usual export
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options – offers the following functions:
Highlight lowest value per row – for better interpretation of the results the value
highest in row is highlighted in red.
Highlight highest value per row – for better interpretation of the results the value
lowest in row is highlighted in green.
Refresh – updates display via recalling the function.

Interactive connection to source data
The Typology Table is linked to the data in your MAXQDA project interactively:
●

●

Double-click on a cell, that shows the number of documents (and no mean value), to
activate these documents in the "Document System".
Double-click on a cell of of the first column, where the cell shows a variable value, to
activate all documents that fit the clicked variable criteria.

Similarity Analysis for Documents
The Similarity Analysis for Documents can be used to check the similarity or
dissimilarity of various documents in terms of code occurrence and code frequency.
The values of document variables can also be included.

Starting the Similarity Analysis
1. Activate all documents you would like to include in the Similarity Analysis.
2. It is also helpful to activate all codes you wish to use for determining similarity.
3. From the Mixed Methods menu tab, click
Similarity Analysis for Documents. A
window will appear that contains all previously created similarity and distance
matrices.
4. Click on the
New Similarity/Distance matrix symbol to begin the similarity
analysis.

Setting the parameters for the analysis
A dialog window will appear in which you can select the codes and variables and
specify the type of analysis.
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Setting options for the analysis

In the upper section, you can add the codes you wish to include in the analysis. You
can add all activated codes directly via the Paste activated codes button.
Next, select the type of analysis:
Existence of code – Generates a similarity matrix that considers only whether the
selected codes occur in the document or not.
Code frequency – Generates a distance matrix that takes the distance of individual
codes into consideration.

Similarity measures with the option “Existence of code”
To calculate similarity, various options are available. All of the calculations are based
on a four-field table of the following type that is generated for each paired
combination of documents (in the background, not displayed):
Document A
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Code/Variable value
exists
Code/Variable value
a
Document exists
B
Code/Variable value
c
does not exist

Code/Variable value
does not exist
b
d

a = Number of codes or variable values that are identical in both documents.
d = Number of codes or variable values that do not exist in both documents.
b and c = Number of codes or variable values that exist in only one document.
The calculation options differ in, among other things, the extent to which field "d",
the non-existence in both documents, is considered a match.
Simple match = (a + d) / (a + b + c + d) – Both existence and non-existence are
counted as a match. The result is the percentage match.
Jaccard = a / (a + b + c) – Non-existence is completely ignored.
Kuckartz & Rädiker zeta = (2a + d) / (2a + b + c + d) – Existence is counted twice, nonexistence once.
Russel & Rao = a / (a + b + c + d) – Only existence is considered a match, but nonexistence reduces the similarity.
Please note: If you include more than one code into the analysis that does not exist in
multiple documents, it may be better to use a coefficient who ignores non-existing
codes (Jaccard) or values them less (Kuckartz & Rädiker zeta, Russel & Rao). Otherwise
you may receive a high similarity score, even if the codes are not assigned very
differently. The non-existing codes will dominate the existing codes in this case.

Distance measures with the option “Code frequency”
To calculate the distance between two documents based on “Code frequency”, the
following options are available in which the code frequencies of two documents will
be compared:
Squared euclidean distance = The sum of squared deviations (higher deviations will be
rated higher as lower ones because of squaring the deviations).
Block distance = The sum of absolute deviations.
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Please note: Since it is also possible to include variable values in the analysis, all code
frequencies and variable values are z- standardized previously beforehand.

Including variables
If you want to include variables in addition to codes in the similarity analysis, click the
Integrate variables button. If you selected “Existence of code” as the type of analysis,
you can then select which variable values MAXQDA should evaluate in the dialog
window. If the selected variable value exists in both documents, this is evaluated as a
match (type “a” in the table above). In the dialog window, only variables of type
“Text”, “Boolean (true/false)”, “Date” as well as categorical “Integer” and categorical
“Decimal” are listed.

Selecting variable values in the “Existence of code” analysis

If you selected "Code frequency" as the type of analysis, another dialog window will
appear that contains only integer or floating-point variables, that are not marked as
"categorical".
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Selecting variable values in the “Code frequency” analysis

Dealing with missing variable values
You can choose how missing values are handled:
Set missing values to 0 – IIf a variable value does not exist, it is set to 0 (which equals
the average due to the z- standardization). Using this option, documents with missing
values are included in the analysis.
Ignore documents with missing values – If in a document one value of the selected
variables is missing, the entire document will be ignored in the analysis.

The final similarity or distance matrix
The following figure shows a similarity matrix for five interviews. The selected
documents are listed both in the rows and in the columns:
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Similarity matrix for five interviews

The default shadowed color helps to interpret the cells, which in a similarity matrix can
have a value of 0 (no similarity) to 1 (identical): The darker the green, the more similar
the two documents are in terms of the selected code and variable values. In the figure,
for example, you can see that "Sam" completely coincides with "Jamie" both in their
codes and their variable values.
The matrix is sortable: click on a column header to sort the documents in the rows
according to their similarity to the clicked document.

The Similarity Analysis toolbar
In addition to the usual export options, the following functions can be accessed from
the toolbar:
New similarity/distance matrix – Calls up the dialog window where you can create
a new matrix.
Delete – Deletes the selected matrix.
Names, columns: none, short, full – Controls column width.
No color highlight – Turns off green highlighting.
Color highlight refers to whole matrix – The highlight color takes into account the
values of all cells. The same values will have the same highlight color in the table.
Color highlight refers to columns – In each column, the colors are graduated from
white to green. In this way, you can see at a glance which documents are particularly
similar to the document in the column. The same values in the matrix may be colored
differently.
Color highlight refers to rows – In each row, the colors are graduated from white
to green. In this way, you can see at a glance which documents are particularly similar
to the document in the row. The same values in the matrix may be colored differently.
Distance matrices look identical to similarity matrices, however their interpretation is
the reverse: The lower the value in a cell, the more similar the two documents are. The
minimum distance is 0, the maximum distance depends on the codes and variables
selected in each case and can be greater than 1.
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The list of existing similarity and distance matrices
In the left pane of the window, you can see the similarity and distance matrices
created earlier in the project. They can be renamed with a double-click or deleted by
clicking the Delete icon in the toolbar.
Tip: In order to ensure the transparency of the analysis process, the matrix name and
selected settings will be displayed in the tooltip if you hover over a matrix name.

Side-by-side Display of Results
Definition: The purpose of the Side-by-side Display is to array quantitative and
qualitative data of a Mixed Methods project together.
Side-by-side Displays are used to display the results of a qualitative and a quantitative
study together by sorted themes. The display is structured like this:
Qualitative Results
(Document A)
Theme 1 Coded segments / Summaries
(Code 1)
Theme 2 Coded segments / Summaries
(Code 2)
Theme 3 Coded segments / Summaries
(Code 3)

Quantitative Results
(Document B)
Coded segments / Summaries
Coded segments / Summaries
Coded segments / Summaries

The Side-by-side Display has two columns. Each column displays coded segments or
summaries for each of the two studies. The rows of the table are made up of themes,
in this case your codes.

Creating a new Side-by-side Display
Navigate to the Mixed Methods menu tab and click the Side-by-side Display entry.
From the dropdown select to create a new display for either coded segments or
summaries. MAXQDA will open the following dialog:
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Creating a side-by-side display

1. Drag and drop a document from the “Document System” into each of the fields for
“Qualitative study” and “Quantitative study” with your mouse. Drag another
document into a field to replace a document you already selected.
2. Drag and drop any number of codes from the “Code System” into the “Themes”
box on the left. Codes can be rearranged with the mouse. Codes can be removed
from the “Themes” box by dragging the code out of the box or selecting the code
and pressing Del key (Windows) or ⌘+Backspace (macOS).
3. Check the box next to Include comments of coded segments to include comments.
If a comment exists, it will be displayed below the coded segment in the final
display. This option is not available for side-by-side displays created for summaries.
4. After clicking OK, a dialog window will appear where you enter a file name and
select the location on your computer to save the display to.
MAXQDA generates an Interactive Quote Matrix with two columns for a Side-by-side
Display, so that you can explore this display interactively. You can find further
information on how to work with this results window in the following section of the
manual: Interactive Quote Matrix.

Qualitative Themes by Quantitative Groups
Definition: This joint display integrates data by arraying the qualitative data (segments
or summaries) as one dimension and the groups formed by the quantitative data as
another dimension.
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This joint display is used to compare coded segments or summaries for groups of
documents. Documents are grouped based on variable values. The following table is a
schematic representation of a joint display for the document variable “Occupation”.
Document groups are created based on their occupational status:

Theme 1
(Code 1)
Theme 2
(Code 2)
Theme 3
(Code 3)

Document variable: Occupation
unemployed
employed
(N = x documents)
(N = y documents)
Coded segments /
Coded segments /
Summaries
Summaries
Coded segments /
Coded segments /
Summaries
Summaries
Coded segments /
Coded segments /
Summaries
Summaries

self-employed
(N = z documents)
Coded segments /
Summaries
Coded segments /
Summaries
Coded segments /
Summaries

Each column displays coded segments or summaries from those documents with the
corresponding variable value, separated into rows by themes (= codes).

Creating a new display
Navigate to the Mixed Methods menu tab and click on the QUAL Themes for QUAN
Groups option either for coded segments or summaries. MAXQDA will open the
following dialog:

Creating a joint display “Qualitative themes by quantitative groups”

1. Select which groups to compare by selecting a document variable and up to four
variable values from the drop-down menus. MAXQDA will include all documents
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2.
3.

4.

5.

with the corresponding variable value in the final columns of the display.
You can limit the display to only include currently activated documents by checking
the box next to Only for activated documents.
Drag and drop any number of codes from the “Code System” into the “Themes”
box on the left. Codes can be rearranged with the mouse. Codes can be removed
from the “Themes” box by dragging the code out of the box or selecting the code
and pressing Del key (Windows) or cmd-Backspace (Mac).
Check the box next to Include comments of coded segments to include comments.
If a comment exists, it will be displayed below the coded segment in the final
display. This option is not available for displays created for summaries.
After clicking OK, a dialog window will appear where you enter a file name and
select the location on your computer to save the display to.

MAXQDA now creates the Joint Display as an Interactive Segment Matrix directly in
MAXQDA, so that you can analyze the results in detail and interactively. For more
information on how to use the results window, please refer to the section Interactive
Quote Matrix.

Statistics by Qualitative Groups
Definition: This joint display integrates a qualitative typology as one dimension with
the quantitative data as another dimension.
This joint display is used to compare types that have been constructed from the
qualitative data by statistical values such as mean, standard deviation, etc. The types
are created based on the existence of codes in each document. The following table is a
schematic representation of this kind of joint display:

Variable 1
(numerical)
Variable 2
(categorical)
Documents

subcode A
Mean (Standard
deviation)
Total (%)

Coded with …
subcode B
Mean (Standard
deviation)
Total (%)

subcode C
Mean (Standard
deviation)
Total (%)

N (%)

N (%)

N (%)

Each column holds all documents, in which the selected subcode occurs. It is therefore
important that only one of the subcodes is assigned to each document. An example
could be an evaluative qualitative text analysis where the code “self-assurance” has
the subcodes “low,” “medium,” and “high”. If one of the subcodes is assigned to
each document, they can now be used to create this joint display.
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Creating a new display
Navigate to the Mixed Methods menu tab and click the Statistics for QUAL Groups
entry. MAXQDA will open the following window:

Creating a joint display “Statistics by qualitative groups“

1. Create groups by dragging a code that has subcodes (but no sub-subcodes) from
the “Code System” window to the “Groups” field at the top of this window. Select
up to 4 subcodes from the drop-down menus below.
2. You can limit the display to only include currently activated documents by checking
the box next to Only for activated documents.
3. Click the “Choose document variables…” button to call up the variable selection
window. Select which variable values to include for categorical variables.
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Choose document variables for the Joint Display “Statistics by qualitative groups“

4. Click OK to include your selection and click OK again to create the joint display.
The result of this display is equal to that of a Typology Table.

Transform a Code into a Document
Variable (Quantitizing)
A code in the “Code System” can be transformed into a document variable, indicating
how often the selected code appears in each document. The document variable is
dynamic. MAXQDA will automatically update the document variable, i.e. increasing
the variable value if a new segment is coded with the code. This feature is particularly
useful as it allows the user to export code frequencies along with variables, or activate
documents based on certain code frequencies for analysis.
To transform a code into a document variable, right-click the code and select
Transform into Document Variable.
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Transform a code into a document variable

MAXQDA will generate a document variable, with the same name as the code, as a
numeric variable. The program will automatically insert the code frequency of each
document into the appropriate cell of the column. It opens along with the “Data
editor” of the document variable and positions it in the appropriate column. The
content of this variable can’t be edited manually. MAXQDA updates the variable
dynamically: if you assign the transformed code to a document, the corresponding
variable value is automatically updated.
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Code ”Friends” converted to a document variable

Please note: To transform multiple codes into document variables at once, activate all
of the codes first, then click the Quantitizing option in the Mixed Methods menu tab.
You can recognize variables transformed from codes in the "List of Document
Variables" by the green square icon in the first column and the "Code" entry in the
"Source" column.
The transformed code can be binarized by clicking the Convert to Boolean variable
icon in the "List of Document Variables". The variable then no longer indicates how
often the corresponding code occurs in the respective document, but whether it
occurs (1) at all in the document or not (0).
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Binarize a variable by converting its type from “Integer” to “Boolean”

Transform a Code into a Categorical
Document Variable
Evaluative categories in (qualitative) content analyses
In many research projects, forms of evaluative qualitative content analysis are used.
The standard steps are to: (1) define evaluative categories, usually with ordinal
variables, (2) code text segments, and (3) analyze the data descriptively and
statistically. A good example of this form of analysis process is found in Philipp
Mayring’s chapter on qualitative content analysis found in “A Companion to
Qualitative Research” (Flick, et al., 2004), which describes scaled variations of structure
content analysis.
In one of Mayring’s detailed examples from a study on student teachers, a category
called “self-confidence” is created with three options: “high,” “medium,” and “low”
(see below). These categories were developed from the data. The following figure
shows that the categories are not only precisely defined, but also empirically supported
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with the help of the anchor examples in the data.

The coding process, which is standard procedure for content analysis, has the
researcher working through the entire data set and assigning evaluative codes to
appropriate text segments that have to do with “self-esteem.” This means that every
single text segment that connects to self-esteem will be assigned the code “high,”
“medium” or “low” based on the coding guidelines established.
In the end, each case (in the case of interviews, a case would be an interviewed
person) can be analyzed as a whole and given a summary characterization as having
“high,” “medium,” or “low” self-esteem. Cases characterized as having high selfesteem can then be compared with those with low self-esteem. Code frequencies can
also be compared and used in combination with other categories in crosstabs.

Principles of application in MAXQDA
The method for evaluative content analysis can be done in MAXQDA in the following
way. First, the category “self-esteem” is created as a code with the subcodes “high,”
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“medium,” and “low.” The definitions of these codes along with anchor examples can
be created as code memos..
Now the data will be analyzed, meaning that each document is read line by line. The
text segments that have to do with self-esteem are identified and then coded with the
appropriate code (e.g. “high” self-esteem). After an entire text has been worked
through in this way, the researcher will have one of the following situations:
●

●

●

●

Text segments about self-esteem in this document were all coded with the same
subcode (e.g. “medium” self-esteem). In this situation, the entire case can be said to
have a medium level of self-esteem.
Text segments about self-esteem in this document were coded with various
subcodes, but one of those subcodes obviously occurs more often (e.g. three with
“high” self-esteem and one with “medium”). In this situation, it makes sense to give
the whole case that level of self-esteem that is coded most often.
Text segments about self-esteem in this document were coded with various
subcodes, and none of them clearly occur more often than the others (e.g. two with
“medium” self-esteem and two with “high”). In this situation, a quick categorization
cannot be made, so the coded segments should be compared to one another by the
coders, who then make a decision about which categorization is more appropriate.
No text segments were coded with self-esteem subcodes, meaning the document
does not contain any information about this theme. None of the subcodes can be
used to categorize this document and will need to be treated as a “missing” value.

The “Transform into a Categorical Variable” function
After coding the appropriate text segments, the “Self-esteem” code can be
transformed into a categorical variable by right-clicking on the code and selecting the
appropriate option in the menu that appears.
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Calling up the “Transform into Categorical Document Variable” function in a code’s context menu

After this option is selected, MAXQDA performs the following actions:
1. A new categorical variable is created in the List of Document Variables with the
name of the code that it was created from (in this case, “Self-esteem”).
2. All cases (documents) in the “Document System” are evaluated according to the
rules explained above.
a) Each case is assigned the value of the subcode that occurs the most often.
b) If there are two or more subcodes used the same number of times, it is labeled
“undefined.”
c) If none of the subcodes are used at all, no value is assigned. If the table is
exported to statistical software, empty values are usually treated as “missing.”
3. MAXQDA opens the "Data Editor for Document Variables".
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Data Editor with the new categorical variable “Self-esteem”

Please note: If a subcode has further subcodes, then these subcodes and their
segments are not included in the evaluation for the categorical variable. Only the
direct subcodes are taken into account.

Dynamic properties of categorical variables
In MAXQDA‘s List of Document Variables, the categorical variables have a special
status. One recognizes them in the list because they have a green square in the first
column and are created from a “Code” as seen in the “Source” column; categorical
variables are defined as text variables, and the texts are taken from the “Code
System” (in this case “high,” “medium,” or “low”).

The newly-created categorical variable “Self-esteem” in the List of Document Variables

Categorical variables are dynamic, which means they are updated automatically when
new segments are coded in the documents. This is also the case for documents that
are imported after the categorical variable has already been created; when one codes
this new document, the variable label changes accordingly.
Tip: If a subcode has further subcodes, they will not be included for the evaluation of
categorical variable values. Only direct subcodes of the codes that were transformed
into a categorical variable are evaluated.

Categorical variables in the context of MAXQDA's mixed methods
functions
Categorical variables lend themselves very well to use with MAXQDA’s mixed methods
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functions, found in the Mixed Methods menu tab. With the Activate Document by
Variables function, for example, one can choose to activate only those documents with
a certain variable value. This is helpful for answering research questions such as “How
do student teachers with low self-esteem experience their situation in the school
system? How do they approach disciplinary issues?”
The Crosstabs function offers an aggregated overview of the number of coded
segments in certain categories in the “Code System” for each of the three self-esteem
variables. The self-esteem characterizations are shown in the columns on the x-axis,
and the selected codes are shown in the rows on the y-axis. Using the self-esteem
example, the Crosstabs function could count the number of times that student
teachers with low self-esteem talk about disciplinary issues in comparison to the
number of times student teachers with high self-esteem talk about the issue. One can
then easily call up the document segments counted in each cell in the “Retrieved
Segments” window.
One can also use the Interactive Quote Matrix to see a detailed table of the document
segments, each column holding those segments that occur in documents with a
specific categorical value. In our self-esteem example, one column could hold those
statements about a certain topic that come from student teachers with high selfesteem, and the other column could display those statements from teachers with low
self-esteem.
The Typology Table uses categorical variables similar to the way the Crosstabs function
does; a table is created with the categorical variable values in the columns. In this case,
however, the variables are analyzed rather than the categories. One could look, for
example, what percentage of people with high self-esteem are older than 30 years
and what percentage are younger, or whether good grades in teacher certification
exams seem to connect in any way to self-esteem, etc.
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20 - Analyzing Videos
Video Analysis with MAXQDA
With MAXQDA, you can import, play, transcribe, paraphrase, and directly code video
footage for video analysis. The “Multimedia Browser” lets you play and code videos
using the same approach you would use for text analyses. The standard tools for
coding texts are also available for video analysis, including:
●
●
●
●

●

Adding to comments to coded segments in videos
Adding weight scores to coded segments in videos
Displaying and hiding coding stripes
Attaching memos to specific time positions in videos, , e.g., to make notes or add
interpretations, hypotheses, or ideas for analysis
Linking video clips to other video clips or text segments, e.g., sections in your
transcript

The following tools are also available especially for video analysis:
●
●
●
●
●

Exporting still images for publications
Saving still images as image documents in MAXQDA for further analysis
Exporting short video clips, e.g. for presentations or analysis sessions
Transcribing short sections or entire videos
Linking videos and transcripts via timestamps

Import Videos
Before you import video files into MAXQDA, you should briefly check their format and
size.

Supported video formats
MAXQDA supports the following standard video formats:
●
●
●
●
●

MP4
MOV
MPG
AVI
M4V
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●
●

3GP, 3GGP
and on Windows: WMV

In general, we recommend the MP4 format with the H.264/AVC video codec.

Recommended resolution
These days you can record videos in very high resolution, which in turn leads to
extremely large files. When analyzing videos with MAXQDA, your video will be
displayed in its own window, which usually doesn’t fill the entire screen. An HD
resolution (720p) will therefore be sufficient for working with videos in MAXQDA. If
you are using a retina or 4K monitor, a Full HD resolution (1080p) may also be
appropriate.
The size of a video file depends on its resolution, frame rate, and data rate. A frame
rate of 25-30 frames/second and a data rate of approx. 1,500 kilobits/second are
usually sufficient.
To check the format, resolution, frame rate and data rate of a video file, follow these
steps:
Windows:
1. Right-click on the file and select Properties.
2. In the window that opens, select the Details tab. Here you can find the relevant
information in the "Video" section.
macOS:
1. Open the video file in the QuickTime Player.
2. Press the keyboard shortcut ⌘+I. A window with the relevant information will
open.

Converting videos
You can use the following programs to convert videos into a supported format and
reduce the resolution if necessary.
Windows: XMedia Recode
This program is available free of charge online and has a small file size itself (10 MB):
1. Drag your video file into the upper window area of XMedia Recode, and then click
the row containing the video to select it for editing.
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2. Select the output format in the lower window area, e.g. the profile "HTML 5" with
"HTML 5 1280×720 HD (mp4)", corresponding to a resolution of 720p.
3. At the bottom of the window, select where you want the converted video to be
saved.
4. Click the "Add to queue" button at the top and then the "Encode" button.
macOS: Quicktime Player
QuickTime, which is installed by default on Mac computers, allows you to save videos
in MOV format:
1. Open your video in the QuickTime Player.
2. In the File menu, select Export as > 720p ... (or 1080p...).

Adding a video file to a MAXQDA project
To import a video into an open MAXQDA project, click on the Video icon on the
Import tab or drag and drop the file directly into the “Document System” window..

Importing video files via the “Import” menu tab

Audio and video files are generally not imported directly into a MAXQDA project.
Instead, they are stored in the MAXQDA Externals folder and linked to a text
document in which you can, if necessary, save a transcript.
When importing an audio or video file, MAXQDA creates a new text document with
the name of the media file and assigns the inserted media file to the newly added
document. The media file itself is copied to the “MAXQDA_Externals” folder so that it
remains available for MAXQDA later if you move the file from its original location or
delete it. If a file with the same name already exists in the Externals folder, MAXQDA
asks if the existing file should be overwritten.
In the “Document System”, you will recognize a text document with the associated
media file by their special symbols: a musical note for audio files and a video camera
for video files.
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Audio and video files in the “Document System“

Folder for externally stored files
You can adjust the location of the folder for external files in the MAXQDA settings.
The settings are called up via the gear wheel at the upper right edge of the window.

Open preferences

Set folder for externally stored files in the “Preferences” window

Please note the following notes when saving video files:
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●

●

●
●

●

●

To avoid slower processing speeds, video files should ideally be stored on the local
hard disk.
If your set of files is very large, you can also store it on an external hard disk
connected to your computer via a fast USB 3 port.
Only save video files to network folders if you have a very fast cable network.
To protect confidential video files, you can store them in an encrypted folder. Such
folders can be created with the open source software Veracrypt and integrated into
your computer as a virtual drive. However, encryption can lead to a loss of
performance when accessing the videos.
To prevent potentially very large amounts of data from being copied to the
MAXQDA_Externals folder when importing, you can specify the original storage
location of your videos as the "Folder for external files" in MAXQDA's main
preferences.
When you open a media file for the first time, MAXQDA creates a file with the
extension .dat in the folder for external files. This file has the same name as the
media file. MAXQDA needs this .dat file to be able to display the media file quickly,
so it should not be deleted.

For more information about external files, see Managing External Files.

Assigning audio/video files to a text document
You can also assign a media file to an existing text document. To do so, right-click on
the document and select Link Audio/Video File in the context menu.
Alternatively, open the Properties window from the context menu. Here you can
add or modify links to media files at any time.
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Assigning an audio/video file to a document

Tip: In this dialog window, you can also easily check which media files are linked to
your text documents.

The Multimedia Browser
You can play and analyze audio and video files in MAXQDA’s “Multimedia Browser”.
To open an audio or video file in the “Multimedia Browser”, right-click the document
in the "Document System" and select Open Audio File or Open Video File.
Alternatively, you can also open a media file directly from the "Document Browser":
1. Open the text document to which the audio or video has been assigned (e.g. by
double-clicking on its name in the "Document System").
2. Click on the icon Open video file (file name) or Open audio file (file name) in
the "Document Browser" toolbar.

Open the “Multimedia Browser” by clicking on the icon in the “Document Browser”

If the text document is empty, i.e. there is no transcript, MAXQDA automatically opens
the video in the “Multimedia Browser” as soon as you open the corresponding text
document.
The “Multimedia Browser” looks like this:
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The “Multimedia Browser” window

The “Multimedia Browser” is composed of the following areas:
●
●

●
●

●
●

The upper panel shows the video.
Underneath, there is a toolbar containing the functions to adjust the view and
playback and the functions for coding. Here, you can also see the current playback
position and the total time of the media file.
Beneath the toolbar, thumbnail pictures can be displayed for fast navigating.
Underneath, you can see the waveform of sound of the media file, and below this,
there is a time line where you can see the current playback position.
Under the time line there is a bar for the timestamps of the transcripts.
At the very bottom is an area where the coded segments are visualized by bars.

For audio files, the video window and preview pictures are not shown.
The blue vertical line and the blue bar underneath the time line indicate the current
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playback position.
The following functions are available on the toolbar:
Control Panel – opens the window with playback options
Display preview thumbnails – displays previews beneath the toolbar
Please note: The previews are loaded the first time you display a preview - this can
take a few minutes with large files.
Insert Internal Link (Anchor/Target)– sets the start and end point of a reciprocal
internal link
New memo (Alt/⌥+⇧+M) – creates a new memo in the current playback position
Previous memo (⇧+F3) – jumps to the memo to the left of the current clip position
Next memo (F3) – jumps to the memo to the right of the current clip position
Paraphrase Audio/Video – opens the paraphrase mode
Set clip start (F7) – sets the beginning of a clip segment at the current playback
position
Set clip end (F8) – sets the end of a clip segment at the current playback position
Play clip (F9) – plays the segment selected on the waveform
Remove clip (F10) – removes current clip marks from the waveform
5 seconds back (⇧+F12) – jumps back 5 seconds from your current playback
position
Play/Pause (F4 or F5) – starts/pauses playback
5 seconds forward (F12) – jumps 5 seconds forward from your current playback
position
Slider – helps you jump to a certain position
Copy video image to clipboard - copies the currently visible video image to the
clipboard, e.g. for inserting it into a Word document
Insert video picture as image document in ‘Document System’ - inserts the
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currently visible video image as an image document in the "Docuemtn System", e.g.
to be able to code segments of the image.
Export coded video clips - in the dialog window that opens, specify the quality and
resolution of the clips and select the codes whose coded video segments you would
like exported.
On the far right of the waveform, there are other icons that you can use to adjust the
zoom for the waveform.
zooms out of the waveform, reduces the number of preview pictures for videos.
zooms the view to 100%. This view is configured by default and is usually ideal
for coding.
shows the complete media file in the “Multimedia Browser”; this gives you an
overview of the waveform of the complete file (unless it's very long). This view is
usually not suitable for coding.
zooms into the waveform, increases the number of preview pictures for videos.
This makes it easier to navigate to single pictures and words and code more
specifically.

Control media files with your keyboard
Media files can be controlled via function keys, e.g. you can jump forward 5 seconds
with F12.
Please note: For information on how to use the function keys F1 .. F12 with a Mac
computer, please see the Frequently Asked Questions.
To start and stop playback, you can use the F4 or F5 or:
●
●

Pressing Ctrl (Windows) or the Shift button ⇧ (macOS) twice, or
if the “Multimedia Browser” window is open, by clicking in within the video
window, the playback can also be started and stopped with the Space key.

Code Videos
Coding in the Multimedia Browser
Video files (as well as audio files) can be coded in the same way as texts in MAXQDA.
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To do so, open the video file in the Multimedia Browser as described in the previous
section.
You start by marking a segment in the waveform (a so-called “clip”). Typically, you will
want to set the beginning and end of a segment in a media file precisely, as the scene
and content can change completely from one moment to the other. For this reason,
MAXQDA offers numerous functions that allow you to mark an audio or video clip:
●

●

●

●

To roughly mark a segment, keep the left mouse button pressed and select the
segment by dragging the cursor over the waveform. The time limits are displayed
underneath the beginning and end marks.
You can easily alter the time limits of the clip by moving the blue-marked time
display or by clicking and dragging the outer borders of the segment in the
waveform.
By using the right and left arrow keys on your keyboard, playback is moved by onetenth of a second. If the playback precisely matches the beginning or end of a clip,
the clip is enlarged or reduced accordingly.
To play the marked clip, click the icon Play clip or press the F9 key.

Marking a clip

Please note: For information on how to use the function keys F1 .. F12 with a Mac
computer, please see the Frequently Asked Questions.
You will usually play a media file and then pause exactly at a position where you want
to set a new coding. To do this:
1. Press the button Play/Pause
or the F4 key.
2. When the playhead is at the designated position, click the button Set clip start
or
press the F9 key. If necessary, use the arrow keys on the keyboard or click and drag
the clip borders to fine-tune the start of the clip.
3. Resume playback and pause at the position where you want to end the coding.
Click the button Set clip end
or press the F10 key. If necessary, make a fineadjust of the clip end.
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Setting the clip limits at the current playback position

You can now code the selected segments as usual, for example by (a) dragging and
dropping the marks on to a code, (b) clicking on an emoticode, or (c) by clicking a
color code. Right-clicking on a marked segment opens a context menu that contains
three options that are relevant for coding:

Context menu on a marked clip

Selecting long passages in a video
To selct a segment in a video, you can click and drag the mouse in the waveform. This
can be impractical if the passage you want to mark is very long. You can save time by
doing the following:
1. Place the playback position at the beginning of the passage.
2. Use the scroll bar to scroll to the approximate end of the passage. Then click the
waveform while holding down the Ctrl key (Windows) or cmd key (Mac).
MAXQDA will then mark the entire area between the two positions. The clip
boundaries can be adjusted as usual with the small sliders.

Displaying coded segments in the Multimedia Browser
The coding is indicated by a horizontal coding strip in the “Multimedia Browser”, the
code name appears on the left below the coding stripe. In addition, the waveform is
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colored with the color of the code in the corresponding time range. If several codings
are superimposed, the color is mixed in the waveform. For coded segments with an
emoticode, the symbol is visualized on the coding stripe.
Clicking on a coding stripe selects the coded segment on the waveform. Doubleclicking plays the clip.

Visualization of coded segments in the “Multimedia Browser”

Right-clicking on a coding stripe opens a context menu containing the usual options:
●
●
●

Modify weight
Edit comment
Delete

Please note: Coded video segments that have a comment are marked with a white
square on the left-hand side of the coding stripe.
The display of the coding stripes can be adjusted. To do this, right-click in the grey
area where the coding stripes are displayed; it is important not to click on a coding
strip but next to it. The following dialog appears:
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Options for displaying the coding stripes in the “Multimedia Browser”

You can select to display only coded segments of selected people or codes with a
specific color. Particularly important for video analysis is the bottom option Display
code favorites at the top. It ensures that all codes that you have defined as favorites
under Codes > Code Favorites are always displayed at the top of the "Multimedia
Browser". A separate line is reserved for each of the favorite codes, creating a kind of
score view. This view is ideal, for example, for structuring the video or identifying the
key players in the video.
Tip: By clicking on the asterisk, you directly open the window with the code favorites
and can add further codes from the "List of codes".
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Transcribe Videos
This manual contains a separate chapter on "Transcription", which provides a detailed
explanation of how to use MAXQDA's Transcription Mode to transcribe video or audio
files and of how to use timestamps to link transcripts with media files. In addition to
the functions described there, MAXQDA provides an additional tool for transcribing
short sections of videos:
Often only specific scenes from videos need to be transcribed, for example in order to
perform a more detailed analysis on these scenes. In these cases you have the option
of transcribing individual passages in the “Multimedia Browser”.
Follow these steps:
1. Open the video file in the “Multimedia Browser”.
2. Right-click on a point in the waveform from which you want to start transcribing.
3. Select the Transcribe item from the context menu that appears when you right-click
the waveform.

Starting a transcription of a selected video clip

MAXQDA will then open Transcription Mode so that you can start transcribing straight
away. The starting time of your selected video sequence is automatically added to the
transcript. Additionally, a timestamp is set to link the transcript with the video. Clicking
on the timestamp will play the video from the corresponding time position in the
“Multimedia Browser”.
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The beginning of a partial transcript with the start time added to the text

Paraphrase Videos
You can use MAXQDA to paraphrase scenes of a video or audio file:
1. Open the video or audio file in the „Multimedia Browser“.
2. Activate the Paraphrase mode by clicking on the symbol Paraphrase audio/video
in the toolbar or by using the keyboard shortcut Ctrl+⇧+P (Windows) und ⌘+⇧+P
(macOS).
3. In the waveform, select the clip for which you want to write a paraphrase.
4. Right-click in the selected clip and choose New Paraphrase. Alternatively, you can
use the keyboard shortcut Ctrl+P (Windows) und ⌘+P (macOS) or click on the
symbol .

Activate Paraphrase Mode in the „Multimedia Browser“
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Write paraphrase for highlighted clip

Edit and delete Paraphrases
To edit the content of a paraphrase, double-click the orange paraphrase icon to the
left of the green paraphrase bar.
To delete a paraphrase, right-click on its green bar. A context menu opens, in which
you can also call up the window with the paraphrase for editing.

Edit or delete paraphrase with the context menu of a green paraphrase bar

Deactivate Paraphrase Mode
Click the icon
shortcut.

again to exit the Paraphrase Mode or use the corresponding keyboard

As soon as you exit the Paraphrase Mode, the paraphrases are hidden in the
“Multimedia Browser” window. The following sections describe how you can continue
working with the paraphrases: for example, they can be categorized or contrasted in
the Paraphrase Matrix for different cases or groups.

Add Memos and Links to Videos
Attaching memos to time positions in videos
As well as coding them, you can also add memos to media files to make notes or
record your thoughts, hypotheses, interpretations, and much more about particular
time positions. The memos can also be used to subdivide a video file so that you can
quickly “navigate” through the video by jumping to the next memo.
To attach a memo to a playback position, there are several options:
●
●

Right-click a position of the waveform
Or click the button New memo
in the Multimedia Browser toolbar
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●

Or use the keyboard shortcut Alt+⇧+M (Windows) / ⌥+⇧+M (macOS)

Creating memos

You can jump back and forth between the memos of a media file at any time by using
the Previous / Next Memo icons in the “Multimedia Browser” toolbar or the associated
keyboard shortcuts ⇧ + F3 and F3 in Multimedia Browser toolbar.
Please note: For information on how to use the function keys F1 .. F12 with a Mac
computer, please see the Frequently Asked Questions.

Setting internal links in video clips
Internal links in MAXQDA are used to connect two parts of the project, for example a
video scene with an interview section. This creates a hyperlink, which you can click to
jump back and forth between the linked sections.
Follow these steps to set an internal link in a video file:
1. Select part of a video in the “Multimedia Browser”.
2. Right-click on the marked section and select Insert Internal Link (Anchor/Target).
Alternatively, you can use the keyboard shortcut Ctrl+L (Windows) or ⌘+L (macOS).
This sets the start of the link.
3. Select another sequence in the video and repeat step 2. This sets your link target.
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Insert Internal Link

In the “Multimedia Browser”, a link icon will now appear in the waveform, which you
can click to jump to the linked section.

Link icon in the “Multimedia Browser“

You can connect a video clip to another video clip or connect a video clip to a text
section in a document or memo. For example, a passage of text that talks about a
particular video scene can be linked to that video scene via an internal link.

Export Video Clips
You may find it useful to export only short extracts of your video data for
presentations or analysis sessions. You can export selected clips as distinct video files
using the “Multimedia Browser”. These clips can also be inserted as new video files
into your MAXQDA project. Additionally, you can also export already coded video clips
as video files.
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Exporting selected video clips using the Multimedia Browser
You can export a selected clip from the “Multimedia Browser” or insert it into your
MAXQDA project as a new document:
1. Select a section in your video material in the “Multimedia Browser”.
2. Right-click on this section and select Export Video Clip in the context menu.
3. In the dialog window that opens, specify the quality and resolution of the clip you
would like to export.

Exporting a selected video clip from the “Multimedia Browser”

Options for exporting video clips

To insert a selected video clip as a new document into your "Document System” - in
other words, to add it as a new document to your open MAXQDA project - select
Insert as New Document in the context menu for the selected clip.
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Exporting coded video clips
To export a single coded segment of a video, select Export Video Clip for that coded
segment. This function is available in the context menu when you right-click on the
following:
●
●

●

In the “Multimedia Browser”: coding stripes
In the “Retrieved Segments“ window: source information or rows in the displayed
table
In the “Overview of Coded Segments”: rows in the displayed table

Exporting a video clip from the “Retrieved Segments“ window

Please note: Even if several rows are selected in the table view of the "Retrieved
Segments" window or that of the “Overview of Coded Segments”, only the video
segment you have specifically clicked on will be exported.
From the “Multimedia Browser”, you can also export all the coded video segments of
one or more codes:
1. In the toolbar, click on the Export coded video clips icon.
2. In the dialog window that opens, specify the quality and resolution of the clips and
select the codes whose coded video segments you would like exported.
3. Click OK and a window will open in which you can specify a location to export
these clips.
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Icon to export coded video clips in the “Multimedia Browser” toolbar

Dialog window for exporting coded video clips

Analyze Coded Videos
Once you have finished coding a video, you have a wide range of analysis options at
your disposal, using the full range of MAXQDA tools:
●

●

●

●

Visual Tools > Code Matrix Browser: Compare distribution of coded segments for
individual videos or groups of videos
Visual Tools > Code Relations Browser and Analysis > Code configurations: Detect
simultaneous occurrences of codes
Visual Tools > MAXMaps: Create concept maps, if necessary with MAXQDA’s model
templates like the Single-case Model
and much more …
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In the following sections, some analysis functions that are particularly relevant for
video analysis are described in more detail.

Retrieve coded videos in the "Retrieved Segments" window
Coded video segments can be retrieved and compiled in the same way you would
retrieve any other coded segments in the "Retrieved Segments" window, through
activation and the Complex Coding Query function. When working with videos, the
"Retrieved Segments" window will display the first image of the video clip as a
preview. For audio clips, a (standardized) image of a waveform is displayed.
The source information includes the start time of your audio and video clips.
Tip: Click on the source information to play the video segment in the “Multimedia
Browser”.

Audio and video clips in the “Retrieved Segments” window

Displaying sequences of codes in the Codeline visual tool
The Codeline is an excellent tool for visualizing the chronological sequence of coded
segments in a video file. Like in a musical score, selected codes are displayed in their
respective colors, one below the other. For example, you can display structural codes
(i.e. "opening stage", "discussion stage", "closing stage") parallel to topic codes.
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The Codeline for video files

Follow these steps:
1. Activate the codes you want to display in the Codeline. If you would like all your
codes to be displayed, you don’t need to activate any.
2. Right-click on the text document with the video file in the "Document System" and
select Codeline in the context menu.
3. In the dialog window that opens, select your preferred options, e.g. Only for
activated codes.
4. In the top left corner of the Codeline window, click the icon Codeline for linked
media file. Otherwise, a codeline for the transcript will be displayed.
5. You can use the Fit to window width option to expand and compress the entire
progression to suit the Codeline window.
6. The option Standardize unit width and color whole unit completely should be
switched off, otherwise the times will always be "rounded" to the nearest full
second/minute.
You can find further information about the Codeline tool here.

Define and compare code coverage
You can use the Code Coverage tool to add up the time covered by certain coded
video segments and compare these aggregate times between different videos. This
tool could be particularly useful if you want to, for example, analyze whether
groupwork phases were coded for longer periods of time in a “lesson” video than in
other videos.

20 - Analyzing Videos

642

Code Coverage: results table for coded videos

Follow these steps:
1. Activate the videos in the "Document System" that you would like to include in
your analysis.
2. Activate the codes you want to display in your results table. If you would like all the
codes to be displayed, you don't need to activate any.
3. Select Analysis > Code Coverage in MAXQDA's main ribbon menu and select Video
in the drop-down menu.
4. In the dialog widow that opens, specify whether you want to compare the
documents individually or in document groups or document sets.
You can find further information about the Code Coverage tool here.
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21 - Analyzing Focus Group Data
How Does MAXQDA Support Focus Group
Data Analysis?
Conducting focus groups and group interviews occupies an important role in social
and market research. Focus groups offer a high potential for diverse analyses,
therefore there are many specific features available in MAXQDA that allow for the
simple and effective analysis of focus group transcripts (besides all the standard tools
that, of course, can also be applied to focus group data). For simplicity we use only the
term “focus groups” in MAXQDA and in this manual, although the functions are all
suitable for the analysis of group interviews as well.
Important: In order to use the analysis functions described in this chapter, it is
necessary that your transcripts have been imported into the MAXQDA project as focus
group transcripts, so that the participants’ contributions were automatically coded
with the speaker’s names. How exactly the import works and how you can convert
transcripts that have already been imported or were created in MAXQDA into a focus
group transcript is described in this section.
In this chapter, we will present the following features:
●
●

●

●

Search words and phrases inside contributions of selected speachers.
The “Overview of Focus Group Speakers” that allows to answer questions such as:
Who has spoken at what frequency? How extensive are the contributions of each
speaker, in words or characters?
Individual participants can be activated directly in the “Document System”, so you
can easily compile the statements of individuals on selected topics. Background
information on the participants, such as age and professional experience, can be
stored as variables for focus group participants and used for the specific and
comparative analysis of groups.
Use the Code Matrix Browser and the Crosstab for Focus Groups to create
visualizations such as “Themes x Speakers”, with which participants or groups of
participants can be compared by diverse themes, arguments, positions, and
viewpoints in the allocation of codes.
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Text Search in Speaker’s Contributions
MAXQDA’s text search can be limited to individual contributions from Focus Group
speakers:
1. Activate the participants whose contributions you would like to search in the
“Document System”.
2. Access the function via the Text Search & Autocode function in the Analysis tab.
3. In the window that appears, enter the desired search terms and select Only in
activated documents/activated focus group contributions.

Search the contributions of focus group participants

The Overview of Focus Group Speakers
The “Overview of Focus Group Speakers” provides important information about the
individual speaker, such as the number and scope of their respective contributions,
and also allows you to store additional information about each speaker in the form of
variables. To access the overview, right-click on a focus group in the “Document
System” and choose Overviews > Focus Group Speakers.
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The following window will open:

The Overview of Focus Group Speakers provides important information

The first three columns are used to identify the participants and their respective focus
group transcript, including the color assigned to each speaker. The table shows the
amount of contributions of the individual persons. For example, you can see from the
table above that Andy made the most contributions to the focus group, with the
exception of “Moderator”, and with about 28% spoke the most words.
In top of the window there are several icons. Besides the typical functions for export
and filtering there are some specific ones for focus group analysis:
Only activated focus group speaker - Reduces rows to those of participants
activated in the “Document System”. This is especially handy if you want to exclude
moderators from the overview: Activate only the other participants in the “Document
System” window and click the icon. The percentages in the table will be calculated for
the filtered persons only.
Statistics - Presents the values of all the columns displayed in a frequency table or
chart, excluding the “speaker” and “focus group” columns. More information on
frequency tables and charts can be found here.
Data Editor - Turns on the Variable View, in which the variable values are visible.
List of Variables - Switches to Variable View, where you can define new variables
and adjust and edit existing variables. More information on the use of variables in
focus group analysis is provided below.
Tip: You can call up the summary table not only for individual focus groups transcripts,
but also for the participants of all the focus groups in the MAXQDA project. To do
this, right-click at the top level in the “Document System ” with the mouse and select
the appropriate entry. A corresponding overview is also available in the context menu
of an individual participant, referred to here as “Overview of Speaker’s Variables”.
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Editing Variables for Focus Group Speaker
You can store background information for each participant in a focus group for
selective analyses and comparisons; for example, comparing the statements of older
and younger participants. First open the “Overview of Focus Group Speakers” from
the context menu in the “Document System” (either at the top level for all focus
groups in the project, or at the level of a document group containing several focus
group transcripts, or at the level of a single focus group).
Tip: You have direct access to the speaker variables via the Variables tab. Click on List
of Speaker Variables to open the "Overview of Focus Group Speakers" table which
contains every speakers from all focus group documents in your project.
As seen above, the default overview contains multiple columns of information that
MAXQDA compiles for the participants. You can add more columns for information
such as, for example, age, profession, or professional rank.

Creating new variables
Adding new variables is done in the same way as in other overviews of variables in
MAXQDA:
1. Click on the List of Variables icon to switch to Variable View.
2. Next, click on the New Variable icon.
A new window will appear, in which you can define the name and type of the new
variable.

Creating a new variable

After clicking OK, you will see that a line has been added with the newly added
variable in Variable View.
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Newly added variable in Variable View

Entering values for the participants
Click on
Data Editor to return to the normal view. On the far right you will see a
newly added column, in which you can enter values for each participant. The editable
column can be easily recognized by its blue column heading, unlike the black headings
of the columns automatically generated by MAXQDA.

Entering data for a variable

The variable values for participants can be used:
●
●

To activate only selected participants with specific values for further analysis or
in a Crosstab for focus groups to compare groups of participants.

Importing speaker variables from Excel
MAXQDA can import speaker variables from XLS/X files. The data must be organized
as follows:
Speaker

Focus Group

Variable 1
Value of Variable 1 for
Speaker A Document name
Speaker A
Value of Variable 1 for
Speaker B Document name
Speaker B

...

Variable N
Value of Variable N for
...
Speaker A
Value of Variable N for
...
Speaker B
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The first and second column serve the unambiguous assignment of variable values to a
speaker, so these columns and their headings are mandatory. Each line must designate
a speaker and the corresponding focus group in the corresponding column.
Only when a speaker, who matches this information exactly, is found in the MAXQDA
project will the data will be imported. You can add as many variables as required in
the subsequent columns.
After preparing and saving the import data, you can then start the import procedure
by going to Variables > Import Speaker Variables. Alternatively, you can click on the
Import data button in the the “Overview of Focus Group Speakers”.
A dialog field appears in which you can specify the source and target variables along
with the type of variables to be imported.
MAXQDA does the following during the import:
●

●

All variables in the import file that did not yet exist in the MAXQDA project are
created.
Variables that already existed will be updated with the new values in the import file.

Tip: An easy way to set up an Excel file for importing new values is to first export the
variable data matrix as an Excel file by clicking on the Excel icon in the toolbar of the
variable list. An Excel file with all of the current variables will open up, and you can
then add new columns for new variables and update variable values that you want
changed. All you have to do after that is save the Excel file and import it into
MAXQDA.

Coding Query for Coded Segments
The central principle for the compilation of coded segments in MAXQDA is the
activation of codes and documents. This principle also applies to the analysis of focus
groups, however in this case you have the possibility to activate not only the focus
group transcript as a whole, but also all or certain participants in the Document
System. In this case, only the contributions of activated participants will be taken into
account in the analysis.

Selecting participants for analysis through activation
To activate a participant in the “Document System” for analysis, proceed exactly as
when activating a document. You can right-click on the participant’s name and select
Activate from the menu, or simply click on icon of the participant. To activate or
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deactivate all the participants in a focus group, you can use the commands Activate all
Speakers or Deactivate all Speakers in the context menu of the focus group.

Activate all speakers of a focus group

MAXQDA analysis of focus groups applies either to the entire document or to
individual participants of the selected focus group, but never a mix of these two levels.
For this reason, the transcript and the participants can never be activated together.
During the search for participant statements, MAXQDA can help you by performing
the following standard tasks:

Retrieve everything that Olga said in a focus group
1. Activate the corresponding focus group in the “Document System”.
2. Activate “Olga” in the “Code System”.
MAXQDA will list all of the contributions from Lucas in the “Retrieved Segments”
window.

Retrieve everything that Olga said in multiple focus groups
1. Activate all focus groups in the “Document System”.
2. Activate all codes for “Olga” in the “Code System”.
MAXQDA will list all of the contributions from Lucas from all focus groups in the
“Retrieved Segments”.

Retrieve everything that Olga said regarding a particular theme:
1. Activate “Olga” in the “Document System” in all of the transcripts you wish to
include.
2. Activate the codes in the “Code System”.
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MAXQDA will list all of the contributions from Olga related to this theme in the
“Retrieved Segments” window. The participant is also indicated in the indication of
origin, so you can easily associate the contribution with the participant.

Statements of a participant on a topic in the “Retrieved Segments” window

Retrieve everything that multiple participants said in a focus group
You can always activate multiple participants simultaneously. MAXQDA takes all
activated participants into account during the Coding Query.

Activate focus group speakers based on their variable values
You can also activate individual participants based on their variable values. To do this,
right-click on root document in the "Document System" and select the entry Activate
focus group speakers by variable values from the context menu. Alternatively, you can
click on the icon Activate via ... in the toolbar of the "Document System" window:
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Activate Focus Group Speakers by Variables

The same window which is used to activate documents based on their variable values
will then appear. You can then select any of the values listed in the Overview of Focus
Group Participants. This also makes it possible to select participants with many or few
contributions and speeches.

Complex Coding Query
The Complex Coding Query function also allows you to limit the search to the
statements of a particular speaker as coded segments. This function follows the same
logic as the simple Coding Query: When you activate the focus group transcript, the
search takes the whole document into account, whereas when you activate an
individual participant, this participant’s contributions are treated as a document.
Suppose you have assigned thematic codes in a transcript, and also coded the
communication sequence so that there is a code system of the following type:
Themes
●
●
●

Financial issues
Motivations for getting a student job
...

Communication sequence
●
●
●

Objections
Support for the statement
...
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If you want to find all the statements in which Olga supports an earlier statement
about the “Motivations for getting a student job”, you can do so using the Complex
Coding Query:
1. Activate the participant “Olga” in the “Document System”.
2. Activate the codes “Motivations for getting a student job” and “Support for the
statement”.
3. Call up the Analysis > Complex Coding Query function.
4. Select the “Intersection” function, which searches for instances in which two codes,
namely “Motivations for getting a student job” and “Support for the statement”
occur simultaneously.
5. Ensure that the Only in activated documents / activated focus group contributions
function is selected.
6. When you click on Home, MAXQDA will list the results in the “Retrieved Segments”
window.

View Coded Segments per Speaker
MAXQDA’s Code Matrix Browser is the ideal tool with which to illustrate and analyze
the distribution of coded segments in different documents. This tool is in the form of a
table, in which the documents make up the columns and the codes make up the rows.
In the analysis of focus groups, often it is not the transcript as an individual document
that is the central focus, but rather the analysis of the contributions in multiple
documents, to be considered separately from each other.
The MAXQDA Code Matrix Browser therefore offers the opportunity to automatically
perform exactly this analysis and visualize the distribution of codes per speaker:
●
●

Open the Code Matrix Browser via the Visual Tools tab.
In the window that appears, select the option Focus Group Speakers. If you would
like to visualize the codes of an individual participant (or to exclude the moderator
from the visualization), you can activate these elements in advance, and additionally
select the option Only for activated focus group speakers.
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Code Matrix Browser options

When you click OK, MAXQDA will open the Code Matrix Browser, whose columns are
made up of the participants.

Codes per speaker

The size of the squares provides information about how many coded segments from
the four thematic codes are present in the contributions of each speaker. The image
above demonstrates the frequency of encodings on the four issues made by Lucas,
Miles, Lisa, Casey, and Parker. The larger the square, the more encodings have been
made with the code in question. It is evident from the image that Lucas a high amount
of coding occurred regarding "Stress due to the financial crisis", whereas Parker made
no contribution to this theme.
In the presentation of focus groups, The Code Matrix Browser operates in the same
manner as usual: Double-clicking on a cell will display the corresponding coded
segments in the “Retrieved Segments” window and clicking on the Display nodes as
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values
presents the information as code frequencies rather than square. The
functions of the other buttons in the Code Matrix Browser are described here .
Please note: If a project has multiple focus groups, all or all activated participants from
all focus groups will be displayed in the Code Matrix Browser. The order of participants
from left to right corresponds to their order in the "Document System" from top to
bottom.

The Interactive Quote Matrix for focus group participants
Using MAXQDA’s Interactive Quote Matrix, you can synoptically compile coded
segments. This can be illustrated as follows: Behind every square in the image above is
a certain number of coded text segments, which can be easily compiled by, for
example, double-clicking on the square. A Quote Matrix contains not only the text
segments that lie behind a square, but also compiles the text segments of all the
squares together in a table.
To create an Interactive Quote Matrix, click the Interactive Quote Matrix button in
the Code Matrix Browser toolbar. MAXQDA will open the Interactive Quote Matrix in a
new window.

Excerpt from an Interactive Quote Matrix

An indication of origin appears below each segment: The contribution in the upper left
is from a statement by the Moderator from paragraph 13-25 of the transcript, and
encoded with a weight of 50. You can export the Interactive Quote Matrix as a Word
file, an Excel table, or a website (HTML format) via the usual icons at the top right.
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Crosstab for Focus Groups
MAXQDA offers the feature to save background information on each focus group
speaker in the form of variables. Suppose you have divided participants into two age
groups: With the Crosstab for Focus Groups, you can easily compare the thematic
coding for these two groups. The Crosstab for Focus Group works essentially the same
way as the “normal” Crosstab: The codes form the rows and the groups of focus
group speakers form the columns, while the respective code frequencies are presented
in the cells.
You can find the Crosstab for Focus Groups feature in the Crosstab menu of the
Mixed Methods tab. The following window appears, in which you can define the
speaker groups.

Define speaker groups for the columns

Each line in the middle column of the window forms a column in the final crosstab.
Please note: In the crosstab, MAXQDA evaluates all participants that meet the
conditions in the second column of the window - regardless of whether they come
from one or more focus groups. You can restrict the evaluation to include only
currently activated participants using the Only for activated focus group speakers
option.
The final crosstab appears as follows:
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Crosstab for focus groups
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22 - Analyzing Surveys
Categorize Survey Data
Guide: Analyzing Open-Ended Survey Questions with MAXQDA

This guide describes a procedure for analyzing responses to open survey questions
with MAXQDA. The procedure does not consider the open-ended questions in
isolation from the other data collected, but rather interlinks this qualitative data with
the standardized, quantitative data in the sense of a mixed methods approach.
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How does MAXQDA help you categorize survey responses?
MAXQDA helps you analyze responses to open questions in surveys efficiently and
effectively with its interactive table window. The responses are listed in a table and can
be categorized with existing or newly developed codes
A prerequisite for using this function is that all the responses to a question have been
coded with one code. This should be the case if you used the Survey Data Import
function to import your survey responses. The name of the code will normally
correspond to the text or a shortened version of the survey question.

Each code will contain the responses to one of your survey questions

Starting the Function
MAXQDA’s interactive interface lets you analyze each of your survey questions, one
after the other:
1. In case you want to analyze only a selection of responses of individual interviewees,
activate these documents.
2. Click on the following function in the ribbon menu bar: Analysis > Categorize
Survey Data
3. Drag the code that contains the responses to your survey question from the “Code
System” window to the following dialog box that appears:

Choose the code that contains the responses to your survey question.

4. If you activated a selection of documents, you can use the Only activated
documents option to restrict the analysis view to these documents (you can turn the
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filter of activated documents on or off at any time later).
Click on OK and the interactive table window will appear, divided into two sections:

Interactive working environment for categorizing survey responses

In the leftmost field of the window, you will see a reduced code system that displays
the selected question code. New categories can be inserted here as subcodes and then
assigned to the individual answers. The number at the end of the code line tells you
how often the code was assigned to the documents you are currently analyzing.
In the table to the right, you see a list of the responses – each in a separate line. The
number of currently displayed lines, i.e. the responses to be categorized, is indicated in
the header above the table.
The individual columns contain the following information:
Document – The source of the response.
Responses – The texts of responses of people who answered your survey.
Codes – A list of the codes assigned to the response or part of the response; only the
codes that are currently visible in the code system on the far left are listed here. The
question codes, whose answers are currently being analyzed, are never shown here.
Comments (initially hidden) – Freely editable text field (up to 255 characters) for notes:
useful for the developing suitable categories.
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Like all MAXQDA table widows, the individual fields can be adjusted: The columns can
be adjusted in width and position with the mouse or hidden with a right-click on a
column heading. A click on the heading sorts the column in ascending order, another
click in descending order.
Please note: All other MAXQDA functions are locked while the window for
categorizing survey responses is open.

Functions in the Ribbon Menu
At the top, you will see a ribbon menu with the following functions:
Display all Codes – displays all your project’s codes. When turned off, only the
selected codes and subcodes are displayed.
Only Activated Documents– Only the answers of the currently activated documents
are displayed. The frequencies displayed in the code tree are adjusted accordingly.
Filter – applies filters, which are defined by right-clicking on a column heading and
selecting the Set Filter, to all columns.
Reset all Filters – removes all filters from all columns.
Display Parent Code – in addition to the code, the "Codes" column also displays
its parent code.
Display Comments – displays comments field.
Display Favorite Variables – shows another column for each favorite variable. For
example, you can display the age of a person or other background information about
a case. You can set favorite variables via selecting Variables > List of Document
Variables in the ribbon of MAXQDA’s main window.
At the top right of the window there are two icons for the local undo function:
Undo – undoes the last action in the window.
Redo – redoes the last action in the window.

Creating New Categories
In order to categorize individual responses, you first need some categories, of course!
If you have already defined some or all of these categories before you begin your
analysis, you can define them as new subcodes of your question code.
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1. Click on the green plus symbol that appears while hovering over an existing code.

Add new code by clicking on the green plus symbol

2. In the dialog window that appears, enter the code name. To better distinguish
between different sub-codes, you can use different colors. You can also enter the
description of the new code (i.e., which responses they are applied to) into the
“Code memo” field..
3. Click Additional code to create a second and third code, and so on. Click OK to
finish creating new codes.
Please note: All changes made to the code system in this window, including the
addition of new codes, are automatically incorporated into your overall “Code
System” window.
If at the beginning of the analysis, you haven’t defined any categories and you would
rather develop these from the data, you can start by reading some of the responses
and then create suitable subcodes.
Tip: You can also use the comment column to collect ideas for categories for the first
few responses, and define appropriate categories after working through several of
them.

Assigning Categories
To assign a response to a code, click and drag the row with that response to one of
the displayed codes in the hierarchical code tree. This allocation is immediately
displayed in the “Codes” column. To assign a code to only part of a response, doubleclick on the text of the response, select the desired portion of text, and drag it to one
of the codes in the code system. Even if you add the same code to multiple sections of
a response, the code name is listed only once in the “Codes” column.
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Assigning a code to part of a response.

Tip: By right-clicking on a row and selecting the function Create and Assign New
Code, you can directly add a code and assign it to the entire response.

Removing assigned categories
To remove a code assigned to a response, click the cross that appears when you move
the mouse over a code in the “Codes” column. All assignments of the code will then
be removed from the response.

Removing a code assigned to a response.

Customizing Your Category System
You can adapt your category system throughout the entire analysis process. You can
change the order of codes with the mouse as well as add subcodes. By right-clicking
on a code, all the features from your “Code System” are available to customize your
code system in this window:
●
●
●
●

Delete code
Sort subcodes (alphabetically or by category frequency)
Change code color
Create or edit code-memo
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●

Copy, move, paste coded segments

Click on a code in the code tree to list all your coded segments under this category
(the categorized answers to the survey question or parts of it). This way, you have an
overview of the contents of individual categories. The highlighted row in the left code
system indicates which code is currently selected. The name of the selected code is
also displayed in the heading of the listed responses.

Display contents of a category

Please note: The “Codes“ column only contains the names of codes that were
additionally assigned to the selected code.

Working with Comments
In the comments column, you can write a comment regarding each response. During
the process of category development, comments can be used to summarize long
responses and to record ideas for new categories for appropriate categories for a
specific response. They are also suitable for notes such as “still unclear” or “come
back to this later” for responses that are hard to categorize.
Double-click a cell in the "Comments" column to enter a new comment or edit an
existing one.
Comments are stored for the code selected in the “Code System”.

Adding a comment to a response.

Pausing and Restarting the Categorization Process
You can pause your current categorization at any time by clicking on the button Quit
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or by closing the window. All your categorizations will be stored as codes in your
MAXQDA project.
To pick up where you left off, restart the function via Analysis > Categorize Survey
Responses and select the code that contains the responses to your survey question.

Exporting Responses
The current view can be exported using the typical icons in the ribbon menu. All
responses of the right pane will be exported.
Export – Creates a table as an Excel file (XLSX format), as a web page (HTML
format), or as a text document (Word or RTF format).
Open as Word document – Creates a Word document and opens it.
Open as Excel spreadsheet – Creates an Excel document and opens it.

Search and Autocode Survey Responses
You can use the Categorize Survey Responses window to search responses to openended questions by search items and have the results automatically coded with a
category.
To do this, start the Analysis > Categorize Survey Responses feature and drag a code
containing the answers to a question from the “Code System” window into the dialog
box that appears.

Select code that contains answers to the open-ended questions

After clicking OK, the following interactive working environment appears:
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Window „Categorize Survey Responses“

Autocode Hits from Local Search
To perform a local search in the answers currently displayed in the right window:
1. Click on the magnifying glass in the header of the table at the top right to show the
search bar.
2. Enter a search term.
3. Click on the filter icon in the search bar to display only the answers with hits (this
step is not mandatory for autocoding, but it is very helpful for a quick overview of
the responses containing the search hit).

Hits of local search
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To code the answers that contain a search hit, click the Autocode search results with a
new code icon in the search bar:

Autocode local search hits

A menu opens in which you can set whether only the hit should be coded with a new
code or whether the surrounding sentences or paragraphs should be coded. For short
answers, the first option is usually the best choice, because then the entire response in
which the search item was found is coded.
After selecting the context to be coded, a dialog box for creating a new code appears.
After clicking OK, the code is assigned to the selected context:

Automatically coded responses

The code name can be adjusted at any time in the code system on the left.

Perform Complex Searches and Autocode Results
The local search bar provides only limited search functionality and is limited to the
answers currently listed in the right pane. If you want to perform more complex
searches, click Search & Autocode in the ribbon menu:

22 - Analyzing Surveys

667

Start text search

This opens the MAXQDA “Text search” window:

The “Text search” window

In the window, several search items can be entered that must appear all in a response;
in the example, a search is performed for the words “lost” AND “job” within the same
response. The search for two or more search items using the AND search can also be
limited to paragraphs or sentences.
The options for the search correspond to those of the text search and are described
there in detail. In addition, there is the option Only in listed responses, which ensures
that only the responses currently listed in the right-hand window are searched. If you
switch off the option, MAXQDA will search all answers that are currently available in
the working environment (the number of available answers is shown in the first line of
the code tree in the left pane).
After clicking Search, the answers with hits are listed in the right pane of the window:
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List of search hits and starting autocoding procedure

To automatically code the answers with a new code, click on the icon of the same
name as shown in the previous figure. A menu appears where you can set the context
for autocoding:
●
●

Either the entire answer is coded
or the highlighted search hits only.

After selecting the context to be coded, a dialog box for creating a new code appears.
After clicking OK, the code is assigned to the selected context. The code name can be
adjusted at any time in the code system on the left.

Autocode Survey Responses with a
Dictionary
In the “Categorize Survey Answers” window, you can automatically code the
responses to open-ended questions using a dictionary. This feature is especially helpful
if you are analyzing a lot of data or repeatedly ask the same questions that should be
coded using the same category system.
Please note: This function is only available if you are using a license of “MAXQDA
Plus” or “MAXQDA Analytics Pro”. This is the case when a menu tab named
MAXDictio is visible in the main MAXQDA window.
To autocode responses with a dictionary, start the Analysis > Categorize Survey
Responses feature and drag a code containing the answers to a question from the
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“Code System” window into the dialog box that appears.

Select code that contains answers to the open-ended questions

After clicking OK, the following interactive working environment appears:

Working environment “Categorize Survey Responses”

Autocoding is then performed in two steps:

Step 1: Create Dictionary
Click Dictionary in the ribbon menu to open the administration environment for
dictionaries in MAXQDA:
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Create dictionary

A dictionary contains categories with search items; in the example above, in the
dictionary with the name “<Standard>”, the category “Job” was underpinned with
the search items “job” and “work”. Following this logic, create a dictionary with
categories and search items for your study in the Dictionary window and close the
window.
For more information on creating, importing, and customizing dictionaries, see this
section.

Step 2: Apply Dictionary
Click the Autocode with Dictionary icon in the Ribbon menu:

Starting the autocode process

A menu opens where you can select which scope should be coded: the whole answer,
the paragraph or sentence in which the search hit occurs, or only the search hit itself.
In case of short answers, you will usually choose the option to code the entire
answers.
After selecting an option, the following dialog appears:
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Options for Autocode with Dictionary process

At the top, select the dictionary to be used for autocoding.
Only in listed responses (<number of responses>) – This option ensures that only the
responses currently listed in the right-hand window are searched. If you switch off the
option, MAXQDA will search all answers that are currently available in the working
environment (the number of available answers is shown in the first line of the code
tree in the left pane).
Ignore inactive categories – It is possible to temporarily disable a category in a
dictionary, to turn it off. Select this option to not include these categories in
autocoding.
After clicking OK MAXQDA will autocode the responses:

Results of autocoding procedure

●

●

A new category is added to the code system, whose subcategories correspond to the
category names from the dictionary.
Depending on the selected context, the entire responses or only parts of them are
coded with these categories. For example, in the figure, all responses containing the
search item “job” or “work” as defined in the dictionary category were coded with
“job”.

Please note: As the figure shows, multiple coding in this process is possible. For
example, the third response was coded with “Pensions” in addition to “Job”.
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Analyze Survey Data with MAXQDA Stats
After you have coded the answers to open-ended questions using the Categorize
Survey Answers feature, you can perform statistical analyses in MAXQDA Stats using
the resulting code frequencies. For example, you can compare whether a category was
coded more often for certain groups of people than for others. The following grouped
bar chart displays the frequency for the code "Jobs lost" (0 or 1) divided according to
the document variable region ("rural" vs. "urban") and it becomes apparent that this
code was assigned to almost 33% of the people living in rural areas, but only to about
18% of the people living in urban areas:

Grouped bar chart created in MAXQDA Stats

Please note: This function is only available if you are using a license of “MAXQDA
Analytics Pro”. This is the case when a menu tab named Stats is visible in the main
MAXQDA window.

Start MAXQDA Stats directly from the “Categorize Survey Responses”
window
When coding is complete, click the Analyze in Stats icon on the ribbon menu.
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Working environment “Categorize Survey Responses” after coding

This will start MAXQDA Stats and provide the code frequencies for statistical analysis.
If the option Only activated documents was selected when starting the Categorize
Survey Responses feature, only the activated documents will also be available in Stats.
All document variables of the project are always available in Stats.
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23 - Analyzing Tweets
Analyze Tweets
The analysis of tweets based on coded segments can reach its limits if you want to
analyze thousands of tweets. It's hard to keep an overview of the whole picture,
simple automatic coding reaches its limits and manual codings are practically
impossible. Analysis functions are needed that enable you to keep track of larger
amounts of data and to make targeted comparisons between authors, etc.
For this purpose, MAXQDA offers a special analysis view for imported twitter data,
with which you can evaluate tweets according to numerous criteria, such as: frequent
words, hashtags, authors, countries and/or sentiments.

A prerequisite: Your project includes Twitter data
A prerequisite for using the Twitter analysis functions in MAXQDA is that you have
already imported Twitter data into your MAXQDA project. You can recognize
imported Twitter data in the "Document System" by their Twitter symbol.

Twitter data in the “Document System”

Follow these steps to begin a Twitter analysis:
1. Select the function Analysis > Analyze Tweets
2. In the dialog window that appears select all Twitter documents that you would like
to include in your analysis.
3. Click on OK and the following analysis will appear:
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Window for Twitter analysis

When opening the window, all analyzed tweets are listed in descending order by
release date in a table. The table is structured as follows:
The first column contains the profile picture, the second the Twitter name and real
name of the author. When you first open the window, no profile pictures will be
displayed - you can display them via clicking on the Load Profile Pictures icon. The
pictures are loaded and gradually displayed. If an image has already been loaded for
an author, it will be used; the image loaded will not be updated if it has changed in
the meantime. Some authors have not posted an image on Twitter.
Type – indicates whether it is a tweet, a retweet, or a reply.
Tweet – contains the text of the tweet. Hashtags and mentioned Twitter accounts are
highlighted in color. Click a link to view the linked website in your computer's internet
browser.
Retweets - how often the Tweet has been retweeted. This number is an indicator of
the tweet’s popularity.
Likes – the number of likes a Tweet received. This number is an indicator of the
tweet's popularity as well.
Followers – how many followers the author had at the time they published the tweet.
This number is an indicator of the author’s popularity.
Tip: This table can be arranged by clicking on each respective column’s header.
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Filter tweets
Using the filter panel on the left, you can filter the tweets according to several criteria.
You can also expand and collapse the filter area by clicking on the filter header.
The number in brackets behind the filter refers to the total number of all analyzed
tweets on the basis of that filter. This means that it will remain constant, even if you
turn on several filters. The current number of listed tweets is displayed at the top of
the menu tab. 150 (2,000) means, that 150 of 2,000 tweets in total are displayed.
Please note: Within a filter range, an OR function is applied: If you set a "Tweet" and
"Retweet" in the "Type" area, both tweets and retweets are displayed. The individual
filter areas are connected with AND: If you put a check mark in the "Retweet" area
and a check mark in the area "Most frequently used hashtags" for "#Berlin", only
retweets with the hashtag #Berlin will be listed.
These filter areas are always available:
Types – always contains the three filter options "Tweet", "Retweet" and "Reply".
Sentiment allows filtering by the sentiment (negative, neutral, positive) expressed in a
tweet. This section will appear automatically once you have determined the sentiment
of each tweet by clicking Sentiment Analysis in the menu tab.
Most frequently used words – Lists the most common words in descending order.
Internet links and mentioned accounts will be ignored. All the words currently
contained in the stop word list for the word cloud will also be filtered out.
Most frequently used hashtags – lists the most common hashtags in descending order.
Authors by number of tweets – lists the most active authors in descending order. Only
the analyzed tweets are considered.
Authors by number of followers – lists the authors with the largest reach in
descending order. Their number of followers is used as an indicator of reach.
Mentioned accounts – lists the most frequently mentioned accounts in descending
order.
Languages – lists the most frequently used languages in descending order. (The
language is identified by Twitter automatically).
Sources – lists the most frequently used devices and programs from which the tweets
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were sent in descending order.

Create word clouds and word frequency lists
You can create word clouds with the most frequently used words in the currently
displayed tweets as well as a list of all the words contained in them:
1. If needed, filter tweets according to selected criteria.
2. Click on the Word Cloud icon to create a word cloud like the following:

Word cloud for tweets
3. To make your word cloud display only the most relevant words, you can transfer
less important words into a stop word list to exclude them. The easiest way to do
this is to click on the Word Frequencies icon it the menu tab Start to display the list
of all the words that appear.
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Transferring words
from the word frequency list to the stop word list
4. The word frequency list is sorted in descending order. To transfer a word to the
stop word list, double-click the green icon in the first column. The green icon then
changes to a stop symbol. Alternatively, select one or more lines with the mouse,
and then click the Add to stop word list symbol in the toolbar.
5. Click the circular arrow in the toolbar to Refresh and apply stop word list. The word
cloud and word frequency list will then be regenerated, taking into account your
new stop word list.
The filters for the tweets allow you to create and compare word clouds between
different groups of authors.
Tip: In MAXDictio, the add-on module for word-based analysis, you can manage
various stop word list and always transfer these words to your "stop word list for word
clouds".

Frequency analyses and charts
You can also create frequency tables and charts from the tweets under specific filters.
Information on the reach of tweets (their followers) as well as their publication times
and weekdays are added:
1. Filter your tweets according to specified criteria.
2. Click Statistics in the manu tab to request a frequency analysis.
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Frequency table displaying the frequency of tweets per day of the week.
3. You can use the arrows at the top of the window to toggle between individual
frequency tables.
4. Click on the chart symbol in the upper left corner to display the table as a
horizontal or vertical bar chart or pie chart. For more information refer to the
Frequency tables and charts for subcodes

Chart displaying the frequency of tweets per day of the week.

MAXQDA generates the following charts with associated frequency tables in the
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twitter analysis:
Chart
Bars represent
Weekday
Number of tweets
Time
Number of tweets
Type
Number of tweets
Most frequent words Number of tweets

Categories
Days
Hours
Tweet, retweet, reply
15 most frequently used words (options
for making this analysis case-sensitive
and/or taking word cloud stop-lists into
account). The category "Other" can also
be displayed.
15 most used hash tags. The category
"Other" can also be displayed.
15 authors with the highest amount of
tweets. The category "Other" can also be
displayed.

Most frequent
Number of tweets
hashtags
Author by number of Number of tweets
tweets (real name) /
Author by number of
tweets (Twitter
name)
Authors followers
Number of followers 15 authors with the most followers. The
category "Other" can also be displayed.
Source
Number of tweets
15 most common sources. The category
"Other" can also be displayed.
Retweets
Number of retweets Specified categories from 0 to a 100+
Likes
Number of likes
Specified categories from 0 to a 1,000+
Followers
Number of followers Specified categories from 0 to a
1,000,000+
Sentiment
Number of sentiment Specified categories from "negative" via
(only available after assessments
"neutral" to "positive"
using the function
Sentiment Analysis)

Export tweets
The current listed tweets can be exported using the usual icons in the Home tab. The
sorting of the table will be adopted.
Export – Creates a table as an Excel file (XLS/X format), a Word file (DOCX format),
a web page (HTML format) or in other (less common) formats.
Open as Excel table – Creates an Excel spreadsheet and opens it.
Open as Word document – Creates a Word document and opens it.
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Autocode Tweets with Hashtags and
Authors
MAXQDA can automatically code the text of up to 100 authors and 100 hashtags
from imported Twitter data.
1. Open the analysis view for tweets via Analysis > Analyze Tweets.
2. In the dialog that appears, select all the Twitter documents you want to include in
the analysis.
3. After clicking Analyze Tweets, the following analysis view appears:

MAXQDA workspace for analyzing tweets

4. Start the autocode process by clicking on Autocode Tweets with Hashtags/Authors
and a dialog window will appear in which you can enter the author names and
hashtags you wish to autocode. (When you import Twitter data, this dialog window
appears automatically following the import.)

Autocode Twitter data
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dialog window
5. Before you can start the autocoding process, you must first select the hashtags or
author names you wish to encode. To do so, use the Select hashtags and Select
authors buttons. A new dialog window will appear, in which the selected hashtags
and author names are listed:

Selecting hashtags for
autocodingIn the "Hashtag" column, the different hashtags are listed, and in the
"Tweet" column you can see the number of tweets in which the hashtag appears.
In the upper left corner you can see how many different hashtags were found in
total; the top right shows how many of these hashtags are currently selected.
6. Select the entries with the hashtags that are relevant to your analysis:
Select the desired row. As usual, you can select multiple rows by holding down
the Ctrl key (Windows) or cmd key (Mac). Your selection will be highlighted.
Click the green checkmark
symbol in the upper toolbar. A green checkmark
will appear in front of the the selected hashtags.
This procedure can be repeated as desired, or reversed by selecting a row and
clicking on the Stop icon to deselect an entry. Note that a maximum of 100 entries
can be selected.
7. When you click OK, you will return to the Autocode dialog window, where you can
proceed in the same manner with author names.
8. When at least one hastag or author name is selected, the Autocode button
becomes available and can be clicked.
❍

❍

MAXQDA then begins the autocoding process, which may take a moment depending
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on the number of entries.
Later, when you close the Analyze Tweets window, you can see the result of the
autocoding process in the "Code System": The resulting new code “Autocode Twitter
data” with the date will be inserted at the top.

The automatically inserted code in the Code System

In the automatically generated codes “Tweet hashtag” and “Tweet author”, the
selected hashtags and author names are used as subcodes. All these codes can be
managed like any other code – for example, you can change the color or arrangement,
depending on what makes the most sense for your analysis.
Please note: Via Analysis > Analyze Tweets > Autocode Tweets with Hashtags/Authors
you can open the autocode function as often as needed. It is therefore not necessary
to perform the autocoding process immediately after import.

Analyzing Coded Tweets
Once you have autocoded your tweets, all the usual MAXQDA twitter analysis tools
are available. For example, you can use the Coding Query to determine which tweets
were written by specific authors:
1. Activate one or more documents with Twitter data in the Document System.
2. Activate the codes with the relevant author names in the Code System.
The result will be a compilation of all relevant tweets, which will appear in the
“Retrieved Segments” window. When clicking on the Word Cloud icon in the
"Retrieved Segments" toolbar, you can visualize the frequently used words in the
compilation of tweets.
Further analysis options, especially when delaing with several thousand tweets that
have not been autocoded, MAXQDA offers further analysis options including filters,
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word-based functions and statistics.

Analyze Sentiments of Tweets
With MAXQDA you can perform a sentiment analysis of tweets. This automatically
evaluates whether tweet content is to be assessed as negative, neutral, or positive. The
tweets can be sorted and filtered according to their sentiments, and the tweets can
also be automatically coded with their sentiments for further analysis.

Perform sentiment analysis
A prerequisite for performing the sentiment analysis is that you have already imported
tweets into the currently opened MAXQDA project.
1. Open the analysis view for tweets via Analysis > Analyze Tweets.
2. In the dialog that appears, select all the Twitter documents you want to include in
the analysis.
3. After clicking Analyze Tweets, the following analysis view appears:

MAXQDA workspace for analyzing tweets

4. Start the Sentiment Analysis by clicking on the Sentiment Analysis icon in the Start
tab.
5. In the dialog that appears, you can select various options:
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Options for sentiment analysis of
tweetsAt the top, set the language of the tweets so that MAXQDA will use the
appropriate resource for sentiment evaluation (currently: English and German, more
languages will follow).Ignore hashtags – if this option is enabled, hashtags, such as
#bestever, are not taken into account when evaluating sentiment.Apply stop word
list – if this option is enabled, all words from the selected stop word list will be
ignored when evaluating the sentiment. Also hashtags that correspond to a stop
word are ignored.
6. After clicking OK, the sentiment analysis is performed and four columns are added
to the tweet table:
Sentiment: Contains the rating of the tweet in five levels from "negative" to
"positive". tweets that do not contain words with a sentiment value are marked
with "No sentiment".
(Positive) Words: Number of words that were evaluated as positive.
(Negative) Words: Number of words that were evaluated as negative.
Difference: Difference between positive and negative words. If the number is
negative, the negative words predominate. Emojis and Symbols count as a word.
❍

❍
❍
❍

Columns for sentiment analysis

You can sort the table by the newly added columns by clicking the column header
with the mouse.
Please note: The sentiment ratings of the tweets are only temporarily visible in the
analysis window and are not saved. If you close and reopen the analysis window, you
can run the sentiment analysis again with the same or different options.

Filter tweets by sentiment
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Once you have determined the sentiments of the tweets, another filter area will
appear in the left pane of the analysis view:

Sentiment filter

Here you can see how many tweets were evaluated positive, neutral, or negative. By
selecting oen of the sentiments, you can filter the tweets, for example, only the
"positive" and "Slightly positive" tweets can be displayed.

Create a diagram of the sentiments
1. Click on Statistics in the Start tab to access the chart function.
2. In the chart view that appears, open the drop-down menu at the top and select
"Sentiment".

Diagram for the frequency distribution of sentiments
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Autocode tweets with sentiments
You can save the assignment of the sentiments to the individual tweets as codes in
MAXQDA’s code system:
1. Call the function Start > Autocode Tweets with Sentiment in the menu tab. The

following dialog appears:
Options for
coding the tweets with their sentiment
2. In the upper area you select the sentiments to be coded. For example, you can
choose to code only the positive and slightly positive tweets. Select the Code
filtered tweets only option to limit the coding to the currently listed tweets. For
example, it is possible to code only tweets containing a specific hashtag with their
sentiments.
After clicking OK, the selected sentiments are created as codes in the "Code System"
window. If they already exist in the code system, the existing codes will be used for
coding. The text of the selected tweets will be autocoded with the selected codes.
If you close the Analyze tweets window, you can continue working with the coded
tweets. For example, activate Twitter documents and the code "Positive" to compile
all positively evaluated tweets in the "Retrieved Segments" window.
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Sentiment codes in the 'Code System' (left); Coded tweet in the 'Retrieved Segments' window (right)

How does MAXQDA evaluate the sentiments?
MAXQDA uses a lexicon to evaluate sentiments, which contains a sentiment score for
each word in the lexicon. This value is negative for words with negative connotations,
close to zero for neutral words, and positive for words with positive connotations.
When analyzing a tweet, MAXQDA checks each word whether it is contained in the
lexicon and assigns the sentiment score to this word (hashtags and stop word list
words are ignored if desired). If the word is not in the lexicon, MAXQDA looks up the
word in a lemma list. If a lemma is found for the word and this lemma is contained in
the sentiment lexicon, the sentiment score of the lemma is used for the word.
In addition, two rules are applied to optimize the evaluation of sentiment:
1. In case of negation, the scores of the following 3 words are reversed, for example,
the statement "I was not very happy" is classified as negative.
2. In case of modal verbs, such as "can", "should", etc., the sentiment scores of the
following words are reduced.
The mean value is calculated from the sentiment scores of the evaluated words in a
tweet. If the mean value is negative, the tweet is evaluated as "negative" or "slightly
negative", if the mean value is positive, the tweet is evaluated as "positive" or
"slightly positive". If the mean value is equal or close to zero, the tweet text is
classified as "neutral". Tweets that don’t contain any word with a sentiment score are
classified as "no sentiment".
Please note: Sorting in the "Sentiment" column is based on the calculated sentiment
value, not on the difference between positive and negative words.
In the literature on automatic sentiment analysis, values of 60 to 70% agreement
compared to a human control assignment are usually reported. It has to be taken into
account that human assessments of the same text can also differ. The quality of a
sentiment analysis depends on several factors, especially the fit of the lexicon for a
given topic. Please also note that a sentiment analysis has little meaning for tweets in
which little to no evaluations are expressed.

English lexicon
The lexicon for English is based on the resource SentiWordNet 3.0, which is licensed
under an Attribution-ShareAlike 4.0 Unported (CC BY-SA 4.0) license (for more info
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on SentiWordNet, see Baccianella, Esuli & Sebastiani, 2010). The SentiWordNet 3.0
lexicon has been optimized for use in MAXQDA, including
●
●

●

removal of special characters and duplicates
addition of typical social media abbreviations (e.g. LOL - laughing out loud), emojis,
and superlatives
manual adjustment of scores for individual words to scores of their synonyms

Please note: You can view and customize the lexicons used by MAXQDA for sentiment
analysis. The lexicons are located in the "ResourcesSentimentScore" subfolder of the
MAXQDA installation folder:
Windows: local installation
C://Programs/MAXQDA2020/Resources/SentimentScore
Windows: portable installation on USB stick
USB stick/MAXQDA2020
Mac: local installation
Program directory > Right mouse click on MAXQDA2020 > Show package contents:
Contents / Resources / SentimentScore
Mac: portable installation on USB stick
USB stick > MAXQDA 2020 Portable for Mac > Right mouse click on MAXQDA2020 >
Show package contents:
Contents / Resources / SentimentScore
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24 - Frequencies
Frequency Tables and Charts for Variables
MAXQDA lets you create frequency tables and corresponding charts for document
variables, code variables and focus group speaker variables. You can open this
function from the ribbon menu:
●
●
●

Variables > Document Variable Statistics
Variables > Code Variable Statistics
Variables > Speaker Variable Statistics

After you click on one of the variable statistics options a split “Choice of Variables”
window is displayed below: Existing variables are listed on the left side; already
selected variables are moved to the right. The arrow buttons in the middle allow you
to transfer variables from one window to the other. You can also do this by doubleclicking on the variable name.

24 - Frequencies

691

Selection of variables

Please note: The colored squares in front of the variable names symbolize the origin of
each variable. System variables that are created and managed by MAXQDA are
marked in red; variables created by you have a blue square; codes that have been
transformed into variables are marked in green.
Both lists can be alphabetized by clicking on the column headers. By selecting Only
activated documents you can limit the analysis to currently activated documents, for
example the transcripts of selected interviewees. The corresponding options Only
activated codes and Only for activated focus group speakers are also available for code
variables and focus group speakers variables.
Tip: The statistics functions for variables can also be accessed directly with the
icon
in the “List of Document Variables“, the “List of Code Variables“ and the “List of
Focus Group Speaker Variables“. MAXQDA then begins the statistical analysis for the
selected variables, taking all documents, codes, and speakers into account that are
currently visible in the Data Editor.
When you click OK MAXQDA will begin the statistical evaluation and display the
results as frequency tables and charts.
The results window displays the results of the first selection of variables in a table. The
“Frequency” column shows how many of the analyzed documents contain the
variable value in question.
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Frequency Table

Tip: Click on the column headers of the first two columns in order to modify the order
of the table rows. For example, you can sort the frequency of categories in ascending
or descending order.
The first column lists the various categories of the variable; the second column lists the
absolute frequency; and the third lists the corresponding percentages. The fourth
column shows percentages based on valid values, meaning missing values are
excluded. If there are no missing values among the variables in question, the
percentages of the third and fourth columns will be identical.
You can customize the order of the rows within the table by clicking on the column
header of the first and second columns. For example, you can sort the table in
ascending or descending order by categorical frequency.

Toolbar functions
The results window has a toolbar at the top. From here you can:
●
●
●
●

Open the chart view by clicking the
button
Flip forwards
or backwards , between variables
Print results, or
Export results as an Excel file

Charts
When you switch to the chart view with the
button, a bar chart of the variables in
question appears in the place of the table view.
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Vertical bar chart of the document variable “Age”

Please note: The order of chart segments is determined by the order of the rows in the
table and can be modified accordingly.
You will see two toolbars at the top of this window. The upper toolbar is the same as
the frequency table, and you can switch at any time to the table view. On the right
side of the lower toolbar, you will see three buttons, with which you can choose
between pie chart, horizontal and vertical bar chart. The chart can be customized
using the options in the lower toolbar:
Display labels – show categorical labels of bar and pie charts on the x-axis.
Display data values – show the data label, meaning frequency of variable values or
subcodes.
Display percentages – show relative, rather than absolute frequencies.
Display missing values – show missing values category.
Display legend – show the legend, which is switched “off” by default in bar charts.
Display scale – how the scale axis in bar charts.
Display title – show diagram title.
Display text – how textual description of diagram.
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Change color scheme – opens window for color scheme selection.
Save current design as default – saves the design of the displayed chart and
automatically applies this design to new diagrams.
Apply current style to all ceated diagrams – applies the style of the displayed chart
to all currently created diagrams.

Customizing chart captions, colors, and font sizes
When creating charts, MAXQDA sets an initial color scheme. To customize your charts,
double-click on the selected segment and choose your desired color. Click on the
Change color scheme
button to select a color scheme.
Double-click on the title or description to customize content.
Formatting, such as font, font size and font style, can be changed via the dialog
window that appears when you double-click on the title, description or another label.

Printing and export charts
In the toolbar in the upper right corner there are three icons that can be used to
export and print the frequency tables and charts:
Copy – The whole window content is copied to the clipboard, so you can copy the
results into a report or presentation without any detours, for example, by using Ctrl+V
(Windows) or ⌘+V (macOS).
Print – Prints the whole window content.
Export – Exports frequency tables as Excel files or as web pages in HTML format.
Exports charts as image files in PNG or SVG format or in EMF format (Windows only).
Tipp:If you export a frequency table in Excel format, all currently created tables will be
exported to a file as one worksheet each.

Missing values in frequency tables and charts
MAXQDA will treat the following as missing variable values:
●

●

For numerical and text variables, values set as “Missing values” in the “List of
Variables” will be treated as missing.
For text variables, blank fields will also be treated as missing.
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Descriptive statistics
When evaluating numerical variables, the Descriptive statistics
symbol is appears in
the top toolbar. Clicking on the icon produces an output of the usual parameters such
as including mean value and variance.

Frequency Tables and Charts for Subcodes
With MAXQDA you can create frequency tables and charts for subcode frequencies.
You can open this function in the ribbon menu via Codes > Subcode Statistics.
The following dialog box appears: on the left side, all existing top-level codes that have
subcodes are listed; on the right side your selected codes appear. In the middle, arrow
buttons allow you to transfer codes from one window to the other. You can also do
this by double clicking on a code. Click on the column header of either list in order to
alphabetize content.
Please note: To select multiple variables at once, hold down the ⇧ Shift key, or Ctrl key
(Windows) or ⌘ key (macOS)

Statistics for subcodes: choose codes
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For codes containing subcodes, this function can also be called up directly from the
“Code System” window. Right-click on the code and select Subcode Statistics. This
allows you to access the statistics functions for codes that are not at the top level of
the code system.
The analysis can be restricted to currently activated documents and subcodes. To do
so, check the appropriate boxes.
The option Aggregate subcodes is selected by default. If the option is selected, all
lower level subcodes of the subcodes will be included in the analysis. They will be
aggregated with the top-level code, and only this code will be displayed in the results
table. If the option is deselected, only the direct subcodes of the selected code will be
included in the analysis.

Selecting units of analysis for statistical evaluations
At the bottom of the screen, you will find options for the unit of analysis. The
following options are available:
Documents (count all subcodes) – This option corresponds, in principle, to an
evaluation of multiple responses. In this case, the analysis is performed assuming that
when several subcodes can be coded in a document, the subcodes are not mutually
exclusive. MAXQDA analyzes the number of documents to which a subcode has been
assigned. All subcodes that occur in a given document will be counted, on a perdocument basis. This type of analysis would typically be employed to answer the
question "What percentage of cases (= documents) mention the theme (= code) XY
?".
Documents (count most frequent subcode only) – In this case, the analysis is
performed under the assumption that subcodes are mutually exclusive, meaning that
subcodes can be interpreted as categorical variables. On a per-document basis, only
the subcode that occurs most frequently is taken into account. If two or more
subcodes occur with the same frequency within a document, a new “not defined”
category will appear.
Coded segments – This option analyzes the number of coded segments per subcode.
Once you click OK, MAXQDA begins the statistical calculation, after which the results
will be displayed as frequency tables and diagrams.
The window shows the table view of the first selected variables:
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Frequency Table

The first column of the table lists the different subcodes of the table; the second
column, the absolute frequency; the third column, the corresponding percentages. The
fourth column shows the percentages based on valid values, meaning documents
without analyzed codes are not taken into account. If there are no missing values,
then the percentages will be identical in the third and fourth columns.
Tip: Click on the column headers of the first two columns in order to define row order.
For example, you can sort in descending or ascending order of category frequency.

Table values
The meaning of the table values depends on which unit of analysis has been selected:
Unit of Analysis: Documents (count all subcodes) – The table will show the number of
documents in which the respective subcode was assigned. For each document, all
subcodes that occur in the document will be counted. At the end of the table, the
number of documents is displayed in which none of the analysed subcodes occur.
Unit of Analysis: Documents (count most frequent subcode only) – The table will show
the number of documents in which the respective subcode was assigned. Subcodes
are mutually exclusive. For each document, only the most frequently occurring
subcode will be counted. At the end of the table, the number of documents is
displayed in which none of the analyzed subcodes occur.
Unit of Analysis: Coded Segments – The table will show how often a subcode was
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assigned, meaning how many coded segments exist for this code.

Unit of Analysis: Coded Segments

If you instead select the unit of analysis “Documents (count most frequent subcode
only)” a new column “Percentage (valid)” is displayed. As you can see below 5 of the
analyzed documents don’t have any of the subcodes in question assigned to them.
The last column calculates the percentages based only on the 30 documents with any
of the selected subcodes. The first line tell us, that in two documents the subcode
“Current work-life balance” is the most frequently assigned subcode. For another two
document the subcode “Siblings” is the most frequent subcode and in one document
“Parents” is the most frequently assigned subcode.
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Unit of Analysis: Document (count most frequent subcode only)

If you select the option "Document (count all subocdes)", MAXQDA counts for each
subcode, in how many of the documents it occurs. Once again you can see that only
30 of the documents have any of the subcodes assigned to them. The subcode
"Current work-life balance" occurs in 30 documents, the subcode "Dissatisfaction"
occurs in 10 documents, and so on. The percentage columns show how large the
percentage of documents with the subcode in question is.

Unit of Analysis: Document (count all subcodes)

The following table explains the structure of the last table schematically:
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Subocde "A"

Number of documents in which Code "A" occurs.

Subcode "B"

Number of documents in which Code "B" occurs.

Subcode "C"

Number of documents in which Code "C" occurs.

DOCUMENTS with code(s)

Number of documents in which at AT LEAST ONE of
the analyzed subcodes occurs.

DOCUMENTS without code(s)

Number of documents in which NONE of the analyzed
subcodes occurs.

ANALYZED DOCUMENTS

Number of documents total.

Toolbar functions
You will see a toolbar at the top of the results window. Here you can:
●
●
●
●

call up charts by clicking the
icon
flip forward
or back
between main codes
print results, or
export results as an Excel file or as a Website in HTML format.

Charts
Once you have switched to the Chart view by clicking on the
the subcodes appear in the place of the table view.

icon, a bar chart of

Vertical bar chart representation for the subcode frequencies
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Please note: The order of columns, bars, and segments is determined by row order in
the frequency table.
You will see two toolbars at the top of this window. The upper toolbar is the same as
the frequency table, and you can switch at any time to the table view. On the right
side of the lower toolbar, you will see three buttons, with which you can choose
between pie chart, horizontal and vertical bar chart. The chart can be customized
using the options in the lower toolbar.
Display labels – show categorical labels of bar and pie charts on the x-axis.
Display data values – show the data label, meaning frequency of variable values or
subcodes.
Display percentages – show relative, rather than absolute frequencies.
Display missing values – show missing values category.
Display legend – show the legend, which is switched “off” by default in bar charts.
Display scale – show the scale axis in bar charts.
Display title – show diagram title.
Display text – show textual description of diagram.
Change color scheme – opens window for color scheme selection.
Save current design as default – saves the current design and automatically applies
this design to new diagrams.
Apply current style to all created diagrams – applies the current style to all
currently created charts.

Customizing chart captions, colors and font sizes
When creating charts, MAXQDA sets an initial color scheme. To customize your charts,
double-click on the selected segment and choose your desired color. Click on the
Change color scheme
button to select from among three preset color schemes.
Double-click on the title, the description, or the category label to customize the text
and its font.
Double-click the bars, circle segments, or axes to customize them.
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Customize text, color, and font

Printing and exporting charts
In the toolbar in the upper right corner there are three icons that can be used to
export and print the frequency tables and charts:
Copy – The whole window content is copied to the clipboard, so you can copy the
results into a report or presentation without any detours, for example, by using Ctrl+V
(Windows) or ⌘+V (macOS).
Pint – Prints the whole window content.
Export – Exports frequency tables as Excel files or as web pages in HTML format.
Exports charts as image files in PNG or SVG format or in EMF format (Windows only).
Tipp: If you export a frequency table in Excel format, all currently created tables will be
exported to a file as one worksheet each.

Code Frequencies
Using the Code Frequencies feature, you can create a table or chart that shows how
many segments and how many documents have been coded with selected codes.
Since the documents often correspond to specific cases (e.g. interviews or
organizations), the following function can be used to quickly analyze for how many
cases a particular topic has been coded.

24 - Frequencies

703

Follow these steps:
●

●
●

Activate the documents you want to include in your analysis. If you want to include
all the documents, you don’t need to activate anything.
Start your analysis via Analysis > Code frequencies.
The following dialog window will appear, to which you can drag the codes to be
analyzed from the "Code System" using the mouse. To insert more than one code,
you can activate it at any time and then use the Add activated codes button. The
Only for activated documents option is automatically selected if documents were
activated when the function was opened. Deselect this option to analyze all
documents

Select codes for the analysis of code frequencies

After clicking OK the following frequency table will appear, which shows in how many
documents the code occurs.

Documents per code
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Frequency table: number of documents containing the respective codes

The bottom three rows contain the following information:
DOCUMENTS with code(s) – refers to the number of documents in which at least one
of the analyzed codes occurs.
DOCUMENTS without codes – refers to the number of documents in which none of
the analyzed codes occur.
ANALYZED DOCUMENTS – refers to the sum of the two numbers directly above and
gives the number of all analyzed documents.

Segments per code
If you click on the blue arrow in the toolbar, MAXQDA switches the display to
"segments with code". Segments are then counted rather than documents. The
results table shows how many segments the listed codes have been assigned to in the
selected documents.
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Frequency table: number of segments with the respective codes

In the second line of the table, you can see that the "Parents" code has been assigned
to 30 segments within the analyzed data. This corresponds to 22,4% of the analyzed
coded segments.

Code frequencies displayed as a chart
By clicking on the chart symbol in the upper left corner, the currently displayed
frequency table can be displayed as a bar, column, or circle chart. Refer to the
Frequency Tables and Subcodes section for further information on charts.
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Code frequencies as a chart

Export and print code frequencies
The current display (table or chart) can be printed and exported via the usual symbols
on the top right corner of the window.
Copy - copies the current view to the clipboard to allow you to then paste it into a
report, presentation or graphics software.
Print – prints the currently displayed window.
Export – exports frequency tables as Excel files or as web pages in HTML format.
Exports charts as image files in PNG or SVG format or in EMF format (Windows only).
Tip: If you export a frequency table in Excel format, all currently created tables will be
exported to a file as one worksheet each.

Code Coverage: Extent of Code
Assignments
With the help of the Code Coverage function, you can analyze to what extent the

24 - Frequencies

707

document has been coded with a particular code. Code Coverage comparisons can be
applied to multiple documents, document groups, and document sets. The tool
compares coded characters (including spaces) in texts, coded areas in images, and
coded time in videos.

Starting the function
Follow these steps to determine Code Coverage:
1. First, activate the documents and the codes that you want to include in the analysis.
If you want to analyze all documents and all codes, you do not need to activate
anything.
2. Click on the Code Coverage function in the Analysis menu and select in the
appearing menu whether you want to analyze (a) texts, tables or PDF documents (b)
images, or (c) videos.

Select the “Code coverage“ function in the Analysis tab

Please note: The “Images“ function also includes coded image segments in PDF
documents, and the “Videos” function includes audio files.
3. The following dialog window will then appear in which you can choose to split the
results by document, document group, or document set.
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Selecting whether to compare documents, document groups or document sets

The results table for two coded documents, for example, could look like this:

Code Coverage: results table for two coded documents

The results table displays the documents, document groups, or document sets in the
columns, and the selected codes in the rows. By default, the cells provide information
about how much area in a document is coded with a code (in percent). In the example
above, you can see that 50% of text in “Class 6a” was coded with the code “Group
work”, whereas in “Class 6b” this percentage is only 34%. The drop-down menu
allows you to define what results are displayed in the cells:
Percentages: none – the absolute numbers are displayed, i.e., the coded characters
including spaces (in texts), the coded area (for pictures), or the coded time (for videos).
Percentages of “coded“ – the result cells indicate what percentage of the coded
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length, area, time of the document was coded with the given code. The sum of the
percentages will exceed 100% if the analyzed codes overlap each other at one or
more points in the document.
Percentages of entire text/image/video – the result cells indicate what percentage of
the coded length, area, time of the document was coded with the given code. The
sum of the percentages will exceed 100% if the analyzed codes overlap each other at
one or more points in the document.
Row percentages – the result cells indicate what percentage of all evaluated
documents, document groups, or document sets have been coded with each
respective code. Each row then indicates how the coded segments are distributed as a
percentage of the individual documents, groups, or sets.
The three rows on the bottom end of the table are always displayed and contain the
following information:
NOT CODED – provides the length/area/time of the document, group, or set that has
been coded with none of the currently displayed codes.
CODED – provides the length/area/time that has been coded with any of the currently
displayed codes.
TOTAL TEXT/AREA/TIME – provides the total extent of the document, document
group, or document set.

Functions in the toolbar
A toolbar with the following functions is located at the top of the "Code Coverage"
window:
No color highlight – turns off color highlighting of the result cells.
Color highlight refers to columns – the cells in each column with the highest value
is dark green, that with the smallest is white. The closer a value is to the highest value,
the darker its green highlight.
Color highlight refers to rows – the cells in each row with the highest value is dark
green, that with the smallest is white. The closer a value is to the highest value, the
darker its green highlight.
Show decimals – for easier readability of the percentages, decimal places are
switched off by default and can be displayed via this symbol.
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Chart view – creates a frequency table with the calculated values for each column.
The frequency table can be turned into a diagram to visualize these results.

Exporting results tables
The current view of the result table can be exported using the usual icons on top right
of the window. When the highlight is turn on, this is also included.
Copy current display as an image to clipboard – copies the currently visible table
as a graphic to the clipboard so it can be pasted directly into a publications or
presentation.
Export – MAXQDA creates a spreadsheet as an Excel file (XLSX format), as a
webpage (HTML format) or as a text document (Word or RTF format) after you have
entered filename and location. Export as a graphic file is also possible.

Displaying results tables as a chart
Your results can be displayed as frequency table or as a chart. In the "Percentage"
column, the percentages are displayed relative to the total area, in the column
"Percent (Valid)" relative to the coded area.
Clicking on the diagram symbols above the frequency table show a vertical or
horizontal bar chart, or a pie chart. By activating the missing values, the graphic
figures show the percentages related to the total area.

Code Coverage: chart view of results

Refer to section Frequency Tables and Charts for Subcodes for information on creating
and customizing charts.
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Code Configurations: Analyze Code
Combinations
Code Configurations enable you to examine the co-occurrence of codes in a
document or segment; They are particularly suitable for analyzing code combinations.
Code configurations can effectively support a multi-dimensional analysis as well as the
formation of types through identifying patterns.
In the case of the Simple Code Configurations, you select individual codes for the
analysis. In the case of Complex Code Configurations, you select parent codes whose
subcodes are evaluated. Let us look at an example of how code configurations may be
used in your analysis:

Example
Imagine you have carried out a video analyses in several situations in a kindergarten, to
determine which games are played by which teachers with which children. Each
analyzed situation is entered as a separate document in the “Document System”, and
in the “Code System” there are three parent codes for your three analysis dimensions,
each with three subcodes:
Parent code 1:
Teacher

Parent code 2:
Child

Parent code 3:
Game

Mrs. Mathilde
Mr. Wolters
Mrs. Berkempers

Finn
Mareike
Joshua

A ball game
Knight’s castle
Board game

Simple Code Configurations are especially suited to analyzing combinations of
subcodes within one dimension. The results table has the following structure:
Finn
x

Mareike
x
x

x

Joshua

Segments
5

x

3

x

2

Selected codes form the columns, and the combination of these codes are marked
with a symbol (here an “x“). In the last column, you can see in how many segments
the combination occurs. For example, you can see in the first row of the table that
Finn and Mareike playing was coded in 5 segments. The remaining rows reveal that it
never occurred that all three children played together as a group, since there is no row
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with an x for each column.
Instead of the number of segments, the number of documents, document groups, or
document can be analyzed. The table then shows how often a configuration of codes
occurs in the selected unit.

Complex Code Configurations are particularly suited to the analysis of interrelationship
between several dimensions. The results table has the following structure:
Teacher?

Child?

Game?

Segments

Mrs. Mathilde

Finn

Ball game

10

Mr. Wolters

Mareike

Knight’s castle

6

Mr. Wolters

Joshua

Ball game

3

The columns contain the parent codes, i.e. the analyzed dimensions. The cells contain
the subcodes, i.e. the manifestations of each individual dimensions. In the last column,
MAXQDA displays in how many segments of your data the three subcodes of each
respective row co-occurred. So, in the first line, you can see that a ball game between
Mrs. Mathilde and Finn was coded in 10 situations.
The number of documents, document groups, or document sets can also be displayed
in lieu of the number of segments.

Analyzing simple code configurations
To perform a simple analysis of code configurations, select the following function:
Analysis > Code Configurations > Simple Code Configurations.
A dialog window will appear into which you can drag-and-drop codes from the "Code
System" with your mouse. Alternatively, the activated codes can be transferred to the
selection window by clicking the Add activated codes button. The Remove code(s)
button can be used to remove selected codes from the selection window again.
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Selecting codes for Simple Code Configurations

Below the code selection you have to select which co-occurrence of codes should be
analyzed, i.e., the counted units:
●

●

●

Segments – Analyzes in how many segments the selected codes co-occur. It is
sufficient if the codes overlap, they do not have to be applied to exactly the same
segment.
Documents - Analyzes in how many documents the selected codes co-occur. It
doesn’t matter where the codes occur in your documents; what is important is that
all codes have been assigned in a document at all. With the unit “Documents”, it is
irrelevant if the code occurs multiple times in a given document – one occurrence is
sufficient to be counted.
Document groups and sets – Like the previous option "Documents", only that is
searched across multiple documents. This means that the codes do not have to occur
in the same document. It is sufficient if one code was assigned in one document and
the other code in another document of the same document group or set.

Differentiation of results– If you selected to count for segments or documents, you can
determine whether the results table should be additionally divided into documents,
document groups, or document sets. This allows easy comparison of cases or groups
of cases. .
Selecting the option Only activated documents, restricts the analysis to activated
documents.
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Click OK to start the analysis and MAXQDA will produce the following results table:

Simple Code Configuration: results table when choosing segments as evaluated unit

The first columns of the results table are headed with the names of the selected codes
and provide information on the occurrence of the respective codes. If the code occurs
on a segment, a blue square is shown in the column. Each line contains a different
combination (the so-called “configuration”) of the analyzed codes.
In the upper right corner of the window, you will find information on how many
combinations actually occurred in the evaluated documents and - behind them in
brackets - how many could maximally have occurred.
Please note: If a combination of codes does not exist, this row will not be listed in the
table. Only the segments with at least one of the selected codes have been analyzed.
So, when the unit "Segments" is selected, a row that does not contain any of the
evaluated codes will not be displayed.
The "Segments" column indicates the number of times a particular combination
occurs in the documents analyzed. The "Percent" column contains the corresponding
relative frequency. The first row in the table above shows that Joshua, Finn and
Mareike have played together in 25 situations (corresponding to 71% of the analyzed
segments).
The "Number of codes" column displays how many codes occur in that combination.
If you selected a differentiation for documents, document groups, or document sets,
additional columns are added for each selected unit at the end of the table – in the
example above for the two documents “Day 1” and “Day 2”. The display in the
columns can be switched between absolute numbers and row or column percentages
with the three symbols in the toolbar. In the above table, the column percentages are
selected so that the results for the individual documents can be directly compared with
the overall values in the “Percent” column.
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Output when analyzing the co-occurrence of codes within documents,
document groups, or document sets
(1) In the results table, the column headed “Segments” with corresponding to the
numbered unit is instead headed “Documents”, “Document groups”, or “Document
sets”. It specifies how many analyzed units contain the respective combination of
codes.
(2) If there are documents, groups, or sets that do not contain any of the analyzed
codes, the results table will contain a row without blue squares.
(3) A “Detailed View” table is also displayed in which you can see which combination
of the selected codes is contained within each document, each group, or each set. The
table basically corresponds to the “Code Matrix Browser” visual tool, with
interchanged rows and columns.

Analyzing complex code configurations
To perform a Complex Code Configurations analysis, select the following function:
Analysis > Code Configurations > Complex Code Configurations.
A dialog window will appear, into which you can drag-and-drop parent codes from
the “Code System“ with your mouse. MAXQDA then automatically lists their
respective subcodes from which you can exclude individual subcodes from the analysis
by unchecking their selection box.
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Selecting codes for Complex Code Configurations

The settings in this dialog window are the same as described above for the Simple
Code Configurations.
Click OK and a MAXQDA will produce the following results table:
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Complex Code Configurations: results table when choosing segments as evaluated unit

The first columns contain your selected parent codes. Each line contains a combination
of the subcodes, and the “Segments” column indicates how often these combinations
occur in your data. For example, from the first line of the above table, you can see that
Mr. Wolters plays “Board game” with Mareike 35 times. This accounts for nearly 12%
of all coded observations.
At the right side of the table, MAXQDA will display columns containing frequencies in
the individual documents, document groups, or document sets, if you selected to
differentiate by them. The values in these additional columns can be switched to
column percentages or line percentages.

Toolbar
Filter – applies the filters you can define by right-clicking on the column heading
and selecting Set filter.
Reset all filters – removes filters from all columns.
Column selection – displays a dialog where you can select the displayed columns
of the results table.
Count hits only once per document – regardless of how many segments in a
document with a combination of codes exist, it will be counted only once if this option
is enabled. The option is displayed only when evaluating segments.
Statistics – displays the results as a frequency table. This frequency table can also
be switched to a chart to visually display the results.
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Number – the additional columns with documents, document groups, or
document sets will display their absolute numbers.
Row percentages – the additional columns with documents, document groups, or
document sets will display their row percentages.
Column percentages – the additional columns with documents, document
groups, or document sets will display their column percentages.

Interactive results tables
The Code Configurations tables are arranged according to combination frequencies –
by clicking on a column header, this arrangement can be adjusted. The order of the
table’s columns can be changed by clicking and dragging the header with the mouse.
Tip: The results tables of the Simple and Complex Code Configurations are interactive.
A double-click on a line with a code combination lists all associated coded segments in
your “Retrieved Segments” window.

Exporting results tables
The current display can be exported using the usual icons at the top right of the
window. The selected rows are always exported - if no rows are selected, the entire
table is exported.
Open as Excel table – Creates an Excel spreadsheet and opens it.
Open as HTML table – Creates a web page in HTML format and opens it.
Export – Creates a table as an Excel file (XLSX format), as a web page (HTML
format), or as a text document (DOCX or RTF format).

Displaying results as a chart
A click on the chart symbol on the top left will display the current table as a horizontal
or vertical bar chart or as a pie chart. If you selected “Documents”, “Document
groups”, or “Document sets” as your unit, you will see in the row, the number of
analyzed documents in which none of the respective codes occur. Refer to the section
Frequency Tables and Charts for Subcodes for information on creating and
customizing charts.
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Simple Code Configuration for segments as a vertical column chart
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25 - Report & Export
Smart Publisher for Coded Segments
Smart Publisher is a convenient report generator. It exports selected coded segments in
a formatted Word document report, including title page and table of contents. The
structure of the report is determined by the “Code System:”
●
●
●

An individual chapter will be created for each top-level code.
A subchapter will be created for each subcode.
Coded segments of each code form the content of each (sub)chapter.

Starting the Smart Publisher
Smart Publisher can be accessed via the main ribbon menu: Reports > Smart Publisher.

Call up Smart Publisher

When Smart Publisher is called up, a dialog window will appear in which you can
select the codes to be included in the report. When top-level codes are selected, their
corresponding subcodes will automatically be included in the report. You can also
choose to include coded segments only from activated documents.
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Selecting top-level codes for Smart Publisher

Smart Publisher settings
The following dialog window displays the various report options:
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Smart Publisher settings

“Title“ settings
Title – The title, which will appear on the first page of the report.
Subtitle – The subtitle, which will appear on the first page of the report.
Image files 1 and 2 – Selection of up to 2 image files, which will appear on the first
page of the report. If the field is left blank, no image will appear.

”Header and Footer” settings
Reports can be formatted to include headers and footers, which will appear on each
page after the title page.
Header – Header text
Footer – Footer text

“Options” settings
You can limit the output to segments where a weight was assigned in a defined area.
Comment – Below a coded segment, its comment is also output.
Use code alias instead of code name – The code alias will be used in the place of the
code name as a heading, if defined for the respective code (see below).

“Coded Segments sorted by” settings
In this part you can set how the coded segments within each chapter of the report are
sorted. You can sort segments by their documents position in the ”Document Sysetm”
or by their assigned weight scores.

“Source information” settings
In the “Source information” you will find numerous options for the information to be
included for each coded segment.
Document – Displays document group and document name.
Position – Displays the beginning and the end of the coded segment (as well as
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paragraph numbers for textual data).
Weight Score – Displays the weight of the coded segments.
Created by – Displays the name of the user who coded the segments.
Creation date – Displays the date on which the segments were coded.
Quotation marks – text segment will be placed in quotation marks
The following figure shows an excerpt from a report that was generated using Smart
Publisher. The displayed segment comes from the paragraphs 35-36 of the document
“Jon” from the document group “New York.” It was encoded with a weight of 100.
The segment was assigned the code “Significantly Positive:”

Excerpt from a Smart Publisher report

The report
The finished report is in the form of a Word document (in DOCX format), which
includes a title page, table of contents, a page that lists of all the documents included
in the report, and the main section including all of the exported segments. If a
header/footer was included, it will appear on all pages aside from the title page. If an
end page was included, it will appear at the end of the report.
All elements of the report are formatted using the Word template (DOT format).
Formatting of the final report can be modified; for example, you can easily insert
additional pages or content.
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Alias names for codes
Smart Publisher uses the code names from the “Code System” as headings for the
individual subchapters of the report. However, you may wish to assign an alternate
name to some or all of the subchapters in the report. This may be the case if the 63
characters per heading allowed by the system are not enough, and you wish to create
a longer name, or if, in other cases, a shorter heading would be more appropriate. For
this reason, MAXQDA allows you to create a “code alias” of up to 225 characters.
In order to assign a code alias, right-click on the code in the “Code System” and select
“Properties”. A dialog window will appear, in which you can enter the code alias.

Assigning a code alias in the code properties window

Adjusting the Smart Publisher layout
It is possible to customize the layout of Smart Publisher reports. To do this, you will
find a settings file named as “SP_Formats.ini”, the contents of which you can
customize. You can find the file in the following folder, depending on your operating
system and installation type:

Windows: local installation
1. Open Windows Explorer
2. In the address bar, type in the following and press “Enter”: %appdata%
3. Navigate to folder “MAXDQA2022” and open it.
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Windows: portable installation on USB pendrive
USB Pendrive\MAXQDA2022\Resources
The structure of “SP_Format.ini” is as follows:
[Default_Format]
StyleName = "MQ_Header1"
FontName="Calibri"
FontSize = 11
LineSpacing = 1.2
SpaceAfter = 6
Indent = 12.5
For example, to use your the font that is used in your corporate design, change the
entry next to FontName from "Calibri" to the appropriate text font.

Codebook with Category Definitions
The “Export Codebook” function allows you to automatically generate a Codebook
that lists all or selected codes in the order of the Code System and also outputs the
associated code memo for each code. The codebook therefore contains the category
definition of each individual code, provided that this was recorded in the code memo.
This saves a lot of work in the creation of the annex for a research report, especially
since it provides the opportunity to unify the font for all memo text.
The Codebook is created in Word document format and can therefore easily be
opened with word processing programs. It includes a cover page with the title
"Codebook", the project name and the creation date. On the following page, the
Code System is listed in a table. In the main section, the respective codes with their
associated memos are listed in the order of the Code System.
The Codebook function is accessed through the menu Reports > Codebook. A
window will appear in which you can specify the Codebook options in more detail.
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Setting options for the Codebook

In the top section of the window, you can specify which codes should be included in
the Codebook.
Only codes with code memos - Set this option to exclude codes that have no memo in
the codebook.
Only top level codes - If you select this option, only the codes in the top level of the
Code System, with their associated code memos, will be included. Subcodes will not
be included.
Only activated codes - In this case, only activated codes will be included in the
Codebook. You can decide whether (inactivated) subcodes should also be included:
Include subcodes. This option is not available if you have selected Only top level codes.
Other options can be set in the lower section:
Standardize memo fonts - If the font, font size, etc. varies between memos, they can
be uniformly displayed in the Codebook using this option.
Number codes - If this option is selected, the listed codes will be numbered according
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to their hierarchy in the Code System.
Include parent code in code name - If this option is selected, the code path will be
specified as a heading for the subcodes.
Export code system with frequencies - If this option is selected, a column containing
the code frequency will be added in the table overview of the code system.
After confirmation, select a name and location for the file before the Codebook is
created and opened.

Summaries with Coded Segments
You can create a report in Word-format (DOCX), which will display your compiled
summaries together with the corresponding coded segments in a table overview.
Follow these steps to create the report:
1. Click on the Summaries symbol in the Reports tab and select the menu option
Summaries with Coded Segments.
2. A dialog window will appear with several options.

Options for creating a report of your summaries with coded segments

Only for activated documents – only summaries from activated documents are
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included.
Only for activated codes – only summaries for activated codes are included.
Include comments – under the coded segments, the corresponding comments (if any)
are also included.
Standardize text formatting – given that coded segments can be formatted very
differently, you can use this option to standardize the font format.
Click OK and enter a name and location for the report. MAXQDA opens the exported
document immediately.

Report: “Summaries with Coded Segments“

For each selected code, your report will display the coded segments of the selected
documents in one column and the summaries in another column. You can use this
examine these summaries and review each of them with reference to their underlying
coded segment. The report presents your summaries in a transparent and
comprehensible way.

Reports: Summaries – without coded segments
You can also create reports that only present your summaries: Reports > Summaries.
The “Coded segments“ column is not displayed – only the codes and their respective
summaries.

25 - Report & Export

729

Report Summaries

Project Information
The function Reports > Project Information collects information about the current
project and shows the completed report in a separate window. Specifically, Project
information contains the following data :
●
●
●
●
●
●
●
●

Report date
Name of the MAXQDA project file
Project Memo (from the root of the Document System)
Number of document groups, document sets, and the individual document types
Number of codes, coded segments, and code sets
Number of memos
Number of document and code variables
Number of internal links

Project information can be copied to the clipboard with the Copy button, and from
there transferred into another program such as Word.
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Project information

Document Profiles
The function "Document Profiles" allows you to export a table with important
information about selected documents. For each document, the table includes the
document memo, a selection of variables, and code frequencies.

Document Profiles Table

The Document Profiles function is accessed via the menu Reports > Documen Profiles.
A window will appear in which you can specify the exported information in more
detail.
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Set options for Document Profiles

Only for activated documents - In this case, only activated documents will be included
in the exported table.
Only for activated codes - In this case, only activated codes will be included in the
exported table.
Display Favorite Variables - If this option is selected, the projects favorite variables and
their values are exported.
Select variables - This option allows to (de-)select the favorite variables to be included
in the export file directly in the dialog window.

Export and Print Documents
You can export your documents in various ways, for example, for documentation
purposes. There are three places in MAXQDA where you can start the export process:
●

●

●

Every opened document can be exported directly from the "Document Browser" by
clicking on the
icon top right.
If you right-click on a document name in the "Document System", you will find the
entry Export Document in the context menu. The same applies to a document group,
where you can use Export Documents to initiate the export process for all the
grouped documents.
In the Reports menu you can find an Export option, which contains an extensive
menu for exporting individual data from MAXQDA, including the options to export
single or multiple document:
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Export options in the „Reports“ menu

If you select All Documents or All Activated Documents, you have to select a folder in
your file system where you want MAXQDA to save the documents. Document groups
are saved as subfolders.

Export interview transcripts with paragraph numbers, coding stripes, and
memos
For the documentation of an interview study, it is often necessary to include selected
or all interview transcripts in the report. For this purpose, MAXQDA offers you the
option not only of exporting the pure transcripts as text files, but also of exporting the
paragraph numbering, the code assignments made, and any attached memos with the
transcripts and saving these as PDF files:
●

●

To export individual transcripts, right-click them in the "Document System" and
select Export Document from the context menu.
To export several transcripts simultaneously, select Export Documents from the
context menu of a document group.

The following dialog box will appear:
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Transcript export options

The following settings are available for exporting text documents:
Export as PDF document / Text document / Excel document - Sets the export format.
Depending on the selected export format there are different further export options.
As table with paragraph/line numbers - Your document is displayed as a table
equivalent to the current view in the “Document Browser” (with paragraph or line
numbering). This option can only be selected when exporting as a text document. It
cannot be combined with the visualization of codes and memos.
Display timestamps - If the transcript contains timestamps, you can include these
timestamps in the exported text.
Display coded segments - The coding stripes are placed to the left of the text. Only
those code assignments are exported that are currently selected in the "Document
Browser" via the display menu for the coding stripes. The colored background of texts
is also included. This option can only be selected when exporting as a PDF document.
Tip: In the “Document Browser”, switch on the option Display coded segments in
color to highlight the coded segments in the transcript in the respective color of the
assigned codes. You can access the option by clicking on the gear wheel in the upper
left corner.
Display memos - If this option is selected, the memo symbols are displayed to the left
of the text. The memo text itself is not exported. This option can only be selected
when exporting as a PDF document.

25 - Report & Export

734

Include memo content - Inserts the content of your in-document memos at the
appropriate place in the exported document. This option can only be selected when
exporting as a text document.
Width of the coded segments' column - Defines how much space should be used for
the display of the coding stripes and memos.
The listed export options are not available for PDF, image and table documents - these
are saved as they are stored in the MAXQDA project file.

Print documents
By clicking on the small printer icon in the upper right corner of the “Document
Browser” you can print individual documents (except table documents). If you have
installed a PDF printer, this provides an alternative way to export a transcript with the
codes in the page margin.
When printing, the following print preview appears, in which you can adjust page
margin and enter header and footer texts. Set the appropriate options in section More
settings if you want to visualize the coding stripes and memo icons to the left of the
document:

Options for printing a document
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Export Adjacency Matrix for Network
Analysis
to do

Exporting Project Components as Excel file
One possibility for exporting is worth noting in particular. If you select the following
option in the ribbon menu, Reports > Export > Project Components as Excel File,
MAXQDA will generate an Excel file that lists the following contents in the individual
tables of an Excel file:
●
●
●
●
●
●
●
●

"Document System" with code frequencies
"Code System" with code frequencies
Memos
Coded segments
Document Variables and their values
Code Variables and their values
Links
Summaries

Anonymize Projects
If you have sensitive data in the text documents of a project, you can save it
anonymously as a project copy. A prerequisite is that the sensitive text areas have been
coded with a specific code. When saving, all texts that have been coded with this code
are replaced by XXX and rendered anonymous. If different codes have been used for
different types of information, these code namessubcode names can all be added to
the anonymous text list, e.g. "People", "Places" and "Jobs".
Follow these steps:
1. Start the function by going to Home > Save anonymized project as. MAXQDA will
then display the following dialog window:
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Options dialog
window for the selection of codes, the texts of which should be anonymized
2. Drag all the codes, the texts of which should be anonymized, from the Code
System“ into the dialog window.
3. Select the option Include code name to show the codename in brackets at the
beginning of each anonymized text area. This is useful, for example, if you have
used several specific codes for the anonymized texts ("person", "place", etc.). If
more than one of the selected codes has been assigned to one text, only the name
of the parent code is displayed.
The project copy can then be passed on to others. The anonymized text locations in
the project file look like this:

Anonymized project with the selected “Display code name“ option

Please note: This function only works for text documents, not for PDF files or other
document types.
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Save Project in MAXQDA 2020 Format
How to save a MAXQDA 2022 project for MAXQDA 2020
MAXQDA 2020 cannot open the .mx22 format of a MAXQDA 2022 project, but you
can save a MAXQDA 2022 project to the .mx20 file format used by MAXQDA 2020.
Open your project file in MAXQDA 2022 and select Save Project As from the Home
menu ribbon tab.

Save a MAXQDA 2020 project for MAXQDA 2018

In the following dialog windows set the file type to “MAXQDA 2020 Projects
(*.mx20)”, enter a file name, select a location to save the project file to, and then click
Save.

Change the file type to MAXQDA 2020 Project

A few elements of MAXQDA 2022 will be changed, because MAXQDA 2020 does not
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have the functionality to handle new or changed features:
●
●

●
●

Text codes in PDF documents are converted to image codes.
emoticodes in the "List of codes" will become normal codes with the emoticode
symbol at the beginning of the code name.
Memo titles are shortened to 63 characters.
Code and document summaries in code and document memos are deleted.

Export and Import REFI-QDA Projects
“The REFI-QDA Standard enables interoperability between Qualitative Data Analysis
Software (QDAS or CAQDAS) programs. Its purpose is to enable users to exchange
processed data between programs. It is an open standard and any program can
implement it, thus increasing the number of software programs that can ‘talk’ to one
another.” (www.qdasoftware.org).
The REFI-QDA Standard makes it possible to exchange projects between all software
packages that support the XML exchange format. Software vendors include Atlas.ti,
f4Analyse, NVivo, QDA-Miner, and other. MAXQDA supports both exporting a
MAXQDA project in the XML exchange format and importing a project from such an
XML file.
The REFI-QDA Project file contains specifications for the following MAXQDA
components:
●
●
●
●
●
●
●

Documents and document groups
Codes
Internal links
Memos (and log book)
Coded segments
Comments assigned to coded segments
Document variables (or more precisely: document group variables, which do not exist
in MAXQDA)

The REFI-QDA Project file does not contain specifications for the following MAXQDA
components:
●
●
●
●

Document sets
Table documents
Summaries
Paraphrases
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●
●
●
●
●

Complex concept maps
Code variables
Speaker variables
Stop lists (word clouds and MAXDictio)
Dictionaries (MAXDictio)

The exchange possibilities are therefore limited, because the REFI-QDA Project does
not support all elements from all software packages. Even if it would support all
elements, it should also be noted that, the project logics of the individual software
packages differ and therefore complex projects can never be transferred one-to-one.
Additionally, not all QDA programs support all elements, for example not all programs
support working with PDF files.
The format is therefore not suitable for a teamwork situation where multiple
researchers work on the same project data with different software packages.
Please note: The same initiative also developed the "REFI-QDA Codebook" standard
for the exchange of codebooks (with code tree incl. memos). This standard has been
supported since MAXQDA version 2018.1 and is available via the menu functions
Codes > Export/Import Code System.

Import a „REFI-QDA Project“
How to import a REFI-QDA Project into MAXQDA:
1. Click on Open Project - either in the Start dialog that appears immediately after
MAXQDA starts, or in the Home tab if you have already opened a project in
MAXQDA.
2. In the appearing file dialog, select an REFI-QDA Project file and click

Important notes for importing:
●
●
●
●
●

●
●
●

Text documents are imported as plain text.
Annotations of coded segments (comments) are shortened to 255 characters.
Memos which are assigned to the whole project are imported as free memos.
Coded text segments in PDF files are imported as coded image segments.
Document groupings are only imported with restrictions: The REFI format does not
support document groups, but works only with sets. A document can belong to
several sets. MAXQDA adopts the sets as document groups and assigns each
document to only one document group.
Document group classifcations are not imported
NVivo case variables are not imported
Audio and video files are copied to the external files folder and have an empty
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●

transcript. Any existing associated transcripts are imported as separate document.
REFI-QDA Project files exported from Dedoose must not be password protected.

Export a „REFI-QDA Project“
To save the opened MAXQDA project in the REFI-QDA-Project format with the file
extension .qdpx, click on Save Project As in the Home menu and select "REFI-QDA
Project" as the file format.

Important notes for exporting:
●
●
●
●

●

●

●
●

The export includes text documents, PDF documents, images, audio, and video.
Text documents are exported as plain text.
PDF text codings are not exported
Transcripts with linked media files are not exported (remove linked media before
exporting and manually transfer and re-link media files)
Focus group speaker codes and their segments are not exported. Paraphrase codes
and their segments are not exported. Emoticode codes and their segments are not
exported.
The project memo, all code set and document set memos are exported as „free“
notes.
Document variables are exported as case variables.
Document subgroups are exported as top-level document groups of equal rank as
their parent groups.

The QDPX file that is created during the export contains all documents of the project
including externally saved files as well as linked audio and video files. The export
process may therefore take a while and the resulting file can be quite large.

Archiving for Data Reuse
To enable the reuse and sharing of research data, MAXQDA allows you to easily
generate a back-up of the data of a project with one click, via the Archive Data
function. A clear and easy to understand folder and file structure is created containing
all collected data, optionally as a compressed ZIP file. The intention behind the Archive
Data function is to make the data collected in research projects and the related
metadata available to the scientific community and other interested members of the
public in a simple data format that can be easily viewed and does not require training
or the purchase of specialized software. The data is therefore available in standard
formats such as DOCX (Word), PDF, XLSX (Excel) and MP4 (video).
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When archiving the data associated with a MAXQDA project, the data is always
exported in the form of documents (interview transcripts, field notes, PDF documents,
focus group transcripts, etc.), the structure of the project's document groups being
adopted as the folder structure. Optionally, the following data can also be exported:
●
●
●

●

Statistical data (document variables with standardized information)
Media data (audio and video files attached to documents)
Metadata (memos from the "Document System", which usually contain information
and documentation on the project and the data collected)
Overview of themes (the code system including code memos)

Starting the data archival process
To archive the data of your open project, choose the Archive Data entry in the Home
tab. The following option dialog window will appear:

Archiving project data for reuse: Options dialog window

At the top, select which data (in addition to documents) you want to export:
Statistical data (variables) – Integrates document variables into the exported archive.
Media data (audio and video files) – Integrates not only the transcripts, but also the
associated audio and video files in the exported archive.
Meta data (memos in “Document System“) – Integrates memos assigned to
documents and document groups as well as document sets into the exported archive.
The project memo, at the top of the "Document System", is also exported.
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Themes (code system) – Integrates your code system into the exported archive.
There are two more options in the lower section:
Only activated documents – Restricts the export to the currently activated documents.
Compress to single file (ZIP) – If this option is selected, the archive is not stored in a
single folder, but in a single compressed ZIP file, using the folder structure described
below.
Click OK and you will be given the option to select a folder in which the archive should
be stored.
MAXQDA then exports all selected data according to the following system:
●

●

●

●

●

In the Documents folder, all or only the activated documents (if so selected) are
saved in their respective format. The structure of the subfolders corresponds to the
project's document groups. Text documents are exported in DOCX format, table
documents in XLSX format and image documents in their respective original format.
The Statistical data folder stores the data table and the "List of Variables", both in
Excel and SPSS format. Of the system variables, only the document group and the
document name are exported.
Audio and video files associated with the documents are stored in the Media data
folder, also in their "Document System" structure. The media file is given the name
of the document to which it is attached.
Information on the collected data is stored in the Meta data folder. These are the
following memos from MAXQDA: the project memo that is attached to the root
folder in the "Document System" and the memos attached to document groups and
documents. Only the memo texts and memo titles are exported, but no further
information about the memos. The memos are also stored in the structure given by
the "Document System": the project memo and the document group memos at the
top level, then the document memos in their respective folders. If there are no
memos in a document group, a subfolder is not created.
The code system is saved as an Excel file named as “Themes.xlsx”, including the text
of the code memos, at the top folder level.
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26 - Teamwork
How Does MAXQDA Support Teamwork?
In the context of scientific research, data analysis is often a collective, rather than
individual endeavor. This raises the question how MAXQDA allows for teamwork.
We recommend using MAXQDA TeamCloud for team collaboration. This offers many
advantages over manual solutions for teamwork, such as email notifications,
automatic management of external files, and the simple import of projects from team
colleagues.
All advantages and requirements for using MAXQDA TeamCloud can be found in a
separate manual.
Are you already working with the MAXQDA TeamCloud? Then only the Intercoder
Agreement feature explained in this chapter is important for you. The other functions,
such as merge projects, are integrated into the TeamCloud workflow.

Guide: Working in Teams with MAXQDA
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This guide combines the organizational, technical and - as far as necessary for
understanding - methodological aspects of teamwork in qualitative research projects
into a practical manual. In this guide, teamwork is understood not only as the joint
analysis of data but as analysis based on the division of labor.

Important: MAXQDA is a single-user, not a multi-user program. Simultaneous use of
the same project file at the same time is not possible. Various people cannot make
changes to the same file at the same time.
Teamwork with MAXQDA (when not using the MAXQDA TeamCloud) is possible in
three principle forms, depending on how the team members want to work together.

1. Handing over a complete MAXQDA project to another team member
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Different people work with the same master version of a project file. They perform
coding, writing memos, text retrievals, and other kinds of analysis with this master
project. But, they do not work simultaneously on the master version. The MAXQDA
project is therefore passed from team member to team member, each time for further
processing.
Learn more

2. Transfering coded segments, memos, variables, etc. between projects
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A MAXQDA project with all the documents to be processed is duplicated for each
team member. Each member works on a pre-arranged part of the project, for
example, only segments coded with selected codes, or only certain documents. At the
end, the coded segments, memos, etc. are transferred from the respective projects
into a master project.
Learn more

3. Merging MAXQDA projects
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Each member is working in a separate project that contains only the documents that
he or she is responsible for. At the end, all three projects are merged. For example,
team member A transcribes and paraphrases 10 interviews, B transcribes another 10
interviews, and team member C collects and codes web pages and online documents.
Learn more

MAXQDA also offers additional functions that are useful for teamwork:

User Access Management
MAXQDA allows you to assign rights for individual users. For example, you can set it
up such that others cannot make changes to text documents to ensure that everyone
is always working with the same data body.
Learn more
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Intercoder Agreement
Finally, there is a function that checks for intercoder matches. MAXQDA helps you to
check and improve the quality of your coding work by comparing yours with other
members in your team.
Learn more

Transfer Coded Segments, Memos,
Variables, etc. Between Projects
Are you using MAXQDA TeamCloud? This function is already integrated into the
TeamCloud workflow and is therefore not available while working with team projects.
Quite often, teamwork starts as follows: researchers work on the same data parallel to
one another - each on their own project file on their own computer. One person only
assigns selected codes to the data, for example, the other only processes selected
documents. Both use already-existing codes and add new codes, create variables, and
write new memos or summaries. In these cases, MAXQDA allows you to transfer the
codes, coded segments, memos, paraphrases, summaries, and variables from one
project file to another.
Of course, this teamwork presupposes that everyone is working with the same data.
To make sure this is the case, it is best to import the existing data (e.g. documents,
variables, interview notes as memos etc.) into a MAXQDA project file on one computer
and then distribute the project file to all team members. Of course, it often makes
sense to define already fixed categories as codes in the “Code System”.
Please note 1: The team members can change the order of the documents in their
project files and also add further documents. Transferring color assignments to
documents is also straightforward. However, they should neither change document
names nor edit the imported texts.
Please note 2: It is not intended to transfer data from a MAXQDA 2022 project to a
MAXQDA 2020 project using the procedures described on this page. If you work in a
team, all team members should work with the same program version and first convert
all projects from 2020 to 2022 on one computer. For more information on the
compatibility of MAXQDA 2022 and 2020, please click here.
In principle, we are dealing with the following situation, where for the sake of
simplicity in the example we are assuming that we are working with only two
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MAXQDA projects. The procedure is basically the same with three, four, or more files.

Exemplary initial situation (differences between projects are printed in italics)

In the example, interview 4 is only available on computer 1, interview 5 only on
computer 2. The set of documents does not have to be completely identical in the
sense that all documents of one project must also be available in the other.
Neither does the code system have to be identical. Though, of course, in a research
group you should make sure that the same category, i.e. the same code, always has
the identical name and hasn't been given a different name by different team
members.
Tip: Of course, the projects don't have to be stored on different computers. It works
fine if they are stored on the same computer.

How does the transfer process work?
Suppose colleague 1 works on computer 1 and has coded “Interview 1” and also
added some memos. How can you now make the results of this work accessible to
colleague 2 on computer 2, especially if colleague 1 on computer 1 redefined some
codes during their work and colleague 2 also continued working on the project file
separately?
This it how it works in MAXQDA: colleague 1 exports all the relevant information to be
transferred from their project file into a MAXQDA exchange file with the extension
“MEX22” and sends this file to colleague 2. Colleague 2 then imports that
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information into their own project file. The abbreviation MEX stands for MAXQDA
EXchange format.

Teamwork export and import procedure

Teamwork export: saving data to an exchange file
To start the export process, select Teamwork > Teamwork Export: Export Data to
Exchange File in the Home tab.

Start Teamwork Export

A dialog box will then appear in which you can select the following options a step at a
time.

Select your codes and documents
First select the documents whose data you want to export. In the dialog box, you can
select individual documents or all documents in a document group or document set at
once. It is also possible to select the documents you activated before starting the
export procedure.
After clicking on Next >> a dialog box for the code selection will appear. At the
bottom, you will see how many codes are currently selected and how many coded
segments occur in the previously selected documents.
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Select documents (left), select codes (right)

Assign a file name and select a storage location.
Clicking Next >> will assign a file name and select a storage location. MAXQDA will
then export all the data (codes, code assignments, memos, variables, summaries,
paraphrases etc.) of the selected documents into the export file.

Importing the exchange file into the target project
You can import the exchange file data into any MAXQDA project that contains the
same document (in this example “Interview 1”).
Select Teamwork > Teamwork Import: Import Data from Exchange File in the Home
tab. A dialog box will appear that guides you through the import process a step at a
time:
1. First select a MEX file. MAXQDA will analyze the file and then display the following:
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Teamwork: Import data
In this dialog box, you have to check the correspondence between the source and
target documents. If the documents in the MAXQDA projects have the same name,
all you have to do is double check the automatic allocations made by MAXQDA.
Otherwise, you have to allocate each text to the appropriate matching text yourself.
If the document does not yet exist in the project, you can select the option to
import the document from the exchange file. You can deselect a document in the
first column if necessary – it will then be ignored during the import process.
If the document does not yet exist in the project, you can select the <New
Document> option to import the document from the exchange file. You can
deselect a document in the first column if necessary - it will then be ignored during
the import process.
2. When you click Next >> the following dialog box will appear for the code selection.
New codes, i.e. those that do not yet exist in the opened project, will be
immediately recognizable by the green font in the displayed list of codes.
In the dialog box, select all the codes that you want to import.

26 - Teamwork

753

Select codes
3. In the third step, select the data you want to import. MAXQDA only displays the
data types in the dialog box that are contained in the MEX file. You can deselect
individual elements, such as variables or paraphrases, to ignore them during the
import process. The other options determine how conflicting code assignments are
to be dealt with - these are described in more detail below.
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Options for the teamwork
import
4. Click Import to start the import process.
Please note: Before MAXQDA starts the teamwork import process, a backup of your
opened project's status is automatically saved to your backup folder. The import
process cannot be reset by clicking on the Undo arrow in the upper right corner of the
window.

Handling of conflicting code assignments
When importing the coded segments, it may happen that the same code has already
been assigned to the corresponding segment in the target project. This segment may
also have other segment boundaries than the coded segment you want to import.
Since the rule in MAXQDA is that a segment in a document can only be coded once
with the same code, you can use the drop-down menu to specify which segment
boundaries should “win” during import process:
●

●

●

Overwrite existing segment boundaries with imported ones – This is the default
selection: in the case of a conflicting code assignment, the segment boundaries of
the imported coded assignment override those in the opened project file.
Preserve existing segment boundaries – In the event of a conflict, the existing coded
assignment "wins", i.e. no changes are made to the segment boundaries.
Use outer segment boundaries of the code assignments – In cases of conflict, the
outermost segment boundaries of the two code assignments are used.
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●

Use inner overlapping area of code assignments – In cases of conflict, only the
overlapping area of the two code assignments is taken as the coded segment.

Each code assignment in MAXQDA also includes a comment and a weight. In the
event of a conflict, you can instruct MAXQDA whether the existing comments and
weights should be retained or overwritten by the imported ones:
●

●

Overwrite existing comments with imported comments – When this option is
activated, the comment of the imported coded segment always "wins", that is, it
overrides the comment in the opened project file. If the imported coded segment has
no comment, this is ignored, i.e. an existing comment is never overwritten by an
empty comment.
Overwrite existing weights with imported weights – If this option is enabled, the
weight of the imported coded segment always "wins".

When importing summaries, you can also control how MAXQDA should proceed if a
summary already exists for a document in a code:
●

●

●

Do not change existing summaries – With this setting, only those summaries are
imported that were empty in the project file. In case of a conflict, the imported
summaries are ignored and not imported.
Overwrite existing summaries with imported summaries – With this setting, in the
event of a conflict, the summaries already existing in the project are deleted and
overwritten by the imported ones.
Add imported summaries to existing ones – In case of a conflict, the imported
summaries are added to the existing summaries.

What exactly happens during the import process?
Code assignments:
●

●
●

All code assignments already present in the document are retained or adapted
depending on the option selected.
Previously non-existing code assignments are inserted into the opened project.
If a coded segment with a code not yet contained in the “Code System” is found in
the exchange file, this code is inserted into the “Code System” at the corresponding
position. Codes with the same name at the same hierarchy position are considered
identical, but their color is irrelevant.

Memos:
●

All in-document memos are imported (exception: memos at the same location with
the same title).
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●

●

Document memos in the "Document System" are only imported if there is no memo
in the document yet. Existing document memos remain unaffected.
Code memos are dealt with in the same way.

Paraphrases:
●

A paraphrase to be imported is ignored if a paraphrase already exists at the same
location in the current project.

Variables:
●

●

Variables that do not yet exist in the list of variables are added and their values are
imported.
Existing variables are overwritten with the value from the import file.

Start your teamwork in the "Document System"
You can also start the export for a document, document group or document set
directly in the "Document System". To do this, right-click an entry and select
Teamwork > Teamwork Export: Export Data to MAXQDA Exchange File from the
context menu.

Start teamwork export for “Interviews New York“ from within the “Document System”
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In the picture, you can see that you can open the complementary function Teamwork
Import for a document, a document group, or a document set directly in the
"Document System" context menu.

Hand over a MAXQDA Project to Other
Team Members
In this form of collaborative teamwork, the entire study is transferred as a MAXQDA
project from one computer to another, ensuring that all team members are always
working from the same database. Two people can never simultaneously code different
documents of the study or create memos on different computers. However, all
evaluation work in which no new codings are made, no new memos are written and
no variable values are changed, are of course possible without any problems
simultaneously.
The transfer of MAXQDA projects is very easy: MAXQDA saves all aspects of the
project in a MX22 file. If you name a project “Interview Study” it will be saved on your
computer as “Interview Study.mx22.”
The project file contains all …
The project file does not contain …
• Documents
• External documents (e.g. PDF files, images, audio
• Codes
and video files)
• Memos
• Externally saved geographical references (KML
• Variables
files)
• Coded segments
• Saved search formulas (SEA files = search files)
• Summaries and Summary Tables • Saved selections for logical activations and other
• QTT worksheets
mixed methods functions (LOA files = LOgical
• Internal links
Activation files)
• Text links
• Saved Code Systems in MTR format
• External links
• Geo links
• Concept maps created in
MAXMaps (without externally
saved images)
• Similarity and Distance matrices
• Project-based dicitonaries and
stop/go word lists of MAXDictio
The project file can be transferred to other team members in the form of a single file.
It can also be sent by email. It can also be saved in the shared folder of a cloud system,
such as Dropbox or OneDrive.

26 - Teamwork

758

If the MX22 project file is opened on any other computer where MAXQDA 2022 is
installed, the entire project appears with all its components.
If you want to set up the project, so that various members of the team can work on it
at the same time, it is recommended that you start by importing all documents into a
MAXQDA project on one computer, and then sending a copy of that file to everyone
in the team. This saves you the work of importing the files on each individual’s
computer and guarantees that everyone will have the exact same data set.

Sharing projects that include external files
If you have assigned audio or video files to documents in your project, or if image or
PDF documents were not imported into the project, they are stored in the MAXQDA
folder for external files (you can customize this folder in MAXQDA's preferences via
the gear symbol at the top right edge of the window).
How to exchange all files of a project between teammates including the externally
stored files is described in detail in the section External Files on the subheading "How
to transfer external files from one computer to another?".

Merge Two MAXQDA Projects
Are you using MAXQDA TeamCloud? This function is already integrated into the
TeamCloud workflow and is therefore not available while working with team projects.
The “Merge projects” function causes all elements of a second project to be added to
a project you currently have open. To do this, follow these steps:
1. Open one of the two projects you want to merge.
2. Choose Merge Projects from the Home menu tab.
3. Select the second project from the file dialog window, which will be in the form of
an MX22 file.
The following dialog window will appear:
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Options for merging projects

Because a MAXQDA project can contain only one project memo, one memo per code,
and one Logbook, you can choose, in the top section, what content should be kept
and what should be overwritten. When the default settings are left as is, the existing
data in the already opened project will remain unchanged.
In the bottom section, two options are available that allow you to determine how
MAXQDA should handle documents whose identical name already exists in the
project:
Don’t import already existing documents – When this option is deselected, all
documents from the imported project are inserted into the open project, regardless of
whether they already exist in the project. When you select this option, already existing
documents will be ignored, thus not imported. For example, if the open project
contains the document group “Interviews” with documents A, B, and C, and the
imported project contains the document group “Interviews” with the documents A, B,
and D, document D will be imported and inserted into a second document group.
Documents A, B, and C will be ignored.
Merge document groups with same name – This option is available only when the
previous option is selected. In this case, no further document groups with the same
name will be created, and the imported documents will be integrated into the already
existing document group. This means if the document group “Interviews” with
documents A, B, and C already exists, only document D will be imported.
When you click OK, MAXQDA then starts the merging process, which may take some
time, depending on the size of the two projects.
Please note: Before merging the projects, MAXQDA automatically creates a backup of
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the current project in the selected backup folder.
The merge function is carried out in the following manner:
●

●
●

●
●
●
●
●

All document groups of the imported project will be inserted with their documents,
possibly generating duplicates. If a text group entitled “Interviews” exists in both
projects, the resulting merged project will have two text groups of this name. The
options above can be set so that already existing documents are ignored and so that
no duplicate document groups are created.
All memos of both projects will be inserted.
Coded segments will be merged; in the case that a code or subcode does not exist in
the new project, it will be created. Codes with the same name and same hierarchy
position will be considered identical; their color is not relevant.
Document and code sets will be added.
Summaries will be imported.
All internal and external links will be imported.
Maps in MAXMaps will be imported and added to the existing maps.
Each variable will be analyzed to determine if it already exists in the project.
- If the variable does not exist in the open project, a variable of that name will be
created. The variable values of the documents in the open project will be set to 0 or
to the preset missing value for numerical variables, or empty for text variables.
- If a variable exists with another type declaration, it will be created. Suppose the
open file contains the text variable "marital status" and the file to be added contains
a numerical variable of the same name. The result is that after import two variables
entitled "marital status" will exist; for the old project the numerical variable will be
set to 0 and for the new project the text variable will be left blank.

Intercoder Agreement
When assigning codes to qualitative data, it is recommended to specify certain
qualitaty criteria. You assume, for example, that coding is not arbitrary or random, but
rather that a certain level of agreement between coders will be reached. The
MAXQDA Intercoder Agreement function makes it possible to compare the coding of
two people who coded the data independently of each other. In qualitative research,
the purpose of comparing independent coders is to discuss the differences, figure out
why they occurred, and learn from the differences in order to improve coding
agreement in the future. In other words, the actual percentage of agreement is not
the most important aspect of the tool. Anyhow, this percentage is provided by
MAXQDA.
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It is always the goal of qualitative analysts to achieve as high a level of agreement as
possible between independent coders. It is not, however, focused on getting to a fixed
statistical coefficient as is common practice in quantitative research. Rather, the focus
is on a practical improvement of the coding quality. For this reason, one does not stop
at the determination of a coefficient,. Instead, qualitative researchers want to address
and edit the code assignments that do not match, so that they can move on with
more accurately coded material.

The intercoder agreement procedure
Checking the intercoder agreement involves the following:
●

●

Two coders process the identical document independently and code it according to
mutually agreed code definitions. This can be done on the same computer or on
separate computers. Of course, it is important that both coders cannot see what the
other person has coded.
The two identical documents coded by different coders must be contained in the
same MAXQDA project. The documents must have the same name, but must be in
different document groups or document sets!

The following procedure is recommended:
1. Create a project with the documents to be coded. The documents must be
contained in one or more document groups; or, alternatively, one or more
document sets.
2. Make sure that the necessary codes are included in the "Code System".
3. Make a copy of the project file and pass it on to the second coder.
4. Both coders write their names behind all document groups or document sets.
5. Both coders independently code the data and add new codes if necessary.
6. Use the function Home > Merge Projects to merge both projects into one. The

"Document System" will look like this:
7. Now MAXQDA's Intercoder Agreement function can be used to compare the code
assignments.
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8. Once the comparison is complete, these added documents can be deleted.

Opening the Intercoder Agreement function
You can start the procedure via Analysis > Intercoder Agreement to check whether
two coders agree or disagree in their assignment of codes.

Starting the Intercoder Agreement function via the Analysis menu

The following dialog box will appear, in which you can adjust the settings for checking
the intercoder agreement.

Options for testing intercoder agreement

●

●

●

Select the document group or document set with the document assigned to Coder 1
in the upper drop-down menu and the document assigned to Coder 2 in the lower
drop-down menu.
You can limit the analysis to the currently activated documents and/or codes by
selecting the appropriate options.
In the lower area you can choose between three alternative analysis levels:
Code occurrence in the document – Per document, it is checked whether both
❍
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❍

❍

persons have assigned the same codes.
Code frequency in the document – Per document, it is checked whether both
coders have assigned the same codes the same number of times
Min- code overlapping rate of X% at the segment level – Per coded segment, it is
checked whether the other person has assigned the same code to the segment.

In the following, all three variants and the respective presentation of results are
explained in detail.

Option 1 (document comparison level): Code occurrence in the document
Per document, it is checked whether both persons have assigned the same codes.
Thus, the criterion of comparison is the occurrence or absence of a code in the
document. This option can be useful, for example, if you are working with relatively
short documents, such as free text responses to a survey, and with a large number of
codes.
MAXQDA generates two tables, the “code-specific results table” with the analyzed
codes and the “result table” with detailed information on each compared document.

The code-specific results table
The "code-specific results table" lists all evaluated codes and indicates for how many
documents the coders match in their assignment of the code:

Code-specific results table for the option “Code occurence in the document”

The example table indicates on the top right that a total of 5 codes were analyzed.
There was disagreement for the code “Sibling” and the code “Grandparents”, both
only within one document which is indicated by the column “Disagreements” (the
numbers in the columns “Agreement”, “Disagreements”, and “Total” refer to the
number of documents).

26 - Teamwork

764

The “Percent” column indicates how high the percentage agreement is for the
respective code of each line. The "Total" line is used to calculate the average
percentage agreement – in the example, it is 83.33%.

The detailed result table with evaluated documents
The result table lists all evaluated documents and thus provides detailed information
on the agreement of individual documents.

Results table for the “Code occurs in the document” option

The table has the following structure:
●

●

●

●

●

The first column displays a green symbol if Coders 1 and 2 have assigned the same
codes to the document. In this case, there is one “disagreement” for 3 evaluated
documents symbolized by a red symbol.
The “Agreement” column displays the number of code assignments that match
between Coder 1 and Coder 2 for each document.
The “Percent” column displays the percentage agreement (i.e. the relative number of
matching code assignments). The percentage agreement is calculated as follows:
Agreements / (Agreements + Disagreements). For Interview 2, the example shows a
value of 3 / (3+2) codes = 60.00 % – this is the proportion of codes that match in
Interview 2.
The ast column indicates a kappa value that contains a chance correction for the
level of agreement (calculation: see below).
The last line "<Total>" adds up the matches and mismatches. The number in the
“Percent” column corresponds to the average number of matching codes, in the
example it is 86.67 %.

The header contains further information:
●

On the left you can see the number of code assignments carried out by the two
coders, which can often already give first indications of the same or different coding
behavior. In the example, one coder has coded 22 segments and the other has
coded 24.
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●

The number of analyzed documents and the relative number of identically coded
documents are shown on the right: In the example these are 2 of 3 documents,
corresponding to 66.67 %.

In addition to the usual MAXQDA functions for opening the function again and for
filtering and exporting the results, the toolbar also contains the following important
tools:

Display only disagreements – Hides all matching rows and provides quick access to
documents where the coders do not match.

Ignore unassigned codes / Count unassigned codes as matches - Here you can decide
whether any given codes that were not assigned by both coders, should be considered
as matches or should be ignored. The difference can be explained using the following
table:
Coder 1 Coder 2
Agreement?
Code A X

X

yes, always

Code B X

no, never

Code C

depending on selected option

Code C was included in the intercoder agreement check but was neither assigned by
Coder 1 nor by Coder 2 in the document. In this case, if you select the option Ignore
unassigned codes, code C will be ignored and the relative number of matching code
assignments is 1 of 2 = 50%. If the other option is selected, the match is 2 of 3 = 67
%, because code C is taken into account.

Interactive results table
The results table is interactive. Double clicking on a row opens the Code Matrix
Browser for the relevant document:
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Inspecting the occurrence of codes in two documents with the Code Matrix Browser

The title bar shows the compared document, in the example “Interview 2”. The view
immediately shows where the two coders disagreed: Coder 1 has assigned the code
“Siblings”, but Coder 2 has not, while Coder 2 assigned the code “Grandparents”,
but Coder 1 has not.

Kappa calculation (Rädiker & Kuckartz)
In the "Kappa (RK)" column, the results table indicates a randomly corrected value for
the percentage agreement. It takes into account the probability of two people
randomly selecting and assigning the same codes in a document (if they simply
randomly selected codes without considering the data material). The calculation only
makes sense if you select the option Count unassigned codes as matches and is
therefore only visible if this option is selected.
Kappa (Rädiker & Kuckartz), abbreviated to Kappa (RK), is calculated as follows:
Ac = Agreement by chance = 0.5 to the power of the number of codes selected for
analysis
Ao = Agreement observed = percentage agreement
Kappa (RK) = (Ao – Ac) / (1 – Ac)
The random correction is generally very small, because the probability for the random
match very quickly becomes negligible with an increasing number of codes. Therefore,
it only makes sense to use this correction, if you are including a maximum of 3 codes
in the intercoder check.

Option 2 (document comparison level): Code frequency in the document
With this analysis option, agreement is deemed to apply when two coders have
assigned a code with the same frequency in the document. The difference between
the frequencies is irrelevant: if one coder assigns a code A once and the other three
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times, or if the difference is once vs. six times, both situations are always considered to
be a disagreement.
The results for this second analysis option corresponds, in principle, to the first option
– with the following exceptions:
●

●

Code-specific results table: : The column “Agreement” informs about the number of
documents for which the frequencies per code between the codesrs matches and
the column “Diagreement” informs about the number of documents in which the
code frequencies differ.
Results table with analyzed documents:
a. The cells indicate how many codes were assigned equally often by both coders
in the document.
b. The "Kappa (RK)" column is never displayed.
c. Double-clicking on a row also displays the Code Matrix Browser. Here, squares
of different sizes now indicate the differences in the coded characteristics of the
clicked document.

Option 3 (segment comparison level): Min. code intersection rate of X%
at the segment level
The system checks whether the two coders match in their coding of individual
segments. This option is the most advanced of the three and is the most commonly
used option for qualitative coding.
Since texts in qualitative analysis processes are not often subdivided into fixed text
units, the system checks the correspondence for each segment coded by the two
coders (dialog option Analysis: Segments of both coders). This means that each coded
segment is analyzed for a match. If, for example, Coder 1 has coded 12 segments and
Coder 2 has coded 14, then 26 test operations are performed and the detailed results
table includes exactly 26 rows. Alternatively, you can choose to analyze only the
segments of document 1 or the segments of document 2. This can be helpful, for
example, to test the extent to which one coder matches a reference example for code
assignments.
Set tolerance for segment boundaries
It is often the case that coders deviate slightly from each other when assigning codes,
e.g. because a person has coded one word more or less. This is usually irrelevant in
terms of content, but can lead to an unnecessarily small percentage match if
absolutely identical coding is evaluated, and lead to “false” disagreements.
You can therefore specify in the options dialog box when two code assignments are to
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be treated as as a match. As the following image illustrates, the criterion used is the
percentage of the intersecting area of two code assignments: How large is the
intersecting area of two code assignments in relation to the total area covered by the
two code assignments with their outermost segment boundaries?
●

●

Code-specific results table: The number of documents for which the frequencies per
code is a 100% match is displayed in the cells.
Results table with analyzed documents:
a. The cells indicate how many codes were assigned equally frequently by both
coders in the document.
b. The "Kappa (RK)" column is never displayed.
c. Double-clicking on a row also displays the Code Matrix Browser. Here squares
of different sizes now indicate the differences in the coded characteristics of the
clicked document.

Results for option 3 „Min. code intersection rate of X% at the segment level“
With this option, the system checks at the segment level whether the codes match. If,
for example, Coder 1 has coded 12 segments and Coder 2 has coded 14, then 26 test
operations are performed and the detailed results table includes exactly 26 rows.
It is often the case that coders deviate slightly from each other when assigning codes,
e.g. because a person has coded one word more or less. This is usually irrelevant in
terms of content, but can lead to an unnecessarily small percentage match if
absolutely identical coding is required, and lead to "false" non-agreements.
You can therefore specify in advance in the options dialog box when two code
assignments are to be treated as as a match. The criterion used is the percentage of
the intersecting area of two code assignments. The following question is answered:
How large is the intersecting area of two code assignments in relation to the total area
covered by the two code assignments with their outermost segment boundaries?
The entry is made as a percentage and the threshold value can be set in the dialog
box. The default value is 90%, but can be set higher for testing purposes and then
reduced step by step if there are too many "false alarms".
Two results tables are generated: the code-specific results table and the segmentspecific table.

The code-specific results table
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The code-specific results table

This table has as many rows as the number of codes included in the intercoder
agreement check. Codes that were not assigned by either of the two coders are not
included in the table even they have been selected for the intercoder check. The table
provides an overview of the matches (agreements) and non-matches (disagreements)
in code assignments between the two coders. It reveals the weak points, i.e., for
which codes the desired percentage agreement is not achieved.
For each code, the table indicates the total number of segments coded ("Total"
column), the number of matches (agreements), and the code-specific agreement
percentage. In the <Total> row, the (dis)agreements are added so that an average
percentage agreement can be calculated. In the example, this is 93.08%.

The detailed results table with analyzed segments
The second table allows for an exact inspection of the intercoder agreement, i.e. it is
possible to determine for which coded segments the two coders do not match.
Depending on the selected setting, the table contains the segments of both coders, or
only those of one coder, and indicates whether the second coder has assigned the
same code at the segment’s location.
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The segment-specific results table

Agreement in the assignment of a code to a given segment is indicated by the green
symbol in the first column. A red icon in this column indicates that there is a
disagreement for this segment.
Tip: Clicking on the first column header sorts the column so that all red rows in the
table are listed at the top and you can inspect and discuss any discrepancies step by
step. By clicking on the
icon, only the problematic segments are displayed.

Interactivity of the Results Table: Compare Segments
The results table is interactively linked to the original data and allows for a targeted
inspection of the analyzed segments:
●

●

●

Clicking on a row highlights both associated documents in the "Document System"
and opens them by default in their own tabs, highlighting the clicked segment. In
the toolbar you can change the setting from Display in two tabs to Display in two
document browsers - then the document coded by "Coder 2" will be displayed in a
separate window. This option is especially useful if you are working with two
screens.
Double-clicking on the small square in the "Coder 1" or "Coder 2" columns focuses
the corresponding document in the "Document Browser" at the location of the
segment in question. This makes it easy to jump back and forth between the two
documents and judge which of the two coders applied the code according to the
code assignment guidelines.
If you click on a row with your right mouse button, a context menu will appear as
shown in the picture above, allowing you to transfer the code assignment, or lack
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thereof, from one document to the other directly. For example, select the option
Adopt the solution of Coder 1.
Coefficient Kappa for exact segment matches
In qualitative analysis, the analysis of intercoder agreement serves primarily to improve
coding instructions and individual codes. Nevertheless, it is also often desirable to
calculate the percentage of agreement, particularly in view of the research report to be
generated later. This percentage of agreement can be viewed in the code-specific
results table above, in which individual codes as well as the ensemble of all codes are
taken into account.
Researchers often express the desire to indicate not only percentage agreement rates
in their research reports, but also to include chance-corrected coefficients. The basic
idea of such a coefficient is to reduce the percentage of agreement by that value
which would be obtained in a random assignment of codes to segments.
In MAXQDA, the commonly used coefficient “Kappa (Brennan & Prediger, 1981)” can
be used for this purpose: In the results table, click on the Kappa symbol to begin the
calculation for the analysis currently underway. MAXQDA will display the following
results table:
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Intercoder coefficient Kappa (Brennan & Prediger, 1981)

The number of codes that match is displayed in the upper left corner of the four-field
table. In the upper right corner and the lower left corner you will find the nonmatches, meaning one code, but not the other, has been assigned in a document. In
MAXQDA, the intercoder agreement at the segment level takes into account only the
segments to which at least one code has been assigned; therefore the cell on the
lower right is, by definition, equal to zero (as document sections will be included in the
analysis only if they are coded by both coders).
“P(obersved)” corresponds to the simple percentage of agreement, as it was displayed
in the “Total” line of the code-specific results table.
For the calculation of “P(chance)”, or chance of agreement, MAXQDA employs a
proposal made by Brennan and Prediger (1981), who dealt extensively with optimal
uses of Cohen’s Kappa and its problems with unequal marginal sum distributions. In
this calculation, the random match is determined by the number of different
categories that have been used by both coders. This corresponds to the number of
codes in the code-specific results table.
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Please note: If the coders have assigned the same number of codes to a segment and
two or more codes have been analyzed, you should include the first Kappa value listed
in the results in your report of publication. If the coders have assigned a different
number of codes to a segment or only one code has been analyzed, you should
include the second Kappa value listed in the results (see Kuckartz & Rädiker, 2019, S.
280–281).

Prerequisites for the calculation of randomly corrected coefficients such as
Kappa
For the calculation of coefficients such as Kappa, segments usually have to be defined
in advance, and are provided with a predetermined set of codes. In qualitative
research, however, a common approach is that not to define segments a priori, but
rather to assign the task to both coders of identifying all document segments that they
view as relevant, and to assign one or more appropriate codes. In this case, the
probability that two coders code the same section with the same code would be
lower, and hence Kappa would be greater. One could also argue that the probability
of randomly occurring coding matches in a text with multiple pages and multiple
codes is so insignificant that Kappa corresponds to the simple percentage agreement.
In any case, the calculation should be carefully considered.

User Access Management
Are you using MAXQDA TeamCloud? Please note that this feature is not available
while working with team projects.
MAXQDA supports teams working on projects with an optional user management
system, in which you can set different rights for different groups of users.
Please note: The admin system is not designed for data security, but for team
collaboration with different user roles.
To activate the user management system, select Home > Teamwork > Activate User
Management from the ribbon menu.
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Activating user management

The user who activates the user management will automatically become administrator
and has to set a password for his/her username.

Set admin password

Caution: Note your password carefully! Without this password, the MAXQDA project
can no longer be opened.
Once the administrator has been established, user management can only be opened
with a valid administrator name and password. The next time the project is opened a
login window will appear and you'll be prompted for a valid username and password.

Login window

In the default configuration, only administrators are able to open the user
management, add users or change rights.
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The User Management window
In the main user management window, you can create new users, remove existing
users, and define the rights of individual user groups.

Main user management window

On the left side of the user management window, the various levels (Admin and Levels
1-3) are displayed. The right side of the window contains information about each user,
which can be created or edited here; it is also here that users can be assigned to one
of four user groups.

Adding a new user
Click on the Add user
button to add a new user. The new user settings can
subsequently be edited:
User: Here you can set the username (= Login name), with which the user can log into
the project.
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Group: Here you can set the level within the hierarchy to which the user is assigned.
Name: Here you can enter the user's real name.
Comments: In this field, you can post comments regarding the user.
The properties of a user can be modified at any time by clicking on the username in
the left side of the window.

Deleting users
To delete a user, select the username in the left side of the window and click the
Delete user button. You will be required to confirm your selection.

User passwords
User passwords can be managed in two ways. If no password has been set by an
admin, each user must first log in and set his own password. Alternatively, the
administrator can set an initial password and communicate it to the other users. In
order to set the initial password, click the Set initial password button. The users can
then access the MAXQDA project with this password, and set their own passwords
upon first use. Only the user will know this new password. If a user forgets his
password, the administrator can reset it by clicking the Reset user password button.
The administrator can also reset the initial password in this way.

Initial password
The purpose of the initial password is to act as a barrier to entry into the project. New
users must enter this password the first time they log into a locked MAXQDA project,
before setting their personal passwords.

Hierarchical levels
When you click on a particular level in the left side of the window, the rights of the
users at this level will be displayed on the right side of the window. Aside from the
Admin Level, users can be placed in three different groups, from Level 1 to Level 3. In
a research project, the levels can be established, for example, in the following way:
●
●

●

Level 1: Project leaders
Level 2: Research associates, who can import and delete texts, work with the “Code
System,” and write, edit and delete memos
Level 3: Student associates, who work primarily on the coding of material
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The following image displays the default Level 1 functions. For example, the top three
functions are reserved by default for the Admin Level. User rights can be modified at
any time by clicking on the red or green icon in front each program function. Any
number of users can be assigned to each level, including the Admin Level. At least one
administrator must be defined in any case, meaning the last entry in this list cannot be
deleted.

Define user rights for various levels of the hierarchy

Modifying user settings
Click on a username in the left side of the window in order to modify settings in the
right side.

Importing and Exporting the Entire Admin System
It is possible to export the entire Admin System of a MAXQDA project, including
usernames, passwords and user rights. Click on the Export button on the lower
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edge of the main window. The data will be saved in MXUSR format, which is, of
course, encrypted. This file can be imported into another MAXQDA project by clicking
on the Import button, thus saving the administrator a lot of time.

Deactivating the User Management system
It is possible to deactivate user management at any tim by opening the User
Management window via Home > User Management > Deactivate User Management
and checking the corresponding box at the lower edge of the window, then closing
the window.

Option “Deactivate user management”

All usernames and passwords will be saved in the project, so it is possible to reactivate
the user management at any time.
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Checking for Updates
Each time you start the program, MAXQDA will check the MAXQDA website to see if
an updated version is available. If an update is available, it is recommended that you
download it in order to benefit from interesting new features and enhancements.
Under Preferences, that you can open from the settings icon in the top right corner of
the MAXQDA window, you have the options to decide if MAXQDA should Search for
updates automatically or not.
If you have opted to skip an update, you can later request it manually: Click on the
question mark in the top right of the MAXQDA main window and select the option
Search for Updates.
Please note:
●
●

You need admin rights to install the update on your computer.
If you are using a MAXQDA network license, it may be possible that your network
admin has deactivated the automatic search for updates. In this case MAXQDA will
not check for an update each time you start the program and you will also not find
the option in the help menu.

Keyboard Shortcuts
The following keyboard shortcuts are available in MAXQDA.

General
Windows
F1
Ctrl + N
ctrl + O
ctrl + A

macOS
⌘ (cmd) + ⇧ + ?
⌘ (cmd) + N
⌘ (cmd) + O
⌘ (cmd) + A

ctrl + C

⌘ (cmd) + C

ctrl + X

⌘ (cmd) + X

Opens the MAXQDA help system.
Creates a new project.
Opens an existing project.
Highlights the entire text.
copies the selected segment to the
clipboard.
cuts out the selected segment and puts it
in the clipboard.
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ctrl + V

⌘ (cmd) + V

Alt + 1

option ⌥ + 1

Alt + 2

option ⌥ + 2

Alt + 3

option ⌥ + 3

Alt + 4

option ⌥ + 4

ctrl + Alt + B
ctrl + Alt + M
ctrl + Alt + R
ctrl + F
ctrl + ⇧ + F
ctrl + P
Alt + Double-click
ctrl + R

Pastes the selection from the clipboard.
Opens/closes the window "document
system".
Opens/closes the window "code system".
Opens/closes the window "document
browser".
Opens/closes the window "retrieved
segments".

⌘ (cmd) + option ⌥
Opens the logbook.
+B
⌘ (cmd) + option ⌥
Opens the Code Matrix Browser.
+M
⌘ (cmd) + option ⌥
Opens the Code Relations Browser.
+R
Opens the search toolbar for the current
⌘ (cmd) + F
window or the table overview.
⌘ (cmd) + ⇧ + F
Opens the text search.
⌘ (cmd) + P
Prints the focused window or view.
Inserts a MAXQDA object (e.g. a
option ⌥ + doubledocument or code) into MAXMaps, if
click
MAXMaps is open.
Resets activations in the "Document
⌘ (cmd) + R
System" and "Code System".

"Document System“
Windows
Double-click
⇧ + double-click
ctrl + click
F2
Del
Alt + ⇧
Alt + ⇩
ctrl + Drag & Drop
ctrl + T
ctrl + D
Alt + ⇧ + M

macOS
Double-click
Opens a document.
⇧ + double-click
Opens a document in a new tab.
⌘ (cmd) + click
Activates or deactivates a document.
Enter
Renames a document.
⌘ (cmd) + BackspacE Deletes a document.
option ⌥ + ⇧
Moves a document or document group up
option ⌥ + ⇩
and down in the “Document System“.
creates a copy of the document without
option ⌥ + Drag &
coded segments (start dragging and then
Drop
hold ctrl/option)
creates a new document and opens it for
⌘ (cmd) + T
editing in the “Document Browser“.
Opens the dialog window for importing
⌘ (cmd) + D
documents.
creates a new memo or opens an existing
option ⌥ + ⇧ + M
memo for a document.
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"Code System“
Windows
ctrl + click
ctrl + ⇧ + click
F2
Entf
Alt + ⇧,
Alt + ⇩
Alt + RightArrow,
Alt + LeftArrow

Alt + Drag & Drop
Alt + N

macOS
Activates or deactivates a code including
the subcodes.
Activates or deactivates a code without
⌘ (cmd) + ⇧ + click
subcodes.
Enter
Renames a code.
Backspace
Deletes a code.
option ⌥ + ⇧
Moves a code (possibly with subcodes) up
option ⌥ + ⇩
and down in the “Code System“.
option ⌥ +
RightArrow,
Increases and decreases the level of
option ⌥ +
hierarchy of a code.
LeftArrow
creates a copy of the code without coded
option ⌥ + Drag &
segments (start dragging and then hold
Drop
ctrl/option).
⌘ (cmd) + option ⌥
Inserts a new code on the chosen level.
+N
⌘ (cmd) + click

"Document Browser“
Windows
ctrl + E
ctrl + ⇧ + P
Alt + L
Alt + W
Alt + C

Alt + I

ctrl + l

macOS
⌘ (cmd) + option ⌥
+E
⌘ (cmd) + ⇧ + P
⌘ (cmd) + option ⌥
+L

starts and stops Edit Mode.

starts and stops Paraphrase Mode.
codes the selected segment with the most
recently used code.
opens the dialog window for creating a
⌘ (cmd) + option ⌥
new code, which will be used to code the
+W
selected segment.
⌘ (cmd) + option ⌥ codes the selected segment with the code
+C
shown in the Quick List.
codes the selected segment with a newly⌘ (cmd) + option ⌥ created code named after the first 63
+I
characters of the selected segment (invivo-coding).
Inserts an internal link at the location of
the selected segment. The location it is
⌘ (cmd) + l
linked to is set by highlighting another
segment in that document or another one
in the project and hitting Ctrl + L again.
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Inserts a new timestamp into a transcript
when in transcription mode.
Moves to the next/previous page of a PDF
document.
Moves to the beginning or the end of a
PDF document.

F6

F6

PgUp, PgDN

PgUp, PgDN

Pos1, End

Pos1, End

ctrl + Plus,
ctrl + Minus
ctrl + Zero
Alt + Tab,
Alt + ⇧ + Tab
ctrl + F4

cmd + Plus,
cmd + Minus
⌘ (cmd) + Zero
option ⌥ + Tab,
option ⌥ + ⇧ + Tab
⌘ (cmd) + W

Zooms in or out of the document.
Zooms the view to 100 %.
Jumps to the next/previous tab.
closes the current tab or the current view.

“Multimedia Browser” toolbar
Windows

macOS

F3
⇧ + F3
F4 or
F5 or
2x⇧
F7
F8
F9
F10
F12
⇧ + F12

F3
⇧ + F3
F4 or
F5 or
2 x ctrl
F7
F8
F9
F10
F12
⇧ + F12

Jumps to the next memo.
Jumps to the previous memo.

ctrl + L

⌘ (cmd) + L

Alt + ⇧ + M

option ⌥ + ⇧ + M

Plays or pauses the media file.
Sets a clip start.
Sets a clip end.
Plays a clip.
cancels the clip mark.
Jump 5 seconds forward
Jump 5 seconds back
Insert a link start to the selected clip. Use
the same keyboard combination to insert a
link goal.
Insert a memo at the current position of
the media file.

Table overviews, e.g. Overview of Coded Segments
Windows
ctrl + ⇧ + E
ctrl + ⇧ + H
ctrl + E
Del

macOS
Opens the table as Excel file in the
standard program.
Opens the table as HTML file in the
⌘ (cmd) + ⇧ + H
standard internet browser.
Opens the dialog window for exporting
⌘ (cmd) + E
the table or view.
⌘ (cmd) + Backspace Deletes the chosen row/s.
⌘ (cmd) + ⇧ + E
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MAXDictio Dictionary [only available in MAXQDA Plus and MAXQDA
Analytics Pro]
Windows
ctrl + ⇧ + N
ctrl + Alt + N
ctrl + E
Del

macOS
⌘ (cmd) + ⇧ + N
creates a new category.
⌘ (cmd) + option ⌥
creates a new search item.
+N
Opens the dialog window for exporting a
⌘ (cmd) + E
dictionary.
⌘ (cmd) + BackspacE Deletes the chosen category.

MAXDictio Stop list [only available in MAXQDA Plus and MAXQDA
Analytics Pro]
Windows
Alt + ⇧ + N
ctrl + E
Del

macOS
⌥ (option) + ⇧ + N creates a new word to be excluded.
Opens the dialog window for exporting
⌘ (cmd) + E
the stop list.
⌘ (cmd) + Backspace Deletes the focused items.

File Management
MAXQDA works with the following file types:
.MX22
.MC22
.MX20
.MX18
.MX12
.MX11
.MX5
.MX4
.MX3
.MX2
.M2K
.LOA
.SEA
.MTR
.MOD
.MEX22

MAXQDA 2022 project file for Windows and Mac
MAXQDA 2022 Team Cloud project file
MAXQDA 2020 project file for Windows and Mac
MAXQDA 2018 project file for Windows and Mac
MAXQDA 12 project file for Windows and Mac
MAXQDA 11 project file for Mac
MAXQDA 11 project file for Windows
MAXQDA 10 project file
MAXQDA 2007 project file
MAXQDA 2 project file
MAXQDA 1 project file
Saved formula files (activation by variables)
Saved search files (SEArch file)
Exported “Code System”
Exported MAXMAp
MAXQDA Exchange file (MAX EXchange)

Technical Data and Information

784

Limitations and Technical Information
MAXQDA sets very few limits. The following table informs about importable file
formats and some limits within MAXQDA.
Importable Text formats: RTF/D, DOC/X, ODT, PDF, TXT, HTML
Importable Table formats: XLS/X
Importable Image
JPG, GIF, TIF, PNG
formats:
Windows: MP3, WAV, WMA, AAC, M4A
Supported Audio formats:
Mac: MP3, WAV, AAC, CAF, M4A
MP4, MOV, MPG, AVI, M4V, 3GP, 3GGP
Supported Video formats:
Windows: WMV recommended Codec: H.264/AVC
Twitter Import:
Max. 10,000 tweets per import
Twitter Analysis:
No set limit to number of tweets
YouTube Import:
Max. 10,000 most current comments per video
Number of projects:
No set limit
Number of document
No set limit
groups:
Groups of more than 1,000 are not recommended
No set limit. Dividing them into document with groups with
Number of documents:
max. 1,000 is recommended
Number of codes:
No set limit
Above 200,000 coded segments the stability of MAXQDA
Number of coded
cannot be guaranteed (if your computer has less than 4 GB
segments:
RAM this threshold may be lower)
Code System levels:
Max. 10

What data volumes can be processed with MAXQDA?
As the table overview above shows, there are very few technical limits to the data you
can work with in MAXQDA. However, it should be noted that several thousand
documents, codes, and coded segments in a project can affect the level of
performance.
It is therefore important to note some qualitative answers to the question of how
many documents, codes, coded segments, etc. you can process with MAXQDA.
General answers are only partially helpful and may differ in individual cases, since the
performance of MAXQDA of course also depends on the hardware used. However, in
practise, such issues only arise in very few instances, in which very large amounts of
data need to be analyzed. They are certainly not common for “standard” projects in
qualitative or mixed methods research.
The following factors may influence the performance of MAXQDA - sometimes in
combination:
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Number of documents in the "Document System"
As a rule, several thousand documents will pose no problem for MAXQDA if they are
organized in several document groups. So, for example, answers to open questions
from (online) surveys with 1,000 cases (= documents) can be analyzed in MAXQDA
with ease.

Number of codes in the "Code System"
Again, there is no technical limit: Several thousand codes can be processed, but
certainly it is not easy to manage more than 1,500 codes from a research point of
view.

Number of coded segments per document
Even 1,000 coded segments and more in a document rarely pose a problem. That
being said, if the length of the text is very large or the codes are spread over a few PDF
pages or paragraphs, it is recommended to hide individual coding stripes to allow for a
greater display speed. To do this, click on the gear drive symbol in the gray area in
which the coding stripes are displayed in the “Document Browser” and select, for
example, which colors should be displayed and which should be hidden.

Length and contents of text documents
If a single text document is very long, e.g. with more than 300 pages, it may take a
few moments before the document is displayed. If such a document also contains a
large number of codes (for example, more than 500), this can cause further delays.
For text documents containing a large number of images (for example, more than 50)
or very large (for example, 30 mega pixels) images, it may be better to import the
document as a PDF document or split it into multiple documents. In this way, the
performance speed can be increased when opening and editing these documents.

Size of table documents
For table documents, the time it takes to open the document depends on the number
of rows/columns and the size of the cell contents. For 1,000 rows of 20 columns, it
may take a few seconds for the document to open. The time to open is also affected
by how many codes there are in the table. The coding and editing of cells in an open
table document with 1,000 rows and 20 columns can then be completed without any
delays.
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Number of tweets analyzed simultaneously
The start of the Twitter analysis as well as the opening and filtering of tweets is still
sufficiently fast even with 200,000 tweets. Only the compilation of word frequencies
requires one to two minutes of computation time for this amount of data.
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